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Prlvodce programem Calc

Predmluva



Pro koho je tato kniha uréena?

Tato kniha je urCena pro zacateCniky i pokrocilé uZivatele programu Calc, tabulkového procesoru
LibreOffice. Neni pfitom dllezité, zda jde o Upiného zacate¢nika nebo uZivatele, ktery uz ma
zkuSenosti s jingm kancelafskym balikem. Pokud jste LibreOffice jeSté nikdy nepouzivali, nebo si
prejete predstavit vSechny jeho komponenty, méli byste si nejdfive pfecist pfirucku Zaciname s
LibreOffice. Pokud jste dosud tabulkovy procesor nepouzivali, miZete si také precist knihu nebo
najit néjaké navody o pouzivani tabulek.

O ¢em je tato kniha?

Tato kniha pfedstavuje vlastnosti a funkce programu LibreOffice Calc. Nejedn& se o navod k
pouZzivani tabulkovych procesord. Nékteré kapitoly pfedpokladaji znalost zakladniho pouzivani
tabulek pfi popisu pouziti programu Calc.

Do sesitd miZzeme vkladat data (obvykle ¢iselnd) a pak s nimi pracovat tak, abychom ziskali
urcité vysledky. Je také mozné zadat data a pak pouzit Calc pro tlohy typu ,Co kdyZ...": nékteré
z Gdajl zménime a zkoumame, jak se zméni vysledky, aniz bychom museli vytvaret novy sesit
nebo list. Funkce Ize pouzit k vytvoreni vzorcl pro provadéni slozitych vypoctd dat.

Mezi dalSi funkce programu Calc patfi:

+ Databazové funkce umoznujici data radit, ukladat a filtrovat.
» Datoveé statistické nastroje pro provadéni komplexni analyzy dat.
« Dynamické grafy: Siroky rozsah 2D a 3D graf(.

« Makra pro zaznamenavani a spousténi ¢asto opakovanych tkolll. Mezi podporované
skriptovaci jazyky na tvorbu maker patfi LibreOffice Basic, Python, BeanShell a
JavaScript.

* Schopnost otevirat, upravovat a ukladat Microsoft Excel a dalsi seSity.
e Import sesitd z rGznych formatd, véetné HTML, CSV a Data Interchange Format.
« export sesitll do rlznych format(, véetné HTML, CSV a Data Interchange Format.

Kde ziskat pomoc

Tato kniha, ostatni pfirucky pro LibreOffice, vestavéna napovéda a podpora uZivatell
predpokladaji, Zze uzivatel méa zakladni znalosti s praci na pocitaci, tj. Ze dokaze spoustét
programy Ci otevirat a ukladat soubory.

Systém napoveédy

LibreOffice pfichazi s rozsahlym systémem napoveédy. Je prvnim mistem, kde ziskat pro
LibreOffice podporu. UzZivatelé Windows a Linux si mohou zvolit staZzeni a instalaci offline
napoveédy pro pouziti ve chvili, kdy nejsou pfipojeni k internetu; offline napovéda je nainstalovana
s programem na systému MacOS.

Chceme-li zobrazit systém napovédy, stiskneme F1 nebo vybereme Napovéda LibreOffice z
nabidky Napovéda (obrazek 1). Pokud neméame v pocitaci nainstalovanou offline napovédu a
jsme pfipojeni k internetu, nas vychozi prohlize¢ otevre stranky online napovédy na webu
LibreOffice.

Nabidka Napovéda obsahuje odkazy na dalSi informace a podporu LibreOffice.
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MNapovéda
© Népovéda LibreOffice F1
[3+ Cojeto?

UZivatelske prirucky

Zobrazit tip dne

= Poradit se online
=] Odeslat zpétnou vazbu

Restartovat v nouzoveém rezimu...

Zapojte se
[#7 Podporit LibreOffice financné
Informace o licenci

O aplikaci LibreOffice
Obrazek 1: Nabidka napovéda

Poznamka

Nasledujici volby oznacené znakem * jsou pfistupné pouze v pfipadg, Ze je pocitac
pripojen k Internetu.

Co je to? — Rychlé tipy ziskame, kdyz umistime ukazatel mySi nad ikonu. Zobrazi se tip
napoveédy s kratkym popisem funkce ikony. Podrobnégjsi vysvétleni ziskame, pokud v
hlavni nabidce zvolime Napovéda > Co je to? a kurzor mySi podrzime nad ikonou.
Kromé toho je mozné aktivovat rozSifené tipy, a to pomoci Nastroje > MozZnosti >
LibreOffice > Obecné z hlavni nabidky.

Poznamka

Co je to? rozSifené tipy se vylepSuji, ale v LibreOffice 7.0 je tato prace nelplna, a
proto nejsou plné funkéni.

Uzivatelské pfirucky * — Otevie vychozi prohliZze¢ na strance Dokumentace na webu
LibreOffice https://documentation.libreoffice.org/cs/czech-documentation. Zde najdeme
kopie uzivatelskych pfirucek a dalSi uzitecné informace.

Zobrazit Tip dne — Otevie dialogové okno zobrazujici uzite€nou informaci o LibreOffice.

Poradit se online * — Otevie vychozi prohlize¢ na strance Ask LibreOffice, strance
dotaz(i a odpovédi Ceské a slovenské komunity uzivatell kancelarského baliku
LibreOffice https://ask.libreoffice.org/cs-cz/questions.

Odeslat zpétnou vazbu * — Otevie vychozi prohlize¢ na webové strance zpétné vazby
LibreOffice https://www.libreoffice.org/get-help/feedback. Odtud mlzeme hlasit chyby,
navrhovat nové funkce a komunikovat s ostatnimi v komunité LibreOffice.

Restartovat v nouzovém reZzimu — Otevfe dialogové okno, ve kterém budeme mit
moznost restartovat LibreOffice a obnovit vychozi nastaveni softwaru.
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e Zapoijte se* — Otevie vychozi prohlize¢ na webové strance LibreOffice Pfipojte se k ndm
https://cs.libreoffice.org/community/pipojte-se-k-nam. Zde zjistite, jak ndm mizZete
pomoci LibreOffice jeSté vylepsit!

« Podpofit LibreOffice finanéné* — Otevie vychozi prohlize¢ na strance Podpotite
LibreOffice https://cs.libreoffice.org/donate. Zde miZeme poskytnout dar na podporu
LibreOffice.

* Informace o licenci - Otevie dialogové okno uvadéjici licence, na zékladé kterych je
LibreOffice k dispozici.

« Zkontrolovat aktualizace* — Otevie dialogové okno a zkontroluje web LibreOffice, zda
neobsahuje aktualizace nasi verze softwaru.

* O aplikaci LibreOffice — Otevrie dialogové okno a zobrazi informace o verzi LibreOffice
a pouzivaném operacnim systému. Tyto informace budou €asto vyZadovany, pokud
pozadate komunitu o0 pomoc nebo asistenci se softwarem. K dispozici je tlagitko, které
nam umozni zkopirovat tyto informace do schranky, abychom je mohli nasledné vloZzit do
prispévku na féru, do e-mailu nebo do zpravy o chybé.

DalSi volné dostupna podpora na internetu

Komunita LibreOffice kromé vyvoje softwaru poskytuje bezplatnou podporu od dobrovolnikd.
Kromé vyse uvedenych odkaz( na nabidku Napovéda jsou k dispozici dalsi moznosti podpory
online komunity, viz tabulka 1.

Tabulka 1: Bezplatna podpora LibreOffice

Odpovédi na Casto kladené otazky

Caste otazky https://wiki.documentfoundation.org/Faq

Podpora od komunity poskytovana siti zkusenych uzivatel(

E-mailove konference https://cs.libreoffice.org/get-help/mailing-lists

Pomoci webové sluzby Ask je poskytovana komunitni podpora zdarma.
Vyhledat podobna témata nebo otevfit nova mizeme na strance

Otazky a odpoveédi a https://ask.libreoffice.org/en/questions.

Databaze znalosti Sluzba je k dispozici v nékolika dalSich jazycich; staci nahradit /en/ za cs-
cz, de, es, fr, ja, ko, nl, pt, tr, a mnoho dalSich na vySe uvedené webové
adrese.

Webové stranky LibreOffice v rliznych jazycich
https://cs.libreoffice.org/community/nic/

Podpora v réznych E-mailové konference pro rlizné jazyky

jazycich https://wiki.documentfoundation.org/Local_Mailing_Lists
Informace o sociélnich sitich
https://wiki.documentfoundation.org/Website/Web_Sites_services

Informace o dostupnych moznostech pro zlepSeni pfistupnosti

Moznosti zpristupnent https://cs.libreoffice.org/get-help/accessibility/

Komunitni podporu v €estiné a slovenstiné nabizi také pro LibreOffice

Forum OpenOfice férum na strance https://forum.openoffice.cz/

Placena podpora a skoleni

Je také moZzno zakoupit podporu ve formé smlouvy o poskytovani sluzeb, a to od prodejce nebo
poradenské firmy specializované na LibreOffice. Informace o certifikované profesionalni podpofe
se nhachazi na webovych strankach The Document Foundation: https://cs.libreoffice.org/get-
help/professional-support/
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Mozné vzhledové odchylky

llustrace

LibreOffice Ize instalovat a spoustét v operacnich systémech Windows, Linux a macOS, pficemz
kazdy z nich ma nékolik verzi a uZivatelé si je mohou pfizpUsobit (pisma, barvy, témata vzhledu,
spravce oken). llustrace v tomto navodu byly vytvoreny v rdznych operacnich systémech a na
rlznych pocitacich. Proto je mozné, Ze né&které prvky v ilustracich nebudou presné takové, jak je
vidime na svém pocitaci.

Neéktera dialogova okna se mohou lisit i kvdli rdznym nastavenim samotného LibreOffice.
UZivatel si totiz mGze zvolit, zda chce pouzivat dialogova okna operaéniho systému, nebo okna
LibreOffice. Tyto rozdily se tykaji pfedevSim dialogovych oken Otevfit, Ulozit a Tisk. Zobrazovani
dialogovych oken LibreOffice Ize povolit a zakazat v dialogovém okné Nastroje > Moznosti >
LibreOffice > Obecné, kde zaSkrtneme Ci zruSime zaSkrtnuti moznosti Pouzit dialogy
LibreOffice.

Ikony

Komunita LibreOffice vytvofila ikony pro nékolik sad ikon: Colibre, Breeze, Breeze Dark,
Elementary, Karasa Jaga, Sifr, Sifr Dark a Sukapura. Kazdy uZivatel si miZe vybrat preferovanou
sadu. Snimky obrazovky byly pro tuto pfiruc¢ky vytvareny v riiznych instalacich LibreOffice, které
pouzivaly rlizné sady ikon. lkony, které opravdu uvidime ve své verzi LibreOffice, se mohou liSit
od téch, které jsou zobrazeny v této pfirucce.

Chceme-li zménit pouzitou sadu ikon, pfejdeme na Nastroje > MozZnosti > LibreOffice >
Zobrazeni. Z rozeviraciho seznamu vybereme Styl ikon a Velikost ikon.

Poznamka

Sady ikon Galaxy a Oxygen jiz nejsou soucasti standardniho instalacniho balicku.
Lze je pfidat zpét stazenim a instalaci nasledujicich rozsifeni:
https://extensions.libreoffice.org/extensions/galaxy-icon-theme
https://extensions.libreoffice.org/extensions/oxygen-icon-theme
https://extensions.libreoffice.org/en/extensions/show/tango-icon-theme-for-libreoffice
Neéktera z dfive zahrnutych pozadi galerie jsou nyni k dispozici pouze jako rozSifeni
z

https://extensions.libreoffice.org/extensions/legacy-gallery-backgrounds

Pouzivani LibreOffice na systému macOS

Nekteré klavesoveé zkratky a poloZzky nabidek jsou v systému macOS jiné neZ v systémech

vvvvvv

knize. PodrobnéjSi seznam najdeme v napovédeé k aplikaci a v pfiloze A Klavesové zkratky této
prirucky.
Tabulka 2: Priklad klavesovych zkratek pro rizna prostiedi

Windows nebo Ekvivalent pro macOS Akce
Linux
Nastroje >
MozZnosti vybér v LibreOffice > Pfedvolby Oteviou se moznosti nastaveni
nabidce
Klepnuti pravym Ctrl + klepnuti a/nebo klepnuti
tlacitkem pravym tliac,ltkem v,zawslostl Otevie se mistni nabidka
na operacnim systému
pocitace
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Windows nebo Ekvivalent pro macOS Akce

Linux

Ctrl (Control) ¥ (Command) Pouziva se také s dalSimi klavesami
Ctrl + Q ¥+0 Ukon¢i LibreOffice

F11 B+T Otevre kartu styly na postranni listé

Jak se jednotlivé prvky nazyvaji?

Pojmy pouzivané v LibreOffice pro oznac¢ovani prvk( uZivatelského rozhrani jsou stejné jako ve
vétsingé jinych programd.

Dialogové okno je specialnim typem okna. Jeho ucelem je o néCem informovat, vyzadat si
vloZeni Udajd nebo oboji najednou. Okno obsahuje ovladaci prvky, které je mozné pouZit k
provedeni né&jaké akce. Technické nazvy béznych ovladacich prvk( jsou uvedeny na obrazku 2.
V této knize nebudeme ve vétSiné pripadd technické pojmy pouZivat, ale je uziteGné tyto pojmy
znat, protoZze napovéda a dalSi zdroje informaci s nimi ¢asto pracuiji.

Ve vétsiné pripadl mizeme béhem doby, kdy je dialogové okno otevieno, pracovat pouze s
timto oknem, nikoliv se samotnym dokumentem. V praci s dokumentem je mozné pokracovat az
poté, kdy dialogové okno zavieme (obvykle klepnutim na OK nebo jiné tlacitko, které ulozi
zmény a zavie okno).

Neéktera dialogova okna je mozné ponechat oteviena i béhem prace a prepinat se mezi nimi a
dokumentem. Pfikladem takového okna je dialogové okno Najit a nahradit.

Styl stranky: Vigchozi

Organizator Stranka OhraniCeni Pozadl Zahlavi EapanLlst 1
Usporadani stranky
#® Shora doll, potom vpravo
2 1 Zleva doprava, potom dold 4
[ Cislo prni stranky: 1 =
Tisk
LI Zahlavi sloupch a fadkd b Grafy
[ Mifizka & Objekty kresby
[ Komentafe O vzorce
[ Objekty/obrazky A Nulové hodnoty
Méfitko 6
ReZim nastaveni méfitka: Upravit méfitko tisku !
Méfitko: 100% 5
Népovida J  Obnovit OK Zrugit

Obréazek 2: Dialogové okno, ve kterém jsou pouZity béZné ovladaci prvky
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1) Karty stranky (angl. Tabbed page, tab), které slouzi k pfepinani karet.

2) Prepinace (angl. Radio buttons), zvolena mize byt vzdy jen jedna polozka.

3) Zaskrtavaci pole (angl. checkbox), miZe byt zvoleno nékolik polozek najednou.

4) Ciselnik (angl. spin box). Klepnutim na Sipky mdZzeme &islo zmensit nebo zvétsit, nebo jej
mUlzeme pfimo zadat v textové Casti.

5) Nahled.

6) Z rozbalovaciho seznamu zvolime nami poZadovanou polozku.

7) Tlagitka (angl. Push buttons).

Casto kladené otazky

Jak je licencovano LibreOffice?
LibreOffice je Sifen pod licenci Mozilla Public License (MPL), schvalenou organizaci the
Open Source Initiative (OSI). Viz https://lwww.libreoffice.org/about-us/licenses/

Je zalozen na kédu z Apache OpenOffice, ktery je k dispozici pod licenci Apache License
2.0, ale zahrnuje takeé software, ktery se liSi od verze k verzi v ramci fady dalSich open
source licenci. Novy kod je dostupny pod licenci GNU Lesser General Public License
(LGPL) 3.0 and MPL 2.0.

Mohu LibreOffice dale distribuovat, rozdavat a Sifit? Mohu LibreOffice prodavat? Mohu

LibreOffice pouzivat pro komer€ni tcely a ve své firmé?
Ano.

Na kolik poéita¢ti mohu LibreOffice nainstalovat?
Na libovolny pocet.

Je LibreOffice dostupny v mém jazyce?
LibreOffice byl lokalizovan do vice nez Gtyficeti jazyk(, takZze poZzadovany jazyk je
pravdépodobné podporovan. Navic je k dispozici vice nez 70 slovnik{ pro kontrolu
pravopisu, déleni a tezaury pro jazyky a jejich dialekty, do nichz neni lokalizované
uzivatelské rozhrani. Slovniky jsou k dispozici na LibreOffice Extension Center:
https://extensions.libreoffice.org/extensions?getCategories=Dictionary.

Jak je mozZné, Ze program LibreOffice je dostupny zdarma?
LibreOffice vyvijeji a udrzuji dobrovolnici s podporou vice firem.

Vyvijim softwarovou aplikaci. Mohu pouZzit zdrojovy kéd LibreOffice v mém programu?
V ramci parametrl stanovenych v licencich mdzete: https://www.mozilla.org/MPL/2.0/
https://www.libreoffice.org/about-us/licenses/.

Pro€ ke spusténi LibreOffice potfebuji Javu? Je napsan v Javé?
LibreOffice neni psan v Javé; vétsinou je psan v jazyce C++. Java je jednim z jazykd, které
Ize pouZzit k jeho rozSifovani. Béhové prostredi Java (JDK / JRE) je tfeba jen kvili nékterym
funkcim. Jednou z nich je napfiklad databazovy stroj HSQLDB, pouzivany komponentou
Base. V programu Calc se Java pouziva pro béh nékterych druh( fesitele, popsanych v
kapitole 9, Analyza dat.

Java je dostupnd bezplatné. DalSi informace a odkazy ke staZzeni na prislusné vydani pro
vas operacni systém najdete na adrese: https://java.com/en/download/manual.jsp.

Poznamka

Pokud chcete pouzivat funkce LibreOffice, které vyzaduji Javu, je ddlezité, aby se
spravna 32 bitova nebo 64 bitova edice shodovala s nainstalovanou verzi
LibreOffice.
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Jak mohu k LibreOffice pFispét?
Pfi vyvoji a uZivatelské podpore LibreOffice Ize pomoci rdznymi zplsoby Neni k tomu tfeba
byt programator. Chceme-li zacit, podivame se na tuto webovou stranku:
https://cs.libreoffice.org/community/get-involved/

Mohu PDF soubor této knihy dale distribuovat, pfipadné jej i tisknout a prodavat?
Ano, pokud jsou spinény podminky alespon jedné z licenci, které jsou uvedeny na zacatku
této knihy. Neni k tomu tfeba Zadné specialni povoleni. Jako pfispévatelé k této knize vas
v3ak Zadame, abyste vzali v Gvahu mnoZstvi prace, které bylo na jeji psani a preklad
vynalozeno a abyste se podélili o ¢ast svého zisku.

Prispéjte LibreOffice: https://cs.libreoffice.org/donate/

Co je nového v LibreOffice Calc 7.0?

Poznamky k vydani LibreOffice 7.0 jsou zde:
https://wiki.documentfoundation.org/ReleaseNotes/7.0

Odkaz na tuto stranku je také uveden v dialogovém okné O LibreOffice, ke kterému se dostanete
klepnutim na Napovéda > O LibreOffice.
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j LibreOffice

Privodce programem Calc

Kapitola 1
Uvod

PouZivani sesitd v LibreOffice



Co je Calc?

Program Calc tabulkovy procesor baliku LibreOffice. Do seSitll miiZzeme vkladat data (obvykle
Ciselnd) a pak s nimi pracovat tak, abychom ziskali urcité vysledky.

Je také moZné zadat data a pak pouzit Calc pro Glohy typu ,Co kdyz...“: nékteré z udajl
zménime a zkoumame, jak se zméni vysledky, aniz bychom museli vytvaret novy sesit nebo list.

Program Calc nabizi mimo jiné nasledujici funkce:
« Funkce, které Ize pouZzit k vytvareni vzorcl umoZziujicich provadét s daty komplexni
vypocty.
» Databazové funkce pro uspofadani, ukladani a filtrovani dat.
« Datové statistické nastroje pro provadéni komplexni analyzy dat.
« Dynamické grafy, véetné Siroké $kaly 2D a 3D grafd.

¢ Makra pro zaznamenavani a spousténi ¢asto opakovanych tkold. Mezi podporované
skriptovaci jazyky na tvorbu maker patfi LibreOffice Basic, Python, BeanShell
a JavaScript.

* Schopnost otevirat, upravovat a ukladat seSity programu Microsoft Excel.

* Importovat a exportovat seSity v mnoha formatech vcetné HTML, CSV, PDF a Data
Interchange Format.

Poznamka

Pokud chceme v LibreOffice pouzivat makra vytvorena v jazyce VBA v programu
Microsoft Excel, musime nejprve v editoru LibreOffice Basic IDE upravit jejich kod.
DalSi informace nalezneme v kapitole 12 — Makra v této pfiru¢ce nebo v kapitole 13
— ZaCiname s makry, v pfiruCce Zac¢iname s LibreOffice.

Sesity, listy a bunky

Calc pracuje s dokumenty, které se nazyvaji sesity. Sesity sestavaji z nékolika jednotlivych list,
pricemz kazdy list obsahuje buriky usporadané do radkd a sloupci. Uréita burika se da
identifikovat podle €isla fadku a pismene sloupce.

V bunkéch jsou uloZeny jednotlivé prvky (text, Cisla, vzorce atd.), které umoZriuji zobrazovat
a zpracovavat data.

Kazdy sesit mdze mit aZz 10 000 listll a kazdy list miZze mit maximalné 1 048 576 fadkd a 1 024
sloupcd.

Hlavni okno programu Calc

Po spusténi programu Calc se otevie hlavni okno (obrazek 3). Riizné ¢asti jsou popsany nize.

Poznamka

Pokud neni néktera ¢ast okna Calc na obrazku 3 zobrazena, miiZzeme ji zobrazit
pomoci nabidky Zobrazit. Napfiklad Zobrazit > Stavovy fadek v hlavni nabidce
prepina (zobrazuje nebo skryva) stavovy fadek. Neni vZzdy nutné zobrazovat

vSechny zobrazené &asti; libovolnou z nich mdzeme zobrazit nebo skryt.

16 | Prirucka Calc 7.0



Standardni Mastrojova
Hlawvni nastrojova lista
nabidka lista formatowvani

B EBe=naz - 1 - LibreOffice Cale

Soubor WUpravy Zobrazit WVioEt Format Styly List Data Mastroje Okmo  Napowéda
- I-h_" = - .= - l.f" b - - { - R IH" L;) - i W
Liberation Sans - 10 | B I U A=~ . o X o =% 00 5 = = B
ik Viastnosti
C [ E i Styl F
) Vychozi w| &
3] A
a4 ~ Znak -
e Zahlavi Pole peT——— - -
. bunka nazvi sloupci vzorcil sl .
I | BI U5 A H A f
8 | Zahlavi Postranni X
9 Fad ki lista
:'; | ~ Format gisla F
12 x Dbecny v [ - L]
13 ZaloZky Stavovy
s listii Fadek Desetinna mista Uvodni nuly:
15 £ 1 =
4 | b -
{ £ s | L] Zapomda &isla demnend
+ Yien O Oddétovad tisich w
List1z1 Wychozi Cettina L = Primér: ; Sowdet: 0 - 4 + 100 %

Obrazek 3: Hlavni okno programu programu Calc

Zahlavi okna

V z&hlavi nahofe je uveden nazev aktuélniho seSitu. Kdyz je sesit nové vytvoren, jeho nazev je
Bez nazvu X, kde X je Cislo. Kdyz seSit ukladame poprvé, zobrazi se vyzva k zadani nazvu.

Hlavni nabidka

Pod zahlavim okna je hlavni nabidka. Pokud vybereme jednu z nabidek, zobrazi se seznam
moznosti. Hlavni nabidku Ize také upravit, coz je vysvétleno v kapitole 14 — Nastaveni
a prizpUsobeni.

* Soubor — obsahuje pfikazy, které se vztahuji na cely dokument, napfiklad Otevfit,
UloZit, Privodci, Exportovat do PDF, Tisk, Elektronické podpisy, Sablony.

« Upravy — obsahuje pfikazy pro GUpravu dokumentu, napfiklad Zpét, Kopirovat, Najit
a nahradit, Sledovani zmén.

» Zobrazit — obsahuje prikazy pro Upravu vzhledu uzivatelského rozhrani Calc, napfiklad
Nastrojové liSty, Zobrazit zahlavi, Cela obrazovka, P¥iblizeni.

« VloZit — obsahuje prikazy pro vkladani prvk( do seSitu, naptiklad Obrazek, , Graf,
Textové pole, Zahlavi a zapati.

* Format — obsahuje pfikazy pro Upravu rozvrzeni seSitu, napfiklad Bunky, Stranka,
Styly automatického formatu, Zarovnani.

« Styly — obsahuje moZnosti pro pouziti a spravu styld, napfiklad Nadpis 1, Poznamka
pod ¢arou, Spravovat styly.
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e List — obsahuje prikazy pro vkladani a mazani prvkd a Upravu celého listu, napfiklad
Smazat fadky, Vlozit list, Pfejmenovat list, Navigovat.

+ Data - obsahuje prikazy pro manipulaci s daty v tabulce, napfiklad Definovat oblast,
Radit, Automaticky filtr, Konsolidovat, Statistika.

« Nastroje — obsahuje funkce, které napriklad pomahaji kontrolovat a pfizplisobovat sesit
Kontrola pravopisu, Sdilet seSit, Makra, MoZnosti.

* Okno - obsahuje dva pfikazy; Nové okno a Zavfit okno. Zobrazuje také vSechna
oteviena okna v jinych programech LibreOffice.

* Napovéda — obsahuje odkazy na Napoveédu LibreOffice (soucasti softwaru),
UZivatelské priru¢ky a dal3i rGizné funkce; napfiklad Restartovat v nouzovém reZimu,
Informace o licenci, Zkontrolovat aktualizace.

Nastrojové listy
Pokud spustime program Calc ve vychozim nastaveni, v horni ¢asti pracovni plochy budou
ukotveny nastrojové liSty Standardni a Formatovani (obrazek 3).

Nastrojové listy programu Calc mohou byt bud ukotveny (pevné na misté) nebo plovouci, coz
umoznuje pfesunout nastrojovou listu na pohodinéjsi misto v pracovnim prostoru. U ukotvenych
nastrojovych list mlze byt zruSeno ukotveni a mohou byt pfesunuty do jiného umisténi a byt
ukotveny nebo se mohou stat plovoucimi panely nastroj. Stejné tak Ize ukotvit plovouci
nastrojové listy.

Jako alternativu k vychozimu usporadani dvojité nastrojové listy si mizeme vybrat rezim jedné
liSsty. Obsahuje nejvice pouzivané pfikazy. Pro aktivaci panelu zvolime Zobrazit > RozvrZeni
nastrojovych list > Jedina nastrojova lista a pro vypnuti Zobrazit > RozvrZeni nastrojovych
list > Vychozi a Zobrazit > Nastrojové liSty > Formatovani.

DalSi informace o nastrojovych listach nalezneme v kapitole 1 — Pfedstavujeme LibreOffice
v pfiru¢ce Zaciname s LibreOffice.

Vychozi sada ikon (nékdy oznacovanych jako tlacitka) na nastrojovych listach nabizi Sirokou
Skalu prikazl a funkci. Na nastrojové listy miizeme také odebrat nebo pridat ikony. Pro dal3i
informace viz kapitolu 14, Nastaveni a pfizplsobeni.

Umisténim kurzoru mySi na ikonu, textové pole nebo pfikaz nabidky se zobrazi malé pole
nazyvaneé tip, které zobrazuje nazev funkce polozky. Chceme-li tip uzavfit, premistime se
z podkladového objektu nebo stiskneme klavesu Esc.

Chceme-li zobrazit podrobné&jsi vysvétleni ikony, textového pole nebo pfikazu nabidky, jednim
z nasledujicich zplsobl otevieme rozsitené tipy:

* Chceme-li rozSifené tipy aktivovat pouze jednou: stiskneme Shift + F1.

* Chceme-li aktivovat rozsifené tipy z hlavni nabidky: pfejdeme na Napovéda > Co je to?
a umistime ukazatel mysi na ikonu.

* Chceme-li rozSifené tipy zapnout nebo vypnout: pfejdeme na Nastroje > MozZnosti >
LibreOffice > Obecné v hlavni nabidce a zaSkrtneme pole RozSifené tipy.

Poznamka

Co je to? rozSifené tipy se vylepSuji, ale v LibreOffice 7.0 je tato prace neuplna,
a proto nejsou plné funkéni.
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Lista vzorcl

LiSta vzorcl je umisténa v horni ¢asti pracovniho prostoru programu Calc. V této poloze je trvale
ukotvena a nelze ji pouzit jako plovouci nastrojovou listu. Nicméné miize byt skryta nebo
zobrazena pomoci Zobrazit > LiSta vzorct v hlavni nabidce.

Al vi fx 2 *= v
Obrézek 4: Lista vzorcl

Zleva doprava na obrazku 4 se Lista vzorcl sklada z nasledujicich polozZek:

* Pole nazvu — zobrazuje aktualni odkaz na aktivni burku, ktery sestava z kombinace
pismen a Cislic, napfiklad Al. Pismeno znaci sloupec a Cislo fadek vybrané buriky.
Pokud jsme oznacili ur€itou oblast bunék, které se také fika rozsah, potom je nazev
oblasti uveden v této kolonce. Pro pfesun na danou buriku miizeme zadat odkaz v poli
Nazev. Pokud zadame nazev oblasti a stisknete tlaitko Enter, pojmenovana oblast se

vybere a zobrazi.

« Privodce funkci — otevie dialogové okno, kde miizeme vyhledavat dostupné funkce. To
mdZe byt také velmi uzitecné pro zobrazeni toho, jak jsou funkce definovany.

* Vybrat funkci — provede vypocet v burikach nad vybranou buikou a vysledek umisti do
vybrané buriky. Pokud nad vybranou burikou nejsou Zadna Cisla, pak se vypocet provede
na burkéch vlevo. Vypocet, ktery ma byt proveden, se vybira z rozbalovaci nabidky
obsahujici moznosti pro soucet, priimér, minimum, maximum a pocet. Klavesova
zkratka Alt + = je ekvivalentni klepnuti na ikonu Vybrat funkci a vybéru volby Sum.

* Vzorec — vlozi do vybrané burky a do vstupniho fadku znaménko se rovna (=), coz
umoznuje zadani vzorce.

* Vstupni fadek — zobrazuje obsah vybrané buriky (data, rovnice nebo funkce)
a umoznuje jeho tpravu. Chceme-li zménit vstupni fadek na viceradkovou vstupni oblast

pro velmi dlouhé vzorce, klepneme na ikonu RozSifit vstupni fadku vpravo. Chceme-li
upravovat v oblasti vstupniho fadku, klepneme do oblasti a zadavame zmény.

Pfimo uvniti buriky mizeme upravovat dvojitym kliknutim na buriku. KdyZ do buriky zadame
nova data, ikony Vyberte funkci a Vzorec se zméni na ikony Zrusit a PFijmout.
Poznamka

Pojem ,funkce" v seSitech zahrnuje mnohem vic nez jen matematické funkce. DalSi
informace nalezneme v kapitole 7 — Pouziti vzorc( a funkci.

Stavovy radek

Stavovy fadek ve spodni €asti pracovniho prostoru (obrazek 5) poskytuje informace o seSitu

a pohodIné zplsoby, jak rychle zménit nékteré z jeho funkci. Vétsina poli je podobna jako

v jinych komponentach LibreOffice. DalSi informace viz kapitola 1 — Pfedstavujeme LibreOffice
v pfirucce Zac¢iname s LibreOffice.

Cislo Styl Rezim NeuloZeny Informace o burnice
listu strany vkladani/prepisovani zZmény nebo objektu
List1z1 ‘.-'-,brarm.ir'adh:u. 2 sloupce Vychoz Ciii-na / I =] i Primér: ; Souéet 0 | — ] + |1
Informace Jazyk Rezim Digitalni Posuvnik ZvétSeni
0 vybéru vybéru podpis Zvetseni v procentech
benek

Obréazek 5: Stavovy radek

Pole na stavovém fadku zleva doprava jsou nasleduijici.
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Cislo listu
Zobrazuje poradové Cislo aktualniho listu a celkovy pocet listd v sesitu. Pofadové Eislo se
nemusi shodovat s nazvem na karté listu, pokud byly listy pfesunuty. Poklepanim na tuto
zbnu otevieme Navigator.

Informace vybéru bunék
Zobrazuje, kolik fadkd a kolik sloupct je vybrano. Prazdné, pokud vybrané buriky netvori
obdélnikovy blok.

Styl stranky
Zobrazuje styl stranky aktualniho listu. Chceme-li upravit styl stranky, poklepadme na toto
pole a otevie se dialogové okno Styl stranky.

Jazyk
Zobrazuje aktualni vychozi jazyk vybrany v Nastroje > MoZnosti > Jazykova nastaveni >
Jazyky.

ReZim vkladanilpfepisovani
KdyZ uZivatel interaguje s burikou v reZimu uprav, toto pole rozliSuje mezi rezimy vioZeni
a prepsani. Pokud je upravovana burka v reZzimu prepisovani, zobrazi se v poli text Prepis.
V jinych pfipadech je pole prazdné. Pro zménu modu mezi pfepisem a vkladanim
zmackneme klavesu Insert.

Rezim vybéru
Klepnutim pravym tlacitkem mysSi otevieme mistni nabidku a vybereme moznost
Standardni vybér, Rozsifitelny vybér nebo Doplnitelny vybér. Poklepanim na ikonu
a Ize postupné prepnout dal$iho rezimy vybéru. kdyz jsou vybrany rlizné rezimy vybéru,
ikona se neméni. DalSi informace viz kapitola 1 — Pfedstavujeme LibreOffice v pfirucce
Zaciname s LibreOffice.

NeuloZené zmény
Tato ikona oznacuje, Ze seSit obsahuje neuloZzené zmeény. Pokud existuji neulozené zmény
a chceme je ulozit, klepeme na ikonu, pouzijeme Soubor > Ulozit, klepneme na
ikonuUlozit na Standardni nastrojové listé nebo zmackneme klavesy Ctrl + S.

Elektronicky podpis
Pokud je dokument digitalné podepsany, zobrazi se v tomto poli ikona. Poklepem na ikonu
mUlZeme zobrazit certifikat. DalSi informace o digitalnich podpisech nalezneme v kapitole 6
— Tisk, export, e-mail a podepisovani.

Informace o bunce nebo objektu
Zobrazuje informace tykajici se polohy kurzoru nebo vybraného prvku tabulky. Je-li vybrana
skupina bunék, je ve vychozim nastaveni zobrazen soucet obsahu. Klepnutim pravym
tlacitkem v tomto poli vybereme dal$i funkce, jako je prdmérna hodnota, maximalni
hodnota, minimalni hodnota nebo pocet (pocet vybranych polozek).

Posuvnik méfitka zobrazeni
PfetaZzenim posuvniku pfiblizeni, klepnutim na drahu posuvniku nebo klepnutim na
znaménka + a - zménime zveétSeni pohledu.

Procento zvétSeni
Znaci uroven zvétSeni dokumentu. Klepnutim pravym tladitkem mySi na procento otevieme
seznam hodnot zvétSeni, ze kterych si vybereme. Klepnutim na procento otevieme
dialogové okno Priblizeni a rezim zobrazeni.

Postranni lista

Postranni liSta (obrazek 6) je smési nastrojovych liSt a dialogovych oken. PFi otevieni (Zobrazit >
Boé€ni panel nebo Ctrl + F5) se objevi na pravé strané okna a sklada se z péti karet: Vlastnosti,
Styly, Galerie, Navigator a Funkce. Kazda karta ma svou ikonu na panelu karet, nachazejicim se
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vpravo od postranni liSty, ktery umoznuje mezi kartami pfepinat. Jednotlivé karty jsou popsany

nize.
i Vlastnosti x
~ Styl
b+
Vychozi e Y ]
M
~ Znak ]
Ll
Liberation Sans 10 | ™ )
BIU~-SA A A f
X
A~
-~ Format cisla F
‘Obecngr ~| &= % 00
Desetinna mista: Uvodni nuly:
= 1 =
[l Zaporna éisla Eervend
(] Oddélovaé tisich
~ Zarovnani ]
=== E NT 5T x>
Odsazeni: 3= <= [ Slougit buriky
0 pt = [1 Zalomit text
Orientace textu: |0° V |§| 4|g
[ Svisle zarovnané
~ Vzhled burky F
Pozadr: R -
-
— [/ ~
Obréazek 6: Postranni liSta
Vlastnosti

Tato karta obsahuje pét panelll. Tyto panely, s vyjimkou panelu Styl, maji tlacitka Dal$i
moznosti, které oteviraji dialogovéa okna s dalSimi moZnostmi. Tato dialogova okna
uzamknou dokument pro Upravy, dokud nebudou uzavfiena.

Styl: MoZnosti pro pouZiti, aktualizaci nebo vytvoreni stylll bunék a stranek.

Znak: MoZnosti forméatovani textu, napfiklad nazev pisma, velikost a barva. Nékteré
ovladaci prvky, jako je napfiklad horni index, se stanou aktivni pouze tehdy, kdyZ je ve
Vstupnim fadku Listy vzorcd nebo v burice textovy kurzor.

Format Cisla: Moznosti formatovani Cisel, v€etné desetinnych mist, mény, data nebo
Ciselného textu.

Zarovnani: Moznosti pro usporadani textu riznymi zplsoby, véetné& vodorovného
a svislého zarovnani, obtékani, odsazeni, slou¢eni, orientace textu a svislého skladani.

Vzhled bunky: MoZnosti zahrnuji barvu pozadi, formaty ohraniCeni v€etné barvy a stylu
cary.
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Styly
UmoZiiuje uZivateli pouzit stavajici styly, upravit stavajici styly nebo vytvorit nové styly. Tuto
kartu Ize také oteviit vybérem Styly > Sprava styld z hlavni nabidky, vybérem Zobrazit >
Styly v hlavni nabidce nebo stisknutim F11.

Galerie
Umoziuje uzivateli pfidat obrazky, diagramy nebo jiné objekty, které jsou k dispozici
v motivech Galerie. Tuto kartu lze také otevfit vyb&rem Zobrazit > Galerie z hlavni
nabidky.

Navigator
Tato karta je podobna jako dialogové okno Navigator oteviené vybérem Zobrazit >
Navigator z hlavni nabidky nebo stisknutim F5. Viz ,PouzivAme Navigator” na strance 46.

Funkce
Tato karta obsahuje seznam funkci uspofadanych do kategorii. Je to zjednoduSena verze
Privodce funkci, ktery je moZné oteviit volbou Vlozit > Funkce z hlavni nabidky, klepnutim
na ikonu Priivodce funkci na listé vzorcl nebo stisknutim Ctrl + F2 .

Na pravé strané zahlavi kazdé oteviené Kkarty je tlaitko Zavfit kartu postranni liSty, které
uzavfe kartu tak, aby zlstal otevien pouze panel karet. Klepnutim na libovolné tla¢itko na panelu
karet zapneme/vypneme zobrazeni pfidruzené karty.

Chceme-li postranni panel skryt, nebo jej zobrazit, pokud je jiz skryt, klepneme na tlacitko
Skryt/Zobrazit na levém okraji. Chceme-li upravit Sifku karty, pfetdhneme levy okraj postranniho
panelu.

Rozvrzeni sesSitu

Jednotlivé bunky
Hlavni Cast obrazovky zobrazuje buriky ve formé mfizky, pficemz kazda burika je umisténa na
priseciku sloupce a radku.

V horni ¢asti sloupcl a na levém konci fadka je fada poli zahlavi obsahujici pismena a Gisla.
Zahlavi sloupcli pouziva znaky, které zacinaji pismenem A a zvysuji se doprava. Zahlavi fadku
pouZziva Ciselné znaky, které zacinaji na 1 a zvySuji se dol(.

Tato zahlavi sloupct a radkd tvori odkazy na buriky, které se zobrazi v Poli ndzvu na Listé vzorcl
(obrazek 4). Pokud nejsou zahlavi v seSitu viditelna, zapneme je v hlavni nabidce v Zobrazit >
Zobrazit zahlavi.

Karty list(

Soubor sesitu mize obsahovat mnoho jednotlivych listd. Ve spodni ¢asti miizky bunék v sesitu
jsou zalozky listll (obrazek 3). Kazda karta predstavuije list v seSitu. Novy list vytvofime klepnutim
na znaménko plus nalevo od karet listu.

Klepnutim na zaloZku ziskame pfistup k jednotlivému listu. KdyZ je list aktivni, je karta
zvyraznéna. Nékolik listl vybereme pridrzenim tlacitka Ctr/ pfi klepnuti na karty listd.

Chceme-Ili zménit vychozi nazev listu (Listl, List2 atd.):

1) Klepneme pravym tlacitkem mySi na kartu listu a vybereme z mistni nabidky moZnost
Pfejmenovat list. Otevie se dialogové okno umoznujici zadat novy nazev listu.

2) Jsme-li hotovi, klepnutim na tlac¢itko OK dialogové okno zavieme.
Zména barvy karty listu:

1) Klepneme pravym tlacitkem mysi na kartu listu a vybereme z mistni nabidky moZnost
Barva karty, ¢imZ otevieme dialogové okno Barva karty (obrazek 7).

2) Vybereme pozadovanou barvu a klepnutim na OK dialogové okno zavieme.
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Barva karty

Wychozi

Vychozi

Zrusit

Obrazek 7: Dialogové okno
Barva karty

Vice informaci o pfidavani novych barev do palety se nachazi v kapitole 14 — Pfizplsobeni
LibreOffice.

Vytvareni, otevirani a ukladani sesiti

Vytvareni a otevirani

Vytvareni a otevirani sesitll je totozné s vytvarenim a oteviranim dokumentd v ostatnich
modulech LibreOffice. Dalsi informace o vytvareni a otevirani sesitdl nalezneme v kapitole 1 —
Predstavujeme LibreOffice v pfirucce Za¢iname s LibreOffice.

Pouzivani Sablon

Dokumenty programu Calc Ize také vytvaret ze Sablon. Informace o tom, jak vytvafet a pouzivat
Sablony, najdeme v kapitole 4 — PouZziti styl( a $ablon.

Otevirani souboru CSV

Soubory oddélené ¢arkami (CSV) jsou tabulkové soubory v textovém formatu, kde je obsah
bunék oddélen znakem, napfiklad ¢arkou nebo stfednikem. Kazdy rfadek predstavuje fadek
v tabulce. Text je vloZen v uvozovkach; Cisla se vkladaji bez uvozovek.

Chceme-li otevfit soubor CSV v Calcu:

1) V hlavni nabidce vybereme Soubor > Otev¥it, klepneme na ikonu Otevfit na Standardni
nastrojové listé nebo zmackneme klavesovou zkratku Ctrl + O a vyhledame soubor CSV,
ktery chceme otevfit.

2) Vybereme soubor a klepneme na tlacitko Otevfit. Ve vychozim nastaveni ma soubor
CSV pfiponu .csv. Nékteré soubory CSV vSak mohou mit pfiponu .txt.

3) Otevre se dialogové okno Import textu (obrazek 8). Zde mizeme vybrat moznosti pro
import souboru CSV do seSitu programu Calc.

4) Klepnutim na tla€itko OK soubor otevieme a importujeme.
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Import textu - [Seznam%20cbci%20UTF.csv]

Importovat

Znakova sada:

Jazyk: Vychozi - Cetina ~

-

Od fadku: 1 z

MozZnosti oddélovace
(") Pevna 3irka ® Oddéleno pomoci

Tabulator Carka Strednik [OMezera [liny
[ Sloucit oddélovace [ Ofiznout mezery Oddélova¢ fetézcl: " |~

Ostatni moZnosti

[J Formatovat pole v uvozovkach jako text [ Detekovat specidlni ¢isla

Pole
Standardni |Standardn|' |Standardn|' Standardr ~
1 [Pbec Kod-obce Pové&Feny ufad Kod~POU
2 rnedtovice 509388  Pelhiimov 61102
3 Jarnolec 586854 Polna 61052
4 Babice 590274  Moravské Bud&jovice 61062
5 Bacovice 561118  Pelhiimov 61102
g Bafice 598282 Hrotovice 61131
7 Batkov 546194  Havligkiv Brod 61022
g Patkovice 544833 Jemnice 61861
o Balinv 595217 Velkeé Mezifigi 61142 ¥
< >
Napovéda OK Zrusit

Obrazek 8: Dialogové okno Import textu
MozZnosti importu souborli CSV do seSitu Calc jsou nasleduijici:

Import
* Znakova sada — urCuje znakovou sadu pouzitou v importovaném souboru.

» Jazyk — urCuje, jak jsou importovany Ciselné fetézce. Pokud je Jazyk nastaven na
hodnotu Vychozi, pouZije program Calc jazyk dle mistniho nastaveni vybrany v Nastroje
> MoZnosti > Jazykova nastaveni > Jazyky > Formaty. Pokud je vybran jiny jazyk,
tento jazyk urci, jak budou zpracovana Cisla.

e Od radku — urcuje, od kterého radku import zapocne. Nahled fadkl se zobrazuje v dolni
¢asti dialogového okna.

Moznosti oddélovace

«  Pevna 3itka — rozdéli data do sloupcti podle nastaveného po&tu znakd. Sifku nastavime
klepnutim na pravitko v okné nahledu.

« Oddéleno pomoci — rozdéluje data do sloupclli na zakladé zde definovaného oddélovace.
Vybereme Jiny a mlizeme specifikovat vlastni oddélovaci znak. Tento vlastni oddélovac
musi byt také obsazen v datech.

* Sloucit oddélovace — spoji po sobé jdouci oddélovace a odstrani prazdna datova pole.
* Oriznout mezery — odstranuje poCatecni a koncové mezery z poli.
e Oddélovac fetézcli — vybere znak, ktery vymezuije textova data.

Ostatni moznosti

* Formatovat pole v uvozovkéch jako text — je-li tato moznost povolena, pole nebo buriky,
jejichz cely obsah je v uvozovkéach, jsou importovany jako text.

s

* Rozpoznat specialni ¢isla — pokud je zaSkrtnuta tato moznost, Calc bude automaticky
rozpoznavat format Cisel, véetn& specialnich formatd, jako jsou datum, ¢as a védecka
notace. Zvoleny jazyk ovliviiuje, jak jsou detekovana specialni Gisla, protoze v rliznych
jazycich a regionech se pro né pouzivaji rzné zvyklosti.
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Je-li tato volba vypnuta, bude Calc detekovat a prfevadét pouze desetinna Cisla. Ostatni
¢isla, vCetné védeckého zapisu, budou importovana jako text. Desetinné &islo mlze
obsahovat &islice 0-9, oddélovace tisict a desetinnych mist. Oddé&lovace tisict

a desetinnych mist se mohou liSit v zavislosti na vybraném jazyku.

Pole — zobrazuje, jak budou data vypadat po rozdéleni do sloupcd.

Typ sloupce — vybereme sloupec v okné nahledu a typ dat, ktery se ma u importovaného
sloupce pouzit.

Standardni — Calc sam urci typ dat.
Text — importovana data budou povazovana za text.

Datum — importovana data jsou povaZzovana za datum ve vybraném forméatu — “DMY”,
“MDY” nebo “YMD".

Anglicky (USA) — budou vyhledana a importovana Cisla formatovana v americké
angli¢ting, bez ohledu na jazyk systému. Formét Cisel nebude pouzit. Pokud neni
nalezeno Cislo v anglickém formatu, pouzije se forméat Standardni.

Skryt — data z vybraného sloupce nebudou importovana.

Ukladani sesitu

Informace o tom, jak ukladat soubory ru¢né nebo automaticky, nalezneme v kapitole 1 —
Predstavujeme LibreOffice v pfiru¢ce Zaciname s LibreOffice. V programu Calc Ize ukladat
sesity v rliznych formatech a také je exportovat do forméatd souboru PDF, HTML a XHTML. Vice
informaci se nachazi v kapitole 6 — Tisk, export, posilani e-mailll a podepisovani.

Ukladani v jinych formatech

Pokud potfebujeme poslat soubory uzivatellm, ktefi nejsou schopni pfijimat soubory sesitu ve
formatu Open Document (ODF) (*.ods), jenz Calc pouziva jako vychozi, miZeme sesSit uloZit
v jiném formatu.

1) V hlavni nabidce zvolime Soubor > UloZit jako, klepneme na Sipku dold vpravo od ikony
Ulozit na Standardni nastrojové listé a z rozbalovaci nabidky zvolime Ulozit jako nebo
zmackneme klavesovou zkratku Ctrl + Shift + S , €imz otevieme dialogové okno Ulozit
jako (obrazek 9).

2) Pokud chceme, do pole Nazev souboru zaddme novy nazev souboru a vybereme sloZzku,
do které chcete soubor uloZit.

3) V UloZit jako typ vybereme z rozbalovaci nabidky typ formatu, ktery chceme pouZit.
Pokud vybereme Automaticka pfipona nazvu soubort, k ndzvu souboru se pfida
spravna pfipona souboru pro zvoleny format sesitu.

4) Klikneme na tlacitko UloZit.
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UloZit jako

T « VERZIA 6.4 CZ > CALC GUIDE » w Q Prohledat: CALC GUIDE »
Uspofadat ~ Nova sloZka — - Q
CGE402 2 Nazev Datum zmény Typ
POMOCME SUBORY BITMARY 13. 06, 2020 12:48
B Plocha IKONY 8. 06. 2020 19:44
@ OneDrive OBRAZKY 13.06. 2020 13:5( s S
POMOCNE SUBORY 13. 06. 2020 14:0C !
& Roman
SOURCE 13, 06. 2020 12:4
= Tento pocital
= v £ >

Néazev souboru: | Podklady pre grafy.xlisx
Ulo#it jako typ: Excel 2007-365 (*xlsx) v
[~] Automaticka pfipona
nazvu souboru
[] UloZit s heslem
[] Zadifrovat klicem GPG

~ Skryt slodky Zrusit

Obrazek 9: Dialogové okno UloZit jako

Pokazdé, kdyz je soubor ulozen v jiném formatu nez ve formatu ODF, otevie se dialogové okno
Potvrdit format souboru (obrazek 10). Klepnutim na tla¢itko Pouzit format [xxx] budeme

v ukladani ve vybraném formatu seSitu pokracovat, klepnutim na tlac¢itko Pouzit format ODF
uloZzime sesit ve vychozim formatu programu Calc. Pokud zakdZzeme Upozornit p¥i ukladani

Vv jiném formatu nez ODF nebo vychozim v hlavni nabidce Nastroje > MoZnosti >
Nacitanilukladani > Obecné, dialogové okno Potvrdit forméat souboru se jiZ nezobrazi. Mizeme
také zrusit zaSkrtnuti pole Zeptat se pfi ukladani do jiného formatu nez ODF v dialogovém
okné. Dialogové okno se jiz nezobrazi.

Potvrdit format souboru

9 Dokument miZe obsahovat formatovani nebo obsah, jehoZ
uloZeni nemusi vybrany format soubori ,Excel 2007-365"
podporovat.

Aby bylo jisté, Ze se dokument ulodi spravné, pouiijte k jeho uloZeni wychozi
format soubord ODF.

[ Zeptat se pfi uklddani do jiného formatu nei ODF nebo wchoziho

[ Pouzit format Excel 2007-365 | Pouzit forméat ODF

Obrazek 10: Dialogové okno Potvrdit format
souboru

Pokud vybereme format Text CSV (*.csv), otevie se dialogové okno Exportovat textovy soubor
(obrazek 11). Zde mizeme vybrat znakovou sadu, oddélovac pole, oddélovac fetézcl a tak dale,
které maiji byt pouzity pro soubor CSV.

@ Poznamka

Jakmile tabulku ulozime v jiném formatu, vSechny zmény, které v tabulce
provedeme, se nyni projevi pouze ve formatu, ktery pouzivame, protoze jsme
zmeénili ndzev a typ souboru dokumentu. Pokud se chceme vratit k praci s verzi
dokumentu ve formétu *.ods, musime soubor uloZit ve formétu *.ods.
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Exportovat textovy soubor

Moznosti pole

Znakova sada:

Oddélovac pole: , ot
QOddélovac fetézcd: |" b
] Ulozit zobrazeny obsah buriky

L1 Misto vypoditanych hodnot bunék uloZit vzorce

[ Textové buriky do uvozovek

[ Pevna sifka sloupce

Mapoveda oK Zrusit

Obréazek 11: Dialogové okno Exportovat textovy soubor

6 Tip

Chceme-li, aby Calc ukladal dokumenty ve vychozim nastaveni v jiném formatu nez
vychozim ODF, pfejdeme do Nastroje > MoZnosti > Nacitani/ukladani > Obecné.
V Casti oznacené Vychozi nastaveni soubort a nastaveni ODF vybereme pro
polozku Typ dokumentu, vybereme SeSit a pod ni v poli VZdy ukladat jako vybereme
uprednostriovany forméat soubord, napfiklad Microsoft Excel.

Ochrana heslem

Chceme-li omezit, kdo miZe sesit otevirat a ¢ist nebo kdo ho mUlize otevirat a upravovat, je nutno
pouzit ochranu heslem. Ochrana heslem je spole€néa pro vSechny moduly LibreOffice; pro vice
informaci viz kapitola 1 — Pfedstavujeme LibreOffice v pfiruCce Zaciname s LibreOffice.

Pohyb v seSitech

Program Calc nabizi mnoho zp(sobd, jak se v sesité pohybovat z buriky na burku a z listu na
list. MGzeme zvolit ten, ktery nam nejvice vyhovuje.

Pohyb mezi bunkami

Kdyz buriku vybereme nebo oznacime, zvyrazni se jeji ohraniCeni. Kdyz vybereme skupinu
bunék, vybarvi se jejich plocha. Barva ohraniceni buriky a skupiny vybranych bunék zavisi na
pouzivaném operacnim systému a ha nastaveni LibreOffice.

» Pomoci mySi — umistime ukazatel mysi nad burniku a klepneme levym tlacitkem mysi.
Chceme-li pomoci mySi pfesunout zaméfeni na jinou buriku, jednoduSe pfesuneme
kurzor mySi na buriku, kterou chceme zameéfit, a klepneme levym tlaCitkem mysi.

* Pomoci odkazu na burnku — zvyraznime nebo smazeme existujici odkaz na bunku v poli
nazvu na panelu vzorcl (obrazek 4 na strané 25). Zadame odkaz na buriku, na kterou se
chceme presunout, a stiskneme klavesu Enter. V odkazech na buiku nerozliSujeme
velikost pismen. Zadanim a3 nebo A3 tedy pfesuneme fokus do burky A3.

* Pomoci Navigatoru — pro otevieni dialogového okna Navigator pfejdeme na Zobrazit >
Navigator nebo stiskneme klavesu F5 (obrazek 12). Do poli Sloupec a Radek zadame
odkazy na buriky a zmackneme klavesu Enter. MiZzeme také pouzit kartu Navigatoru na
postranni li5té.
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Pomoci klavesy Enter — stisknuti tlagitka Enter pfesune zaméreni buriky ve sloupci dol(

na dalsi fadek (vychozi). Smér tohoto pohybu zaostfeni mizeme zménit podle popisu
v Casti ,Prizplsobeni klavesy Enter” na strance 37.

Stisknuti Shift + Enter posune fokus o jednu burku v opacném smeéru, nez je smér
pridruzeny ke klavese Enter.

Klavesou Tab — stisk tabulatoru aktivuje burfiku v nasledujicim sloupci vpravo. Stisknuti
Shift + Tab posune fokus o jednu buriku doleva.

Pomoci klaves Sipek — stisknuti klaves Sipek na klavesnici pfesune zaméfeni bunék ve

sméru stisknuté Sipky.

- [

Sloupec: |A =
Radek: |1 = - Bl Be

nnn L:ST)'
Zaklady
Legenda
Kont. tabulka
t Nazvy oblasti
(=] Databazové oblasti
|* Propojené oblasti
|aa Obrazky
I Objekty OLE
-= Komentafe
(st Objekty kresby

Lunapark (aktivni) o

Obrazek 12: Dialogové okno
Navigator

Pouzivani klaves Home, End, Page Up a Page Down

— Home presune zaméreni burnky na zaCatek fadku. Ctrl + Home pfesune zaméreni
bunky na prvni buriku v listu Al.

— Vysledek zmé&cknuti klaves End nebo Ctrl + End zavisi na datech v seSitu. Pro
vysvétleni téchto stisknuti klaves je uzite¢né definovat Rmax jako nejvyssi oCislovany
fadek v listu, ktery obsahuje vSechna data, a Cmax jako sloupec zcela vpravo v listu,
ktery obsahuje vSechna data. Zmacknuti klavesy End pfesune zaméreni bunky
v aktualnim fadku do bunky ve sloupci Cmax. Klavesova zkratka Ctrl + End pfesune
zaméreni buriky do buriky v priseciku fadku Rmax a sloupce Cmax. VSimneme si, Ze
v obou pfipadech nové zaméfena burika nemusi obsahovat Zadna data.

— Page Down presune zaméreni buriky o jednu obrazovku dol0.
— Page Up pfesune zaméfeni buriky o jednu obrazovku nahoru.

Pohyb mezi listy

Kazdy list v seSité je nezavisly na ostatnich listech, ackoli odkazy mohou propojovat jeden list
s druhym. Existuji tfi zptsoby, jak se pohybovat mezi rliznymi listy v seSité.

Pomoci Navigatoru — je-li Navigator otevien (obrazek 12), poklepanim na néktery z listd
v seznamu jej vybereme. MUZeme také pouzit kartu Navigatoru na postranni listé.

Pomoci klavesnice — stisknutim kombinace klaves Ctrl + Page Down se pfesuneme
o0 jeden list doprava, pomoci Ctrl + Page Up se pfesuneme o jeden list doleva.

28 | Priru¢ka Calc 7.0



» Pomoci mySi — klepnutim na nékterou z karet listu v dolni ¢asti seSitu tento list vybereme.

Pokud sesit obsahuje velké mnoZzstvi listll, nékteré z karet mohou byt skryty. Pomoci ¢tyr tlacitek
vlevo od karty mdzZzeme skryté karty zobrazit (obrazek 13).

Poznamka

Sipky na karté list(l, které se zobrazuji vievo na obrazku 13 , jsou aktivni pouze
pokud existuje vice karet list(l, neZ je mozné zobrazit.

Prejit na prvni list
Prejit na predchozi list
Prejit na nasledujici list
Prejit na posledni list

[ A TR 5 List2 Ligt3 Listd Lists
List2z17 f

Zalozky listd
Obrazek 13: Pohyb mezi listy

Vychozi

Poznamka

Kdyz do seSitu vlozime novy list, Calc automaticky k jeho pojmenovani pouzije dalSi
Cislo v poradi. Umisténi nového listu zavisi na tom, ktery list je pfi jeho vkladani
pravé otevrien, a proto nazvy listl nemuseji ¢iselnému poradi odpovidat. Listy

v sesité se doporuCuje pfejmenovat tak, aby byly snadnéji rozpoznatelné.

Pohyb pomoci klavesnice

Sesit mlzeme prochazet pomoci klavesnice sou¢asnym stisknutim klavesy nebo kombinace
klaves. Napriklad Ctrl + Home pfesune zaméfeni do buriky Al. Tabulka 3 uvadi klavesy
a kombinace klaves, které mizeme k pohybu v seSitu Calc pouZit.

Tabulka 3. Pohyb mezi burikami pomoci klavesnice

Klavesova C ,

skratka Pohyb mezi bunkami

-/ Pfesune zaméreni burky o jednu burnku doprava/doleva.
/1 Pfesune zaméreni burky o jednu buriku nahoru/dold.
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Klavesova
Zkratka

Ctrl+ - /
Ctrl + —

Ctrl +1/
Ctrl + |

Ctrl + Home/Ctrl +
End

Alt + Page Down /
Alt + Page Up

Ctrl + Page Down
/

Ctrl + Page Up

Tab/
Shift + tabulator

Pohyb mezi burikami

Pokud je zaméfeni na prazdnou bunku, Ctrl + - pfesune zaméfeni

v aktualnim fadku do prvni buriky vpravo, ktera obsahuje data. Pokud
vpravo neni zadna bunka obsahujici data, pfesune zaméfeni v aktualnim
fadku do posledni burky vpravo na listu.

Pokud je zaméreni na prazdnou bunku, Ctrl + — pfesune zaméfeni

v aktualnim fadku do prvni bunky vievo, ktera obsahuje data. Pokud vievo
neni Zadna burika obsahujici data, pfesune zaméfeni v aktualnim fadku do
bunky A na listu.

Pokud je zaméfeni na bunce obsahujici data, Ctrl + — normalné presune
zameéfeni v aktualnim fadku do buiky na pravém okraji stejné datové
oblasti. Pokud je prazdna burika napravo od plvodni buiiky, zaméfeni se
presune do buriky na levém okraji dalSi datové oblasti vpravo. V tomto
pfipadé, pokud neni napravo Zadn& oblast dat, zamé&rfeni se pfesune

v aktualnim fadku v listu do posledni buriky napravo.

Pokud je zaméreni na burce obsahujici data, Ctr/ + — normalné pfesune
zaméreni v aktualnim fadku do burky na levém okraji stejné datové oblasti.
Pokud je prazdna burika nalevo od ptvodni buriky, zaméfeni se presune do
bunky na pravém okraji dalSi datové oblasti vievo. V tomto pfipadé, pokud
neni nalevo Zadna oblast dat, zaméreni se pfesune v aktualnim fadku

v listu do bunky ve sloupci A.

Pokud je zaméreni na prazdnou buriku, Ctrl + 1 pfesune zaméfeni nahoru
ve vybraném sloupci do prvni bunky, ktera obsahuje data. Pokud nad daty
neni zadna burika obsahujici data, pfesune zaméfeni nahoru v aktualnim
sloupci do bunky v fadku 1 listu.

Pokud je zaméfeni na prazdnou buriku, Ctrl + | pfesune zaméreni dold ve
vybraném sloupci do prvni bunky, ktera obsahuje data. Pokud nize neni
Zadna burka obsahujici data, pfesune zaméreni dolll v aktualnim sloupci
na posledni bunku nize v listu.

Pokud je zaméreni na buice obsahuijici data, Ctr/ + 1 normalné presune
zaméreni v aktualnim sloupci nahoru do buriky na hornim okraji stejné
datové oblasti. Pokud je nad vybranou burnkou prazdna burika, zaméreni se
pfesune do burky na spodnim okraji vySe umisténé datové oblasti. V tomto
pfipadé, pokud neni vySe Zadna oblast dat, zaméreni se pfesune nahoru

v aktualnim sloupci do bunky v Fadku 1 listu.

Pokud je zaméfeni na bunce obsahujici data, Ctr/ + | normalné pfesune
zaméreni v aktualnim sloupci doll do buriky na spodnim okraji stejné
datové oblasti. Pokud je pod vybranou burnkou prazdna burika, zaméreni se
pfesune do burky na hornim okraji nize umisténé datové oblasti. V tomto
pripadé, pokud neni nize Zadna oblast dat, zaméreni se presune doll

v aktualnim sloupci na posledni buriku nize v listu.

Detailni popis téchto zkratkovych klaves je na strané 34.

Aktivuje buriku o jednu obrazovku doleva/doprava (pokud je to mozné)

Pokud ve sméru vybéru obsahuje sesit dalsi listy, presune zaméreni na
dalSi list vpravo/vievo.

PFesune zaméreni buriky na dalSi buriku vpravo/vlevo.
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Klavesova Pohyb mezi burikami

Zkratka
Enter/ Presune zaméreni o jednu buriku dold &i nahoru (neni-li zménéno
Shift + Enter uZivatelem, coz je vysveétleno v nasledujicim odstavci).

Prizpisobeni klavesy Enter

Smeér, kterym klavesa Enter pfesune zaméreni buriky, miizeme upravit v nabidce Nastroje >
MozZnosti > LibreOffice Calc > Obecné. Pouzijte prvni dvé mozZnosti v Casti Nastaveni vstupu
(obradzek 14) a zménime nastaveni klavesy Enter. Z rozbalovaciho seznamu vybereme smér,
kterym se zaméreni buriky pfesune. Nastaveni jiného sméru miZe byt uZite¢né v zavislosti na
pouzitém souboru nebo typu vkladanych dat. Klavesu Enter Ize také pouzit k prepinani do

a z editacniho rezimu.

MNastaveni vstupu

Stisk klavesy Enter presune vybeér

O Stisk klavesy Enter piepne rezim (|2l
U Roziifit formatovani Doprava
hNal’u::ru

[ e e e R Empees Dlcva_

[ Rozzifit odkazy pfi vioZeni novjc o fadkd

Zvyraznit viybér v zahlavi sloupcl a fadka

[ Pro formatovani textu pouZit metriku tiskarny

Pfi vkladani dat zobrazit upozornéni na pfepsani
[ Posouvat odkaz na buiku s vybérem

Obrazek 14: Prizplisobeni klavesy Enter

Vybér polozek v seSité

Vybér bunky

Jedna bunka

Klepneme levym tlacitkem na buriku. Vybér miizeme ovérit tak, ze se podivame do pole Nazev
na listé vzorcl (obrazek 4).

Souvisla oblast bunék
Oblast bunék lze vybrat pomoci kldvesnice nebo mysi.
Chceme-li vybrat oblast bunék taZzenim kurzoru mysi:
1) Klepneme na bunku.
2) Stiskneme a podrzime levé tlacitko mysi.
3) Presuneme ukazatel mysi po obrazovce.
4) Jakmile je zvyraznéna pozadovand oblast bunék, uvolnime levé tlaCitko mysi.
Chceme-li vybrat oblast bunék bez tazeni mysi:
1) Klepneme do buriky, kter& ma byt jednim z roh( oblasti bunék.
2) Presuneme ukazatel mysi do protéjSiho rohu oblasti bunék.
3) Podrzime klavesu Shift a klepneme.
Vybér oblasti bunék pomoci rezimu RozSifitelny vybér:

1) Klepneme do buriky, kterd ma byt jednim z roh( oblasti bunék.
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2) Klepneme pravym tlac¢itkem mysi do pole M6d vybéru na stavovém radku (obrazek 5 na
strané 25) a vybereme RozSifitelny vybér.

3) Klepneme na buiiku v opacném rohu oblasti bunék.

6 Tip

Ujistime se, Ze jsme zménili volbu zpét na méd Standardniho vybéru, nebot’ jinak
mUZeme nadale vybér bunék nelimysiné rozsifovat.

Chceme-li vybrat oblast bunék bez pouziti mysi:

1) Vybereme buriku, ktera bude jednim z roh( oblasti bunék.

2) Podrzime klavesu Shift a pomoci kurzorovych Sipek vybereme zbytek oblasti.
Vybér rozsahu bunék pomoci Pole nazvu:

1) Klepneme do Pole ndzvu na Panelu vzorcl (obrazek 4 na strané 25).

2) Zadame odkaz pro levou horni buriku, nasledovanou dvojteckou (:), a poté odkaz na
dolni pravou buriku a stiskneme klavesu Enter. Chceme-li napfiklad vybrat oblast, ktera
se bude rozkladat od bunky A3 aZ po C6, zadame A3:C6.

Nesouvisla oblast bunék

Vybér oblasti nesousedicich bunék pomoci mysi:
1) Vybereme buiku nebo oblast bunék pomoci jedné z vySe uvedenych metod.
2) Presuneme ukazatel mysi na zacatek nasledujici oblasti nebo jediné buriky.

3) Podrzime klavesu Ctrl a klepnutim nebo pretazenim vybereme jinou oblast bunék, kterou
chceme pridat k prvni oblasti.

4) Opakujeme podle potieby.
Vybér rozsahu bunék pomoci rezimu Doplnitelny vybér:

1) Klepneme pravym tlaCitkem mysSi do pole Méd vybéru na stavovém fadku (obrazek 5 na
strané 25) a vybereme Doplnitelny vybér.

2) Klepnutim nebo klepnutim a pfetazenim vybereme oblast bunék, kterou chceme pfidat do
vybéru.
Vybér sloupct a fadku

Jediny sloupec nebo radek

Chceme-li vybrat jeden sloupec, klepneme na zahlavi sloupce (obrdzek 3 na strance 23).
Chceme-li vybrat jediny fadek, klepneme na zahlavi fadku.

Vice sloupcii nebo radku
Chceme-li vybrat vice sloupcl nebo radkd, které jsou souvisle vedle sebe:
1) Klepneme na prvni sloupec nebo fadek ve skupiné.
2) Podrzime klavesu Shift.
3) Klepneme na posledni sloupec nebo fadek ve skupingé.
Chceme-li vybrat vice sloupcti nebo fadk, které nejsou souvisle vedle sebe:
1) Klepneme na prvni sloupec nebo fadek ve skupiné.
2) Podrzime klavesu Citrl.
3) Klepneme na vSechny dalsi sloupce nebo fadky, zatimco drzime klavesu Ctrl.
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Cely list

Chceme-li vybrat cely list, klepneme na obdélni¢ek mezi zahlavim sloupct a fadkd (obrazek 15),
pouzijeme kombinaci klaves Ctrl + A, zmackneme Ctrl + Shift + Space nebo zvolime v hlavni
nabidce Upravy a vybereme polozku Vybrat vSe.

B

2 \ I
Wyhbrat vie

Obréazek 15: Obdélnik pro vybér
vSeho

Vybér listl
V Calcu si miiZzeme vybrat bud jeden, nebo vice listl. Vybér vice listd mdze byt vyhodny, pokud
chceme provést zmény v mnoha listech najednou.

Jeden list
Klepneme na kartu listu, ktery chceme vybrat. Karta vybraného listu se zvyrazni.

Nékolik sousedicich listi
Chceme-li vybrat nékolik sousedicich listd:
1) Klepneme na kartu prvniho pozadovaného listu.
2) Podrzime klavesu Shift a klepneme na zaloZzku posledniho poZadovaného listu vybéru.
3) VSechny karty mezi témito dvéma vybéry se zvyrazni. VeSkeré akce, které nyni
provedeme, ovlivni vdechny zvyraznéné listy.
Nékolik nesousedicich list(
Chceme-li vybrat nékolik nesousedicich listl:
1) Klepneme na kartu prvniho poZadovaného listu.
2) Podrzime klavesu Ctrl a klepneme na karty listd, které chceme pfidat do vybéru.
3) Vybrané karty se zvyrazni. VeSkeré akce, které nyni provedeme, ovlivni vSechny
zvyraznéne listy.
VSechny listy

Klepneme pravym tlacitkem mysi na kartu libovolného listu a z mistni nabidky zvolime Vybrat
vSechny listy nebo vybereme z hlavni nabidky volbu Upravy > Vybrat > Vybrat vSechny listy.

6 Tip

Vybrat vSechny listy miizeme také pomoci dialogového okna Vybrat listy. Dialogové
okno vyvolame z hlavni nabidky Upravy > Vybrat > Vybrat listy.

Prace se sloupci a radky

Vkladani sloupci a radka

Pfi vkladani novych sloupct nebo fadkd buriky pfevezmou formatovani odpovidajicich bunék,
u sloupct zprava nebo u fadkd zezdola.
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Jediny sloupec nebo radek
Pomoci nabidky VloZit:
1) Vybereme buriku, sloupec nebo fadek podle toho, kam chceme novy sloupec nebo fadek
vlozit.

2) V hlavni nabidce zvolime List. Pro sloupce vybereme List > VloZit sloupce a poté
vybereme Sloupce pred nebo Sloupce za. Pro fadky vybereme List > VloZit fadky
a poté vybereme Radky nad nebo Radky pod.

Pomoci mistni nabidky:

1) Vybereme sloupec nebo fadek podle toho, kam chceme novy sloupec nebo rfadek vlozit.
2) Klepneme pravym tlaCitkem mysi na zahlavi sloupce nebo fadku.
3) Z mistni nabidky zvolime Vlozit sloupce pfed/za nebo Vlozit fadky nad/pod.

Vice sloupcii nebo radki
Je vhodnéjsi vlozit vice sloupcli nebo Ffadkl najednou nez vkladat jeden po druhém.
1) Vybereme pozadovany pocet sloupctl nebo fadkd tim, Ze podrzime levé tlacitko mysi na
prvnim z nich a tAhneme pres jejich zahlavi.

2) Daéle postupujeme stejné jako u vkladani jednoho sloupce nebo fadku popisovaného
vySe. Bude vloZen pocet zvyraznénych sloupcl nebo radka.

Mazani sloupct a fadku

Jediny sloupec nebo radek
Chceme-li odstranit jeden sloupec nebo fadek, provedeme jednu z nasledujicich akci:

* Vybereme buriku ve sloupci nebo fadku, kterou chceme odstranit, klepneme pravym
tlacitkem a vybereme v mistni nabidce Smazat, zvolime v hlavni nabidce List > Smazat
bunky nebo zmackneme Ctrl + -. Otevie se dialogové okno Odstranit buriky (obrazek

7 vz

16). Vybereme Smazat celé sloupce nebo Smazat celé fadky a zmackneme tlacitko
OK.

* Vybereme burku ve sloupci nebo fadku, kterou chceme odstranit, a vybereme List >
Smazat sloupce nebo List > Smazat fadky.

* Klepneme pravym tlacitkem mysSi na zahlavi sloupce nebo fadku, ktery chceme odstranit
a vybereme z mistni nabidky Smazat sloupce nebo Smazat fadky.

Smazat buriky X

Vyhér
® Posunout buriky nahoru:
) Posunout burky doleva
) Smazat celé fadky

) Smazat celé sloupce

Napovéda 0K Zrusit

Obrazek 16: Dialogové okno Smazat
buriky
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Vice sloupcii nebo radkii
Chceme-li odstranit vice sloupcti nebo fadkd, provedeme jednu z nasledujicich akci:
* Vybereme oblast bunék pfes sloupce nebo Fadky, které chceme odstranit, klepneme

pravym tlaCitkem a vybereme v mistni nabidce Smazat, zvolime v hlavni nabidce List >
Smazat bunky nebo zmackneme Ctrl + -. Otevie se dialogové okno Odstranit buriky.

7 vz

Vybereme Smazat celé sloupce nebo Smazat celé Fadky a zmackneme tlacitko OK.

* Vybereme oblast bunék pres sloupce nebo fadky, které chceme odstranit, a vybereme
List > Smazat sloupce nebo List > Smazat fadky.

« Vybereme poZadovany pocet sloupct nebo rfadkd tim, Ze podrzime levé tlac¢itko mysi na
prvnim z nich a tAhneme pres jejich zahlavi. Klepneme pravym tlacitkem mySi na zahlavi
jednoho z vybranych sloupcl nebo fadkl a vybereme z mistni nabidky Smazat sloupce
nebo Smazat Fadky.

Mazani bunék

1) Vybereme bunku nebo buriky, které chceme odstranit.

2) Vybereme List > Smazat bunky, zmackneme Ctrl + - nebo klepneme pravym tlacitkem
na jednu z vybranych bunék a vybereme z mistni nabidky Smazat.

3) V dialogu Smazat burky vybereme poZzadovanou moznost a stiskneme tlacitko OK.

Prace se seSity

Vkladani nového listu

Klepnutim na symbol + vedle karet listll vioZzime novy list za posledni list v tabulce, bez otevieni
dialogové okna Vlozit list. Nasledujicim zplsobem se otevira dialogové okno VloZit list (obrazek
17), ve kterém mUlZeme urcit umisténi nového listu, vytvorit vice listll, zadat ndzev nového listu
nebo vybrat list ze souboru.

* Vybereme list na misté, kam chceme vloZit novy list, a poté zvolime v hlavni nabidce List
> Vloiit list.

» Klepneme pravym tlaCitkem mysi na kartu, kam chceme vloZit novy list, a vybereme
v mistni nabidce Vlozit list.

« Klepneme v prazdném prostoru na konci karet listd.

« Klepneme pravym tlac¢itkem mysi do prazdného mista na konci karet listd a vybereme
v mistni nabidce Vlozit list.
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VioZit list

Umisténi
() Za aktualni list

List
® Novy list
Pocet listd: |1 =
Nazev: List2

() Ze souboru

Prochazet..

Qdkaz

Mapovéda Zrusit

Obrazek 17: Dialogové okno VioZit list

Presouvani a kopirovani listt
Listy mdzeme v ramci téhoz seSitu presouvat nebo kopirovat pfetahovanim nebo pomoci

dialogového okna Presunout/kopirovat list (obrazek 18). Chceme-li list pfesunout nebo
zkopirovat do jiného sesitu, je tfeba pouzit dialogové okno Pfesunout/kopirovat list.

Presouvani pomoci mysi

Chceme-li list pfesunout na jiné misto v témZe seSitu, klepneme na jeho kartu, pretahneme ji na
nové misto a az poté uvolnime tla€itko mysi.

Chceme-li list v témZe seSitu zkopirovat, podrzime klavesu Ctrl, potom klepneme na kartu listu
a pfetdhneme ji na nové misto a az poté uvolnime tlacitko mysi. V zavislosti na nastaveni
operaéniho systému se mizZe ukazatel mysi zménit na znaménko plus.
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Pouzivani dialogového okna Presunout/kopirovat list

Pomoci dialogového okna Pfesunout/kopirovat list miiZzeme urcit, zda se ma list pfesunout nebo
zkopirovat do stejného nebo jiného seSitu, kde ma byt v ramci seSitu umistén a jaky ma byt jeho
nazev.

Presunout/kopirovat list

Cinnost

® presunout 2 Kopirovat
Umisténi

Do dokumentu

Lunapark (aktualni dokument) ~

VioZit pred
Zaklady

Seznamy
Kont. tabulka
- presunout na konec -

Novy nazev

Wysvétliviy

MNapovéda oK Zrusit

Obrazek 18: Dialogové okno
Presunout/kopirovat list

1) V aktualnim dokumentu klepneme pravym tlacitkem mysi na kartu listu, ktery chceme
pfesunout nebo kopirovat, vybereme z mistni nabidky Pfesunout/kopirovat list nebo
zvolime v hlavni nabidce List > Pfesunout nebo kopirovat list.

2) Vybereme Pfesunout, pokud chceme list pfesunout, nebo Kopirovat, pokud ho chceme
zkopirovat.

3) Zrozbalovaciho seznamu Do dokumentu vybereme seSit, do kterého chceme list umistit.
MUzZe to byt stejny sesit, jiny jiz otevieny, nebo miiZzeme vytvofit novy.
4) V poli ViloZit pred vybereme, kam chceme list umistit.

5) Pokud chceme pfi pfesouvani nebo kopirovani list pfejmenovat, napiSeme nazev do
textového pole Novy nazev. Pfi kopirovani navrhne Calc vychozi nazev (Listl_2, List2_2
atd.).

6) Klepnutim na tlagitko OK presun nebo kopirovani potvrdime a dialogové okno se zavre.

Upozornéni

Pokud presouvame nebo kopirujeme do jiného nebo nového sesitu, miiZe nastat
konflikt se vzorci odkazujicimi na jiné listy z plivodniho umisténti.

Mazani listl

Chceme-li smazat jeden list, klepneme pravym tlacitkem mySi na jeho kartu a zvolime z mistni
nabidky Smazat list nebo vybereme z hlavni nabidky List > Smazat list. Smazani potvrdime
klepnutim na tlacitko Ano.
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Pokud chceme smazat vice listd, vybereme je (viz ,Vybér listd“ na strané& 39), pak na jednu
z vybranych karet klepneme pravym tlacitkem mySi a z mistni nabidky zvolime Smazat list nebo
Z hlavni nabidky zvolime List > Smazat list. Smazani potvrdime klepnutim na tlaCitko Ano.

Pfejmenovani listt
Vychozi nadzev pridaného listu je List X, kde X je Cislo pfidaného listu. Takové nazvy jsou vhodné
pro maly pocet listd, ale pfi velkych poctech jsou nepiehledné a je lepsi listy pojmenovat jinak.
KdyZ chceme list pfejmenovat, mizeme pouzit jeden z nasledujicich zptsobd:
* Zadame nazev do textového pole Nazev pfi jeho vytvafeni, pomoci dialogového okna
Vlozit list (obrdzek 17 na strané 42).

* Klepneme pravym tlacitkem mySi na kartu listu, v mistni nabidce zvolime Pfejmenovat
list a nahradime sou€asny nazev novym.

* Vybereme v hlavni nabidce List > Pfejmenovat list, ¢imZ otevieme dialogové okno
Pfejmenovat list.

* Poklepeme na kartu listu, ¢imz otevieme dialogové okno Pfejmenovat list.

Poznamka

Nazvy listd mohou obsahovat témér libovolny znak. Plati néktera omezeni
pojmenovani, v nazvech listli nejsou povoleny nasledujici znaky: dvojtecka (:),
lomitko (\), lomitko (/), otaznik (?), hvézdicka (*), leva hranata zavorka ([) nebo prava
hranata zavorka (]). Kromé toho nelze jako prvni nebo posledni znak nazvu pouzit
jednoduchou uvozovku (*).

Zobrazeni v programu Calc

Zména zobrazeni dokumentu

Pro zménu méfitka zobrazeni, tedy pro zobrazeni vétSiho ¢i mensiho poCtu bunék v okné sesitu,
je mozné pouZzit funkci pfiblizeni. Vice informaci o funkci pfiblizeni nalezneme v kapitole 1 —
Predstavujeme LibreOffice v pfiru¢ce ZaCiname s LibreOffice.

Ukotveni fadku a sloupci

Ukotveni se pouziva k uzaméeni fadkd v horni ¢asti listu nebo k uzaméeni sloupct v levé ¢asti
listu. KdyZ se potom pohybujeme v listé, ukotvené sloupce a fadky zUstavaji stale zobrazené.

Obrazek 19 zobrazuje ukotvené fadky a sloupce. Na obrazku vidime silnéjsi vodorovnou ¢aru
mezi fadky 4 a 5 a svislou ¢aru mezi sloupci C a D, které vymezuji ukotvené oblasti. Radky 4 az
22 a sloupce G az P byly posunuty mimo stranku. Ukotveni fadkd nebo sloupct:

1) Klepneme na zahlavi fadku pod fadky, které chceme ukotvit, nebo na zahlavi sloupce
vpravo od sloupct, kde chceme ukotvit. Chceme-li ukotvit fadky i sloupce, vybereme
bunku (nikoli FAdek nebo sloupec), ktera je pod fadkem a napravo od sloupce, ktery
chceme ukotvit.

2) V hlavni nabidce pfejdeme do polozky Zobrazit a vybereme Ukotvit fadky a sloupce.
Zobrazi se silngjsi ¢ara, ktera indikuje polohu ukotveni.
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A | 8 | ¢ | o | E | F | a | R

1 Pfijmeni Jméno Adresa Mésto Krajina
2 Weber Jean PO Box 640  Airlie Beach Australie
3 Schofield Peter Jankowskiego Opole Polsko

z

Obrazek 19: Ukotvené radky a sloupce

ZrusSeni ukotveni

Chceme-li ukotveni fadkd a sloupct zrusit, zvolime v hlavni nabidce Zobrazit a vybereme

polozku Ukotvit fadky a sloupce. SilngjSi Cary indikujici ukotveni zmizi.

Rozdéleni obrazovky

Druhy zplsob, jak zménit zobrazeni listu, je rozdéleni obrazovky (pouziva se i pojem ,rozdéleni
okna“). Obrazovka se déa rozdélit vodorovné, svisle nebo obéma zplsoby najednou. Mizeme tak
soucasné zobrazit az Ctyfi Casti seSitu. Pfiklad je znazornén na obrazku 20 , pficemz rozdéleni je
oznaceno Sedou Carou.

Tento zplisob se mlze hodit napfiklad tehdy, kdyZ mame v jedné ¢asti velkého listu buriku

s Cislem pouzivanym tfemi vzorci v jinych bunikach. PouZiti techniky rozdéleni obrazovky lze
umistit buriku obsahuijici ¢islo v jedné asti zobrazeni a burky s vzorc( v jinych ¢astech. Tato
moznost ndm umoziuje jednoduse sledovat, jaky vliv ma zmeéna €isla v bufice na vysledky
vzorcu.

A | B | c |

T Beta= 3.2000
_ 2 | AD= 0.1000
_ 5 |

6

7 Al= Beta*A0*(1-AD) 0.2880
8 A2=| Beta*Al1*(1-Al) 0.6562
g A3= Beta*A3*(1-A2) 0.7219
10 Ad=| Beta"A4*(1-A3) 0.6424
11 A5=| Beta*A5*(1-Ad) 0.7351
Obréazek 20: Priklad rozdéleni
obrazovky

Vodorovné nebo svislé rozdéleni obrazovky
Existuji dva zplsoby rozdéleni obrazovky vodorovné nebo svisle:

Prvni zplsob:

1) Klepneme na zahlavi fadku, nad ktery chceme vloZzit bod rozdéleni, nebo na zahlavi
sloupce, pred ktery chceme vlozit bod rozdéleni.

2) V hlavni nabidce zvolime Zobrazit a vybereme Rozdélit okno. Mezi fadky nebo sloupci
se zobrazi tlustd Cara, ktera indikuje polohu rozdéleni. Priklad délici Cary je zobrazen pod
fadkem 2 na obrazku 20.

Druhy zpisob:

Chceme-li okno rozdélit vodorovné, uchopime mysi obdélniCek s vodorovnou ¢arkou, ktery se
nachazi nad svislym posuvnikem (obrazek 21), a pfetahneme jej pod rfadek, pod kterym chceme
okno rozdélit.

Podobné pro svislé rozdéleni uchopime mySi obdélnicek se svislou ¢arkou, ktery se nachazi na
pravé strané za vodorovnym posuvnikem (obrazek 21), a pretdhneme jej za sloupec, za kterym
chceme okno rozdélit.
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obrazovky obrazovky

Obréazek 21: Pruhy rozdéleni obrazovky

Vodorovné a svislé rozdéleni obrazovky

Prvni zplsob:
Umistime jak ¢ernou vodorovnou, tak i €ernou svislou ¢aru, jak je popsano vyse a jak je
znazornéno na obrazku 21.

Druhy zpUsob:
1) Klepneme na buriku, kterd méa byt tésné pod vodorovnym a zaroven tésné za svislym
rozdélenim.

2) V hlavni nabidce zvolime Zobrazit a vybereme Rozdélit okno. Mezi fadky nebo sloupci
se zobrazi tlusta Cara, ktera indikuje polohu rozdéleni.
Odebrani rozdéleni obrazovky
Rozdéleni obrazovky odebereme jednim z nasledujicich zplsob:

* Poklepeme postupné na kazdou rozdélovaci caru.
« Klepneme a pietahneme rozdélovaci ¢ary zpét na jejich mista na koncich posuvnikd.
* V hlavni nabidce zvolime Zobrazit a vybereme Rozdélit okno.

Pouzivame Navigator

Navigator (obrazek 22) je k dispozici ve vSech modulech LibreOffice. Poskytuje nastroje
a metody pro rychly pohyb v seSitu a hledani konkrétnich polozek.

Sloupec: |A = [ N
Radek |1 =] |F b &~
= B8 Listy

List1

{3 Nazvy oblasti

=] Databazové oblasti
|* Propojené oblasti
[l Obrazky

51t Objekty OLE

L. Komentare

[.al Objekty kresby

Bez nazvu 1 (aktivni) w

Obrazek 22: Dialogové okno
Navigator v programu Calc
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Navigator kategorizuje a seskupuje objekty sesitu, na které mizeme klepnout a rychle se

k tomuto objektu pfesunout. Pokud se vedle kategorie objevi indikator (znaménko plus nebo
trojuhelnik v zavislosti na nastaveni pocitaCe), existuje v této kategorii alespon jeden objekt.
Klepnutim na indikator otevieme seznam polozek. Pokud kategorie obsahuje seznam objekt(,
poklepanim na néjaky objekt pfejdeme pfimo na tento objekt.

Navigator otevieme jednim z nasledujicich zpsobu:

» Stiskem klavesy F5 otevieme dialogové okno Navigator.
* V hlavni nabidce zvolime Zobrazit > Navigator a otevieme dialogové okno Navigator.
* V postranni listé klikneme na ikonu Navigator, otevie se stejnojmennd karta.
Dialogové okno Navigator a karta Navigator postranniho panelu nabizeji ekvivalentni moznosti.
Ovladaci prvky a nastroje dostupné v Navigatoru jsou nasleduijici:
* Sloupec — pro pfemisténi kurzoru bunky do ureného sloupce ve stejném fadku
napiSeme pismeno sloupce a stiskneme klavesu Enter.

« Radek — pro pfemisténi kurzoru buriky na uréeny rfadek ve stejném sloupci zadame &islo
fadku a stiskneme klavesu Enter.

* Oblast dat — urCuje aktualni rozsah dat oznaceny pozici kurzoru bunky.

« Zacatek — presune kurzor do buiiky na zacatek aktualni oblasti dat, kterou mdZzeme
zvyraznit pomoci ikony Oblast dat.

« Konec — presune kurzor do buiiky na zacatek aktualni oblasti dat, kterou miZzeme
zvyraznit pomoci ikony Oblast dat.

* Obsah - pfepina zobrazeni pohledu na obsah ve spodni ¢asti dialogového okna
Navigator, aby se doCasné zmenSila jeho velikost. Na karté Navigator v postranni listé
neexistuje obdobny ovladaci prvek.

* Pfepnout — prepina zobrazeni obsahu. Zobrazi se pouze vybrana kategorie a jeji
objekty. Opétovnym klepnutim na ikonu obnovime vSechny prvky pro prohlizeni.

* Scénare — zobrazi vSechny dostupné scénare. Dalsi informace o scénafich najdeme
v kapitole 9, Analyza dat. Poklepanim na nazev pouZijeme tento scénér a vysledek se
zobrazi v listu. Pokud Navigator zobrazi scénare, miizeme po klepnuti pravym tlacitkem
mySi na poloZzku scénére ziskat pristup k nasledujicim pfikazdm:

— Odstranit — odstrani vybrany scénar.

— Vlastnosti — otevie dialogové okno Upravit scénéaf, kde mdzeme upravit viastnosti
scénére.

* Rezim pretazeni — otevie podnabidku pro vybér akce, ktera se provede pfi pfetazeni
objektu z Navigatoru do dokumentu. V zavislosti na zvoleném rezimu ikona oznacuje,
zda je vytvofen hypertextovy odkaz, odkaz nebo kopie.

VioZit jako hypertextovy odkaz — hypertextové odkazy na celou polozZku.

VioZit jako odkaz — propoji zkopirovanou polozku s plvodni polozkou tak, aby se pfi
zméné plvodni polozky tato zména projevila v aktualnim dokumentu.

VioZit jako kopii — vlozi kopii vybrané polozky.
@ ip

Oblasti, scénare, obrazky a dalSi objekty je mnohem snazsi najit, pokud jsme jim pfi
jejich vytvareni namisto ponechani vychozich nazvl Calc (napfiklad scénar 1,
obrazek 1, obrazek 2, objekt 1 atd.) dali informativni jména. Tyto vychozi ndzvy
nemusi odpovidat poloze objektu v dokumentu.
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Pouzivani vlastnosti dokumentu

Chceme-li otevrit dialogové okno Vlastnosti souboru, pfejdeme na Soubor > Vlastnosti v hlavni
nabidce. Dialogové okno Vlastnosti souboru poskytuje informace o seSitu a umoZziiuje nastavit
nékteré z jeho vlastnosti. Dialogové okno je zobrazeno na obrazku 23 a jeho karty jsou popséany
nize.

Vlastnosti souboru ,Seznam prodeje”

Obecne Popis Vlastni viastnosti Zabezpecenl Plsmo Statistika

Seznam prodeje.ods Zménit heslo
Typ: Sesit OpenDocument

Umisténi;  DAMOIJE DOKUMENTY\ROZROBENE VECNDOKUMENTACIA LIBRE OFFICE\V

Velikost: 29 kB (29 887 Bajtd)

Vytvoren: 21.10.2018, 19:35:56, Dave Barton

Zménén: 05.09.2020, 17.07:04, Roman Toman

Sablona:

Elektronicky podepsan: Elektronické podpisy...
Vytistén:
Celkowy €as dprav: 01:54:40
Cislo revize: 23

PouzZit uZivatelské (daje

] Obnovit vlastnosti
UloZit s timto dokumentem obrazek nahledu

MNapovéda Obnovit QK Zrusit

Obréazek 23: Dialogové okno Vlastnosti souboru, karta Obecné

Obecné

Obsahuje zakladni informace o aktualnim souboru.

s w7z

* Text v horni &asti dialogu zobrazuje nazev souboru.

+ Zmeénit heslo — otevie dialogové okno pro zménu hesla. Je aktivni, pouze pokud bylo
nastaveno heslo souboru.

* Typ — zobrazi typ souboru aktualniho dokumentu.

* Umisténi — zobrazi cestu a nazev adresare, kde je soubor ulozen.

» Velikost — zobrazuje velikost aktualniho dokumentu v bytech.

* Vytvoren — zobrazi datum, €¢as a autora, kdy byl soubor poprvé uloZen.

* Zménén — zobrazuje datum, ¢as a autora, kdy byl soubor naposledy uloZzen ve formatu
souboru LibreOffice.

+ Sablona — je-li to moZné, zobrazi Sablonu, ktera byla pouZita k vytvofeni souboru.

42 | Priru¢ka Calc 7.0



» Elektronicky podepsan — zobrazuje datum a cas, kdy byl soubor naposledy podepsan
a jméno autora, ktery dokument podepsal.

« Elektronické podpisy — otevie dialogové okno Digitalni podpisy, v némz mlizeme
spravovat digitalni podpisy pro aktualni dokument.

* VytiStén — zobrazuje datum, €as a uzivatelské jméno, kdy byl soubor naposledy vytistén.

* Celkovy €as uUprav — zobrazuje dobu, po kterou byl soubor otevien od vytvoreni
souboru. Cas ulozeni se aktualizuje pfi ulozeni souboru.

« Cislo revize — zobrazuije, kolikrat byl soubor uloZen.

* Pouzit uzivatelské udaje — ulozi celé jméno uzivatele se souborem. UZivatelské jméno
mlZeme zménit v hlavni nabidce Nastroje > MoZnosti > LibreOffice > UZivatelské
udaje.

* UloZit s timto dokumentem obrazek nahledu — uloZi do dokumentu thumbnail.png.
Tyto obrazky mlzZe za uréitych podminek pouzit spravce soubord.

* Obnovit vlastnosti — nastavi €as Uprav na nulu, datum vytvofeni na aktualni datum
a Cas a Cislo verze na 1. Také se smaze datum dpravy a vytisténi.

Popis
Obsahuje volitelné editovatelné popisné informace o seSitu.

* Nazev — zadame titulek seSitu.

* Predmét — zadame prfedmét seSitu. Pomoci pfedmétu je mozné seskupit dokumenty
s podobnym obsahem.

+ KiliCova slova — vloZzime slova, ze kterych chceme vytvofit index obsahu seSitu. Klicova
slova musi byt oddélena ¢arkou. Kli¢ové slovo mlize obsahovat prazdné znaky nebo
stfedniky.

« Komentare — zadame komentar, ktery pomdze identifikovat sesit.

Vlastni vlastnosti

Zalozku pouzijeme pro pfifazeni informac¢nich poli do sesitu. V novém sesitu mize byt tato
stranka prazdna. Pokud je novy sesit zaloZen na Sabloné, miZe tato stranka obsahovat pole.
Nazev, typ a obsah kazdého fadku Ize zménit. Informace v polich budou exportovany jako
metadata do dalSich souborovych forméatd.

Chceme-li pfidat novou vlastni vlastnost, klepneme na Pfidat vlastnost. Pomoci sousedniho
tlaCitka Odebrat vlastnost odstranime vlastni vlastnost.

Vlastnosti CMIS

Relevantni pouze pro seSity ulozené na vzdalenych serverech. Pro vice informaci viz ndpovéda
nebo pfirucka Zaciname s LibreOffice.

Zabezpeceni
UmoZiuje dvé moznosti zabezpec€eni chranéné heslem.

» Otevirit jen pro ¢teni — vybérem povolime tento dokument otevirat pouze v rezimu pro
¢teni. Tato moznost sdileni soubor( chrani dokument pfed nahodnymi zménami. Stale je
moZzné upravit kopii dokumentu a tuto kopii uloZit pod stejnym nazvem jako original.

* Zaznamenavat zmény — vybereme, pokud poZzadujeme zaznamenavat vSechny zmeény.
Stav sledovani zmén uzamkneme heslem klepnutim na Zamknout a zadame heslo. Jde
o obdobu volby v hlavni nabidce Upravy > Sledovani zmén > Zaznam. Ostatni
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uzivatelé budou moci dokument ménit, ale nebudou moci bez znalosti hesla vypnout
zaznamenavani zmeén.

* Zamknout nebo Odemknout — uzamkne stav sledovani zmén heslem. Pokud je
v aktualnim dokumentu zaznamenavani zmén uzamceno, tlacitko se jmenuje
Odemknout. Uzamknuti zru§ime klepnutim na Odemknout.

Pismo

Po zaSkrtnuti pole Vlozit pisma do dokumentu se vSechna pisma pouzita v sesitu ulozi spolu
s dokumentem. To miZe byt uzite¢né, pokud vytvafime ze sesitu PDF a chceme zajistit jednotny
vzhled dokumentu pfi zobrazeni na jiném pocitaci.

VloZit pouze pisma pouZzita v dokumentech — tuto moznost zvolime, pokud nechceme, aby se
do seSitu vkladala vSechna pisma (napriklad ze Sablony dokumentu), ale jen pisma v dokumentu
pouZita.

Vkladana pisma — vybereme, které typy pisem chceme vloZit: latinskd, asijska, komplexni. Vice
informaci se nachézi v pfirucce Zac¢iname s LibreOffice.

Statistika

Zobrazi statistiku pro aktualni soubor: pocet listll, bunék, stranek a skupin vzorcu.

Regularni vyrazy

Podpora regularnich vyraz( (¢asto oznacovanych jako regex nebo regexp) je skrytym klenotem v
programu Calc. Regularni vyrazy jsou velmi silné a umoZznuji uzivateldm definovat slozité vzory
vyhledavani pro nalezeni dat, které nas v sesitu zajimaji Nékterym uzivatelim muze pfipadat
syntaxe pro definici regularniho vyrazu slozita a nezkuSeni uzivatelé mohou udélat chybu. Mala
¢asova investice, abychom se naucili zakladni pojmy a nékteré syntaxe, se v3ak v budoucnu
vyplati. Doporu€ujeme, abyste se nepokouseli zapamatovat si celou syntaxi, ale soustfedili se
jen na objeveni nékolika aspektd, které vam pomohou pfi kazdodenni praci. Jakmile uvidite
vyhody pouzivani regularnich vyrazd, urcité budete mit motivaci dozvédét se vice.

Regularni vyraz je fetézec znakl definujicich vzor textu, ktery ma byt porovnan. Podrobnéjsi
obecné informace najdeme na Wikipedii na adrese
https://en.wikipedia.org/wiki/Regular_expression.

Regularni vyrazy jsou Siroce pouzivany v mnoha doménach a k dispozici je nékolik procesorl
regularnich vyraz(. Calc pouziva open source Regular Expressions package z International
Components for Unicode (ICU), pro dalSi detaily viz
http://userguide.icu-project.org/strings/regexp, kde najdeme Gplnou definici syntaxe pro ICU
regularni vyrazy.

Regulérni vyrazy se objevuji ve tfech oblastech funkcionality programu Calc:

+ Hledani v dialogovém okné& Najit a nahradit, které Ize otevfit v hlavni nabidce Upravy >
Najit a nahradit, klepnutim na ikonu Najit a nahradit na nastrojové listé Najit nebo
zmacknutim Ctrl + H. DalSi informace nalezneme v kapitole 2, Zadavani, Gprava
a forméatovani dat.

» Filtrovani pomoci dialogovych oken Standardni filtr a RozSifeny filtr, ke kterému se
dostaneme volbami Data > DalSi filtry > Standardni filtr a Data > DalSi filtry >
RozSifeny filtr. DalSi informace nalezneme v kapitole 2, Zadavani, Gprava a formatovani
dat.

* Funkce. Mnoho funkci programu Calc pouZiva ve vyhledavacich kritériich regularni
vyrazy. Funguji pouze pokud je vybrdna moznost Nastroje > MoZnosti > LibreOffice
Calc > VypocCty > Zastupné znaky ve vzorcich > Povolit regularni vyrazy ve
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vzorcich. Doporucujeme také zapnout volbu Nastroje > MoZnosti > LibreOffice Calc >
Vypocdty > Obecné vypocty > Vyhledavaci kritéria = a <> musi platit pro celé bunky,
takze kritéria vyhledavani ve vzorcich musi odpovidat celému obsahu buriky. DalSi

informace nalezneme v kapitole 7, Pouziti vzorcl a funkci.

Pro ilustraci pouzivani regularnich vyraz(i pouzijeme sesit s daty prodeje. Nékolik prvnich radki
je ukdzano na obrazku 24.

A \ B \ c | o | E
1 Datum  Hodnota prodeje Kategorie Region Zaméstnanec
2 | 02.01.2008 $410 Tenis Sever  Kurt
3 | 02.01.2008 $1,508 Golf Vychod Hans
4 102.01.2008 $2,340 Jachting  Jih Ute
5 |03.01.2008 $4,872 Tenis Wychod | Brigitte
6 | 06.01.2008 $2 623 Tenis Vychod Fritz
7 | 06.01.2008 $3,821 Tenis Jih Fritz
8 |07.01.2008 $3,739 Golf Jih Fritz
9 | 08.01.2008 $4,195 Golf Zapad Ute
10 | 10.01.2008 $2,023 Golf Vychod Hans
11 | 14.01.2008 $2 804 Tenis Zapad |Hans
12 | 15.01.2008 $579 Jachting Zapad Ute
13 | 15.01.2008 $1,858 Tenis Sever Kurt
14 | 17.01.2008 $2 827 Tenis Vychod Hans
15 | 17.01.2008 $4 842 Golf Sever Ute

Obrazek 24: Sesit s daty pro priklad regularnich vyraz(

Ufednici, ktefi zadavaji data bohuzel neznaji dobfe prodejni personal, a proto tabulka obsahuje
fadu preklepd jména Brigitte. Pfi kontrole dat si vSimneme, Ze pokud bychom mohli najit vSechny
burky obsahuijici fetézec, ktery zacina znaky ,Bri“, a poté nahradit cely obsah kazdé takové
bunky fetézcem ,Brigitte”, pak by data v tabulce byla opravena. Toho Ize snadno dosahnout
pomoci jednoduchého regularniho vyrazu, jak je uvedeno nize:

1) V hlavni nabidce zvolime Upravy > Najit a nahradit. Calc otevfe dialogové okno Najit
a nahradit (obrazek 25).
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Najit: ABr* g

Nahradit: |Erigitte b

[=I Ostatni moZnosti:

Najit a nahradit

[ Rozlizovat velikost [ 1Zobrazeny fetézec Celé bunky [1VSechny listy

MNajit vie Majit predchozi MNajit dalsi Mahradit MNahradit vie

Pouze v souCasném vybéru [ Nahradit pozpatku
Zastupné znaky O Styly buriky
Regularni wrazy

Hledani podobnosti Podobnosti...

Rozlisovat diakritiku

Smer. @Radky O Sloupce Hledat v:

MNapovéda Zaviit

Obrazek 25: PouZivani regularniho vyrazu v dialogovém okné Najit a nahradit

2)

3)
4)

5)
6)

7

Do pole Najit zadame text "*Bri.*'. Znak “A” znamena shodu na zacatku; “.” znamena
shodu s libovolnym znakem; a “*” znamen& shodu 0 nebo vicekrat.
Do pole Nahradit zadame text "Brigitte".

V pfipadé potfeby klepneme na ikonu v dialogovém okné a rozbalime sekci Ostatni
moZnosti.

Ujistime se, Ze je vybrano zaSkrtavaci pole Regularni vyrazy.

Zmackneme tlacitko Nahradit vSe. Program Calc zaktualizuje data seSitu, nahradi
vSechny vyskyty slov “Bridget” a “Brigid” slovem “Brigitte”.

Stisknutim tlacitka Zavfit uzavieme dialogové okno Najit a nahradit.

Predpokladejme, Ze chceme filtrovat stejny seSit (obrazek 24), aby zobrazoval pouze data
odpovidajici kategoriim Tennis a Golf z region( Sever a Vychod. Toho Ize snadno dosahnout
pomoci regularnich vyraz( pomoci nasledujicich krokd:

1)
2)

Klepneme na buriku v datech prodeje.

V hlavni nabidce zvolime Data > DalSi filtry > Standardni filtr. Calc otevie dialogové
okno Standardni filtr (obrazek 26).
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3)
4)
5)
6)
7
8)
9)

Standardni filtr

Kritéria filtru

Operator Mazev pole

Podminka

‘Kategorie i

|
‘A V‘ ‘Region V| |=

|

|

Hodnota &
v | |Tennis|Golf ~
V| Sever|Vyche ~
W

=l MoZnosti

[] Rozlisovat velikost pismen
Oblast obsahuje popisky sloupct
L Kopirovat vysledky do:

- nedefinovano -

Mapovéda

[ Bez duplikatd

Ponechat kriténa filtru

Zrusit

Obrazek 26: PouZiti reqularnich vyrazi v dialogovém okné

Standardn filtr

Ve sloupci Nazev pole vybereme z prvni rozbalovaci nabidky Kategorie.

Ve sloupci Podminka vybereme z prvni rozbalovaci nabidky =.

V prvnim textovém poli ve sloupci Hodnota zadame "Tennis|Golf".

Ve sloupci Nazev pole vybereme z druhé rozbalovaci nabidky Region.

Ve sloupci Podminka vybereme z druhé rozbalovaci nabidky =.

V druhém textovém poli ve sloupci Hodnota zadame "Sever|Vychod".

V pfipadé potfeby klepneme na ikonu v dialogovém okné a rozbalime sekci MoZnosti.

10) Ujistime se, Ze je vybrano zaSkrtavaci pole Regularni vyrazy.

11) Stiskneme tlacitko OK a program Calc aktualizuje zobrazena data v souladu se zadanymi

kritérii filtru.

Data zobrazena na obrazku 27 Ize pouzit k ukazce jednoduchého pfikladu volani funkce, které
obsahuje regularni vyraz. Pfedpokladejme, Ze chceme vypocitat vynosy z prodeje tuzek (pencil),
pendld (pencil case) a per (pens). Toho Ize dosahnout zadanim nasledujiciho vzorce do prazdné

bunky =SUMIFS(C2:C6, A2:A6,

"Apen.*"), kde regularni vyraz odpovida nazvu

jakéhokoliv produktu, ktery za€ina znaky ,pen“. Obdobné& bychom mohli vypocitat pfijem
z prodeje knih (book) a poznamovych blokd (notebook) pomoci vzorce =SUMIFS(C2:C6,

A2:A6,

znaky ,book".

".*book$" ), kde regularni vyraz odpovida nadzvu jakéhokoliv produktu, ktery konci
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A | B | ¢
__1 | Product Name  Sales Revenue
2 Pencil 20 65
3 Pen 35 85
4 | Notebook 20 190
_ 5 | Book 17 180
] Pencil case 12 96

Obréazek 27: Udaje o prodeji
a vynosech z papirnictvi

V programu Calc existuje 26 funkci, které podporuji pouZiti regularnich vyraz(, a ty jsou uvedeny
v kapitole 7, Pouzivani vzorcl a funkci. Funkce REGEX je obzvlasté vykonna, porovnava

a extrahuje nebo volitelné nahrazuje text pomoci regularnich vyraz(. Napfiklad vzorec
=REGEX("123456ABCDEF";"[126]";"";"g") vréati "345ABCDEF", vSechny vyskyty &islic
"1","2" a "6" jsou nahrazeny prazdnym fetézcem, tedy smazany.

6 Tip

Online napovéda obsahuje popis mnoha regularnich vyrazl a priklad( jejich uZiti.

Poznamka

Pokud je pro nasi tabulku dUlezita interoperabilita s Microsoft Excel, mozna
nebudeme moci pIné vyuZivat moznosti regularnich vyraz( programu Calc, protoze
Excel neposkytuje ekvivalentni funkce. KdyZ tedy exportujeme tabulku Calc do
formatu Excel, informace tykajici se regularnich vyrazti nebudou v aplikaci Excel
pouzitelné. V tomto pfipadé mdzeme pouZzit méné vykonnou funkci zastupnych
znakl poskytovanou programem Calc, protoZe tabulky, které pouzivaji zastupné
znaky, Ize exportovat do formatu Excel bez ztraty dat. DalSi informace o zastupnych
znacich nalezneme v kapitole 7, Pouziti vzorcl a funkci.

Existuje mnoho internetovych stranek, které obsahuiji pfiklady regularnich vyrazi a které
poskytuji nekonecny zdroj inspirace a napadu, které ndm pomohou zlepsit naSe dovednosti
v oblasti analyzy dat.

DalSi informace o regularnich vyrazech v programu Calc Ize nalézt v systému napoveédy a na wiki
The Document Foundation’s na strance
https://wiki.documentfoundation.org/Documentation/HowTo/Calc/Regular_Expressions.
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j LibreOffice

Prlivodce programem Calc

Kapitola 2
Zadavani, upravy
a formatovani dat



Uvod

Do aplikace Calc miiZzeme vlozit data nékolika zplsoby: pouZitim klavesnice, nastrojem Vyplnit
a Seznamem pro vybér, stejné jako pfetaZzenim a pusténim. Calc také poskytuje moZznost zadat
data do vice listll stejné tabulky najednou. Po zadani midZzeme data formatovat a zobrazit
rlznymi zplsoby.

Zadavani dat

VétSina dat jde do Calc zadat pomoci klavesnice.

Cisla

Klepneme do buriky a zadame €islo pomoci Ciselnych klaves na hlavni klavesnici nebo na
Ciselné klavesnici.

Zaporna cisla
Kdyz chceme zadat zaporné Cislo, bud napiSeme pred €islo znaménko minus nebo €islo

uzavieme do zavorky (), napriklad (1234). Vysledek obou metod zadavani je stejny; napriklad -
1234.

Uvodni nuly

Pokud zadané Cislo ve vychozim nastaveni zacina nulami, napfiklad 01481, Calc automaticky
prvni nulu smaze. Pokud chceme zachovat oba ¢iselné formaty a minimalni pocet znak(

v bunice, kdyz pfidavame cisla, napriklad 1234 a 0012, pouzijeme tuto metodu k pridani
pocateCnich nul:

3) S oznacenou burikou vybereme v hlavni nabidce Format > Burnky nebo poklepeme
pravym tlacitkem mysSi na bunku a v mistni nabidce vybereme Format bunék nebo
pouzijeme klavesovou zkratku Ctrl + 1, aby se nam otevfelo dialogové okno Format
bunék (obrazek 28).

4) Zvolime kartu Cisla a vybereme polozku Cislo v seznamu Kategorie.

5) V poli Uvodni nuly v oblasti MoZnosti, viozime maximalni pocet nul ke zobrazeni pred
desetinnou Carkou. Pokud poZadujeme napfiklad minimalné Ctyfi znaky, zadame 4.
Kazdé Cislo menSi nez Ctyfi znaky bude mit pfidané Gvodni nuly, napfiklad z Cisla 12 se
stane 0012.

6) Potvrdime je stisknutim tlagitka OK. Cislo si v3ak intern& zachova sv(j bézny formét a tak
ho bude program vyhodnocovat, pokud bude pouZito jako argument ve funkcich nebo
vzorcich.

6 Tip

K formatovani Cisel pouze s desetinnymi misty ale bez Gvodni nuly postupujeme
podle krok( 3 a 4 vySe, dale v Formatovani kédu pole typu a. (tecka nebo konec
véty) nasledovany ? (jeden nebo vice otaznik() reprezentujici potifebny pocet
desetinnych mist. Napfiklad pro 3 desetinna mista zadame .??? a klepneme na OK.
Jakékoliv Cislo s jedinym desetinnym mistem pak nebude mit nulu pfed desetinnou
¢arkou, napfiklad 0.01856 se zméni na .019.
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Format bunék

Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana buriky

Kategorie Format Jazyk
Vse Vychozi - Cestina |
Definované uZivatelem -1235
Cislo -1234,57
Procento -1 235
Meéna -1 234,57
Datum -1 234,57
Cas
Vedecky
Zlomek
Eool ka hodnot

OolEovska hodnota -1234,56789012346
Text
MozZnosti

Desetinna mista: + [OZaporna éisla cervend

Uvodni nuly: |1 L] Oddélovac tisict

Formatovaci kod

Standard

Definované uZivatelem

Napovéda Obnovit QK Zrusit

Obrézek 28: Dialogové okno formatovéni bunék — karta Cisla

Cisla a text

Cisla mGzeme prevést do textové podoby nasledujicim zplsobem:

1) Vybereme burku a otevieme dialogové okno format bunék (obrazek 28).
2) Ujistime se, Ze je vybrana karta Cisla, poté vybereme Text ze seznamu Kategorie.

3) Potvrdime je stisknutim tla¢itka OK. Cislo je pfevedeno do textové podoby a je, podle
vychoziho nastaveni, zarovnané doleva. Zménit formatovani a zarovnani ¢isel miizeme
stejné jako kterykoliv jiny text.

Text

Klepneme na buriku a napiSeme text. Text je automaticky zarovnan vlevo. Buriky mohou
obsahovat nékolik fadk( textu. Pokud chceme vytvorit odstavce, stiskneme pro vytvoreni nového

odstavce Ctrl + Enter.

Zadavame-li nékolik radkul textu na fadku vzorcl, mizeme prodlouzit vstupni fadek. Klepnutim

s vz

na ikonu RozsSiFit | Sbalit vstupni fadek umisténym na vpravo od LiSty vzorcl a Vstupniho
radku se stane vicefadkovy, jako je zobrazeno na obrazku 29. MZeme pretahnout spodni ¢ast
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Vstupniho fadku nahoru a doltl, abychom zkontrolovali jeho skute¢nou vysku. Klepneme na

ikonu RozsSifeni | Shalit vstupni fadek znovu, abychom vrétili Vstupni fadek do jeho vychozi
jednotné vysky.

Al o F._ meC rutnem purus semper vel. Pragsent tincidunt negue eu pellentesque pharetra. Fusce

pellentesque est orci. Integer sodales tincidunt tnstique. S5ed a metus posuere,
adipiscing nunc ef, viverr amet trig lectus
hendrent sad, Crat sodald lkona rozsifeni/sbaleni ! T BCCUITILAR
pharetra risus a, vestibul, Vstupnihu fadku bllis, Vivamus nec tellus
faucibus, tempor magna him a vehicula i
B C D F F G Ho o

Lorem ipsum dolor sit amet. consectetur adipiscing ehit. Yesiibulum consequatl mi quis pretium semper. Proin |
neque ¥enenatis. quis commodo dolor posuere. Curabitur dignissim sapien quis cursus egestas, Donec blandit
nec pellentesque eros moleslie egel. In consectelur aliquam hendreril. Sed cursus mauris vilae ligula pellenies:
|pelientesque uma aliguel. Fusce placeral MAUMS enim. nec rutrum purls semper vel. Pragsent incidunt neque
pellemesque phareira, Fusce pelleplesque est grol, Integer sodales uncdunt Instque, Sed a Metus poseers, ad
nun e, viverra odio. Donec aucior molestie sem, sil amel instique lecius hendreo sed. Cras sodales nisl sed
fiaculis. Nunc eget dolor accumsan, pharetra risus a, vestibulum mauns,. Nunc vulputate lobortis mollis, Yivamu
faucibus, tempor magna nec, facilisis felis. Donec commodo enim a vehicula

=) | | | e | | P

[

a
Obrazek 29: Rozsiteny Vstupni fadek na panelu vzorct

Datum a Cas

Vybereme bunku a zadame datum nebo ¢as. Jednotlivé Casti data je mozné oddélovat teckou
(15.10.2013 nebo 15.10.13), spojovnikem (pouze 15-10) nebo Ize pouZzit text (15. fijen 2013).
Formét data se po zadani automaticky zméni na nastaveny vychozi formét.

@ Poznamka

Nastroje > MoZnosti > Nastaveni jazyku > Jazyky > Formaty > Vzory

k rozpoznani dat definuje vzory dat, které budou rozpoznany programem Calc.
Kromé toho akceptuje vstup kazdého narodniho prostfedi ve vzorci ISO 8601Y-M-D
(napriklad 2020-07-26).

Kdyz zadavame Cas, oddélime Casové prvky dvojteCkami, napfiklad 10:43:45. Format Casu se po
zadani automaticky zmeéni na nastaveny vychozi forméat.

Zména formatu data a €asu, ktery Calc pouZziva:

1) Vybereme buiiku a otevieme dialogové okno forméat bunék (obrazek 28).

2) Ujistime se, Ze je vybrana karta €isla, poté vybereme datum nebo €as ze seznamu
Kategorie.

3) Pozadovany format zvolime v seznamu Format.
4) Klepnutim na tla€itko OK ulozime zmény a zavieme dialogové okno.

@ Poznamka

Formét data bude ovlivnén systémem nebo nastavenim jazyku dokumentu.

Specialni znaky

Specialni znak je znak, ktery se béZné nenachéazi na uzivatelské klavesnici, napriklad, © % & ¢ fi
0 @ ¢. Chceme-li vlozit specialni znak:

1) Vybereme bunku a umistime kurzor na buriku nebo do vstupniho fadku na to misto, kde
chceme, aby se znak zobrazil.

2) Prejdeme na VloZit > Specialni znak na panelu nabidek a otevie se dialogové okno
Specialni znaky (obrazek 30).

52 | Prirucka Calc 7.0



3) Z mrizky znakl vybereme pozadovany znak. Posledni vybrany znak je ukazany napravo
od dialogového okna specialni znaky spole¢né se svym Ciselnym kédem.

4) VSechny nedavno vloZzené znaky jsou zobrazeny pod mfiZkou znak( a Ize je vybrat

stejnym zplsobem jako kterykoliv jiny znak v dialogovém okné.

5) Ve spodni ¢asti dialogového okna je moZnost vytvoreni malé sbirky oblibenych znaka.
Chceme-li do sbirky pfidat novy znak, vybereme pozadovany znak a klikneme na ikonu
Pridat k oblibenym. Chceme-li odebrat existujici znak ze sbirky, vybereme znak
a klikneme na ikonu Odstranit z oblibenych.

6) Dvakrat klepneme na specialni znak, abychom jej vioZzili do buriky bez toho, aniz by se
uzavrel dialog. Klepeme na Vlozit, abychom vloZili specialni znak do buriky a uzavreli

dialog.

Specidlni znaky
Hledat: Pismo: PodmnoZina:

Liberation 5ans ~| |Latin-1

PI" | #%|% &[] ( *l+ |, - /
0(1/2/3|4,5/6|7|8 V<= ?
@/A/B|C|ID/E|F|G|H JIK|L/M[N|O
PQIR|S|TIUV|WX Zi [V
“la|/bjc|dje|flg|/h]i|j|k|l | m|n]o
plg|rj{s|tjujv | w|Xx z|{||!|}!|~
1IBBEENEE - BREEEEE
+|2]|3 TR e » | Ya|%|%| ¢ | A
Posledni znaky:
Oblibené znaky:
[e]v e Je = Jo Is 2 = 0 ]+ <]

Napovéda

©

COPYRIGHT SIGN

Sestnactkové: U+ A9
Desitkowé: 169

Pridat k oblibenym

W

Obréazek 30: Dialogové okno Specialni znaky

6 Tip

Mdzeme rychle vlozit jeden z nasich poslednich nebo oblibenych specialnich znak
poklepanim na ikonu VloZzit specialni znaky na standardnim panelu nastroj

a vybérem pozadovaného znaku z rozeviraci nabidky. Klepneme na Vice znaki

v této rozeviraci nabidce k otevieni dialogu Speciélni znaky (obrazek 30).

@ Poznamka

R{zna pisma mohou obsahovat rlizné specialni znaky. Pokud nenajdeme
poZadovany specialni znak, zkusime zménit vybéry Pismo a PodmnoZina.
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MozZnosti automatickych oprav

Calc automaticky aplikuje mnoho zmén béhem vkladani dat pomoci automatickych oprav, pokud
ve funkci automatické opravy zmény nevypneme. Mizeme vrétit jakékoliv zmény automatické
opravy vybérem Upravit > Zpét v mistni nabidce, stiskneme klavesovou zkratku Ctrl + Z, nebo
manualné provedeme zmeény krokem zpét a nahradime automatickou opravu tim, co
momentalné chceme vidét.

Ke zméné moznosti automatickych oprav pfejdeme na Nastroje > MozZnosti automatické
opravy na panelu nabidek. Otevie se dialogové okno Automatické opravy (obrazek 31).

Automatické opravy

Mahrady a vyjimky pro jazyk: |Ceitina et |
MNahradit Vyjimky MoZnosti Mistni moZnosti
Mahradit Za
-- - Pouze text
MNova
o - Smazat
o [
i ]
L+ +
._{}I [
b 1
2 2
3 3
4 a
5 s
b 5
7. 7 i
MNépovéda CObnovit oK Zrusit

Obrazek 31: Dialogové okno Automatické opravy

* Nahradit — upravime tabulku nidhrad pro automatickou opravu nebo nahrazovani slov
nebo zkratek.

* Vyjimka - specifikujeme zkratky nebo kombinaci pismen, které nechceme opravovat
automaticky.

* Moznosti — vybereme moznosti na automatickou opravu chyb béhem psani.

* Mistni moZnosti - specifikujeme moznost automatické kontroly pro uvozovky a pro
moznosti, které jsou specifické pro dany jazyk textu.

* Obnoveni - obnovime zménéné hodnoty zpét do pfedchozich hodnot.
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Vkladani pomléek

Calc poskytuje textové zkratky, abychom mohli rychle vkladat pomicky do buriky — tyto zkratky
jsou uvedeny v tabulce 4.

Tabulka 4: VloZeni pomicek

Text, ktery vkladate Vysledek

A - B (A, mezera, spojovnik, mezera, B) A — B (A, mezera, kratka pomlcka, mezera, B)
g‘)" B (A, mezera, spojovnik, pomicka, mezera, — , _ g (A, mezera, kratka pomlicka, mezera, B)
A--B (A, spojovnik, spojovnik, B) A—-B (A, dlouha pomicka, B)

A-B (A, spojovnik, B) A-B (nezménéno)

A -B (A, mezera, spojovnik, B) A -B (nezménéno)

A --B (A, mezera, spojovnik, spojovnik, B) A -B (A, mezera, kratka pomicka, B)

Urychleni vkladani dat

Vkladani dat do tabulky mdze byt pracné, ale Calc poskytuje nastroje které vkladani usnadiuji.
Mezi tyto nastroje patfi tAhni a pust (pro pfesun a kopirovani obsahu jednoho mista na misto jiné
pomoci mysSi), nastroj pro automatické dokonc€ovani, nastroj Vyplii a seznam vybéru.

Nastroje Vyplnit a seznamy pro vybé&r automatizuji zadavani opakovanych tdajd do bunék. Calc
ma také mozZnost zadat data do vice listd stejného seSitu najednou.

Nastroje automatického dokoncéovani

Funkce automatického dokoncovani v aplikaci Calc automaticky dokonci zaznamy na zakladé
ostatnich poloZek ve stejném sloupci. Sloupec je prohledavan do maximalné 2 000 bunék nebo
200 rliznych fetézcq.

KdyZ je text v bufice zvyraznén, Ize automatické dokoncovani pouZzit nasledovné:

* Pokud chceme pfijmout navrzené dokonceni, stiskneme Enter nebo F2, nebo klepneme
na tla¢itko mysi.

* Chceme-li zobrazit dalSi dokon€eni, za€inajici stejnymi pismeny, pouzijeme kombinace
klaves Ctrl + Tab pro posun vpfed nebo Ctrl + Shift + Tab pro posun zpét.

» Pokud chceme zobrazit seznam dostupnych poloZek automatického dokon€ovani textu
pro aktualni sloupec, pouzijeme kombinaci Alt + 1. Pro vice informaci viz ,Seznamy pro
vybér” na strané 72.

KdyZz piSeme vzorec pouzivajici znaky, které se shoduji se nazvem funkce, zobrazi se napovéda
s uvedenim dostupnych funkci, které zacinaji shodnymi znaky.

Automatické dokonCovani ignoruje pfi zadavani dat velikost pismen. Pokud jsme napfiklad do
buriky napsali ,Celkem“, nemlzeme zadat ,celkem*“ do jiné buiiky ve stejném sloupci, aniz
bychom nejprve deaktivovali Automatické dokon€ovani.

Ve vychozim nastaveni v programu Calc je funkce automatické dokoncovani aktivovana.
Chceme-li ji vypnout, pfejdeme v hlavni nabidce na Nastroje a zruSime vybér Automatické
dokonéovani.

Nastroj Vyplnit

Pomoci nastroje Vyplnit v programu Calc mdzeme duplikovat existujici obsah nebo vytvofrit fadu
v oblasti bunék v seSitu, jak je znazornéno na pfikladech na obrazku 32.
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1) Vybereme burku, jejiz obsah chceme kopirovat nebo ze které chceme vytvofrit
posloupnost.

2) Pretdhneme kurzor libovolnym smérem nebo podrZzime klavesu Shift a klepneme na
posledni buriku, kterou chceme vyplnit.

3) V hlavni nabidce pfejdeme na List > Vyplnit bufiky a vybereme smér, kterym chceme
kopirovat nebo vytvaret data (Doll, Vpravo, Nahoru, Vlevo, Listy, Posloupnost nebo
Nahodna €isla). Pokud neni k dispozici, bude moznost nabidky zaSedla.

AZAZ v | AZAR e

Vyplnéni
nosloupnosti

1
2
3
4
5
6
7
-]

Obrazek 32: Priklady pouZiti nési‘roje
Viyplnit

6 Tip

MdZeme vyuZit klavesovou zkratku Ctrl + D jako alternativu k oznaceni List> Vyplnit
bunky> Vyplnit v mistni nabidce.

Alternativné mizeme pouzit zkratku k vypInéni bunék:

1) Vybereme buriku, jejiz obsah chceme kopirovat nebo ze které chceme vytvofit
posloupnost.

2) Kurzor pfesuneme nad Ctverecek v jejim pravém dolnim rohu. Kurzor zméni tvar.

3) Stiskneme levé tlaCitko mysi a kurzor potahneme smérem, ve kterém chceme bunky
vyplnit, svisle nebo vodorovné. Pokud burika obsahuje text, buriky se v daném sméru
vyplni stejnym textem. Pokud plvodni burika obsahuje ¢isla nebo text z definovaného
seznamu (viz “Definovani posloupnosti’ na strané 71), bude vytvofena posloupnost.
Pokud chceme misto toho Cislo nebo text duplikovat, drzime Ctrl, zatimco tahneme.

Upozornéni

Kdyz vybereme buriky, abychom mohli pouzit nastroj Vyplnit, ujistime se, Ze Zadna
z bunék neobsahuje data, kromé dat buriky, kterou chceme pouZzit. Pfi pouZiti
nastroje Vyplnit budou vSechna data obsazena ve vybranych burikach pfepsana.

Vyplnovani posloupnosti dat

Kdyz vybereme vyplnit posloupnost z hlavni nabidky List > Vyplnit buriky > Vyplnit
posloupnost, otevie se dialogové okno Vyplnit posloupnost(obrazek 33). Zde si miZzeme vybrat
typ posloupnosti nebo si vytvorit svij vlastni seznam.

*  Smér — urCuje smér vytvareni posloupnosti.

— Dolii — ve vybrané oblasti bunék vytvori posloupnost smé&rem doll s pouzitim
zadaného prirdstku aZz po zadanou koncovou hodnotu.
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Vpravo — ve vybrané oblasti bunék vytvofi posloupnost smérem doprava s pouZitim
zadaného prirdistku az po zadanou koncovou hodnotu.

Nahoru — ve vybrané oblasti bunék vytvori posloupnost smérem nahoru s pouzitim
zadaného prirlistku aZz po zadanou koncovou hodnotu.

Vlevo — ve vybrané oblasti bunék vytvori posloupnost smérem doleva s pouzitim
zadaného prirdistku aZ po zadanou kone¢nou hodnotu.

Vyplnit posloupnost X
Typ posloupnosti Jednotka €asu
® Linearni Den
() Rast Den v tydnu
) Datum Mésic
Vlevo () Automaticke vyplnéni Rok

Pocateéni hodnota: 1234
Koncové hodnota:

Piirdstek: 1

MNapovéda oK Zrusit

Obrazek 33: Dialogové okno Vyplnit posloupnost

* Typ posloupnosti — urcuje typ posloupnosti. Jsou to:

Linearni — vytvofi linearni posloupnost ¢isel se zadanym pfirlistkem a koncovou
hodnotou.

Rdst — vytvori geometrickou posloupnost ¢isel se zadanym pfirlistkem a koncovou
hodnotou.

Datum — vytvori posloupnost dat se zadanym pfirlistkem a koncovym datem.

Automatické vyplnéni — vytvori posloupnost pfimo v listu. Automatické vyplnéni
vyuziva prizplsobitelné seznamy. Napfiklad, pokud do prvni buriky zadame 'leden’,
posloupnost se doplni podle seznamu, ktery je definovan v Nastroje > MoZnosti >
LibreOffice Calc > Razené seznamy. Automatické vyplnéni se pokusi dokongit Fadu
hodnot pomoci definovaného vzoru. Napfiklad, Ciseln& posloupnost 1, 3, 5 se
automaticky doplni €isly 7, 9, 11, 13 a data 01.01.99 a 15.01.99 se doplIni o data

s dvoutydennim odstupem.

+ Jednotka €asu — V této oblasti zadame pozadovanou jednotku ¢asu. Tato oblast je
aktivni, pouze pokud byla moznost Datum vybrana v typu vybéru. Moznosti jsou:

Den — vytvofime posloupnost dat po sedmi dnech.

Den v tydnu — vytvofime posloupnost v péti dennich mnozinach.
Mésic — vytvofime posloupnost z nadzvi nebo zkratek mésicd.
Rok — vytvofime posloupnost let.

» Pocatecni hodnota — ur€ujeme pocate¢ni hodnotu posloupnosti. Pouzit Cislo, datum
nebo Cas.

» Koncova hodnota — urcuje koncovou hodnotu postupnosti. Pouzit ¢islo, datum nebo
cas.
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« PFirGstek - hodnota, ktera uruje zménu prvkl posloupnosti v zavislosti na jejim typu.
Tyto hodnoty Ize zadat, jen kdyZ je vybrana posloupnost Linearni, Rlst nebo Datum.

Definovani posloupnosti
Chceme-li definovat vlastni posloupnosti:
1) V hlavni nabidce zvolime Nastroje > MoZnosti > LibreOffice Calc > Razené seznamy,
¢imz otevieme dialogové okno Razené seznamy (obrazek 34). V tomto okné se na levé

strané v poli Seznamy zobrazuiji jiz definované seznamy, v poli PoloZky pak jednotlivé
prvky vybraného seznamu.

2) Klepneme na tlacitko Novy, ¢imz se PoloZky vycisti.

3) Zadame posloupnost pro novy seznam do policka PoloZky, jedna poloZzka na fadek
(obrazek 35).

4) Klepneme na tlacitko PFidat, ¢imz se novy seznam objevi v poli Seznamy.
5) Klepnutim na tla¢itko OK uloZzime novy seznam a zavieme dialogové okno.

Moznosti - LibreOffice Calc - Razené seznamy

Libtt?t')ﬁjce - Seznamy Polozky Novy
Macitani/ukladani Po.Ut St &t Pi So Ne Po
Je_zzykove? nastavent Pondelok,Utorok, Streda, Stvrtok, Piatok,s¢ Yt Pfidat
=/ LibreOffice Calc LILILIVV VLVILVITLICXXE XL 3t
Obecne L . P 5t
Vochost nast | [Januar,februar,marec,april,maj,jun,jul,au Bi Smazat
yehoz! nrfxs SVEN 1 leden, unor bezen,duben kvéten cerven, So
Zobrazen| PondiliUtery, Streda, Cturtek Pétek Sobol | Ne
Vypocy Po,Ut,5t,Ct,P4,50,Ne
Vzorec led, ino, bie,dub,kvé,&vn, &ve,srp,zat i lis,
Razené seznamy
Zmény
Kompatibilita
Mrizka
Tisk
LibreOffice Base < >
Grafy
Internet Kopirovat seznam z | $List3.5A%52:3A58 Kopirovat
MNapovéda Obnovit PouZit OK Zrusit

Obréazek 34: Dialogové okno Razené seznamy
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Seznamy PoloZky

Mowy
Po,Ut,St,5LP1,So,Ne led
Pondelok Utorok,Streda,Stvrtok Piatok, ¢ Uno Pridat
LILHLIV AV VIV ES XXX bre
Januar,februar,marec,april,maj junjul,au s:l: Smazat

leden,unor,bfezen,duben, kvéten,cerven,
Pondéli,Utery,Streda,Ctvriek Patek,Sobo|  #y¢
Po,Ut,5t,Ct,Pa,So,Ne srp
%Ied_.l;m o,bfe,dub,kvé cvn,cvc,srp,Zar,fij, l'.i

lis
pro

Obrazek 35: Viytvareni nového razeného seznamu

Seznamy pro vybér

Seznamy vybéru jsou dostupné pouze pro text a jejich pouZziti je omezeno jen na text, ktery jiz byl
zadéan do stejného sloupce.

1)
2)

3)

Vybereme buriku ve sloupci nebo fadku, ktery obsahuje buriky s textovymi polozkami.

Klepneme pravym tlacitkem a vybereme seznam vybeéru z mistni nabidky nebo pomoci
klavesové zkratky Alt + 1. Otevie se rozbalovaci seznam, ve kterém se nachazeji
vSechny textové polozky z daného sloupce.

Klepneme na pozadovanou polozku, ktera se nasledné viozi do buriky.

Slouceni a rozdéleni bunék

Slucovani

Sousedici buriky miZzeme vybrat a sloucit je do jedné takto:

1)
2)

3)

4)

Vybereme oblast sousedicich bunék, které chceme slouit.

Prejdeme na Format > Sloucit buniky > Sloucit buriky nebo Sloucit bunky a zarovnat
na stfed v mistni nabidce nebo klikneme na ikonu Sloucit buriky a zarovnat na stied
na formatovacim panelu nastrojove listy, nebo klikneme pravym tlaCitkem mysi a vybrané
bunky a vybereme Sloucit bunky v kontextové nabidce. Pomoci Sloucit bunky

a zarovnat na stfed bude obsah v burikach zarovnan na stred.

Pokud buriky obsahuji néjaka data, dialogové okno Sloucit buriky se otevie a zobrazi
volby pro posunuti nebo skryti dat ve skrytych bunkéach (obrazek 36).

Vybereme si a klepneme na OK.
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Sloucit buriky

Mekteré buriky nejsou prazdné.

) Pfesunout obsah skrytych bunék do prvni buriky

1 | 2 |—*| 1 2 |
®Zachovat obsah skrytych bunék:
(12 ]—[1 2]

() Odstranit obsah skrytych bunék
(12 ]—[1 2]

Napovéda oK £rusit

Obrazek 36: Volby slouc¢eni pro neprazdné buriky

Upozornéni

Sloucéeni bunék miiZe zpUsobit chyby vypoétu ve vzorcich v tabulce.

Rozdélovani

MUlzeme zrusit slou¢enou operaci rozdélenim buriky, ktera byla predtim vytvorena sloucéeni
nékolika bunék.

1) Vybereme slouc¢enou buriku.

2) Prejdeme na Format > Sloucit buriky > Slou€it bufiky v mistni nabidce, nebo klikneme
na ikonu v panelu Formatovani Slouc€it buiiky a zarovnat na stfed, nebo klikneme
pravym tlacitkem mysSi a vybereme Sloucit bunky z kontextové nabidky.

3) Data, kterd jsou v burice, zlstanou v prvni burice. Pokud skryté buriky mély pred
slou¢enim bunék néjaky obsah, bude pravdépodobné nutné ru¢né pfesunout obsah do
spravné buriky.

Sdileni obsahu meazi listy

Stejny Udaj je mozné vloZit najednou do stejné buriky ve vice listech sesitu, napfiklad tehdy, kdyZz
chceme ve vSech listech vytvorit stejny seznam jednotlivell nebo organizaci. Nemusime tedy
seznam vkladat jednotlivé na kazdy list, miZzeme ho najednou vloZit do vSech list(.
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Vybrat listy

Vyhrané listy

MNapoveda OK Zrusit

Obréazek 37: Dialogové okno Vybrat listy

1) V hlavni nabidce zvolime Upravy > Vybrat listy, &imZ otevfeme dialogové okno Vybrat
listy (obrazek 37).

2) V ném vybereme jednotlivé listy, do kterych chceme data vlozit.
3) Vybér potvrdime klepnutim na tladitko OK, karty listl se pfitom zvyrazni.

4) Udaje zadame do bunék prvniho z vybranych list(, ty se zarovefi vloZi i do vSech
ostatnich.

5) Po dokonc&eni zadavani informaci, které se maji opakovat, zrusime vybér list,

6 Tip

Obsah mlzZeme oznacit mysi, jako je popsano v sekci "Oznaceni listl
Uvod.

v Kapitole 1,

Upozornéni

Tato metoda bez upozornéni prepiSe vSechny Udaje, které jiz jsou v pfislusnych
burikach na ostatnich vybranych listech. Po vloZeni spolecnych dat proto nesmime
zapomenout vybér listll zrusit, aby se dalsi zadavana data vkladala jen do jednoho
listu.

Oveérovani obsahu bunék

PTi vytvareni sesitd, které budou pouzivat jini lidé, mizeme chtit zajistit, aby jimi zadavana data
byla platna a aby byla zadavana do spravnych bunék. Ovéfeni platnosti miiZzeme pouzit i pro
svou vlastni praci jako pomdcku pfi zadavani slozitych nebo méné ¢asto pouzivanych dat.

Posloupnost a Seznamy vybéru umoZiiuji zpracovat ur€ité typy dat, které jsou omezeny na
preddefinované informace. Buiika mlZe napfiklad vyzadovat datum, celé ¢islo bez pismen i
desetinné ¢arky, nebo Ze nesmi zlstat prazdna.

Podle toho, jakou platnost nastavime, miizeme také definovat rozsah obsahu, ktery mlze byt
zadan. MGzeme také nechat zobrazit napovédu, ktera vysvétli nastavena pravidla a to, co by
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méli uzivatelé délat, kdyz je obsah buriky neplatny. MiiZzeme také nastavit buriku tak, aby
neplatny obsah odmitla, pfijala ho s upozornénim, nebo pfi ném spustila makro.
Definovani platnosti

Chceme-li ovéfit vSechna novéa data zadana do buriky:

1) Vybereme bunku a pfejdeme na Data > Platnost na panelu nabidky a otevie se dialog
Platnost (obrazek 38).

2) Pomoci voleb uvedenych na kartach Kritéria, Napovéda pri vstupu a Chybové hlaseni
ur€ime typ obsahu, ktery Ize do této burnky zadat. MozZnosti jsou vysvétleny nize.

Platnost

Kritéria Napovéda pfi vstupu Chybové hlaseni

Povaolit;
Povolit prazdné buriky
Zobrazit seznam pro vybér

[ Sefadit zaznamy vzestupné

Zdroj =
Platny zdroj miZe obsahovat pouze souvisly vybér fadkad
nebo sloupcl, piipadné vzorec, jehoZ vysledkem je oblast
nebo matice.

Napovéda Obnovit OK Zrusit

Obrazek 38: Dialog Platnost — karta Kritéria
Moznosti kritérii
UrCime pravidla pravidla pro vybrané buriky pomoci karty Kritéria v dialogu Platnost, jak je

znazornéno na obrazku 38. MlZzeme naptiklad definovat kritéria, jako jsou ¢isla mezi 1 a 10,
nebo texty, které nemaji vice nez 20 znakd.

Moznosti dostupné na karté Kritéria zavisi na tom, co bylo vybrano v rozbalovacim seznamu
Povolit.

* Povolit — z rozeviraciho seznamu vybereme moZnost ovéreni pro vybrané buriky.
— VSechny hodnoty — bez omezeni.

s s ws

— Cela ¢isla — povolena pouze cela cisla.

— Desetinna Cisla — vSechna Cisla odpovidaji desetinnému formatu.

— Datum — vSechna Cisla odpovidaji formatu data. Zadané hodnoty jsou formatovany pfi
pFistim vyvolani dialogového okna.

— Cas — v3echna ¢isla odpovidaji formatu ¢asu. Zadané hodnoty jsou formatovany pi
pfistim vyvolani dialogového okna.

— Oblast bunék — povolit pouze hodnoty uvedené v oblasti bunék. Rozsah bunék Ize
zadat explicitng, jako pojmenovanou oblast databaze nebo jako pojmenovanou oblast.
Rozsah miZe sestavat z jednoho sloupce nebo jednoho fadku bunék. Pokud uréime
rozsah sloupct a Ffadkd, pouzije se pouze prvni sloupec.
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— Seznam — povoli pouze hodnoty a fetézce obsaZzené v seznamu. Retézce a hodnoty
Ize kombinovat. U Cisel jsou vyhodnoceny jejich hodnoty, proto kdyZz zadame do
seznamu Cislo 1, bude vstup 100 % vyhodnocen jako platny.

— Délka textu — povoluje polozky, jejichz délka odpovida poctu nastavenych znakd.
— Vlastni — povoli zaznamy, které odpovidaji vzorci zadanému do pole Vzorec.

Povolit prazdné bunky — ve spojeni s Nastroje > Detektiv > Oznacit neplatna data to
definuje, Ze prdzdné burky jsou zobrazeny jako neplatna data (vypnuto) nebo nejsou
zobrazeny (zapnuto).

Zobrazit seznam pro vybér — zobrazi seznam vSech platnych fetézcll nebo hodnot,
Z nichz Ize vybirat. Seznam Ize také otevfit kliknutim na Sipku dold napravo od buiiky,
nebo vybérem buriky a stisknutim Alt + 1.

Seradit zaznamy vzestupné — tfidi vybérovy seznam ve vzestupném poradi a filtruje
duplikaty ze seznamu. Pokud neni volba zaSkrtnuta, je ponechano ptvodni pofadi zdroje
dat.

Zdroj — zadame oblast bunék, kterd obsahuje platné hodnoty nebo text.
Polozky — zadame poloZky, které budou platné hodnoty nebo textové Fetézce.

Data — z rozeviraciho seznamu vybereme srovnavaci operator, ktery chceme pouzit.
Dostupné operatory zavisi na tom, co jsme vybrali v rozbalovacim seznamu Data. Pokud
napfiklad vybereme platny rozsah, vstupni pole Minimum a Maximum nahradi pole
Hodnota.

Hodnota — zadame hodnotu ovéfeni dat, kterou jsme vybrali v rozbalovacim seznamu
Data.

Minimum — zaddme minimalni hodnotu pro moznost ovéfeni dat, kterou jsme vybrali
v rozbalovacim seznamu Data.

Maximum — zadame maximalni hodnotu pro mozZnost ovéfeni dat, kterou jsme vybrali
v rozbalovacim seznamu Data.

Vzorec — vklada vzorec, ktery mlzZe interpretovan jako pravda (ne-nulova hodnota) nebo
chyba (nula) k poskytnuti pfizplsobeni platnosti. Napfiklad za prfedpokladu, Ze burika A4
byla vybrana pred otevienim dialogu, mohli bychom vlozit ISEVEN (A4 ) k indikovani, ze
pouze sudé hodnoty mohou byt vioZzeny do buriky A4.

MozZnosti Napovédy pfri vstupu
Zadame zpravu, ktera se ma zobrazit, kdyz je v tabulce vybrana bufika nebo oblast bunék
(obrazek 39).

Zobrazit napovédu k zadavani Gdaju, je-li buiika vybrana — zobrazi zpravu, kterou
zadadme do pole Nadpis a Napovéda pii vstupu, kdyZ je v listu vybrana burka nebo
oblast bunék. Pokud zadame text do poli Nadpis a vstupni napovéda a pak odznaCime
tuto moznost, text nebude zobrazen.

Nadpis — zadame nazev, ktery se ma zobrazit, kdyz je vybrana burika nebo oblast
bunék.

Napovéda pfi vstupu — zadame zpravu, ktera se ma zobrazit, kdyZ je vybrana burka
nebo oblast bunék.
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Platnost

Kritéria Ndpovéda pfi vstupu Chybové hlaseni

[¥1Zobrazit napovédu k zadavani adaj(, je-li bunka vybrana:

Obsah
Nadpis:

Napovéda pfi vstupu:

Napovéda Obnovit OK Zrusit

Obrazek 39: Dialogové okno Platnost — karta Napovéda pri
vstupu

Moznosti Chybovych hlaseni

Definuje chybovou zpravu, kterd se zobrazi, kdyz jsou do buriky zadana neplatna data (obrazek
40).

* Zobrazit chybové hlaseni, pokud jsou zadany neplatné hodnoty — pokud je vybrano,

zobrazi se chybova zprava, kterou zadame do oblasti Obsah, kdyz jsou do burnky zadana
neplatna data.

Akce — vybereme akci, kterou chceme provést pfi zadavani neplatnych dat do buriky.

— Zastavit — odmitne neplathou poloZku a zobrazi dialogové okno, které musime zavfit
klepnutim na OK.

— Upozornéni a Informace — zobrazi dialogové okno, které Ize zavfit klepnutim na OK
nebo ZrusSit. Neplatna polozka bude odmitnuta pouze po klepnuti na Zrusit.

— Makro — stisknutim tlaCitka Prochazet otevieme dialog Vybér makra, ve kterém

mUlZeme vybrat makro, které se provede po zadani neplatnych dat do buriky. Makro
se spusti po zobrazeni chybové zpravy.

Nadpis — zadame nazev makra nebo chybovou zpravu, kterou chceme zobrazit pfi
zadavani neplatnych dat do bunky.

Chybové hlaseni — zadame zpravu, kterou chceme zobrazit, kdyz jsou do burky zadana
neplatna data.
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Platnost

Kritéria Napovéda pii vstupu Chybové hlaseni

[ Zobrazit chybové hlaseni, pokud jsou zadany neplatné hodnoty:

Obsah

Akce: 7 astavit L Prochazet...

Nadpis:
Chyboveé hlaseni:

Napovéda QObnovit oK Zrudit

Obrazek 40: Dialogové okno Platnost — karta Chybové hlaseni

Calc detektiv

Detektiv je nastroj v programu Calc, ktery mlizeme pouzit k vyhledani vSech bunék v tabulce,
které obsahuji neplatna data, pokud jsou buriky nastaveny tak, aby pfijimaly neplatna data
S upozornénim.

1) Bunky obsahujici neplatna data vyhledame tak, ze v hlavni nabidce zapneme Nastroje >
Detektiv > Oznacit neplatna data. Funkce Detektiv ozna€i vSechny bunky obsahujici
neplatna data.

2) Opravime data tak, aby byla platna.

3) Prejdeme do Nastroje > Deaktivovat > Odstranit vSechny zavislosti na kontextové
nabidce a vSechny buriky, které byly pfedtim ozna€eny jako obsahujici neplatna data, se
oznaceni neplatnych dat odstrani.

@ Poznamka

Pravidlo platnosti je povazovano za soucast formatu bunky. Pokud z dialogového
okna Smazat obsah vybereme Smazat vSe (obrazek 42), bude odstranéno. Pokud
chceme zkopirovat pravidlo platnosti se zbytkem buriky, pouZijeme Upravy > VloZit
jinak > Vlozit jinak, aby se otevrel dialog VloZit jinak (obrazek 43), pak oznacCime
Vlozit vSe nebo Formaty a klikneme na OK.

Uprava dat

Mazani dat

Mazani pouze burikovych dat

Data Ize smazat z buriky tak, aby v ni zlstalo formatovani. Vybereme buriku nebo oblast bunék
a stiskneme klavesu Delete.

Uprava dat | 65



Mazani bunék

Tato moznost zcela odstrani vybrané buriky, sloupce nebo fadky. Buriky pod nebo napravo od
odstranénych bunék vyplni misto.

1) Oznacime buriku nebo oblast bunék.

2) Vybereme List > Smazat buniky nebo na mistni nabidce, nebo klikneme pravym
tlaCitkem mysi do vybranych bunék a vybereme Smazat v mistni nabidce nebo
zméackneme klavesy Ctrl + —.

Smazat buriky XK

Vibér
® Posunout burky nahoru:
(Z) Posunout buriky doleva
() Smazat celé fadky

() Smazat celé sloupce

Napovéda oK Zrusit

Obrazek 41: Dialogové okno Smazat buriky

3) Dialogové okno Smazat buriky (obrdzek 41) nabizi ¢tyfi moznosti, jimiz Ize definovat
zobrazeni listl po odstranéni bunék.

— Posunuti bunék nahoru. Vyplni zbyvajici prostor daty z bunék vespod.

— Posunuti bunék vlevo. Vyplni zbyvaijici prostor daty z bunék vpravo od smazané
bunky.

— Odstranéni celého Ffadku. Po vybrani aspon jedné burky odstrani z listu cely fadek.

— Odstrani cely sloupec. Po vybrani aspon jedné buriky odstrani z listu cely sloupec.

4) Vybér potvrdime klepnutim na OK.

Poznamka

Vybrana moznost odstranéni je zachovana a znovunactena, kdyz je dialog znovu
otevien, dokud neni LibreOffice zavien. Po znovuotevieni LibreOffice moznost
odstranéni obsahuje vychozi nastaveni.

Mazani dat a formatovani
Data a formatovani se daji z buriky smazat soucasné. Provedeme to nasledovné:

1) Oznacime buiku nebo oblast bunék.

2) Vybereme List > Vymazat buniky v mistni nabidce, nebo klikneme pravym tlacitkem
mysi do vybranych bunék a vybereme Vymazat obsah z kontextové nabidky nebo
stiskneme klavesu Backspace.

3) V dialogovém okné Smazat obsah (obrazek 42) vybereme nékterou z moznosti nebo
zvolime Smazat vSe. Klepneme na OK.
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Smazat obsah

[ Text Cisla

[] Datum a ¢as Vzorce

[] Komentare U Formaty

[ Objekty

Mapoveda OK Lrusit

Obréazek 42: Dialogové okno Smazat obsah

Nahrazovani dat

Chceme-li odstranit stavajici data a vlozit nova, vybereme buriku a nova data zadame. Plvodni
data burnky budou nahrazena novymi, plvodni formatovani se zachova.

Druhou mozZnosti je klepnout na vstupni fadek na listé vzorcll, nasledné poklepat na obsah, aby
se cely vybral, a zadat nova data.

Uprava dat

Neékdy je tfeba zménit obsah buriky, aniz by se cely odstranil. Napfiklad zménu textu ,Prodej ve
2. kvartalu“ za text ,Nardst prodeje v kvartalu“ nasledujicim postupem.

Pomoci klavesnice

1)
2)
3)

4)

5)

Klepnutim vybereme buriku.
Stiskneme klavesu F2, ¢imz se kurzor umisti na konec textu v burice.

Zmackneme klavesu Backspace pro vymazani vSech dat az do bodu, kde chceme zadat
nova data.

Pripadné pomoci Sipek pfemistime kurzor na misto, kde chceme udélat Upravy, poté
stiskneme klavesu Delete nebo klavesu Backspace a pred zadanim novych dat smazeme
vSechna nezadouci.

Po dokonceni aprav stiskneme klavesu Enter, ¢imz ulozime zmeény.

6 Tip

Pokazdé, kdyZ vybereme buriku, zobrazi se obsah ve vstupnim fadku na listé
vzorcU. PouZiti vstupni fadky mdze byt pfi Gpravé dat snazsi.

Pomoci mysi

1)
2)
3)

4)

Poklepeme na buriku, ¢imz ji vybereme a umistime do ni kurzor.
Kurzor pfemistime v burice tam, kam chceme zacit zadavat nova data.

Pfipadné mlzeme klepnutim vybrat buriku a poté pfesunout kurzor na vstupni fadek na
listé vzorcl a klepnout na misto, kde chceme zacit upravovat data v burice.

Po ukon&eni Uprav klepneme na jinou buriku, ¢imZ se zmény uloZi.
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Funkce Vlozit jinak

MUdZeme také pouzit funkci VloZit jinak pro vloZeni vybrané ¢asti dat z plvodni buriky nebo
oblasti bunék, napt. forméat dat nebo vysledek vzorce, do jiné buriky.

Viozit zvlastni dialog

1)
2)

3)
4)

5)

6)

Vybereme buriku nebo oblast bunék.

Pfejdeme na Upravit > Kopirovat na mistni nabidce nebo klikneme na ikonu Kopirovat
na standardni nastrojové listé nebo s klikneme pravym tlacitkem mySi a vybereme
Kopirovat v kontextové nabidce nebo stiskneme Ctrl + C.

Vybereme cilovou buriku nebo oblast bunék.

Prejdeme na Upravit > Vlozit jinak > Vlozit jinak v mistni nabidce nebo klikneme
pravym tlacitkem mysi a vybereme Vlozit jinak > Vlozit jinak v mistni nabidce nebo
pouzijeme klavesovou zkratku Ctrl + Shift + V, aby se otevrel dialog VloZzit jinak (obrazek
43).

Vybereme moznost pro Operace vybrat, MoZnosti, a Posunout buriky. NiZe jsou
vysvétleny moznosti VlIoZzit jinak.

Klikneme na OK k vloZeni dat do cilové burky nebo rozsahu bunék a dialogové okno
zavieme.

$0 X i
Vybér Operace
v ® Nic
Text ) Pfidat
Cisla ) Odecist
Datum a cas ) Nasobit
L Vzorce ) Délit
U Komentare
Ul Formaty
[ Objekty
MoZnosti Posunout buiky

L] Pfeskocit prazdné buriky @ Neposouvat

U Transponovat 2 Dold
U Odkaz ) Vpravo
MNapovéda OK Zrusit

Obrazek 43: Dialogové okno VloZit jinak

6 Tip

Misto krok( 5) a 6) vySe, mizeme zmacknout jednu ze tfi zkratkovych tlacitek

v hodni ¢asti dialogu — Pouze hodnoty, Hodnoty a formaty, nebo Transponovat.
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MozZnosti VloZit jinak
* Vybér — zvolime format obsahu schranky, ktery chceme vlozit.

VioZit vSe — do aktualniho dokumentu vlozi veSkery obsah bunék, komentare, formaty
a objekty.

Text — vloZi buiiky obsahuijici text.

Cisla — vlozi buiky obsahuijici ¢isla.

Datum a ¢as — vloZi buinky obsahujici hodnoty data a ¢asu.
Vzorce — vloZi buiky obsahujici vzorce.

Komentére — vlozi komentare, které jsou pfipojeny k buikam. Pokud chceme pfidat
k existujicimu obsahu buriky komentéare, vybereme operaci Pridat.

Formaty — vlozi atributy formatu buriky.

Objekty — vlozi objekty obsazené ve vybraném rozsahu bunék. Mohou to byt objekty
OLE, objekty grafi nebo objekty kresby.

* Operace — vybereme operaci, ktera se pouzije pfi vlozeni bunék do listu.

Nic — pfi vloZeni oblasti bunék ze schranky nepouzije operaci. Obsah schranky
nahradi stavajici obsah bunék.

Pridat — pfida hodnoty v bunikach schranky k hodnotam v cilovych burikach. Pokud
schranka obsahuje pouze komentére, pfida je do cilovych bunék.

Odecist — odeCte hodnoty v bunkéach schranky od hodnot v cilovych burikach.
Nasobit — vynasobi hodnoty v burikach schranky hodnotami v cilovych burikach.
Délit — déli hodnoty v cilovych burikach hodnotami v burikach schranky.

* MozZnosti — nastavuje moznosti vloZeni obsahu schranky.

Preskocit prazdné buriky — nenahrazuje cilové bunky prazdnymi burikami ze
schranky. Pokud tuto moznost pouZijeme ve spojeni s operaci Nasobit nebo Délit,
operace se nepouzije na cilovou bunku prazdné buriky ve schrance. Pokud vybereme
matematickou operaci a zrusime vybér Preskocit prazdné buriky, prazdné burky ve
schrance se povaZzuji za nuly. Napfiklad, pokud pouzijeme operaci Nasobit operace,
jsou cilové buiky naplnény nulami.

Transponovat — vklada fadky rozsahu ve schrance jako sloupce vysledného rozsahu
a sloupce rozsahu ve schrance jako radky.

Odkaz — vlozi oblast bunék jako odkaz, takze zmény provedené v burikach ve
zdrojovém souboru jsou aktualizovany v cilovém souboru. Chceme-li zajistit, aby
zmény provedené v prazdnych burkach ve zdrojovém souboru byly aktualizovany

v cilovém souboru, vybereme volbu VloZit v§e. MiZeme také propoijit listy ve stejném
sesSitu. PTi propojeni na jiné soubory se automaticky vytvori odkaz DDE. Odkaz DDE
je vloZen jako maticovy vzorec a lze jej upravit pouze jako celek.

* Posun bunék — nastavuje moznosti posunu pro cilové buriky pfi viozeni obsahu
schranky.

Neposouvat — vloZzené buiky nahrazuji cilové buriky.
Dol — cilové buriky jsou pfi vkladani bunék ze schranky posunuty dol(.
Vpravo — cilové buriky jsou pfi vkladani bunék ze schranky posunuty doprava.

Moznosti VloZit jen
Pokud chceme do cilové buriky nebo oblasti bunék pouze kopirovat text, ¢isla nebo vzorce:

1) Vybereme zdrojovou buriku nebo oblast bunék a zkopirujeme data.
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2) Vybereme cilovou buriku nebo oblast bunék.

3) Klepneme pravym tlacitkem mysi na cilovou buiiku nebo oblast bunék a z mistni nabidky
vybereme Vlozit jinak, poté vybereme Text, Cislo nebo Vzorec.

4) Nebo mizeme pouzit VloZit jen text, VloZit jen &isla, nebo VloZit jen vzorce moznosti
v mistni nabidce Upravit > VloZit jinak

Vlozit pole bunék
Do buiiky mGzeme vlozit pole spojené s datem, nazvem listu nebo nazvem dokumentu.

1) Vybereme burky a dvojklikem aktivujeme editacni méd.

2) Klepneme pravym tlacitkem mysi a vybereme VloZit pole > Datum, Nazev listu nebo
Nazev dokumentu v mistni nabidce.

3) Nebo mizeme pouzit podobné moznosti v menu VloZit > Pole v mistni nabidce.

Poznamka

Pfikaz VloZit pole > Nazev dokumentu vklada nazev seSitu a nikoliv ndzev
definovany v karté Popis v dialogu Vlastnosti souboru.

@ Tip
Pokud je tabulka uloZzena nebo prepocitana pfi pouziti zkratkové klavesy Ctrl + Shift
+ F9, jsou pole obnovena.

Formatovani dat

Poznamka

VSechna nastaveni popsana v této ¢asti Ize také nastavit jako soucast stylu bunky.
Vice informaci najedeme v kapitole 4, Pouzivani styl(l a Sablon.

V programu Calc miiZzeme data formatovat nékolika zpUsoby, bud definovat format jako soucast
stylu buniky tak, aby byl automaticky pouZzit, nebo na buriku aplikovat ru¢ni formatovani. DalSi
moznosti ovladani a dalSi moznosti ziskame tak, Ze vybereme buriku nebo oblast bunék

a pouzijeme dialogové okno Formét bunék. VSechny moznosti formatovani jsou popsany nize.

Viceradkovy text

Vice fadkul Ize zadat do jedné buriky bud automatickym, nebo rué¢nim zalomenim. Kazda
Z metod je vhodna pro jiné situace.

Automatické zalamovani
Automatické zalomeni né&kolika fadkU textu v burice:
1) Vybereme buriku nebo oblast bunék.

2) V hlavni nabidce zvolime Format > Buriky, klepneme pravym tlacitkem a z mistni
nabidky vybereme Format bunék nebo zmackneme klavesy Ctrl + 1. Otevre se dialogové
okno Format bunék.

3) Klepneme na kartu Zarovnani (obrazek 44).
4) V sekci Vlastnosti vybereme Automaticky zalomit text a klepneme na OK.
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Rucéni zalomeni textu

Kdyz chceme zalomit text v bunice ru¢né, stiskneme béhem psani v bufice kombinaci klaves Ctrl

+ Enter. KdyZ text upravujeme, nejprve na buriku poklepeme a pak kurzor umistime tam, kde
chceme fadek zalomit.

KdyzZ text v buiice zalomime ru¢né, Sitka buriky se nezméni a text mizZe pfesahovat pres jeji

v

okraj. Musime zménit Sifku burky ru¢né nebo pfemistit zalomeni fadku tak, aby text
nepresahoval konec burky.

Format bunék

Zarovnani textu

Vodorovng: [Vychozi ~ | Odsazent:

4

=
>

L

Svisle; Ma stred A

Orientace textu
[ Svisle zarovnané
ReZim asijskeho rozvrZeni

F

Stupné; 0

- = -
= ABCD -

Zakladna: fal[=

Vlastnosti
] Automaticky zalomit text
Déleni slov aktivni

[ Zmensit podle velikosti buriky

Smér textu: |PouZit nastaveni nadfazeného objektu |

Mapovéda Obnovit oK Lrusit

Obrazek 44: Dialogové okno Format bunék - karta Zarovnani

Zmensit text podle velikosti bunky
Velikost pisma textu v burice Ize automaticky pfizplsobit velikosti buiiky.
1) Vybereme buiku nebo oblast bunék.

2) V hlavni nabidce zvolime Format > Bunky, klepneme pravym tlacitkem a z mistni

nabidky vybereme Format bunék nebo zmackneme klavesy Ctrl + 1. Otevre se dialogové
okno Forméat bunék.

3) Klepneme na kartu Zarovnani (obrazek 44).
4) V sekci Vlastnosti vybereme Zmensit podle velikosti buiiky a klepneme na OK.
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Formatovani Cisel

Pomoci ikon na nastrojové listé Formatovani Ize na buriky pouZzit nékolik rtiznych formatd cisel
(zvyraznéno na obrazku 45). Vybereme buriku a pak klepnutim na pfislusnou ikonu zménime
format Cisla.

Vice moznosti a dali formaty &isel mdizeme nastavit na karté Cisla v dialogovém okné& Formét
bunék (obrazek 28 na strané 64):

« K formatovani dat mizeme pouZit kterykoliv typ dat ze seznamu Kategorie.

* V seznamu zvolime pfeddefinované formaty v seznamu Formatovani.

« V Casti MoZnosti mizeme nastavit pocet desetinnych mist a Gvodnich nul.

« Mulzeme zadat vlastni formatovaci kdd. Jedna se o velmi vykonnou funkci, ktera je
podrobné popsana na strance napovédy Kody pro format ¢isla.

eV oddile Jazyk mizeme zohlednit mistni nastaveni pro rlizné formaty, jako napfiklad
format data Ci symbol mény.

Formatovan( v X
Liberation Sans 10 B I U A=r» l it = 00 | 0 | ] ¢ .
i

Obrazek 45: TlaCitka formatu Cisla na nastrojové listé Formatovan

Formatovani pisma
Pokud chceme vybrat format pisma pro konkrétni buriku:

1) Vybereme buriku nebo oblast bunék.

2) Klikneme na malou Sipku doll na pravé strané od nastrojové listy Formatovani Nazev
pisma zvyraznéno na obrazku 46) a vybereme pismo z rozeviraciho seznamu. Pismo Ize
také zménit pomoci zalozky Pismo v dialogovém okné Formét bunék

3) Klikneme na Sipku dol( napravo od nastrojové listy Formatovani Velikost pisma
a vybereme velikost pisma z rozeviraciho seznamu. Pismo Ize také zménit pomoci karty
Pismo v dialogovém okné Format bunék.

4) Dalsi atributy pisma miZeme nastavit pomoci tlacitek na ikonach nastrojové listy
Formatovani Tu€né, Kurziva nebo Podtrzené.

5) Chceme-li zménit zarovnani sloupce, klikneme na jednu z ikon zarovnani (Zarovnat
vlevo, Zarovnat na stfed, Zarovnat vpravo a Do bloku). Format> Zarovnat nabidka
také poskytuje tyto moznosti.

Formatovani

LiberationSans >~ (10 ~|B | U A ~rf.~ 1

Obréazek 46: Velikost a nazev pisma na nastrojové listé Formatovani

Poznamka

Pokud chceme urcit jazyk v bunce, pouzijeme kartu Pismo v dialogovém okné
Format bunék. Zména jazyka v buiice nam umozni vytvaret vicejazycny dokument.
DalSi zmény charakteristik pisma nalezneme v Casti ,Efekty pro pismo” nize.
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@ ip
Chceme-li zvolit, zda se maji nazvy pisem zobrazovat v jejich fontu nebo v prostém
textu, pfejdeme na Nastroje > Moznosti > LibreOffice > Zobrazeni a vybereme

nebo zruSime vybér volby Zobrazit nahled pisem v sekci Seznamy pisem. DalSi
informace viz Kapitolal4, Nastaveni a Pfizplsobeni.

Efekty pro pismo

1) Vybereme burnku nebo oblast bunék.

2) K otevieni dialogového okna Formatovani bunék klepneme tlacitkem mysi a vybereme
Format bunék z mistni nabidky, pfejdeme na Format > Buiky v mistni nabidce nebo
stiskneme Ctrl + 1.

3) Klepneme na kartu Efekty pro pismo (obrazek 47).

4) Z dostupnych moznosti vybereme efekt pisma, ktery chceme pouzit. Dostupné moznosti
jsou popsany v kapitole 4, Pouzivani styl( a Sablon.

5) Klepnutim na OK nastavime efekty pro pismo a zavieme dialogoveé okno.

Format bunék

Cisla Pismo éEfekty pro pismo§ Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana burky

Barva pisma

Barva pisma: |:| Automaticka v
Dekorace textu
MNadtrZeni: (Zadné) e Automaticka
Predkrtnuti: (Z&dné) v
Podtrieni: (Zadné) W Automaticka
Jednotliva slova
Efekty
Reliéf: (Zadny) ~ | [JObrys [IStin
Znacka zvyraznéni: |(Zadna) v
Umistent: Mad textemn

Lorem ipsum AZ#] HEAE nqv naq7x

MNapovéda Obnovit OK Zrusit

Obrazek 47: Dialogové okno formatovani bunék — karta Efekty pro pismo

Jakékoli zmény efektu pisma se pouziji na aktudlni vybér nebo na celé slovo, které obsahuje
kurzor, nebo na jakykoli novy text, ktery piSeme.
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Smér textu

Chceme-Ili zménit smér textu v burice, pouzijeme kartu Zarovnani v dialogovém okné Forméat
bunék (obrazek 44 na strané 84).

1) Na karté v dialogu Zarovnani bunék Zarovnani vybereme Zakladna, ze které se text ma
otacet nasledujicim zplsobem:

— Text vychazi z dolniho okraje buriky — zapiSe otoCeny text od spodni hrany bunky
smérem ven.

— Text vychazi z horniho okraje buriky — zapiSe oto¢eny text od horniho okraje buriky
smeérem ven.

— Text zlstane uvnitl buriky — zapiSe oto¢eny text pouze v burice.

2) Klikneme na maly indikator na okraji od dialogu Orientace textu a ota€ime, dokud
nedosahneme pozadovanych stupiid.

3) Pripadné zadame pocet stupiill, o které chceme text otoCit do pole Stupné.
4) Vybereme Svisle zarovnané, aby se text v burice objevil svisle.

ReZim asijského rozvrzeni pole je dostupny v karté dialogu Formatovani bunék Zarovnani, kdyz
je podpora asijského jazyka umoznéna, a smér textu je nastaven na svisly. Tato moznost
zarovna asijské znaky pod sebe ve vybrané buiice &i bunikach. Pokud burika obsahuje vice nez
jeden fadek textu, fadky jsou prevedeny na sloupce textu, které jsou usporadany zprava doleva.
Z&apadni znaky jsou v pfevedeném textu otoceny o 90 stupiili doprava. Asijské znaky otoceny
nejsou.

Pouziti ikon na formatovacim panelu nastroji
Ikony na nastrojové listé Formatovani Ize po vybéru buriky pouzit nasledovné:

* Chceme-li zménit smér textu z vodorovného (vychozi smér) na svisly, klikneme na ikonu
Smér textu shora dold.

e Chceme-li zménit smér textu z vertikalniho na horizontalni (vychozi), klikneme na ikonu
Smér textu zleva doprava.

* Chceme-li zménit smér textu zleva doprava, ktery je vychozim smérem pro zapadni
pisma, na smér zprava doleva, ktery je pouzivan na néktera pisma, napfiklad na
u arabstiny, pak klikneme na ikonu Zprava doleva. Toto funguje, pouze pokud bylo
pouzito pismo, které vyzaduje smér zprava doleva.

* Chceme-li zménit smér textu zpét na vychozi smeér zleva doprava pouzivany pro zapadni
pisma, klikneme na ikonu Zleva doprava.

Poznamka

Ikony sméru textu mohou byt k dispozici, pouze pokud jsou zaSkrtnuty moznosti
Asijské a Komplexni rozvrzeni textu v Nastroje > MoZnosti > Jazykova
nastaveni > Jazyky > Vychozi jazyky pro dokumenty. Je-li nutné tlacitka
zviditelnit, klepneme pravym tlagitkem na nastrojovou liStu a vybereme v mistni
nabidce Viditelna tlacitka, klepneme na pozadovanou ikonu a ta se umisti na
nastrojovou listu Formatovani.

Asijska typografie

Pokud je podpora asijského jazyka umoznéna pfes Nastroje > MoZnosti> Nastaveni jazyka >
Jazyky > Vychozi jazyky pro dokumenty > Asijsky, karta asijska typografie je zahrnuta

v dialogu Format bunék (obrazek 48). Tato karta umoZnuje nastaveni typografickych moznosti
pro bunky v dokumentech asijského jazyka.
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Format bunék

Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana buriky
Zména rfadky

4l PouZit seznam zakazanych znaki na zacatek a konec radky:

Povolit zav&Senou interpunkci

PouZit rozestup znakd mezi asijskym a jinym textem

MNapovéda Obnovit QK Zrusit

Obrazek48: Dialogové okno Format bunék - karta Asijska typografie
K dispozici jsou nasledujici moznosti:

« Pouzit seznam zakazanych znakd na zac¢atku a na konci fadku — chrani pfed znaky
v seznamu zakazanych znak( ze zacatku nebo konce fadku. Znaky jsou pfesunuty na
pfedchozi nebo nasledujici fadek. Chceme-li upravit seznam zakazanych znakd,
pfejdeme na Nastroje > MozZnosti > Nastaveni jazyka > Asijské rozvrzeni > Prvni
a posledni znaky.

* Povolit zavéSenou interpunkci — brani ¢arkam a te€kam v zalomeni fadku. Misto toho
jsou tyto znaky pfidany na konec fadku, a to i na okraji stranky.

« PouZit rozestup znakli mezi asijskym a jinym textem — vklada mezery mezi
ideograficky a abecedni text.

Formatovani ohrani¢eni bunék

Chceme-li bunice (nebo skupiné vybranych bunék) nastavit ohrani¢eni, klepneme na ikonu
Ohrani€eni na nastrojové listé Formatovani a pouZzijeme nastavené styly nebo otevieme
dialogové okno Forméat bunék pro dalSi moznosti. DalSi informace o moznostech nastaveni
nalezneme v kapitole 4, Pouzivani styl( a $ablon.

@ Poznamka

Vlastnosti ohraniCeni bunék se aplikuji pouze na vybrané burky a daji se zménit
pouze jejich apravou. Pokud ma napfiklad burika C3 horni ohrani€eni, je mozné jej
odstranit pouze pfi zvoleni bufiky C3. Nelze ji odstranit v C2, i kdyz se zd4, Ze je
spodni hranici pro burnku C2.

1) Oznacime burnku nebo oblast bunék.

2) V hlavni nabidce zvolime Format > Bunky, klepneme pravym tlaCitkem a z mistni
nabidky vybereme Format bunék nebo zmackneme klavesy Ctrl + 1. Otevrie se dialogové
okno Forméat bunék.

3) Na karté Ohraniceni (obrazek 49) vybereme pozadované moznosti.
4) Klepnutim na OK zavieme dialogové okno a uloZzime zmény.
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Pro nastaveni prednastavenych stylli ohrani¢eni mizeme také pouzit ikony na nastrojové listé
Formétovani:

1) Klikneme na ikonu Ohrani€eni a vybereme jednu z moznosti zobrazenou v paleté
Ohraniceni.

2) Klikneme na ikonu Styl ohraniéeni a vybereme jednu ze stylll linek z palety Sty/
ohraniceni.

3) Klikneme na ikonu Barva ohrani€eni, abychom pouzili posledni vybranou barvu.
Klikneme na Sipku dold napravo od ikony Barva ohrani¢eni, abychom vybrali jinou barvu
z palety Barva ohraniCeni.

@ Poznamka

Pfi zadavani ohrani¢eni pomoci ikon ohrani¢eni na panelu nastroji Formatovani
mame dvé moznosti: klepnutim na poZadovanou ikonu pfidame ohraniceni

k soucasnym ohranic¢enim nebo pomaoci Shift + klepnuti pfidame a odstranime
stavajici ohraniceni.

Format bunék

I Pozadi Ochrana bunky

Usporadani car Okraj
Predlohy: O [ P X Vievo: 0,35 mm
Definovane uZivatelem: Vpravo: 0,35 mm

Mahofe; 0,35 mm

R RE B IRE RECRE B

Dole: 0,25 mm
Synchronizovat
Sousedni buriky:
Odstranit ohraniceni
Cara Styl stinovani

Styl: hd Umistént: U Ll L] L]

Barva: Bl Cens - Barva: Seda
Sitka: 075pt & Vzdalenost: |1,76 mm =
MNapovéda Obnovit 0K Zrusit

Obrazek 49: Dialogové okno Format bunék — karta Ohraniceni

Formatovani pozadi bunky

Formétovani barvy pozadi buriky nebo skupiny bunék (dalSi informace nalezneme v kapitole 4,
Pouziti styld a Sablon):
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1) Oznacime buriku nebo oblast bunék.

2) V hlavni nabidce zvolime Format > Bunky, klepneme pravym tlacitkem a z mistni
nabidky vybereme Format bunék nebo zmackneme klavesy Ctrl + 1. Otevre se dialogové
okno Formét bunék.

3) Na karté Pozadi klepneme na tlacitko Barva a vybereme barvu z palety barev.
4) Klepnutim na tla¢itko OK ulozime zmeény a zavieme dialogové okno.

Nebo klepneme na ikonu Barva pozadi na nastrojové listé Formatovani, abychom pouzili
naposledy vybranou barvu. Chceme-li vybrat jinou barvu z palety Barva pozadi, klepneme na
ikonu Sipky vpravo od palety Barva pozadi.

Automaticky format bunék a listl

Pouziti automatického formatovani
K formatovani skupiny bunék miiZzeme pouzit automaticky format.

1) Vybereme buriky, které chceme formatovat, a to minimalné v rozsahu tfi fadkl a sloupct
vcetné jejich zahlavi.

2) V hlavni nabidce zvolime Format > Styly automatického formatu, ¢imz se otevie
dialogové okno Automaticky format (obrazek 50).

3) V seznamu zvolime typ a barvu forméatovani.

4) Zvolime, které formatovaci prvky budou pfi automatickém formatovani pouzity.

5) Klepnutim na tlaitko OK uloZime zmény a zavieme dialogové okno.

Automaticky format

Pridat
Akademicky
Cerveny seznam Smazat
Elegantni
Finaneni Prejmenovat
Jednoduché fadky
Jednoduche sloupce
Jednoduchy stinovany v
Formatovani
Format &isla Pismo Zarovnani
Ohraniceni Vzor Automaticky pfizplsobit vysku a Sifku
Napovéda OK Zrusit

Obrazek 50: Dialogové okno Automaticky format

Definovani nového automatického formatovani

MdGzeme definovat vlastni styl automatického formatovani, ktery bude dostupny pro vSechny
sesity.

1) Mlzeme pfitom zvolit typ dat a pisma, velikost pisma, ohrani¢eni bunék, pozadi a dalsi.
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2) Pro otevieni dialogového okna Automaticky format vybereme v hlavni nabidce Format >
Styly automatického formatu. Tlacitko PFidat je nyni aktivni.

3) Klepneme na P¥idat.

4) V dialogovém okné Automaticky format, které se otevie, zadame do pole Nazev
smysluplny ndzev nového formatu a klepneme na OK.

5) Novy automaticky format je nyni k dispozici v seznamu Format v dialogovém okné
Automaticky forméat. Kliknutim na OK zavieme dialogové okno Automaticky format.

"/ Poznamka
Chceme-li definovat novy automaticky format, musime vybrat rozsah bunék alespon
4x4. Vybereme-li mensi rozsah, tlacitko Pfidat bude nedostupné.

Pouzivani témat

Program Calc obsahuje sadu preddefinovanych témat formatovani, které mizeme pouZzit ve
svych seSitech. Neni mozné pfidavat nova témata do programu Calc a preddefinované styly
nelze upravovat. Styly midiZzeme po jejich pouziti v sesitu upravit, ale upravené styly jsou

k dispozici pouze pro pouziti v tomto sesitu.

Jak pouzit téma na sesit:

1) Prejdeme na Forméat > Motiv vzhledu sesSitu v nabidce menu, nebo klikneme na ikonu
Motiv vzhledu seSitu na nastrojové listé (obrazek 51), ktera uvadi dostupné motivy pro
cely sesit.

2) Oznacime téma, které chceme pouZit. lhned po vybéru tématu se styly pouZziji, a zmény
jsou tedy okamzité patrné.

3) Potvrdime je stisknutim tlaCitka OK.

Vybér motivu vzhledu

{Standardni) ~
Be

Dyné

DZinovina

Ledaovec

Milénium

MNeon

MNoc

Namaofnicka modf
Obéd v padesatych
Oslava

OstruZinik

PC nostalgie

Pastel

Podzimni listi

PFirnda

Zrusit
E YT TTTITIooNs |

Obrézek 51: Dialogové okno Vybér
tématu
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Nyni miZeme prejit na kartu Styly v postranni listé€, kde Ize upravit konkrétni styly. Tyto Gpravy
nezméni téma, ale jen vzhled otevieného sesitu. Vice informaci o Upravé stylll nalezneme
v kapitole 4, Pouziti styld a Sablon.

Zvyraznovani hodnot

Zvyraznéni hodnoty zobrazuje obsah buriky v rliznych barvach v zavislosti na typu obsahu.
Pfiklad zvyraznéni hodnoty je znazornén na obrazku 52.

» Text je zobrazen Cerné.
* Vzorce jsou zobrazeny zelené.
+ Cisla (v¢etné data a ¢asu) jsou zobrazena modrou barvou.

15 |03.01.2008 Kurt 7:30 17:45 9,50
16 | 03.01.2008 Ute 8:30 18:30 9,25
_ 17 |06.01.2008 Brigitte 9:30 17:30 7,25
18 106.01.2008 | Fritz 11:00 14:30 3,50

Obréazek 52: Priklad zvyraznéni hodnot

Barvy zvyraznujici hodnoty maji pfednost pfed vdemi barvami pouzitymi pfi forméatovani. Tato
zména barvy plati pouze pro barvy viditelné na displeji. P¥i tisku tabulky se vytisknou pdvodni
barvy pouzité pro forméatovani.

Pro vypnuti ¢i zapnuti této funkce zvolime v hlavni nabidce Zobrazit > Zvyraziovani hodnot
nebo pouzijeme klavesovou zkratku Ctrl + F8. KdyZ je zvyraznéni hodnot vypnuto, pouziji se pro
zobrazeni plvodni barvy formatovani.

Automatické nastaveni zvyraziovani hodnot Ize zapnout v nabidce Nastroje > Moznosti >
LibreOffice Calc > Zobrazeni > Zobrazit > Zvyrazinovani hodnot. Tento vychozi rezim pro
zvyraznéni hodnot nemusi byt to, co chceme, pokud se chystame formatovat buriky pro tisk.

Pouziti podminéného formatovani

Formatovani buriky je mozné nastavit tak, aby se ménilo podle podminek, které definujeme.
Podminéné formatovani je vyuzivano k zvyraznéni dat, které jsou mimo specifick& nastaveni,
kterd vyuzivdme. Pfehnané pouzivani podminéného formatovani mdize vést k prehlédnuti dat,
jeZ nejsou takto zforméatovana.

Pfiklad pouZiti podminéného formatovani nalezneme v ¢asti ,Pfiklad podminéného forméatovani”
na strané 98 .

Poznamka

Podminéné formatovani zavisi na pouzivani stylll a funkce Automaticky vypocet,
kterd musi byt zapnuta. Pokud nejsme obeznadmeni se styly, nalezneme vice
informaci v kapitole 4, Pouzivani styl( a Sablon.

Nastaveni podminéného formatovani
1) Ujistime se, Ze je povolen automaticky vypocCet: Data > Spoditat > Automaticky
vypocet.
2) Vybereme buiky, ve kterych chceme pouzit podminéné formatovani.
3) V hlavni nabidce zvolime Format > Podminény > Podminka (obrazek 53), Barevna
Skala (obrazek 54), Datovy pruh (obrazek 55), Sady ikon (obrazek 56) nebo Datum

(obrazek 57). Otevie se dialogové okno Podminéné formatovani. Zobrazi se vSechny jiz
definované podminky.
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4) Klepnutim na PFidat vytvofime nebo definujeme novou podminku. Podle potfeby tento
krok opakujeme.

5) Vybereme styl ze stylé uvedenych v rozbalovacim seznamu PouZit styl. Podle potieby
tento krok opakujeme.

6) Pro pfipadné otevieni dialogového okna Styl buriky vybereme polozku Novy styl
(obrazek 58) a vytvorime novy styl buriky. Podle potfeby tento krok opakujeme.

7) Klepnutim na OK uloZzime podminky a zavieme dialogové okno. Vybrané buiiky jsou nyni
nastaveny k pouziti vysledku pomoci podminéného formatovani.

Podminéné formatovani pro A1:F8

Podminky

Podminka 1

je rovno ~

Pousit styl: Accent v ‘ Lorem ipsum ‘
Zadejte hodnotu:

Pridat Smazat MNahoru Dold

Oblast bunék
Oblast. |A1:F8 =

MNapovéda oK Zrusit

Obrazek 53: Dialogové okno Podminéné formatovani — Podminka
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Podminéné formatovani pro A1:F8

Podminky
Podminka 1
JEL_hrTlprnIﬂu |TF|’barevné skala ~ |
Minirmum Maximum
|Min V| |Percenti| V| |Max ~
50
B Cervens v | [ ] 7ts v B Zeleni v
Pridat Smazat Nahoru Doli
Oblast bunék
Oblast. |AT:F8 =)
MNapovéda QK Zrusit

Obrazek 54: Dialogové okno Podminéné formatovani — Barevna Skala

Podminéné formatovani pro A1:F8

Podminky
Podminka 1
|Dat0'u'§' pruh > |
Minimum Maximum
|Aut0maticky ~ | ‘Automaticky >

Dalsi moZnosti...

Pridat Smazat MNahoru Dold
Oblast bunék
Oblast. |A1:F8 =]
Napovéda QK Zrusit

Obréazek 55: Dialogové okno Podminéné formatovani — Datovy pruh
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Podminéné formatovani pro A1:F8

Podminky
Podminka 1
Vzechny buriky 'Sada ikon 3 sipky
&
® o | |
. |
Pridat Smazat Nahoru Dol
Oblast bunék
Oblast: |AT:F8 ‘ ‘ = ‘
Népovéda oK Zrait

Obréazek 56: Dialogové okno Podminéné formatovani — Sada ikon

Podminéné formatovani pro A1:F8

Podminky

Podminka 1

Datum je

Poudit styl:

Pristi tyden

:Accent

Lsum AT HAE

Pridat Smazat

Oblast bunék

Nahoru

Dol

Oblast: AT1:F8

| (=]

Napovéda

Zrugit

Postava 57 : Dialog Podminéné formatovani - Datum
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Styl buriky

Organizétor Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana buriky
Styl
Nazev: |Test
Rodicovsky: (LT - | | Upravitsty
Kategorie: |Vlastni styly V‘
Obsahuje
Napovéda Obnovit Standardni oK Zrusit

Obrazek 58: Dialogové okno Styly buriky

Druhy podminéného formatovani

Podminka

Podminka je po¢ate¢nim bodem k vyuZziti podminéného formatovani. Zde miizeme definovat,
jaké formaty pouzit ke zvyraznéni jakychkoliv dat v seSitu, ktera nespadaji do definovanych
specifikaci.

Barevna skala

Pomoci barevné Skaly nastavime barvu pozadi bunék v zavislosti na hodnotach dat v téchto
burikach. Barevna skala mize byt vyuZita jen tehdy, kdyZ jsou v této podmince vybrany véechny
buriky. Pro barevnou stupnici miiZzeme pouzit dvé nebo tfi barvy.

Datovy pruh

Datovy pruh poskytuje grafické znazornéni dat v seSitu. Grafické znazornéni je zalozeno na
hodnotach dat vybrané oblasti. Klepnutim na DalSi moZnosti v dialogovém okné Podminéného
forméatovani specifikujeme, jak budou datové pruhy vypadat. Datové pruhy lze pouzit jen tehdy,
kdyZ jsou v této podmince vybrany vSechny buriky.

Sada ikon

Sady ikon zobrazi vedle dat v kazdé vybrané burice ikonu, ktera umoZziiuje vizualni zndzornéni
mista, kde data burky spadaji do definovaného nastaveného rozsahu. Mezi sady ikon, které jsou
k dispozici, patfi barevné Sipky, Sedé Sipky, barevné vlajky, barevné znaky, symboly, hodnoceni
pruhd a étvrtin. Sada ikon mlze byt pfistupna pouze tehdy, pokud je otevieno dialogové okno
Podminéného forméatovani a jako podminka byly vybrany VSechny buniky.

Datum
Datum pouzije definovany styl v zavislosti na rozsahu dat, ktery vybereme z rozeviraci nabidky.

v

Priklady zahrnuji Zitra, Poslednich 7 dni, Tento tyden, Pristi mésic, Minuly rok.
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0 Tip

Ackoliv ke kazdému Ize pfistupovat pomoci jiné moznosti v nabidce hlavni nabidky
Format > podminény, pét variant dialogového okna Podminéné formatovani
zobrazenych na obrazcich 53 az 57 neni rozdilnych. Jakmile je dialogové okno
oteviené, mizeme vytvaret podminky vSech typd bez otevirani hlavni nabidky.
Napfiklad miZzeme vytvofit Podminku 1 pro vybér stylu buiiky, kterd se pouZije,
pokud burika nabude pfesné hodnoty (Podminka 1 je typu “Podminka”). MiZzeme
poté zmacknout tla€itko PFidat a vytvofit Podminku 2 vybérem hodnoty VSechny
bunky v levém hornim rozbalovacim poli a poté vybrat Datovy pruh v nasledujicim
rozbalovacim poli (Podminka 2 je typu “Datovy pruh”). Poté miizeme zmacknout
tlaCitko PFidat a vytvofit Podminku 3 vybé&rem Datum je v levém hornim
rozbalovacim poli (Podminka 3 je typu “Datum”). Timto zplisobem miZeme vytvorit
mnoho podminek rdznych typl pro fizeni podminéného formatovani vybranych
bunék.

Sprava podminéného formatovani
Chceme-li zobrazit vSechna podminénéa formatovani definované v seSitu a vSechny pouzité styly:

1) V hlavni nabidce Format > Podminény > Spravovat otevieme dialogové okno
Spravovat podminéné formatovani (obrazek 59).

2) Vybereme oblast ze seznamu Oblast a pro Upravu pfedefinovaného podminéného
formatovani klepneme na Upravit.

3) Vybereme oblast ze seznamu Oblast a pro vymaz podminéného forméatovéani klepneme
na Smazat. Odstranéni je okamzité bez potvrzeni.

4) Pro vytvoreni nové definice podminéného formatovani klepneme na PFidat.
5) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno.

Spravovat podminéné formatovani

Podminéné formatovani

Oblast Prvni podminka
AT:F18 Barevna kala
Hodnota buriky = 5

Pridat Upravit... Odstranit

MNapovéda QK Lrusit

Obrazek 59: Dialogové okno Spravovat podminéné formatovani

Kopirovani styli bunék
Chceme-li pozdégji pouzit podminéné forméatovani u dalSich bunék:

1) Klepneme na jednu z bunék, kterym bylo pfifazeno podminéné formatovani,
a zkopirujeme buriku do schranky.
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2) Vybereme burnky, kterym se ma nastavit stejné forméatovani jako ma zkopirované burika.

3) V hlavni nabidce zvolime Upravy > Vlozit jinak > VloZit jinak,klepneme pravym
tlaCitkem mysi a z mistni nabidky vybereme Vlozit jinak > VloZzit jinak nebo pouZijeme
klavesovou zkratku Ctrl + Shift + V. Ve vSech pfipadech se otevie dialogové okno VloZit
jinak (obrazek 43 na strance 81).

4) Ujistime se, Ze je vybrdna moznost pouze Formaty. Klepnutim na OK vloZzime podminéné
formatovani do bunky.

Priklad podminéného formatovani

Jeden z priklad(l pouziti podminéného forméatovani je napfiklad zvyraznéni souctd, které
presahuji primérnou hodnotu vSech souctl. Pokud se souéty zméni, formatovani se
odpovidajicim zplisobem zméni, aniz by bylo nutné pouZit ruéné jiné styly. Pfed zpracovanim se
doporucuje, aby byla na postrannim panelu oteviena a viditelna karta Styly.

Definovani podminek
1) Vybereme buniky, ve kterych chceme pouZzit podminény styl.
2) V hlavni nabidce zvolime Format > Podminény > Podminka, Barevna Skala, Datovy
pruh, Sada ikon, nebo Datum. Otevie se dialogové okno Podminéné formatovani.

3) Zadejte podminky, které chceme pouzit pro podminéné formatovani.

Generovani ¢iselnych hodnot

Urcité hodnoty v tabulce Ize patfi¢né zvyraznit Napriklad v tabulce obratli mGzeme zobrazit
vSechny hodnoty nad priimérem zelenou barvou a pod priimérem ¢ervenou barvou. To umoziuje
podminéné formatovani.

1) Vytvorime tabulku, ve které se vyskytne nékolik réiznych hodnot. Pro nas test miizeme
vytvofit tabulky s libovolnymi nahodnymi Cisly. V jedné z bunék zadame vzorec =RAND()
a ziskame nahodné Cislo mezi 0 a 1. Pokud chceme cela €isla mezi 0 a 50, zadame
vzorec =INT(RAND()*50).

2) Zkopirujeme vzorec a vytvofime fadu nahodnych &isel.

3) Klepneme na pravy dolni roh vybrané buriky a pretdhneme ji doprava a dol(i, dokud neni
vybran poZadovany rozsah bunék.

Definovani styl(i bunék
DalSim krokem je pouZziti stylu buné&k na vSechny hodnoty, které predstavuji nadprdimérny obrat
a jeden na buriky, které jsou pod prlimérem.
1) Klepneme pravym tlaCitkem do prazdné bunky a v mistni nabidce vybereme Forméat
bunky. Otevie se dialogové okno Format bunék.
2) Klepneme na kartu Pozadi, klepneme na tlaCitko Barva a vybereme barvu pozadi, poté
klepneme na OK.

3) Pro otevieni dialogového okna Styl buriky v dialogovém okné Podminéné forméatovani
vybereme Novy styl z rozeviraciho seznamu PouZit styl.

4) Zadame nazev nového stylu. V tomto pfikladu pojmenujeme styl Nad.

5) Definujeme druhy styl, klepneme znovu do prazdné buriky a pokracujeme, jak je popsano
vySe. Prfiradime burice jinou barvu pozadi a pfiftadime ji nazev. V tomto prikladu
pojmenujeme styl Pod.
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Vypocet priméru
V nasem konkrétnim pfikladu pocitame prlimér nadhodnych hodnot. Vysledek je umistén do
bunky:

1) Klepneme do prazdné buriky, napfiklad J14, a pfejdeme v hlavni nabidce na Vlozit >
Funkce, klepneme na ikonu Prlivodce funkci na listé vzorcl nebo zmackneme Ctrl +
F2. Ve vSech pfipadech se otevie dialogové okno Priivodce funkci.

2) Ze seznamu funkci vybereme AVERAGE.
3) Pomoci kurzoru vybereme vSechna nahodna cisla.
4) Klepnutim na OK zavieme Prlivodce funkci.

Pou?Ziti styl bunék
Nyni mdZeme na list pouzit podminéné formatovani:
1) Vybereme vSechny burky obsahujici ndhodna cisla.

2) V hlavni nabidce Format > Podminka > Podminka otevieme dialogové okno
Podminéné formatovani.

3) Definujeme podminku pro kazdou buiiku nasledujicim zptsobem: pokud je hodnota
buniky mensi nez J14, formatujeme se stylem buriky Pod NEBO pokud je hodnota bunky
vétSi nebo rovna J14, formatujeme se stylem burnky Nad.

Skryvani a zobrazovani dat

V programu Calc mlZzeme skryt rlizné prvky tak, Ze nebudou viditelné na obrazovce a ani se
nevytisknou pfi tisku seSitu. Skryté prvky v3ak Ize stale vybrat pro kopirovani, pokud vybereme
prvky kolem nich; napfiklad, pokud je sloupec B skryty, zkopiruje se, kdyZ vybereme sloupce
A a C. KdyZ znovu potfebujeme skryty prvek, miizeme tento proces obratit a prvek zobrazit.

Skryvani dat

Listy
V hlavni nabidce zvolime List > Skryt list nebo klepneme pravym tlacitkem mysi na kartu listu,

kde se ma list skryt, a z mistni nabidky vybereme kryt list. VZdy musi existovat jeden list, ktery
neni skryty.

Réadky a sloupce
1) Vyberte bunku v faddku nebo sloupci, ktery chceme skryt.
2) V hlavni nabidce prejdeme do polozky Format a zvolime Radky nebo Sloupce.
3) Z nabidky zvolime Skryt a fadek nebo sloupec jiZz nelze zobrazit ani vytisknout.

4) Muizeme také klepnout pravym tlacitkem mysi na zahlavi fadku nebo sloupce a z mistni
nabidky vybrat volbu Skryt fadky nebo Skryt sloupce.

Buriky

vvvvvv

a skryté; pak musime zamknout list.

1) Vybereme buriky, které chceme skryt.

2) V hlavni nabidce zvolime Format > Bunky, klepneme pravym tla¢itkem a z mistni
nabidky vybereme Format bunék nebo zméackneme klavesy Ctrl + 1. Otevie se dialogové
okno Forméat bunék (obrazek 60).

3) Klepneme na kartu Ochrana buriky a vybereme moZznost skryti a tisku bunék.
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4) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno.

5) V hlavni nabidce zvolime Nastroje > Uzamknout list nebo klepneme pravym tlaCitkem
a z mistni nabidky vybereme Uzamknout list. Otevie se dialogové okno Uzamknout list
(obrazek 61).

6) V ném zvolime Uzamknout tento list a obsah uzaméenych bunék.
7) Zadame a potvrdime heslo.

8) Vybereme nebo zrusime vybér moznosti v oblasti Povolit vSem uZivatelim listu:, takze
uZivatelé mohou vybrat chrdnéné nebo nechranéné buriky.

9) Klepnutim na tlagitko OK ulozime zmény a zavieme dialogové okno.

Format bunék

Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana buriky

Ochrana
DEKMM@E Uzaméeni buriky se uplatni, pouze je-li aktivni
uzamdceni pfisluiného listu.
[l Zamknuto P

L] Skryt vzorec  Vyberte poloZku 'Uzamknout list’ z nabidky "Nastroje’.

Tisk
L] Skryt pfi tisku ~ Vybrané buriky budou pfi tisku vynechany.

MNapovéda Obnovit oK Zrusit

Obréazek 60: Dialogové okno Format bunék - karta Ochrana buriky

& Poznamka

Skryti Gdajl v buiikadch znamen4, Ze tyto nejsou zobrazeny a Ze chranéné buriky
nelze upravit. Na jejich misté jsou v listu zobrazeny prazdné buriky.
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Uzamknout list

[l Uzamknout tento list a obsah uzaméenych bunék

Heslo:

Potvrdit:

Povolit véem uZivateldm listu;

Vybrat zamdeng buriky
Vybrat odemdéené buriky
VloZit sloupce

VioZit radky

Smazat sloupce

Smazat fadky

OO0 da A

Mapovéda oK Zrusit

Obréazek 61: Dialogové okno Uzamknout list

Zobrazeni dat

Listy

V hlavni nabidce zvolime List > Zobrazit list nebo klepneme pravym tlacitkem mySi na kartu
listu a z mistni nabidky vybereme Zobrazit list. V dialogovém okné Zobrazit list vybereme ze
seznamu list, ktery chceme zobrazit. Pokud neexistuji Zadné skryté listy, moZnost Zobrazit list
se v mistni nabidce neaobjevi.

Réadky a sloupce
1) Vybereme fadky nebo sloupce na kazdé strané skrytého fadku nebo sloupce.

2) V hlavni nabidce prejdeme do polozky Format a zvolime Radky nebo Sloupce.
Z nabidky vybereme Zobrazit a Fadek nebo sloupec se zobrazi a Ize jej vytisknout.

3) Muizeme také klepnout pravym tlacitkem mysi na zahlavi fadku nebo sloupce a z mistni
nabidky zvolit Zobrazit fadky nebo Zobrazit sloupce.
Buriky

1) V hlavni nabidce zvolime Nastroje > Uzamknout list nebo klepneme pravym tlacitkem
a z mistni nabidky vybereme Uzamknout list. Otevfe se dialogové okno Uzamknout list
(obrazek 61).

2) Zadame heslo k odemknuti listu a klepneme na OK.

3) V hlavni nabidce zvolime Format > Buriky, klepneme pravym tlaCitkem a z mistni
nabidky vybereme Format bunék nebo zmackneme klavesy Ctrl + 1. Otevie se
dialogové okno Formét bunék (obrazek 60).

4) Klepneme na kartu Ochrana buriky a v ni zruSime oznaceni moznosti skryti burky.
Klepneme na OK.
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./ Poznamka

Kdyz zamykame list pomoci dialogového okna Uzamknout list, mdZeme nechat pole
pro heslo nevyplnénd. V takovém pripadé se dialogové okno Uzamknout list v kroku
1) vySe nezobrazi a krok 2) neni nutny.

Seskupeni a souhrn

Pokud neustale skryvame a zobrazujeme stejné buriky, miiZzeme vytvofit souhrn naSich dat
a seskupit dohromady fadky nebo sloupce, takZze mizeme skupinu sbalit a skryt ji nebo rozbalit
skupinu tak, aby se zobrazovala, jedinym kliknutim.

Zakladni ovladaci prvky pro seskupeni a souhrn zobrazuji znaménka plus (+) nebo minus (-) na
indikatoru skupiny pro zobrazeni nebo skryti fadkd nebo sloupctd. Pokud jsou v3ak v sobé
skupiny vnoreny, maji zakladni ovladaci prvky Gislovana tlacitka, takze mdzeme skryt riizné
arovné vnofenych skupin.

Seskupeni
Seskupeni fadkd nebo sloupcl:

1) V seSitu vybereme bunky, které chceme seskupit.

2) V hlavni nabidce zvolime Data > Seskupeni a souhrn > Seskupit nebo stiskneme
klavesu F12.

3) V dialogovém okné Seskupit, které se otevie, vybereme bud Radky nebo Sloupce
a klepneme na OK. Vlevo od vSech seskupenych fadkd nebo nad seskupenymi sloupci
se zobrazi ukazatel skupiny. Obrazek 62 ukazuje indikator skupiny vlevo od prvnich dvou
radka tabulky, jez byly seskupeny.

|zl A B c D 3
| 1 | Datum Zameéstnanec Zacatek Konec Hodiny
2 | 01.01.2008 Brigitte 10:15 16:15 6,00
ﬂ 01.01.2008]| Fritz 11:00 16:45 7.00
01.01.2008 Hans 815 19:00 10,00
5 101.01.2008 Kurt 11:15 14:00 2.79
6 |01.01.2008 e 11:00 13:45 2.75

Obrazek 62: Indikator skupiny

Skryti detaill
Chceme-li skryt podrobnosti jakékoliv skupiny fadkd nebo sloupcu:
1) Klepneme na znaménko minus (-) na ukazateli skupiny.

2) Pripadné vybereme buriku ve skupiné a v hlavni nabidce zvolime Data > Seskupeni
a souhrn > Skryt podrobnosti.

3) Radky nebo sloupce jsou skryté a znaménko minus (-) na ukazateli skupiny se zméni na
znaménko plus (+).
Zobrazeni detailti
Zobrazeni podrobnosti o skrytych skupinach, radcich nebo sloupcich:
1) Klepneme na znaménko plus (+) na ukazateli skupiny.

2) Pripadné vybereme buriku ve skupiné a v hlavni nabidce zvolime Data > Seskupeni
a souhrn > Zobrazit podrobnosti.

3) Radky nebo sloupce jsou zobrazeny a znaménko plus (+) na ukazateli skupiny se zméni
na znaménko minus (-).
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Zruseni seskupeni
Zruseni skupiny radkd nebo sloupcl:
1) Ujistime se, Ze jsou zobrazeny seskupené Ffadky nebo sloupce a klepneme do buriky ve
skupiné.
2) V hlavni nabidce zvolime Data > Seskupeni a souhrn > ZruSit skupinu nebo stiskneme
klavesovou zkratku Ctrl + F12.

3) Jsou-li seskupeny pouze radky nebo pouze sloupce, seskupeni se zrusi. Jsou-li
seskupeny fadky i sloupce, vybereme nékterou bud Radky nebo Sloupce, ¢imZ zrusime
seskupeni a klepneme na OK.

Upozornéni

Musi byt zobrazeny v8echny skryté skupiny fadkl nebo sloupctl. Pokud jsou skryté,

budou seskupené Ffadky nebo sloupce odstranény ze seSitu.

Poznamka

Pokud existuji vnofené skupiny, pouze u posledni skupiny fadkd nebo sloupct se
zruSi seskupeni.

Automatické souhrny

Pokud vybrany rozsah bunék obsahuje vzorce nebo odkazy, program Calc miZe automaticky
provést souhrn vybéru. Napfiklad na obrazku 63 buriky pro 1. a 2. Ctvrtleti obsahuji souhrnny
vzorec pro tfi bunky vlevo. Pokud pouzijeme pfikaz Automatické souhrny, jsou sloupce
seskupeny do dvou Ctvrtleti.

Chceme-li pouzit funkci Automatické souhrny, v hlavni nabidce zvolime Data > Seskupeni
a souhrn > Automatické souhrny. Calc pak zkontroluje buriky, které obsahuji vzorce nebo
odkazy, a automaticky seskupi buriky podle potfeby.

A23 — r-_:c : . =
1| |=f ' - " ]
B C D E F | G | H
1 led uno bie 1. étvrileti dub Kvé cyn 2. ctvrtleti
2 100 120 130 350 100 100 200 400
3

Obrazek 63: Priklad automatického souhrnu

Odstrarniovani

Chceme-li odstranit jakékoliv skupiny fadkd nebo sloupcd, v hlavni nabidce zvolime Data >
Seskupeni a souhrn > Odstranit souhrny a vSechny skupiny budou odstranény.

Pro jakoukoliv skupinu bunék nebo radkd, které jsou skryty, je seskupeni z bunék odstranéno
a bunky jsou zobrazeny v seSitu.

Filtrovani

Filtr je seznam podminek, které musi kazda polozZka splfiovat, aby mohla byt zobrazena. Calc
poskytuije tfi typy filtrd:

« Standardni — urCuje logické podminky pro filtrovani dat.

* Automaticky filtr — Filtruje data podle konkrétni hodnoty nebo fetézce. Automaticky
filtruje vybrany rozsah bunék a vytvori jednoradkové seznamy, ve kterych si miizeme
vybrat polozky, které chceme zobrazit.
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Rozsifeny filtr — Pouziva kritéria filtru z ur€enych bunék.

Pou?ziti béZného filtru

MM

a kombinovat je s operatory AND nebo OR. Standardni filtry jsou vétSinou uzitecné pro Cisla,
i kdyZ také pro text Ize pouzit nékolik podminénych operatord.

1)
2)

3)
4)

Vybereme oblast bunék v sesitu.

Dialogové okno Standardni filtr otevieme v hlavni nabidce Data > DalSi filtry >
Standardni filtr (obrazek 64).

Urcime kritéria filtru a moZznosti filtrovani, které chceme pouzit.
Klepnutim na tlacitko OK pouzijeme filtr a zavfeme dialogové okno. Zobrazi se viechny
zaznamy, které odpovidaji zadanym kritériim a moznostem filtru.

Standardni filtr

Kritéria filtru

Operator Mazev pole Podminka Hodnota =
: — N Nt
- Zadné - =
- Zadné - =
- Zadne - = ”
=l MoZnosti
[ Rozlidovat velikost pismen L] Reqularni wyrazy

[ Oblast obsahuje popisky sloupct L] Bez duplikatd
[ Kopirovat vysledky do: Ponechat kritéria filtru

- nedefinovano -

MNapovéda oK Zrusit

Obrazek 64: Dialogové okno Standardni filtr

Pomoci dialogu Standardni filtr definujeme podminky filtru, které se maji zkombinovat, aby se
vytvofila celkova kritéria filtru. Kazda podminka filtru je ur€ena uvedenim typu logického
operétoru, nazvu pole, logické podminky a hodnoty.

Operator — pro nasledujici argumenty si miizeme vybrat mezi logickymi operatory
AND/OR. Pro prvni podminku filtru v seznamu neni zadan zadny logicky operator.
Nazev pole — urCuje nazvy poli aktualni tabulky, které je mozné pouzit v argumentech.
Pokud neni ur€en nazev pole, uvidime identifikator sloupce.

Podminka — ur€uje porovnhavaci operatory, jejichZz prostfednictvim Ize propoijit polozky
v polich Nézev pole a Hodnota.

Hodnota — ur€uje hodnotu pro filtrovani pole. Seznam Hodnota obsahuje vSechny

mozné hodnoty pro zadany nazev pole. Vybereme hodnotu, kterd mé byt pouZita ve filtru,
vcetné polozek Prazdné a Neprazdné.

RozliSovat velikost pismen — pfi filtrovani dat budou rozliSovana velka a mala pismena.
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Oblast obsahuje popisky sloupcti — prvni fadek oblasti bun&k obsahuje popisky
sloupcd.

Kopirovat vysledky do — zaSkrtneme toto pole a poté vybereme oblast bunék, do které
chceme zkopirovat vysledky filtru. Také je mozné ze seznamu vybrat pojmenovanou
oblast.

Regularni vyrazy — vybereme, pokud chceme pfi hledani pouzit regularni vyrazy. Je-li
tato volba vybrana, je mozné v definici filtru v poli Hodnota pouZzit regularni vyrazy, pokud
je v poli Podminka nastaveno “=" (obsahuje) nebo “<>" (neobsahuje). DalSi informace

o regularnich vyrazech nalezneme v €asti ,Regularni vyrazy“ v kapitole 1, Uvod.

Bez duplikatt — vynecha z vysledku filtrovani duplikované radky.

Ponechat kritéria filtru — vybereme Kopirovat vysledky do a poté ur€ime cilovou
oblast, ve které chceme zobrazit filtrovana data. Je-li toto pole zaskrtnuto, cilova oblast je
propojena se zdrojovou oblasti Musime mit definovanu zdrojovou oblast v Data >
Definovat jako databazovou oblast. Definovany filtr miizeme také kdykoli znovu pouzit
klepnutim do zdrojové oblasti a poté zvolime Data > Obnovit oblast.

Pouziti automatického filtru

Funkce Automaticky filtr vioZi pole se seznamem nad jeden &i vice sloupcd a umoziuje vybirat
zaznamy (fadky), které chceme mit zobrazené. Seznam obsahuje vSechny jedine¢né polozky ve
vybranych burikach sefazené do lexikalniho poradi (viz
https://lwww.dictionary.com/browse/lexical-order pro vysvétleni lexikalniho poradi). Automaticky
filtr Ize pouZzit na vice listech bez pfedchoziho definovani databazové oblasti.

1)

2)

3)

4)

Klepneme na oblast bunék v seSitu. Pokud chceme v jednom seSitu pouZit vice
Automatickych filtr(i, musime nejprve definovat databazové oblasti a potom na né pouzit
prislusny filtr.

V hlavni nabidce zvolime Data > Automaticky filtr nebo klepneme na ikonu
Automaticky filtr na nastrojové listé Standardni. Do zahlavi kazdého sloupce

v databazové oblasti je pfidano tlacitko s Sipkou.

Klepneme na Sipku v tom sloupci, kde chceme nastauvit filtr na urCitou hodnotu Ci text
(zobrazeno na obrazku 65).

Vybereme hodnotu Ci text, ktery chceme pouzit jako parametr filtru. Zobrazi se zaznamy,
které odpovidaji zadanym podminkam.
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https://www.dictionary.com/browse/lexical-order

Soubor Upravy Zobrazit VloZit Format Styly List Data Nastroj
B-mw-H D& B X B X AlS-
Arial vl |v| BT UA-7-== =
B5 v fx 2 v = || Kurt
A c | b | E

1 | Datum [+] Zaméstnanec [~] Zagatek [~| Konec [+]| Hodiny [~]
2| 01.01.2008 g, voestupne 15 16:15 6,00
3 01.01.2008 gy sestupne 00 18:45 7.00
4 |01.01.2008 15 19:00 10,00
BER 01.01.2008 | Hernich 10 15 14:00 2,75
6 |01.01.2008 Prézdne 00 13:45 2,75
7 | 02.01.2008 | MNeprazdné 00 18:45 6,00
8 | 02.01.2008  standardnifilr.. 45 13:45 6,00
9 |02.01.2008 30 17:30 8,25
10 |02.01.2008 Hledat proky.. 45 18:30 7.00
11 | 02.01.2008 15 16-00 6,00
12 | 03.01.2008 | Vse X too 1830 8,75
13 | 03.01.2008 00 14:30 5,50
14 |03.01.2008 Mrie 30 18:00 9,75
15 | 03.01.2008 |[AHans 30 17:45 9,50
16 |03.01.2008 Mkur 30 18:30 9,25
17 | 06.01.2008 [Hute 30 17:30 7,25
18 | 06.01.2008 00 14:30 3,50
19 | 06.01.2008 30 16:15 6,00
20 | 06.01.2008 45 15:45 5,00
21 | 06.01.2008 Zasit | (30 15:00 4,50

NT N4 2nang T 1E-418 A TE

Obrazek 65: Priklad automatického filtru

PouZiti pokrocilého filtru

Pokrocily filtr ma strukturu podobnou béznému filtru. Rozdil je v tom, Ze argumenty rozSifeného
filtru nejsou zadany v dialogovém okné. Namisto toho Ize parametry filtru zadat do prazdné
oblasti tabulky a poté pomoci dialogu filtru odkazovat na parametry.

1) Vybereme oblast bunék v sesitu.

2) V hlavni nabidce zvolime Data > DalSi filtry > RozSifeny filtr a otevieme dialogové

okno Rozsifeny filtr (obrazek 66).

3) V Nacist parametry filtru z vybereme pojmenovanou oblast nebo zadame oblast bunék,

ktera obsahuje kritéria filtru, ktera chceme pouzit.

v

4) Klepnutim na tla¢itko OK pouzijeme rozSiteny filtr a zavieme dialogové okno. Zobrazi se
vSechny zaznamy, které odpovidaji zadanym kritériim a moznostem filtru.

ﬁ% Poznamka

Moznosti pro pokrocilé filtrovani jsou stejné jako moznosti pouzivané pro standardni

filtrovani, viz ,Pouziti bézného filtru” na strané 104.
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Rozsireny filtr

Nacist parametry filtru z

- nedefinovano - |~ =]

[ Rozliovat velikost pismen L1 Regularni wrazy
Oblast obsahuje popisky sloupct [ Bez duplikatd

U Kopirovat wysledky do: Ponechat kritéria filtru

- nedefinovano -

Napovéda oK Zrusit

Obréazek 66: Dialogové okno Rozsireny filtr

Priklad pokrocilého filtru nalezneme na strance napovédy nazvané ,Filtr: PouZiti pokrocilych
filtrd“.

Razeni zaznamu

Nastroj pro fazeni v programu Calc usporada buriky v listé podle zadanych kritérii. MiZzeme
zadat najednou vice kritérii, ktera se nasledné pouZziji v urCeném poradi. Razeni je uziteCné, kdyz

N e

Kromé toho je sefazeni Casto uziteCné pfi pfidavani novych dat do seSitu. KdyzZ je list dlouhy, je
obvykle jednodussi pridat nové Udaje dospod listu namisto toho, abychom pfidavali nové fadky
pfimo na spravna mista. Po pfidani novych dat mizeme list aktualizovat sefazenim.

Dialogové okno Radit
Pokud chceme sefadit buriky v sesité, pouZijeme dialogové okno Radit:

1) Vybereme buriky, fadky nebo sloupce, které chceme fadit.

2) V hlavni nabidce zvolime Data > Radit nebo klepneme na ikonu Radit na standardni
nastrojové listé. V obou pripadech se otevie dialogové okno Radit.

3) Na karté MoZnosti (obradzek 67) vybereme moznosti véetné toho, zda se maji fadit Fadky
nebo sloupce. Detaily viz ,MoZnosti fazeni” na strané 109.

4) Na karté Seradit podle (obrazek 68) vybereme z rozeviraciho seznamu kritéria. PoloZky
této nabidky zaviseji na vybranych bunkach.

5) Vybereme bud pofadi Vzestupné (A-Z, 0-9) nebo poradi Sestupné (Z-A, 9-0).
6) Klepneme na OK. Data se v seSité sefadi.

./ Poznamka
Pokud jsou nékteré buriky, které chceme fadit, chranény a list je chranén, nemdze
Calc tyto bunky upravit a fazeni nebude provedeno. Zobrazi se chybova zprava

oznacujici, ze chranéné bunky nelze zménit. Je vSak mozné fadit oblast obsahujici
fadu Stitk( sloupcd, které jsou chranény, protoZe tyto nejsou fazenim zménény.
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Sefadit podle MoZnosti

MozZnosti Fazeni

[0 Rozlisovat velikost pismen:

Oblast obsahuje popisky sloupcl

Zahrnout formatovani

L] Povolit pfirozené fazeni

[ Zahrnout okrajové sloupce obsahujici pouze komentafe
[] Zahrnout okrajové sloupce obsahujici pouze obrazky

[ Kopirovat vysledky fazeni do:

- nedefinovano - ~

LI Vlastni pofadi fazeni

Po,Ut,5t,5t,Pi,So,Ne

lazyk

Vychozi - Ceitina v

Smeér

® Shora dold (sefadit Fadky)
() Zleva doprava (sefadit sloupce)

MNapovéda Obnovit OK Zrusit

Obréazek 67: Dialogové okno Radit — karta MoZnosti

Sefadit podle MoZnosti
Kli€ fazeni 1
® Vzestupné
() Sestupné
Kli€ fazeni 2
— ® Vzestupné
|— nedefinovano - ~ ‘
() Sestupneé
Kli€ Fazeni 3
: i Vzestupne
|— nedefinovano - ~ -
sestupne
Napovéda Obnovit OK Lrusit

Obréazek 68: Dialogové okno Radit — karta Sefadit podle
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MoZnosti fazeni
Na strance Moznosti v dialogovém okné Radit (obrazek 67) mizeme nastavit tyto moznosti:

* RozliSovat velikost pismen — tfidi se nejprve velkymi pismeny a potom malymi
pismeny. Pro asijské jazyky plati specialni pravidla.

Poznamka

Pokud u asijskych jazyk( zaskrtneme RozliSovat velikost pismen, je mozné pouZzit
vicelrovinové fazeni. Pri vicelroviiovém fazeni se polozky nejprve porovnavaji
podle svych primitivnich tvar(i bez ohledu na velikost pismen a diakritiku. Pokud jsou
vyhodnoceny jako stejné, pro druhou Uroven se porovnavaji i s diakritikou. Pokud
jsou i tehdy vyhodnoceny jako stejné, porovnava se ve treti Grovni velikost pismen,
Sitka znakl a japonské znaky Kana.

« Oblast obsahuje popisky sloupct/fadkt — pfi fazeni vynecha prvni sloupec/fadek.
Nastaveni Smér ve spodni ¢asti dialogového okna definuje nazev a funkci tohoto
zaskrtavaciho poli¢ka: pokud je to shora dolll, pak popisy sloupcl; pokud zleva doprava,
pak popisy fadka.

+ Zahrnout formatovani — zachova aktualni forméatovani buriky.

* Povolit pfirozené fazeni — pfirozené tfidéni je algoritmus tfidéni, ktery namisto
tradi¢niho zpUsobu tfidéni jako obycejnych fetézcl tfidi Eisla s pfedponou fetézce na
zakladé hodnoty numerického prvku v kazdém sefazeném cisle. Pfedpokladejme
napriklad, ze mame fadu hodnot, napfiklad Al, A2, A3, A4, A5, A6,..., A19, A20, A21.
KdyZ tyto hodnoty vioZime do Ffady bunék a spustime fazeni, vysledkem je Al, Al1l, A12,
Al3, ..., A19, A2, A20, A21, A3, A4, A5, ..., A9. Pfi zvoleném pfirozeném fazeni jsou
takové hodnoty spravné sefazeny.

* Zahrnout okrajové sloupce obsahujici pouze komentafre — udrzuje tyto buriky spojené
s tfidénymi burikami.

« Zahrnout okrajové sloupce obsahujici pouze obrazky — udrZuje tyto burky spojené
s tfidénymi burikami.

» Kopirovat vysledky fazeni do — zkopiruje sefazeny seznam do uréené oblasti bunék.

Vybereme pojmenovanou oblast bunék, do které chceme zobrazit sefazeny seznam,
nebo zadame do pole oblast bunék.

* Vlastni poradi Fazeni — vybereme tuto moznost a poté vybereme vlastni pofradi fazeni,
které chceme pouzit. Dostupné vybéry jsou definovany jako ,fazené seznamy*
v Nastroje > MoZnosti > LibreOffice Calc > Razené seznamy. Viz ,Definovani
posloupnosti” na strané 71.

« Jazyk — vybereme jazyk pro pravidla fazeni.

* MozZnosti — vybereme moZnost tfidéni pro jazyk. Pro mnoho jazyk je tento vybér
zaSedly, ale pro nékteré jazyky jsou k dispozici moznosti. Napfiklad pro némcinu je
vychozi hodnota Alfanumericky, ale miZzeme také vybrat moznost Telefonni seznam,
coz zahrne do tfidéni zvlaStni znak prehlasky.

« Shora dolt (sefadit Fadky) — sefadi radky podle hodnot v aktivnich sloupcich vybrané
oblasti.

+ Zleva doprava (sefadit sloupce) — sefadi sloupce podle hodnot v aktivnich fadcich
vybrané oblasti.

Rychlé fazeni

Pokud maiji sloupce v sesitu zahlavi s textovym formatem, miizeme pouzit rychlé fazeni.
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1) Vybereme buriku nebo oblast bunék, které se maji radit.

2) V hlavni nabidce vybereme Data > Radit vzestupné nebo Data > Radit sestupné nebo
klepneme na ikonu Radit vzestupné nebo Radit sestupné na standardni nastrojové
listé.

Najit a nahradit

Program Calc ma dva zpUsoby, jak najit text v dokumentu: nastrojovou listu Najit a dialogové
okno Najit a Nahradit. Nastrojova liSta je rychla a snadno pouzitelnd, ale jeji funkce jsou

> s

omezenegjsi nez pouzivani dialogového okna.

Nastrojova liSta Najit

Najit w X
lajit “ Najit vée []Zobrazeny fetézec[ ] Rozlisovat velikost | (]
Obrazek 69: Nastrojova lista Najit
1) V hlavni nabidce zvolime Zobrazit > Nastrojové listy > Najit nebo Upravy > Najit, nebo
pouzijeme klavesovou zkratku Ctrl + F. Zobrazi se nastrojova liSta Najit (obrazek 69). Ve

vychozim nastaveni je tato nastrojova liSta ukotvena v levé dolni ¢asti okna Calc.
Nastrojovou listu miZzeme presunout.

2) Do textového pole Najit zadame hledany vyraz.

3) Upresnit vyhledavani mizeme vybérem volby RozliSovat velikost. Pokud je napfiklad
hledany vyraz Vlastnik, vybér volby RozliSovat velikost najde Viastnik, ale ne viastnik.
MUGzeme také vybrat moznosti Najit vSe nebo Zobrazeny fetézec.

4) Klepneme na ikonu Najit dalSi nebo Najit pfedchozi. Nalezeni dalSiho vyskytu terminu
se provede opétovnym klepnutim na ikonu.

Dialog najit a nahradit

Pro otevfeni dialogového okna Najit a nahradit (obrazek 70) zvolime v hlavni nabidce Upravy >
Najit a nahradit, pouzijeme klavesovou zkratku Ctrl + H nebo klepneme na ikonu Nayjit
a nahradit na nastrojové listé Standardni.

Hledani
1) V dialogovém okné Najit a nahradit (obrazek 70) zadame do pole Najit kritéria hledani.
2) Vybereme zakladni moznosti z moznosti umisténych pfimo pod polem Najit.
3) Pro zvy3eni poctu vyhledavacich filtr(i klepneme na Ostatni moZnosti.
4) Klepnutim na Najit dalSi najdeme prvni instanci vyhledavacich kritérii.

5) Opétovnym klepnutim na Najit dalSi najdeme dalSi instanci vyhledavacich kritérii.
Opakujeme podle potfeby.

6) Mulzeme také klepnout na Najit vSe a najdeme vSechny buriky obsahujici vyhledavaci
kritéria. Tyto buriky budou v seSité zvyraznény. Zobrazi se dialogové okno Vysledky
hledani se seznamem umisténi bunék.

Nahrazovani
1) V dialogovém okné Najit a nahradit (obrazek 70) zadame do pole Najit kritéria hledani.
2) Vybereme zakladni moZnosti z moznosti umisténych pfimo pod polem Najit.
3) Text pro nahrazeni hledaného textu zadame do pole Nahradit.
4) Pro zvySeni poctu vyhledavacich filtr(i klepneme na Ostatni moZnosti.
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5)
6)
7)

8)
9)

Chceme-li prochazet burikami a zvolit, zda chceme nahradit obsah:
Klepnutim na Najit dalSi najdeme prvni instanci vyhledavacich kritérii.

V pripadé potfeby klepneme na Nahradit,cimZ nahradime kritéria vyhledavani obsahem
pole Nahradit.
Opakujeme podle potfeby.

Chceme-li vyhledat a nahradit vSechny vyskyty kritérii vyhledavani bez zastaveni
u kazdého z nich, klepneme na Nahradit vSe. Zobrazi se dialogové okno Vysledky
hledani se seznamem nalezenych bunék.

o Tip

Chceme-li nahradit prvni instanci vyhledavacich kritérii, miZzeme jednoduse
stisknout Nahradit bez prvniho stisknuti Najdi dalsi.

Upozornéni

Nahradit v§e pouZivejme s opatrnosti; v opacném pfipadé mizeme skonéit s trochu
trapnymi chybami. Chyby, které vzniknou nespravnym pouzitim funkce Nahradit
vse, je Castokrat nutné rucné opravovat slovo za slovem, pokud se dostaneme do
stavu, Ze zmény jiz nejdou vratit zpét.

Majit a nahradit

Najit: ]
[ Rozlitovat velikost ¥ Zobrazeny fetézec [ Celé buriky [ Vsechny listy

Nahradit: ™

Majit vse Majit pfedchozi Najit dalsr Mahradit Nahradit vie

[=I Ostatni moZnosti:

[ Pouze v souéasném vybéru [1 Nahradit pozpatku
Zastupné znaky Styly buriky
Regularni vyrazy [ Porovnat 3itku znaku
Hledani podobnosti Podobnosti... | [1Zni jako (japonitina) Zni jako...
L1 Rozlisovat diakritiku [ Rozlisovat kasidu
Smér. @ Radky (O Sloupge Hledat v:
Napovéda Zavrit

Obréazek 70: Dialogové okno Najit a nahradit

MozZnosti hledani a nahrazovani
Moznosti upfesnéni hledani a nahrazeni jsou nasledujici:

Najit — zadame text, ktery chceme vyhledat nebo jej vybereme ze seznamu.
RozliSovat velikost — rozliSuje mezi velkymi a malymi znaky.

98 | Prirucka Calc 7.0



* Zobrazeny fetézec — hleda obsah burky v urcitém formatu. Pokud ma napfiklad burika
hodnotu mény, feknéme 123,45 $ a jind ma stejny obsah, ale vychozi formatovani
(123,45), pak hledanim ,123,45%" se najde burika s formatem meény, ale ne burnka
s vychozim formatem.

* Celé bunky — hleda buriky s obsahem, ktery je identicky s hledanym textem.
* VSechny listy — prohledavéa vSechny listy v aktualnim sesitu.

* Nahradit — zadame nebo vybereme ze seznamu text Ci styl pro nahrazeni.

* Pouze v sou€asném vybéru — prohledava pouze vybrany text nebo bunky.

* Nahradit pozpatku — vyhledavani za€ina na aktualni pozici kurzoru a pokracuje zpét na
zaCatek souboru.

« Zastupné znaky — vybereme, pokud chceme pfi hledani pouZit zastupné znaky.
Zastupny znak je specialni znak, ktery zastupuje jeden nebo vice blize neurenych
znakl. Vyhledavani s vyuZzitim zastupnych znakl je vykonné, ¢asto je vSak méné
konkrétni. K dispozici jsou nasledujici zastupné znaky:

— ? (otaznik) odpovida jakémukoliv jedinému znaku. Napfiklad b?g najde “bag”, “beg”,
“big”, “bog” a “bug”.
— * (hvézdicka) odpovida jakékoliv posloupnosti znakll véetné prazdného fetézce

Napriklad *cast najde “cast”, “forecast” a “outcast”.

— ~ (vlnovka) rusi platnost otazniku, hvézdic¢ky nebo vinovky, ktera za ni bezprostfedné
nasleduje Napfiklad why~? najde “why?”.

* Regularni vyrazy — vybereme, pokud chceme pfi hledani pouzit zastupné znaky.
Regularni vyrazy nabizeji vykonné metody hledani textovych fetézcl. Dalsi informace
o reguléarnich vyrazech nalezneme v Casti ,Regularni vyrazy“ v kapitole 1, Uvod.

» Hledani podobnosti — hleda vyrazy podobné textu v poli Najit. Zvolime tuto volbu a poté
klepneme na tlaCitko Podobnosti, kde ur¢ime v dialogovém okné Hledani podobnosti
upresnujici volby.

» Styly bunky — vyhleda obsah burky formatovany podle uréeného stylu. Vybereme tuto
moznost a poté vybereme styl ze seznamu Najit. Ke specifikaci stylu nahrazeni
vybereme styl ze seznamu Nahradit.

* RozliSovat diakritiku — do vyhledavani zahrne diakritiku.
«  Smér — urtuje pofadi prohledavani bunék — Radky nebo Sloupce.

* Hledat v — vybereme Vzorce, Hodnoty nebo Komentare. Vyhledavani pak bude
probihat bud' ve vzorcich, hodnotach ¢i komentafich.

DalSi moznosti se mohou liSit podle nastaveni naSeho jazyka na strance Nastroje > Moznosti >
Jazykova nastaveni > Jazyky (napfiklad Porovnat Sifku znaku, Zni jako (japonstina) (pouze
jsou-li povoleny asijské jazyky), Citlivy na Kashida). DalSi informace o téchto moznostech

nalezneme v napovede.

Poznamka

Volby Zastupné znaky, Regularni vyrazy a Hledani podobnosti se vzajemné
vyluCuiji; Ize vybrat pouze jednu volbu.

Dialogové okno Vysledky vyhledavani

P¥i vychozim chovani programu Calc se po vybéru Najit vSe, Najit vSe a Nahradit vSe
v dialogovém okné Najit a nahradit, je zobrazit dialogové okno Vysledky vyhledavani (obrazek
71). Tento dialog shrnuje vysledky. Kromeé toho jsou nalezené buiky v seSitu zvyraznény.
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Dialogové okno Vysledky hledani obsahuje seznam nalezenych bunék a jejich aktualni obsah
(po jakémkoliv nahrazeni). Uvadi také pocet nalezenych bunék. Pokud zruSime vybér zaskrtnuti
u pole Zobrazovat toto dialogové okno v dialogovém okné Vysledky vyhledavani pred
stisknutim tlacitka Zavfit, dialog se v budoucnosti po zmacknuti Najit vSe nebo Nahradit vSe
nezobrazi. Zobrazeni dialogového okna Vysledky vyhledavani Ize také ovladat povolenim nebo
zakazanim volby Nastroje > Moznosti > LibreOffice Calc > Zobrazeni > Okno > Shrnuti
vyhledavani.

Vysledky vyhledavani

List Buika  |Obsah

Seznam Pr $E$2 Hans ~
Seznam Pr $ES10 Hans

Seznam Pr $E$11 Hans

Seznam Pr $ES14 Hans
Seznam Pr $ES16 Hans
Seznam Pr $E$20 Hans
Seznam Pr $E$22 Hans
Seznam Pr $E$29 Hans
Seznam Pr $ES30 Hans
Seznam Pr $E$36 Hans
Seznam Pr $E$69 Hans
Seznam Pr SE$79 Hans
Seznam Pr $E$94 Hans
Seznam Pr $E$98 Hans
Seznam Pr $E$103 Hans A

Malezeno 24 vysledkl

Zobrazovat toto dialogové okno Zavfit

Obréazek 71: Dialogové okno Vysledky
vyhledavani
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j LibreOffice

Priivodce programem Calc

Kapitola 3
Tvorba graft

Vizualni prezentace informaci



Uvod

Grafy mohou byt G¢innym zptsobem pro zprostifedkovani informaci. Program Calc nabizi fadu
zpUsobl, jak data prezentovat. Grafy mohou byt do zna¢né miry pfizplisobeny, coz umoziuje
zobrazovat informace nejjasnéjSim zplsobem.

Pro Ctenare, ktefi se zajimaji o efektivni zplsoby grafické prezentace informaci, existuji dvé
vynikajici knihy k tomuto tématu: William S. Cleveland’'s The Elements of Graphing Data, 2nd
edition, Hobart Press (1994) a Edward R. Tufte’s The Visual Display of Quantitative Information,
2nd edition, Graphics Press (2001).

Privodce grafy

Pomoci Prlivodce grafy vytvofime z dat v seSitu Uvodni graf. Poté pomoci moznosti Priivodce
grafem zménime typ grafu, upravime oblasti dat a upravime nékteré prvky grafu. Kazda
provedena zména je okamzité v grafu viditelna.

Prehled Privodce grafem

A B | c | D |
1 Pronajem vybaveni
2 Kanoe Cluny Motorové
3 |led 12 23 47
4 |ano 9 31 54
5 |bre 14 27 56
6 |dub 17 28 48
7 |kvé 13 19 39
8 |[&vn 8 27 52

Obréazek 72: Priklad dat pro vytvofeni grafu

Pokud chceme ukazat proces pouziti Privodce grafy k vytvareni grafd, pouzijeme data z obrazku
72 i v nasledujicich ¢astech. Zde je prehled zakladnich krokd:

10) Vybereme buiiky obsahujici v§echna data (véetné nazvd, kategorii a popiskd), které maji
byt zobrazeny v grafu. Vybér mize byt jeden blok, jednotlivé buriky nebo skupiny bunék
(sloupce nebo fadky). V tomto pfikladu mlZze byt nejlepsi varianta vybrat oblast bunék
A2:D8, kterd zamérné vynechava z grafu celkovy nazev "Plj¢ovna vybaveni".

6 Tip

Pokud jsou data v jedné oblasti, Prlivodce grafem mize odhadnout rozsah a vytvorit
pocatecni graf i tehdy, kdyz nejsou vybrana vSechna data. Pfed otevienim Prlivodce
grafem staci umistit kurzor nebo vybrat buriku kdekoli v oblasti dat.

11) Provedeme jeden z nasledujicich krokl. To zplsobi, Ze graf bude umistén do sesitu jako
objekt (obrazek 73) a otevie se dialogové okno Privodce grafem (obrazek 74).

— V hlavni nabidce zvolime Vlozit > Graf.
— Klepneme na ikonu Vlozit graf na standardni nastrojové listé.
12) Vybereme typ grafu a nastavime dalSi poZadované volby. MoZnosti jsou vysvétleny nize.
13) Klepneme na tlacitko Dokon¢it, ulozime vybér a zavieme Privodce grafem.
Nasledujici ¢asti obsahuiji dalsi podrobnosti o pouziti Priivodce grafem.

102 | Pfirucka Calc 7.0



60
50

40
B Kanoe

® Cluny
‘ ‘ ‘ i J o

led uno bfe dub kvé &un

Obréazek 73: Priklad grafu vytvoreného automaticky pomoci
Priivodce grafy
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Vybér typu grafu

Program Calc nabizi vybér z deseti zakladnich typl grafdl. DalSi moZnosti se lisi podle typu
vybraného grafu. Dal$i informace o rliznych typech grafli nalezneme v ¢asti ,Galerie typ( grafd"
na strané 188.

Privodce grafy

Zvolte typ grafu

I Sloupcovy

Radkowy I
1. Typ grafu e ii‘ ?W, . [ | I n
VyseCovy %
2.0blast dat ]

L Plogny
3. Datové fady L~ Carovy

4. Prvky grafu |- XY (bodowy)

|- Bublinowy (03D vzhled
1 Paprskovy Tvar
[ Burzovni

lie Sloupcovy s €arami

Valec

Kuze

Jehlan

Napovéda < /pét Dalsi = Dokoncit Zrusit

Obrazek 74: Dialogové okno Priivodce grafem — vybér typu grafu

Uvodni graf vytvofeny pomoci Privodce grafem je 2D sloupcovy graf. Maly nahled zvolené
varianty grafu je zvyraznén rameckem, jak je uvedeno na obrazku 74. Nazev varianty (BéZny na
obrazku 74) se zobrazi pod nahledem.

Zména typl a moznosti grafu:

1) Vybereme typ grafu ze seznamu pod oznacenim Zvolte typ grafu.

2) V pripadé potfeby vybereme variantu grafu klepnutim v ¢asti nahledu. Dostupné moznosti
zavisi na vybraném typu grafu. Graf se zmeéni tak, aby odrézel vybrany typ grafu.
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3) Pokud chceme pouzit 3D graf, zaskrtneme policko 3D vzhled a vybereme typ 3D
zobrazeni (Realisticky nebo Jednoduchy. Tato moznost je k dispozici pouze pro grafy
sloupcové, radkové, vysecoveé nebo plosné.

4) Klepneme na tlacitko Dal$i a provedeme zmény v oblasti dat, datovych fad a prvkl grafu
(podrobnéji je vysvétleno déle v textu).

5) Pokud jsme s grafem spokojeni, klepneme na tlacitko Dokongéit a zavieme Privodce
grafem.
./ Poznamka

Pokud chceme znovu vytvofit grafy zobrazené v nasledujicich ¢astech, vybereme
typ grafu Sloupcovy, variantu Bézny a nezaskrtnutou volbu 3D vzhled.

Vybér oblasti dat

Oblast dat obsahuje vSechny buriky s daty (véetné popiskl a kategorii), které by mély byt
zahrnuty do grafu. V kroku Oblast dat v Priivodci grafem (obrazek 75) ruéné opravime vSechny
chyby ve vybéru dat pro graf.

Pravodce grafy

Zvolte oblast dat
Kroky

Oblast dat: |3'Podklady pro grafy’.3A52:3D%8 =
1.Typ grafu () Datové fady v fadcich

> Oblast dat ® Datové fady ve sloupcich:
Prvni fadek jako popisek

3.Datove fady

4. Prvky grafu
Obréazek 75: Dialogové okno Priivodce grafem — vybér oblasti dat

Prvni sloupec jako popisek

Pouziti stranky Oblast dat:

1) V pripadé potfeby zménime fadky a sloupce pouZité jako zdroje dat pro graf pomoci
Upravy odkazu na buriky v textovém poli Oblast dat Odkazy na buriky upravime jednim z
téchto dvou zpUsobu:

— PFimo upravime text v textovém poli Oblast dat.

— Klepneme na tlacCitko Vyberte oblast dat vpravo od pole Oblast dat. Potom pomoci
kurzoru vybereme oblast(i) dat v tabulce.

2) Urcime, zda jsou datové fady uspofadany v fadcich nebo ve sloupcich. V ukazkovych
datech, zobrazenych na obrazku 72, jsou datové fady ve sloupcich.

3) Vybereme, zda chceme jako popisky pouzit data v prvnim fadku nebo v prvnim sloupci
nebo v obou.

4) Klepneme na tlacitko DalSi > a pfesuneme se na provedeni zmén v datovych fadach
(obrazek 76).

5) Pokud jsme s grafem spokojeni, klepneme na tlacitko Dokon¢éit a zavieme Priivodce
grafem.
"/ Poznamka

Pokud neni syntaxe oblasti dat v porfadku, program Calc zobrazi textové okno Oblast
dat pro informaci o chybé a deaktivuje tlaCitka < Zpét, DalSi > a Dokondit.
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Vybér nesouvislé oblasti dat

Pokud chceme vytvofrit Gplny rozsah dat z vice bunék, které nejsou vedle sebe, pouzijeme
oddélovac mezi jednotlivymi rozsahy. Napfiklad anglické narodni prostfedi (USA) pouziva Carku
jako oddélovac a zapis "$Sheetl.A1:A5,$Sheet1.D1:D5" je platn& oblast dat. DalSi béZzné
pouzivany oddélovac je stfednik.

Prislusny oddélovac zavisi na zvolené moznosti v nabidce Narodni prostfedi v ¢asti Formaty v
Nastroje > MoZnosti > Jazykové nastaveni > Jazyky. Podivat se nebo zméni vychozi
oddélovac pro narodni prostfedi mizeme v nabidce Nastroje > MoZnosti > LibreOffice Calc >
Vzorec. V Casti Oddélovace, v poli Sloupce matice je zobrazen vychozi oddélovac.

Poznamka

Volba Nastroje > Moznosti nemusi byt dostupna, pokud je graf v rezimu Uprav. V
pfipadé potfeby klepneme mimo graf, abychom opustili rezim Uprav a zobrazime
volbu moznosti. Dvojitym klepnutim na graf vstoupime zpét do moédu editace grafu.

Chceme-li vybrat nesouvislou oblast dat, provedeme v kroku 1) jednu z nasledujicich moznosti:

* Ruc¢né zadame do textového pole rozsahy dat s oddélovacem (oddélovaci) mezi nimi.

* Vybereme data klepnutim na tlacitko Vyberte oblast dat, které se nachazi vpravo od
pole Oblast dat. Umistime kurzor do textového pole na konec prvniho rozsahu dat (v
opacném pfipadé je vybran prvni rozsah a poté odstranén) a zadame oddélovac. Poté
pretdhneme kurzor v tabulce a vybereme dalSi rozsah dat.

Poznamka

Pokud jsou data ve stejném dokumentu jako graf, zmény dat se okamzZité projevi v
grafu.

Propojeni s externimi daty

Aplikace Calc nabizi nékolik moznosti propojeni dat s externimi zdroji. To umozZziiuje, aby se data
(a graf pouzivajici data) automaticky aktualizovala pfi zméné externich dat. Propoijit Ize
nasledujici typy soubor(: HTML, Calc, Base, CSV, Excel a registrované zdroje dat. DalSi
informace nalezneme v kapitole 10, Propojeni dat, v této prirucce.

Vybér datovych fad

Stranka Datové fady v Prdvodci grafem (obrazek 76) umoziiuje jemné doladéni dat. Kazda
datova fada obsahuje sadu dat, kterd maji néco spolecného (jako napfiklad typy ndjemnich
zarizeni uvedenych na obrazku 72). Pomoci stranky Datové fady mizeme zménit zdrojovou
oblast kazdé datové Ffady a uspofadat jejich zobrazeni v grafu. To zahrnuje odstranéni
nepotfebnych dat a urCeni, jak jsou data vykreslena podél os.

Usporadani datovych rad

6 Tip

Privodce grafem odhadne zobrazeni dat, ale tento odhad m(iZe byt nespravny.
Pokud graf nevypada podle oCekavani, je nejprve tfeba zkontrolovat, zda jsou
vSechny datové fady definovany spravné.

Zkontrolujeme také nastaveni na strance Oblast dat, kde je definovano, jestli jsou
data v fadcich nebo ve sloupcich a jestli prvni fadek nebo sloupec obsahuje popisky.
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Nazvy jednotlivych datovych fad jsou uvedeny v seznamu Datové rady (prostfedni rAmecek na
obrazku 76). Pokud chceme usporadat datové fady, vybereme polozku v seznamu Datové Ffady a
provedeme jednu nebo vice z nasledujicich akci:

* Pokud chceme zménit nazev datové fady, vybereme poloZku Nazev v seznamu Oblasti
dat na pravé strané. Upravime odkaz na bunky, ktery se objevi v textovém poli Oblast
pro Nazev.

* Pokud chceme zménit odkazy na bunky pro kategorie datovych fad, upravime odkazy na
bunky v textovém poli Kategorie, které se nachazi pod polem Oblasti dat.

* Klepnutim na tlagitko PFidat pfidame dalSi datovou fadu, ktera se vlozi pod vybranou
poloZku. Poté bude nutné definovat oblasti dat pro novou datovou fadu.

* Klepnutim na tlaitko Odebrat odebereme vybranou poloZzku ze seznamu Datové fady.

e Klepnutim na tlagitko Nahoru nebo Dol presuneme vybranou polozku nahoru nebo
dold v seznamu Datové Fady. Tim se nezméni poradi dat ve zdrojové tabulce dat, ale
zméni se pouze usporadani dat v grafu.

@ Poznamka

Rdzné datové fady musi byt v samostatnych sloupcich nebo fadcich. Jinak bude
aplikace Calc prfedpokladat, ze se jedna o stejné datové rady.

Nastaveni rozsaht datovych Fad

Abychom pochopili, jak aplikace Calc zpracovava data v grafech, je dilezité porozumét rozdilu
mezi hodnotami a kategoriemi. Hodnoty jsou Ciselna data, ktera se méni prlibézné. Naproti tomu
kategorie nemaji mezi sebou zadné matematické vztahy. Napfiklad kategorie dat uvedené na
obrazku 76 a graf vyobrazeny na obradzku 73 jsou mésice roku.

Vétsina grafd aplikace Calc vyZzaduje data hodnot i kategorii, pficemZ hodnoty jsou vyneseny
podél osy Y a kategorie podél osy X. Vyjimkou jsou XY (bodové) grafy a bublinové grafy, které
pouzivaji pouze data hodnot podél obou os.

Privodce grafy X
Datové rady: Oblasti dat:
Kroky i
Barva ohraniceni
1.Typ grafu Motorove Ba'n.ra vypiné ) '
Nazev $'Pronajem vybaveni®$C$2
2.0blast dat Hodnoty Y $'Pronajem vybaveni” $C$3:3C%8
4. Prvky grafu Oblast pro Barva ohraniceni
=
Kategorie
=
Pridat
Odebrat = ¥
Upravte oblasti dat pro jednotlivé datové rady
MNapovéda < /pét Dalai = Dokondcit Lrusit

Obrazek 76: Dialogové okno Privodce grafem - vybér datovych rad
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Oblasti dat, které mohou byt definovany pro konkrétni typ grafu, se zobrazuji v poli Oblasti dat na
pravé strané stranky Datové fady, viz obrazek 76. MoZné nebude nutné vyplnit vS8echny oblasti
dat.

Oblasti dat mohou obsahovat:

Barva ohraniceni a Barva vypiné
Barvy ohrani¢eni nebo vyplné pro kazdy datovy bod v datové fadé Ize zadat zde pomoci
Ciselnych hodnot pro systém barev RGBA. Pokud zde neni nic uvedeno, pouZije aplikace
Calc vychozi barvy. Lze také pouzit podminéné formatovani. To umoznuje ménit barvy
datovych bodi v zAvislosti na tom, zda splfiuji uréité podminky nebo nabyvaji uréitych
hodnot. Vice informaci nalezneme v ¢asti ,Pfifazeni barev" na strané 148.

Néazev
Pokud na strance Oblast dat jsou oznaCeny volby Datové Fady ve sloupcich a Prvni
fadek jako popisek, aplikace Calc predpoklada, Ze popisky sloupct vybranych dat jsou
nazvy datovych fad. Aplikace Calc tedy predpoklada, Ze nazvy datovych fad na obrazku 72
jsou “Kanoe”, “Cluny”, and “Motory”. Podobné& pokud jsou vybrany volby Datové fady v
fadcich a Prvni sloupec jako popisek, aplikace Calc predpoklada, Ze popisky fadkd
vybranych dat jsou nazvy datovych fad.

Jediny zpUsob, jak zménit ndzev datové fady, je vybrat Nazev v poli Oblasti dat vpravo
nahore na strance Datové fady (obrazek 76). Poté zadame do pole Oblast pro Nazev, které
se objevi pod polem Oblasti dat, jinou oblast bunék. (Za povSimnuti stoji fakt, ze nazev
datové fady je Casto obsaZen v jedné burice, nikoliv rozsahu bunék.)

Hodnoty Y
Jednd se o Ciselné hodnoty, které jsou Casto vykresleny podél svislé osy. Ne vzdy to tak
v8ak musi byt. Napfiklad, zatimco hodnoty Y jsou vykresleny na svislé ose ve sloupcovych
grafech, tak v fadkovych grafech jsou vykresleny podél vodorovné osy.

Kategorie
Rozsah dat pro kategorie je definovan zvlast v poli Kategorie pod Casti Oblasti dat. Za
povSimnuti stoji rozdil mezi kategoriemi a nazvy datovych fad. Pro Udaje na obrazku 72,
kategorie jsou popisky fadku, zatimco nazvy datovych fad jsou popisky sloupct.

Poznamka

XY (bodové) a bublinové grafy se od jinych typ( grafd lisi, protoZe pouzivaji pro své
osy X spiSe hodnoty nez kategorie. Pro XY (bodové) a bublinové grafy plati, Ze
stranka Datové rady v Prlivodci grafem obsahuje pole Popisky dat na misto pole
Kategorie, které je zobrazeno pro jiné typy grafli. Pro vytvofeni mnoziny popiskd dat
(jeden pro kazdy datovy bod) zadame poZzadované textové fetézce do oblasti bunék
a nasledné zadame popisy této oblasti bunék do pole Popisky dat. Popisky mohou
byt zobrazeny v grafu pomoci vybéru moznosti Zobrazit kategorii v dialogovém
okné Popisky dat (viz obrazky 106 a 107).

V zavislosti na typu grafu bude mozna nutné definovat dalSi rozsahy dat kromé téch, které jsou
uvedeny na obrazku 76.
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Vybér prvkt grafu

Pravodce grafy

MNastavte popisy, legendu a mfiZky
Kroky

Nadpis Zobrazit legendu
1.Typ grafu Podnadpis L Vlevo
2.Oblast dat g
.Oblast da e
2D 4 a8 (2 Mahofe
.Datové fa
/ Osa¥ 2 Dole
4.Prvky grafu _q
- Osa Z

Zobrazit mfizky
Ll 0sa X Osa Y Osa Z

LA

Napaovéda < /pét Dalsi = Dokoncit Zrusit

Obrazek 77: Dialogové okno Priivodce grafem — vybér a zména prvki grafu

Na strance Prvky grafu v dialogovém okné Priivodce grafem (obrazek 77), pfidame nebo
zménime nadpis, podnadpis, ndzvy os a mfizky. Pouzivejme nadpisy, které upoutaji pozornost
divakl na ucel grafu a popisuiji, na co by se méli divaci zaméfit.

Prvky grafu pro 2D a 3D grafy jsou znazornény na obrazku 78.
* Sténa grafu obsahuje obrazek zobrazujici data.
* Oblast grafu je pozadi celého grafu.
* Nadpis a podnadpis grafu, legenda grafu, popisky os a nazvy os jsou v oblasti grafu.
» PatiCka grafu je k dispozici pouze pro 3D grafy.

Vysledky pronajmu motorovych a jinych lodi
Madpis a ____________,_._._—-I' Oblast
podnadpis Prvni polovina roku 2019 " grafu
grafu . p / g
60
50 . Ifance Legenda
40 B Cluny a—T grafu
o Motoroveé
s 30
; =
N:SEV/ 20 StEna
Y 10 " grafu
0 \
; led Gno bie dub kvé &vn plocha grafu
Popisky -~ pouze pro
os 3d grafy

Obréazek 78: Prvky grafu

Chceme-li pridat prvky do grafu, provedeme jeden nebo vice z nasledujicich krokl na strance
Prvky grafu (obrazek 77):

* Nadpis a podnadpis (pokud je potfeba) zadame do poli Nadpis a Podnadpis.
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» Do textovych poli Osa X a Osa Y zadame nazvy os. Textové pole Osa Z je aktivni pouze
tehdy, kdyz vytvafime 3D graf.

« ZaSkrtneme volbu Zobrazit legendu (ve vychozim nastaveni je zapnuto) a zvolime si,
kde se legenda zobrazi — Vlevo, Vpravo, Nahoie nebo Dole. Nazvy v legendé jsou
nazvy datovych fad. Nazvy zadame do pole Oblast pro Nazev na strdnce Datové fady.

v

* Pod textem Zobrazit mriZky zaSkrtneme volbu Osa Y nebo Osa X pro zobrazeni
vodorovnych nebo svislych ¢ar miizky. U nékterych grafd je ve vychozim nastaveni
mriZzka zobrazena. MfiZzka neni k dispozici pro vysecové grafy. ZaSkrtavaci pole Osa Z je
aktivni pouze pfi tvorbé 3D grafu. Vice informaci o mfizkach najdeme v ¢asti Mfizky na
strané 163.

Poznamka

Po klepnuti na tladitko Dokonéit se Privodce grafy zavie, graf zlstane v reZimu
Uprav, ktery je oznaCen Sedymi okraji, a |ze jej dale upravovat. Rezim Gprav
ukon€ime klepnutim mimo graf.

Nastaveni grafu pomoci postranni liSty

Karta Vlastnosti v Postranni listé (obrazek 79) zpfistupni nékteré zakladni moznosti pro
upfesnéni vzhledu grafli. Pokud chceme otevfit Postranni listu, nejprve zruSime vybér klepnutim
mimo graf a po té prejdeme do nabidky Zobrazit > Postranni liSta v hlavni nabidce nebo
stiskneme kombinaci klaves Ctrl + F5. Ve vychozim nastaveni se Postranni liSta zobrazi na pravé
strané obrazovky.

Obsah Postranni liSty zavisi na tom, jestli je graf vybrany nebo jestli je v rezimu Gprav. Postranni
liSta na levé strané na obrazku 79 zobrazuje kartu Vlastnosti, kdyZ je graf vybrany (jednim
klepnutim na graf). Pokud je graf v reZimu editace (dvoji klepnuti na graf), zobrazi se karta
Vlastnosti ukazana na pravé strané obrazku 79.

6 Tip

Pokud budeme postupovat dle pokyn(l vy3e a karta Vlastnosti se v Postranni listé
nezobrazi, klepneme na ikonu Vlastnosti vpravo nahotre v Postranni listé.

Moznosti dostupné na karté Vlastnosti v Postranni liSté jsou dostupné také jinde. Najdeme je v
hlavni nabidce, v nastrojové listé Formatovani nebo v mistnich nabidkach (dostupnych po
klepnuti pravym tlaCitkem mysi na prvek grafu).

Poznamka

Postranni lista mdzZe byt docela uziteéna. Vzhledem k tomu, Ze moznosti jsou
snadno viditelné a jsou dostupné jinde, nejsou v této kapitole zminény dalSi odkazy
na né.
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~ Oblast

~ Typ grafu

Vyplrc |_Zadn!.'r

Prihlednost: |iadn.a
v Stin

O Povolit
Uhel: |
Vzddlenost: |0 pt
Barva

Prihlednost:

Barva:

B Cemni

0%

Prihlednost: 0%

~ Umisténi a velikost
Pozice X;
230 cm
Sitka:
‘I_E!,DU cm
[l Zachovat pomér

Pozice Y:
(= 4,06 cm

Viiska:
= 6,00 cm

Usporadat:
S E

Zarovnani:

Upravit graf

L Sloupcovy

il

[0 30 vzhled |*ie.:' isticky

Al

BéZny

Tvar

Popisy
I Madpis
Legenda
Umisténi: Vpravo

O Podnadpis

]

Zobrazit legendu nepreknyvajici graf

Osy
Osa X [ Popis osy X
Osa ¥ [l Popis osy Y
Osa Z Popis osy Z
Miizhy
Hiawni vodorovna [ Vedlejsi vodorovna
[ Hlavni svisla [ Vedlejsi svisla
~ Oblast M
Vyplic Barva I~]
|Lineani 3 | EI | Automaticka
Automaticka =
Prihlednost:  Zadna |~
I [s0% =
 Céra M|
ﬁé_ra: -
Sifka: —_—
Barva: = I -
Prihiednost: 0% =

Obréazek 79: Karta Vlastnosti v Postranni liSté pro graf vybrany (vlevo) a pro graf v reZimu

Uprav (vpravo)
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Uprava graftl

Privodce grafem definuje zakladni funkce grafu. Po jeho pouZiti miiZzeme chtit zménit oblasti dat
nebo upravit vzhled grafu. Aplikace Calc poskytuje mnoho moZznosti pro formatovani a jemné
doladéni vzhledu grafil. To zahrnuje nastroje pro Upravu typu grafu, prvkd grafu, oblasti dat,
pisem, barev a mnoha dalSich moznosti.

Grafy upravujeme jednim ze dvou zpUsobU v zavislosti na tom, co chceme zménit.

Uprava vlastnosti objektu

Klepnutim na graf upravime vlastnosti objektu. Mezi né patfi velikost, umisténi na strance,
zarovnani, vnéjsi ohraniCeni, kopirovani, export a dalsi. Vice informaci najdeme v Casti
zacinajici ,Zmény velikosti, pfesouvani a umisténi grafli na strané 179.

PouZiti reZimu tprav

Pomoci rezimu Uprav miizeme zménit vybér dat, typ grafu a také prvky grafu (jako jsou osy,
nadpisy, pozadi, mfizky, datové rady, popisky dat, spojnice trendu a dalsi.

Prehled pouziti rezimu uprav

V rezimu Uprav mameé nékolik obecnych zplsobl Gpravy grafl. Jednotlivé zplsoby jsou
podrobnéji popsany v nasledujicich ¢astech.

Pokud chceme pfidat prvek, ktery jesté neni v grafu, pouzijeme volbu Vlozit v hlavni
nabidce. VloZime nadpisy, legendu, popisky os, mfizky, popisky dat, spojnice trendu,
primky stfedni hodnoty a chybové Usecky.

Chceme-li pfesunout nebo zménit velikost nadpist, nazvl os, stén grafu a legendy,
klepneme na né jednou. Kurzor se zméni na ikonu se symbolem pfesunu (zobrazeni
zAavisi na pouzitém operacnim systému). Pfetahneme prvek do nového umisténi.
Chceme-li zménit velikost, pretahneme Uchyty vybéru.

Uprava prvkil nékolika zakladnimi zpdsoby. Pfislusné dialogové okno nebo nabidku

mlZeme otevrit jednim z nasledujicich zplsobl. Ne vSechny uvedené zplsoby budou

fungovat pro vSechny prvky:

— Poklepeme na prvek (viz vyjimka nize).

— Vybereme prvek z nabidky Vlozit (obrazek 80) nebo z nabidky Format (obrazek 81) v
hlavni nabidce.

— Klepneme jednou na prvek a poté klepneme na ikonu Format vybéru, kterou
najdeme na nastrojové listé Formatovani (obrazek 82).

— Vybereme prvek z rozeviraciho seznamu Zvolte prvek grafu a potom klepneme na
ikonu Format vybéru, kterou najdeme hned vedle tohoto rozeviraciho seznamu.

— Klepneme pravym tlaCitkem mysi na prvek a otevieme mistni nabidku.

Poklepanim na nadpisy a ndzvy os zménime jejich pravopis. Chceme-li upravit pravopis
jiného textu, napfiklad kategorii, popiskd dat a poloZek legendy, zménime text v datech v
tabulce.

Jednim klepnutim na datovy bod (napfiklad sloupec nebo fadek) vybereme a upravime
pridruzené datové rady.

— Pokud mame vybranu datovou fadu, poklepeme na jeden datovy bod a upravime jeho
vlastnosti (napfiklad jeden sloupec ve sloupcovém grafu).

Prepnuti do rezimu Uprav

Pokud chceme upravit nebo forméatovat grafy, poklepeme na graf a pfejdeme do reZzimu Gprav.
Graf je nyni oramovan Sedym rameckem. V rezimu Uprav se hlavni nabidka zméni a nastrojova
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liSta Formatovani obsahuje fadu moznosti formatovani a ikon, jak je uvedeno v nasledujicich
castech.

Poznamka

Né&kolik dalSich ¢asti (az do ¢asti ,Zmény velikosti, pfesouvani a umisténi grafl” na
strané 179) vyzaduje, aby byl graf v rezimu Gprav.

Nabidka Vlozit

V rezimu Uprav nabidka Vlozit v hlavni nabidce zobrazuje moZnosti ukazané na obrazku 80 a
zminéné nize:

VloZit Format Nastroje O
Popisy...
Legenda...
Qsy...

Mrizky...

B2 R=

Popisky dat...

Spojnice trendu...
PFimky stfedni hodnoty
Chybove lsecky X...
Chybové usecky ...

specialnl Znak..

Obréazek 80: Nabidka
VioZit pokud je graf v
reZimu dprav

Popisy
Nabizi textova pole pro zadavani nadpisu a podnadpisu grafu a ndzvi os X, Y a Z, véetné
sekundarnich os. Vice informaci nalezneme v ¢asti ,Nadpisy, podnadpisy a nazev os” na
strané 137.

Legenda

Urcuje, zda ma byt v grafu zahrnuta i legenda a pokud ano, tak kde. Vice informaci
nalezneme v Casti ,Legenda” na strané 139.

Osy
Nabizi moZnosti pro zobrazeni nebo nezobrazeni popiski os. Priivodce grafem zobrazi ve
vychozim nastaveni popisky. Vice informaci nalezneme v €asti ,,Osy” na strané 150.
MFizky
Nabizi moznosti pro zobrazeni nebo nezobrazeni hlavnich a vedlejSich mfiZzek pro osy X, Y
a Z. Vice informaci o formatovani mrizky najdeme v ¢asti ,Mfizky” na strané 163.

Popisky dat
Nabizi moznosti pro vlastnosti textu, zda se maji kategorie zobrazovat nebo umisténi a
otoceni popiskd. Tyto popisky se zobrazi u kazdého datového bodu. Vice informaci
nalezneme v Césti ,Popisky dat” na strané 158.

Spojnice trendu
UrCuje typ regresni Cary, ktera se ma pouzit, moznosti extrapolace, kde by se osy mély
protinat, nazev spojnice trendu a jak by se méla rovnice zobrazit. Volba je zobrazena Sedé,
dokud neni vybrana datova fada. Vice informaci nalezneme v Casti ,Spojnice trendu a
pfimky stfedni hodnoty" na strané 168.
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PFimky stfedni hodnoty
Zobrazuje pfimky stfedni hodnoty pro vybranou datovou fadu nebo vSechny datové fady.
Vice informaci nalezneme v Casti ,Pfimky stfedni hodnoty” na strané 173.

Chybové tsecky X a chybové usecky Y
UrCuje kategorii chyb, kterd se mé pouzit, parametry a moznosti zobrazeni pro pozitivni a
negativni indikatory. Vice informaci nalezneme v ¢asti ,Chybové Usecky" na strané 174.

Specialni znaky
Zapina moznost vklada specialnich znakl v textovych fetézcich (naptiklad nadpisech a
podnadpisech). Moznost je vypnuta, pokud neni relevantni pro vybrany prvek grafu. DalSi
informace o vkladani specialnich znakd najdeme v kapitole 2, Zadavani, Upravy a
formatovani dat.

Nabidka Format

V reZzimu Uprav se tato nastaveni zobrazi v nabidce Format (obrazek 81) v hlavni nabidce.
Nasleduje popis jednotlivych voleb:

Format MNastroje Okno N
Popis v
If  Legenda..
f Osa '
& Mrizka 8
Sténa grafu...
Pata grafu...

Placha grafu...

14 Typ grafu..
% Oblasti dat...

3D pohled...

Format vybéru...

Umisténi a velikost... F4

Uspofadani v
Obrazek 81: Nabidka

Format pro graf v reZimu
uprav

Popis
Umoznuje formatovat nadpis a podnadpis grafu a ndzvy os. Text musi byt nejprve zada na
strance Prvky grafu v Priivodci grafu nebo pomoci nabidky VloZit > Popisy.

Legenda
Formatovéani zobrazeni a umisténi legendy. Legenda musi byt nejprve zapnuta na strance
Prvky grafu v Privodci grafem nebo zvolenim nabidky VloZit > Legenda.

Osy

Formatovani vlastnosti jako je prisecik os, méfitko jednotek a formatovani popiskd os.
MFizka

Formatovani €ar mfizky. Mfizku zapneme, resp. vypneme, bud na strance Prvky grafu v

~ v

Privodci grafem nebo pomoci nabidky VloZit > MFizky.
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Sténa grafu, Pata grafu nebo Plocha grafu
Formatovani ohrani¢eni, oblasti a prdhlednosti téchto prvk(. Pata grafu je k dispozici pouze
pro 3D grafy. Vice informaci najdeme v ¢asti ,Formatovani pozadi grafu” na strané 141.

Typ grafu
UmoZiuje ménit typ grafu a to, zda se jedna o 2D nebo 3D graf. Rlzné typy grafl jsou
vysvétleny v ¢asti ,Galerie typl graf(” zadinajici na strané 188.

Oblasti dat
UmozZiuje nastaveni oblasti pro vSechna data v grafu a pro jednotlivé datové fady, jak je
vysvétleno v Casti ,Vybér oblasti dat" na strance 125 a ,Vybér datovych fad na strané 126.

3D pohled
Umoziuje formatovani 3D grafd a je dostupny pouze pro 3D grafy. Jako 3D grafy je mozné
zobrazit pouze sloupcové, fadkové, vysecové a plosné grafy. Vice informaci najdeme v
¢asti ,3D grafy” na strané 164.

Format vybéru
Otevrie dialogové okno s nastavenim pro vybrany prvek. Volby mohou zahrnovat vypln

v/,

oblasti, ohrani¢eni, umisténi, prihlednost, pisma, popisky, méfitko a dalsi volby.

Umisténi a velikost
UmozZiuje pfesné urceni pozice a velikosti vybraného prvku. Umisténi je definovano ve
vztahu ke grafu. Vice informaci nalezneme v ¢asti ,Dialogového okno Umisténi a velikost”
na strané 180.

Usporadani
Nabizi dvé moZnosti: Pfenést bliz a Odsunout dal. U nékterych polozek mdze byt aktivni
pouze jedna z moznosti. Pomoci téchto moZnosti mizeme usporadat prekryvajici se
datové fady.

Nastrojova lista Formatovani

V rezimu navrhu se nastrojova liSta Formatovani zobrazi jako na obrazku 82. Klepnutim na jednu
z ikon otevieme dialogové okno nebo zapneme, resp. vypneme, danou volbu. Nabidky VloZit a
Format v hlavni nabidce, popsané vySe, obsahuji az na jednu vyjimku stejné volby.

Rozeviraci seznam Zvolte prvek grafu se jinde nez v nastrojove liSté nezobrazi. Slouzi k
snadnému vybéru jednotlivych prvkl grafu. To miZe byt zvlasté uzitec¢né, kdyz je graf preplnény
nebo je jinak obtizné vybrat prvky pomoci kurzoru. Za povSimnuti stoji fakt, Ze se moznosti jako
Popisky dat nebo Spojnice trendu v tomto seznamu nezobrazi, dokud nejsou vloZzeny pomaoci
nabidky Vlozit.

114 | Prirucka Calc 7.0



9 9990099000000069

B M5  E M| I

Plocha grafu

Graf

Legenda | F G | H |
Cisa X

Oza

Datova fada 'Kanoe'

Datova fada 'Kénoe' Popisky dat

Datova fada 'Kanoe' Plimka stfedni hodnoty
Datova fada ‘Cluny’

Datové fada 'Cluny’ Popisky dat

Datova fada 'Cluny' Piimka stfedni hodnoty

Datova fada ‘Motorowe

Datova fada 'Motorove” Popisky dat
Datova fada 'Motorové’ Piimka stredni hodnoty

1. Zvolte prvek grafu 7. Oblasti dat 13. Svislé mrizky
2. Format vybéru 8. Tabulka dat 14. Osa X

3. Typ grafu 9. Popisy 15. OsaY

4. Plocha grafu 10. Legenda zap/vyp 16. Osa Z

5. Sténa grafu 11. Legenda 17. VSechny osy
6. 3D pohled 12. Vodorovné mrizky

Obrazek 82: Nastrojova liSta Formatovani pro graf v reZimu tprav

Vybér a pfesun prvki grafu

Vybér prvkl grafu

Po dvojim klepnuti na graf vstoupime do reZimu Uprav a vybereme prvky grafu jednou z
nasledujicich moznosti:

* Klepneme jednou na prvek v grafu (pro vybér jednotlivych datovych bodd, klepneme
dvakrat - ale ne pifilis rychle - po prvnim klepnuti na datovou fadu.

* Vybereme prvek z rozeviraciho seznamu Zvolte prvek grafu, ktery se zobrazi na levé
strané nastrojové liSty Formatovani, jak je znazornéno na obrazku 82.

Pokud mame vybrano, bude prvek grafu zvyraznén pomoci ¢tvercovych Gehytd vybéru.

@ ip
KdyZ umistime kurzor nad prvek, aplikace Calc zobrazi nazev prvku, coz usnadnuje
vybeér spravného prvku. Nazev vybraného prvku se také objevi ve stavovém radku.

Pfesun prvkul grafu

MoZna budeme chtit pfesunout jednotlivé prvky grafu, nezavisle na jinych prvcich grafu.
Napfiklad mdZeme chtit zménit umisténi nadpisu nebo nazvili os. Provedeme to nasledovné:

1) Vybereme prvek grafu, jak je popsano vysSe.
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2) Drzime stisknuté tlacitko na mySi. Kurzor se zmeéni na ikonu se symbolem pfesunu
(zobrazeni zavisi na pouzitém operacnim systému).

3) PretaZzenim kurzoru pfesuneme prvek.
4) Jakmile je prvek na pozadovaném misté, uvolnime tlacitko mysi.

Alternativné mizeme pro nékteré prvky pouZit dialogové okno Umisténi a velikost, jak je
popsano na strané 180.

Jednotlivé body nebo datové fady presouvat nelze. Vyjimku tvofi vysecové grafy. U vyseCového
grafu mizeme presouvat jednotlivé vysece nebo cely graf. Vice informaci najdeme v ¢asti
.Vysecové grafy na strance 189.

Vice informaci o pfesunu popisku os najdeme v ¢asti ,Umisténi os, popiskl a znacek intervalu"
na strané 153. Vice informaci o pfesunu popiskl dat najdeme v ¢asti ,Pfidavani a formatovani
popiskl dat pro datové fady" na strané 158.

@ Tip
U nékterych prvkl grafu (jako jsou nadpis, podnadpis, nadzvy os a legenda) miizeme
stisknout klavesy se Sipkami a posouvat tak objekt po malych krocich.

Poznamka

Pokud je vybran prvek 3D grafu, mohou se zobrazit ovladace pro otaceni grafu. Tyto
ovladaci prvky urcuji 3D Uhel prvku. BEhem zobrazeni nemizeme ménit velikost
nebo umisténi prvku. Opétovnym klepnutim ziskame Ctvercové Gchyty, které nam
umozni zmeénit velikost a umisténi 3D grafu.

Zmeéna typu grafu

Pokud chceme zmeénit typ grafu (fadkovy, sloupcovy, vyse€ovy, Carovy atd.):

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
2) Otevieme dialogové okno Typ grafu pomoci jedné z téchto moznosti:
— V hlavni nabidce zvolime Format > Typ grafu.
— Klepneme na ikonu Typ grafu v nastrojové listé Formatovani.
— Pravym tlaCitkem mysi klepneme na graf a z mistni nabidky zvolime Typ grafu.

Dialogové okno je stejné jako prvni stranka dialogového okna Priivodce grafem
zobrazeného na obrazku 75 na strance 125.

3) Vybereme poZadovany typ grafu a jeho variantu.

4) Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

Vice informaci o typech grafli najdeme v ¢asti ,Galerie typl graf(" na strané 188.

Nadpisy, podnadpisy a hazev os

Tvorba nebo zména textu
Pro vytvofeni nebo zménu textu ndzvu grafu, podnadpisu nebo nazvy os:

1) Dvojitym klepnutim vybereme graf a prejdeme do rezimu Gprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
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2) Jednim z téchto zplsobl otevieme dialogové okno Popisy (obrazek 83):
— V hlavnim nabidce zvolime Vlozit > Popisy.
— Klepneme na ikonu Nadpisy na nastrojove li5té Formatovani.

— Pravym tlacitkem mysSi klepneme v oblasti grafu a z mistni nabidky vybereme Vlozit
popisy.
3) Do odpovidajicich textovych poli zadame nebo upravime text.

4) Klepnutim na OK okno zavieme. Pokud chceme rezim Gprav opustit, klepneme mimo
graf.

6 Tip

Text nadpisu (ale ne formatovani) Ize upravit pfimo. Pokud mame graf v rezimu
Gprav, poklepanim na text jej mizeme zménit. Pouziti Shift + Enter na konci fadku
umozni vytvorit dalSi radek, ktery rozdéli text.

Madpis

Podnadpis
Osy

Osa X

Osa Y

Osa £
Vedlejsi osy

QOsa X

Osa Y

MNapovéda QK Zrusit

Obréazek 83: Dialogové okno Vkladani
nadpisti

Formatovani textu

Pomoci roz$ifeného dialogového okna Popisy miizeme formatovat vzhled nazvu grafu, titulkd
nebo nazvu os. Pro pfistup k tomuto dialogovému oknu:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
2) Jednim z nasledujicich zplsob( otevieme dialogové okno Popisy pro formatovani
(obrazek 84):
— Klepneme na volbu Format > Popisy a zvolime pozadovany typ popisu nebo volbu
VSechny popisy.

— Klepneme na prvek v grafu, pak klepneme pravym tlacitkem mySi a z mistni nabidky
zvolime Format popisu (nebo vhodny prvek).
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— Klepneme na prvek v grafu nebo jej vybereme pomoci rozeviraciho seznamu Zvolte
prvek grafu v nastrojové listé Forméatovani. Poté vybereme Format > Format vybéru
v hlavni nabidce nebo klepneme na ikonu Format vybéru na nastrojové listé
Formatovani.

3) Naformatujeme popisy nebo nazvy dle potfeby. Funkce jednotlivych moznosti jsou
snadno pochopitelné.

4) Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

Ohraniceni Oblast Prihlednost Pismo Efekty pro pismo Zarovnani Asijska typografie

Vlastnosti €ary

Styl:
Barva: Cerna
Sitka: 0,00 cm

LR B

Prihlednost: |0 %

Mapovéda Obnowvit oK £rusit

Obrazek 84: Dialogové okno Popisy pro formatovani popist (po zvoleni volby VSechny popisy)

Legenda

Pokud je legenda zobrazena, zobrazuje nazvy datovych fad spolu s jejich grafickym
znazornénim jako jsou sloupce, ¢ary nebo body. Ukazuje také spojnice trendu, pokud jsou
zapnuté, jak je vidét na obrazku 85.

—8— Kanoe Logaritmicka (Kanoe) == Cluny Primé&rova (Cluny)

Motorové =de= Kola e Tk OIKY

s w7

Obrazek 85: Priklad legendy grafu v dolni ¢asti grafu.
Umisténi, vkladani nebo mazani legendy

Pouze vkladani nebo mazani
Vlozeni nebo odstranéni legendy:
1) Dvojitym klepnutim na graf pfejdeme do rezimu Uprav. Kolem grafu by se nyni mél objevit
Sedy ramecek.
2) Provedeme jeden z nasledujicich krokd:

— Klepneme na ikonu Legenda zapl/vyp na nastrojové listé Forméatovani. Vychozi
pozice pro vlioZeni legendy je na praveé strané oblasti grafu.

118 | Prirucka Calc 7.0



— Klepneme pravym tlaCitkem mysi v oblasti grafu a z mistni nabidky vybereme VloZit
legendu nebo Smazat legendu.

3) Pokud chceme reZzim Gprav opustit, klepneme mimo graf.

"/ Poznamka

Nazvy v legendé jsou nazvy datovych fad. Nazvy jsou prevzaty z Nazvu oblasti dat,
jak bylo zminéno v ¢éasti ,,Vybér datovych fad" na strané 126. Nazvy polozek legendy
zménime Vv textu v tabulce.

Umisténi, vkladani a mazani
Umisténi legendy pomoci zékladniho dialogového okna Legenda (obrazek 86) stejné jako jeji
vloZeni nebo odstranéni provedeme pomoci nasledujicich kroku:

1) Dvojitym klepnutim na graf pfejdeme do rezimu Uprav. Kolem grafu by se nyni mél objevit
Sedy rdmecek.
2) V hlavni nabidce zvolime VloZit > Legenda a otevieme zékladni dialogového okno

Legenda.
Legenda X

Umisténi
Zobrazit legendu

) Nahofe
) Dole

Napovéda QK Zrusit

Obrazek 86: Dialogové okno Legenda

3) Vybereme nebo zruSime vybér volby Zobrazit legendu pro zobrazeni nebo skryti
legendy v oblasti grafu.

4) Vybereme pozadované misto pro legendu — Vlevo, Vpravo, Nahofe nebo Dole.

5) Klepnutim na OK okno zavieme.

6) Pokud chceme rezim Gprav opustit, klepneme mimo graf.

6 Tip

Pro pfesnéjsi umisténi legendy pouZzijeme jednu z moZznosti popsanych v ¢asti
,Presun prvkd grafu" na strané 136.

Formatovani legendy

Pro pokrocilou editaci vzhledu legendy pouZijeme rozSifené dialogové okno Legendy (obrazek
87), které nabizi nékolik moZnosti pro formatovani ohraniceni, vypiné, pisem, prihlednosti a
umisténi.
1) Dvojitym klepnutim na graf pfejdeme do rezimu Gprav. Kolem grafu by se nyni mél objevit
Sedy ramecek.
2) Jednim z nasledujicich zplsobU otevieme dialogové okno Legenda (obrazek 87):
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3)
4)

Ohraniceni Oblast Prihlednost Pismo Efekty pro pismo Umisténi Asijska typografie

Klepneme na ikonu Legenda na nastrojové listé Formatovani.

V hlavni nabidce zvolime Format > Legenda.

Pravym tlaCitkem mysi klepneme na legendu a z mistni nabidky zvolime Format
legendy.

Klepneme na polozku Legenda v rozeviracim seznamu Zvolte prvek grafu na
nastrojové listé Formatovani nebo klepneme na legendu v grafu a vybereme ji. Poté

klepneme na ikonu Format vybéru na nastrojové listé Formatovani nebo zvolime
Format > Format vybéru.

Provedeme poZadované zmény. Funkce jednotlivych moznosti jsou snadno pochopitelné.

Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

Legenda

Vlastnosti cary

Styl:

Barva #B3B3E3
S ) -
Sitka: 0,00 cm =
Prihlednost: |0 % =

MNapovéda Qbnovit oK Zrusit

Obréazek 87: Dialogové okno formatovani legendy

Formatovani pozadi grafu

Pozadi grafu je rozdéleno do oblasti grafu, stény grafu a paty grafu, jak je ukadzano na obrazku
78 na strané 129. MozZnosti ohrani¢eni, oblasti a prihlednosti je moZné nastavit pro tyto oblasti
nasledujicim zplsobem:

1)

2)

Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy rdmecek.

Jednim z nasledujicich zplisobl otevieme pfislusné dialogové okno (jak vidime napf. na
obrazku 88):

— V hlavni nabidce pfejdeme do volby Format a vybereme Plocha grafu, Sténa grafu

nebo Pata grafu.

Pravym tlacitkem mysi klepneme na sténu grafu, patu grafu nebo oblast grafu v grafu
a z mistni nabidky zvolime Format stény grafu, Format paty grafu nebo Format
oblasti grafu. (Vice informaci o vybéru téchto oblasti grafu nalezneme v Casti ,Vybér
prvkl grafu” na strané 136.)

Na néstrojové listé Formatovani klepneme na ikonu Oblast grafu nebo na ikonu
Sténa grafu (ikona pro patu grafu zde neni).
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— Klepneme na volbu Plocha grafu, Sténa grafu nebo Graf, kterou najdeme v
rozeviracim seznamu Zvolte prvek grafu na nastrojove listé Formatovani. Poté
klepneme na sousedni ikonu Format vybéru nebo zvolime Format > Format
vybéru.

— Dvakrét klepneme na oblast grafu, sténu grafu nebo patu grafu.

3) Vybereme pozadované nastaveni z karet Ohrani¢eni, Oblast a Priihlednost.

4) Klepnutim na tla€itko OK ulozime zmény a zavieme dialogové okno. Pokud chceme
rezim Uprav opustit, klepneme mimo graf.

Pata grafu zminéna v krocich vy3e je pouzitelna pouze pro 3D grafy.

Plocha grafu

Ohrani¢eni Oblast Prihlednost

ReZim prahlednosti oblasti
D ﬂeprﬂhledné T —

{7y Prdhlednost;

[
)
L

i@ Prechod

Stfed X: |50 % =
Stfed ¥: |50 % =

Uhel: |0° =
Hranice: 0% =

1k

Poéateéni hodnota: |0 %

Ak

Koncova hodnota: |[100 %

Obnovit oK Zrusit

Obrazek 88: Dialogové okno Plocha grafu — karta Prihlednost

Oblast dat a datové rady

Cilem vytvofeni grafu je jasné predstavit jednu nebo vice datovych fad. Aplikace Calc nabizi fadu
zpUsobd, jak tyto Gdaje definovat a prezentovat. Nasledujici ¢asti popisuii, jak definovat a ménit
datové oblasti, zarovnat data k sekundarni ose Y a formatovat vzhled datovych fad.

Zmeéna oblasti dat

KdyZ se oblasti dat v tabulce zméni, upravime nastaveni grafu tak, aby se tyto zmény projevily i v
grafu. Pouzijeme jednu z nasledujicich moznosti.

& Poznamka

Graf automaticky odrazi zmény v datech tabulky. Zména Cisla z 5 na 50 v datech
zpUsobi okamzité zobrazeni nového Gdaje v grafu.
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Nahrazeni dat pretaZzenim

Ruc¢né nahradit jednu sadu dat jinou sadou dat je snadné. Udélame to jednim z nasledujicich
zpUsob:

1)
2)

3)

Pomoci mysSi vybereme vSechna nova data.

PretAhneme data pfes graf a poté uvolnime tlacitko mysi. Tim otevieme dialogové okno
Zménit zdrojovou oblast dat, které je zobrazeno na obrazku 89.

Urcité zda prvni sloupec nebo fadek obsahuje popisy a klepneme na tlaitko OK.

Zmeénit zdrojovou oblast dat

Popisky
[4Prvni sloupec obsahuje popisky:

Pryni fadek obsahuje popisky

MNapovéda QK Zrusit

Obrazek 89: Dialogové okno Zménit
zdrojovou oblast dat

Uprava oblasti dat a datovych Fad
Pokud chceme zmeénit oblast dat nebo datovou fadu, postupujeme takto:

1)

2)

3)
4)

5)

Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy rdmecek.

Dialogové okno Oblasti dat otevieme pomoci jednoho z téchto zplsobi:

— V hlavni nabidce pfejdeme do Forméat > Oblasti dat.

— Klepneme na ikonu Oblasti dat na nastrojové listé Forméatovani.

— Klepneme pravym tlaCitkem mysi na graf a z mistni nabidky vybereme Oblasti dat.

Na karté Oblast dat upravime oblast dat. Tato karta je podobna oblasti Zvolte oblast dat
zobrazené na obrazku 75 na strané 125.

Na karté Datové rady upravime datové fady. Tato karta je podobné oblasti Upravte
oblasti dat pro jednotlivé datové fady zobrazené na Obrazku 76 na strané 127.

Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno. Pokud chceme
reZim Uprav opustit, klepneme mimo graf.

6 Tip

Pokud aplikace Calc potfebuje vice Casu na zpracovani velkého mnoZzstvi dat pro
graf, zkusime toto: Vybereme pouze omezenou €ast dat pro kaZzdou datovou fadu,
abychom vytvofili po¢ate€ni rozloZeni grafu. Upravime nastaveni grafu tak, aby graf
vypadal podle potfeby a poté vybereme vSechna data, ktera chceme v grafu
zobrazit.

Vice informaci najdeme v Casti ,Vybér oblasti dat" na strané 125 a v ¢asti ,,Vybér datovych fad"
na strané 126.

Otevieni dialogového okna Datové Fady

Dialogové okno Datové fady nabizi nékolik moZnosti pro prezentaci dat v grafu. Upozoriiujeme,
ze najednou lze vybrat pouze jednu datovou fadu.
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Otevieni dialogového okna Datova fada (obrazek 90):

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy rAmecek.
2) Datovou fadu vybereme jednim z nasledujicich zplsobd:
— Klepneme na datovou fadu v grafu.
— Klepneme na nazev datové fady v rozeviracim seznamu Zvolte prvek grafu na
nastrojové listé Formatovani.
3) Dialogové okno Datové fady otevieme jednim z t&chto zpUsob:
— V hlavni nabidce zvolime Format > Format vybéru.
— Klepneme na ikonu Forméat vybéru na nastrojové listé Formatovani.

— Klepneme pravym tlaCitkem mysi na datovou fadu a z mistni nabidky zvolime Format
datovych fad.

4) Pro provedeni potfebnych zmén klepneme na kartu pfislusné stranky. MoZnosti pro
kazdou ze stranek jsou vysvétleny dale.

5) Klepnutim na tlagitko OK ulozime zmény a zavieme dialogové okno. Pokud chceme
rezim Uprav opustit, klepneme mimo graf.

Datova fada

MoZnosti Cara
Zarovnat datové rady na
] v

) Vedlejsi osa

Moznosti grafu

Vykreslit chybéjici hodnoty ® Nechat mezeru
) Pfedpokladat nulu
) Pokracovat v pfimce
U Zahrnout hodnoty ze skrytych bunék
Polozka legendy
[ Skryt poloZku legendy

MNapovéda Obnovit QK Zrusit

Obrazek 90: Dialogové okno Datova fada — karta MoZnosti

@ Poznamka

Karty, které jsou zobrazeny v dialogovém okné Datové fada, zavisi na vybraném
typu grafu. Podobné se, v zavislosti na typu grafu, mohou liSit i ovladaci prvky, které
se zobrazuji na kazdé karte.
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MoZnosti zarovnhani, rozestupy a vykreslovani

Zarovnani dat k vedlejSi ose Y

Vedlejsi osa mize byt uziteGna ve chvili, kdy se data lisi v jednotkdch nebo v méfitku jako na
obrazku 91. V tomto pfipadé existuje vyrazneé vice Cisel jedné z datovych fad (kajaky). Aby bylo
mozné vykreslit vdechny tfi datové fady v jednom grafu, je datova fada kajak( zarovnana s
vedlejSi osou Y, ktera ma vétsi méfitko. Barva vedlejSi osy Y a nazev vedlejSi osy pomahaji s
ur€enim, ktera fada je zarovnana podle vedlejSi osy.

4 Poznamka

Datova Ffada mUZe byt spojena s vedleji osou Y az poté, co Priivodce grafem
dokonci vytvoreni grafu.

Pronajem vybaveni

> == Kanoe
E z Cluny
E .% = K ajaky
E ¥
g
¥
5 i -40
= 20
0- -0
led (no bfe dub kvé cvn

Obréazek 91: Datové Fady zarovnané s vedlejsi osou Y
Zarovnani datove fady s vedlejSi osou Y:

1) Vybereme datovou fadu a otevieme dialogové okno Datova fada, jak je popsano v
predchozi ¢asti.
2) Na karté MoZnosti v ¢asti Zarovnat datové rady na vybereme VedlejSi osa Y.

3) Klepnutim na OK okno zavieme. Pokud chceme rezim Gprav opustit, klepneme mimo
graf.

Zarovnani datovych fad k vedlejSi ose Y neni mozné u vysecovych a sitovych graf(.

Data Ize zarovnat pouze k vedlejSi ose Y, nikoli k vedlejSi ose X. Je vS8ak mozné vytvofit vedlejsi
osy X a Y, které duplikuji hlavni osy na opacnych stranach grafu. Toto je popséano v ¢asti “Pridani
nebo odebrani popist 0s” na strané 150. Na vedlejSi ose je také mozné zobrazit riizné jednotky
nebo méfitka (s nebo bez zarovnani dat k této ose), jak je popsano v ¢asti ,Definovani méritka"
na strané 152.

MozZnosti rozestupti a vykreslovani

Karta MoZnosti v dialogovém okné Datovéa fada (obrazek 90) obsahuje dal3i nastaveni, ktera
zavisi na typu grafu. Tato nastaveni zahrnuiji:

Rozestupy
UmozZiiuje nastaveni rozestupl sloupcli nebo pruhd mezi kategoriemi. Hodnoty nad 100 %
zvétSuji mezery, zatimco hodnoty pod 100 % zmenSuji mezery. Maximélni hodnota je 600
%.
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Pfesah
Umoziiuje nastaveni piekryti sloupct nebo pruht v kategorii, napfiklad v ur€ity ¢as. Cim
vySSi procento, tim veétsi prekryti (maximum je 100 %). Zaporna procenta zvysuji oddéleni
(minimum je - 100 %).

Zobrazit sloupce vedle sebe
Pokud je zaSkrtnuto, nezobrazuje se Zzadna mezera ve sloupcich nebo pruzich v intervalu
mezi kategoriemi. Pokud tato volba neni zaSkrtnuta, mohou data zarovnana s vedlejSi osou
Y skryt jina data. Povolenim mozZnosti tomu zabranime.

Spojovaci ¢ary
Pokud si pfejeme pro skladané sloupce a sloupce s procenty (sloupcové grafy) propojit
¢arami vrstvy sloupct, které patii k sobé, zaskrtneme toto pole.

Ye=sr s

Vykreslit chybéjici hodnoty
Ur€uje zpracovani chybgjicich hodnot v zavislosti na typu grafu.

Zahrnout hodnoty ze skrytych bunék
UmoZiiuje zahrnout nebo nezahrnout data ze skrytych bunék.

Skryt poloZku legendy
Umoziuje zahrnout nebo odebrat ndzev vybrané datové fady z legendy.

Dvé dalSi mozZnosti (nejsou znazornény na obrazku 90) se objevi u vyseCovych nebo
prstencovych grafl:

Orientace
Urcuje poradi vyseci (datovych bodU) - ve sméru nebo proti sméru hodinovych rucicek.
Vychozi smér je proti sméru hodinovych rucicek.

Pocatecni uhel
Urcéuje pocatecni thel prvniho Gseku vysece (datovy bod) v rozsahu 0 az 359 stupiid.
Pretahneme malou te¢ku kolem kruhu nebo zadame Udaj ve stupnich. Hodnota O stupiili
znamena, ze prvni sekce zacina ve 3 hodiny. Hodnota 90 stupiili znamena, Ze prvni sekce
zaCina ve 12 hodin.
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Oblast, prihlednost a ohranic¢eni

Datova fada

MoZnosti Oblast Prihlednost Ohraniceni

Zadna Barva Prechod Rastr Vzorek Srafovani

Prechod Moznosti Nahled

~ | Typ:
Radialni v

Prirdstek:
Automaticky 64
Stred (X a Y

50 % -~ 50 % =

Uhel:

4 F

Pridat Zmeénit

0°

Ohraniceni:

I 0%

0Od barvy:
|- Modra ~ |[100%
w | Do barvy:

[ ]Bila > 100%

3

4

HORE
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Obrazek 92: Dialogové okno Datova fada — karta Oblast, stranka Prechod

V pripadé jinych typl grafli nez ¢arovych a bodovych obsahuje dialogového okno Datova fada
(obrazek 92) stranky pro formatovani vyplné a ohranic¢eni grafického znazornéni sloupcl nebo
pruhl. Karta Oblast nabizi moznosti pro vybér barvy klepnutim pfimo na barvu v paleté, pridani
vlastni palety nebo zadanim barevnych kédli RGB nebo Hex. Ostatni stranky obsahuji moznosti
pro prechod rastr, vzorek, Srafovani, prihlednost a ohrani¢eni. Funkce jednotlivych moZnosti
jsou snadno pochopitelné.

@ ip
Pokud pouziti pfechodu nefunguje dle ocekavéni, postupujeme takto: Po vybéru

pozadovanych moznosti na strance Pfechod klepneme na tlagitko PFidat, zadame
nazev prechodu (nebo akceptujeme vychozi ndzev) a klepneme na tlaCitko OK.

Cary, oblasti a ikony datovych bod(i

U nékterych typl grafd (napfiklad ¢arové grafy nebo xy (bodove) grafy) obsahuje dialogové okno
Datova rfada pouze kartu MoZnosti a kartu Cara (obrazek 93).

Na levé strané karty Cara ur&ime styl, barvu, $itku a prihlednost ¢ary. V ¢asti Ikona vybereme z
rozeviraciho seznamu pozadovany symbol: Bez symbolu, Automaticky, Ze souboru, Galerie
nebo Symboly.
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» Ze souboru otevre prohlize€ pro vybér souboru, ktery obsahuje odpovidajici symbol.

« Galerie otevie seznam dostupnych grafickych soubor( (které jsou soucasti instalace
LibreOffice), ze kterych si miizeme vybrat.

« Symboly otevie seznam zobrazujici dostupné symboly, ze kterych si mizeme vybrat.

Nahled vybéru se zobrazi v poli nahledu v dolni ¢asti dialogového okna. Zadame pozadovanou
Sitku a vySku symbolu. Zvolime Zachovat pomér, pokud by mél byt zachovan pomér Sitky a
vySky symbolu.

Datova rfada

Moznosti Céra

Vlastnosti ¢ary

Styl: _

Vybrat... -
Barva: I 004586 A
) Sitka: 0,25 cm =
Sirka: 0,08 cm

) = Vjtka:  025em =
Prahlednost: |0 % =
Zachovat pomér

. VA
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Obrézek 93: Dialogové okno Datové Fada pro ¢arové a bodové grafy — karta Cara

Pfifazeni barev

Barvy pro zobrazeni datovych fad je mozné zadat tfemi zplsoby: zménou vychoziho barevného
schématu pouzitim dialogového okna Datova fada nebo pouZzitim oblasti dat pro nastaveni barvy
ohraniceni a vypIné.

Zména vychoziho barevného schématu

Pokud chceme zménit vychozi barevné schéma datovych fad, zvolime si volbu Nastroje >
MozZnosti > Grafy > Vychozi barvy a urCime barvy pro jednotlivé datové fady. Zde provedené
zmeény ovliviuji vychozi barvy pro vSechny budouci grafy.

Pouziti dialogového okna Datové fady

Jak bylo uvedeno v pfedchozi €asti, dialogové okno Datova fada ma moznosti pro pfifazeni
barev pro ¢ary, oblasti a ohrani¢eni. Dostupné moznosti zavisi na typu grafu.

Pouziti oblasti dat k pfifazeni barev

Pomoci funkce COLOR v Privodci funkci (popsaném v kapitole 7 — PouZziti vzorcl a funkci)
urcime barvy pomoci Cisel RGB modelu barev. Poté pfifadime Cisla k oblastem dat pro barvu
ohraniceni a vypIné na strance Datové Fady v Privodci grafem (viz ,Vybér datovych fad" na
strané 126) nebo v karté Datova rada dialogového okna Oblasti dat (viz ,Zména oblasti dat" na
strané 142).
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Napriklad pomoci funkce COLOR v Priivodce funkci zadame hodnoty 255 pro ¢ervenou, 0 pro
zelenou a 255 pro modrou. Funkce COLOR vypocita kombinovanou hodnotu RGB 16711935.
Poté pri definovani oblasti bunék zadame do oblasti bunék RGB hodnoty pro barvu ohrani¢eni a
vypIné. Volitelné Ize do funkce COLOR zahrnout i hodnotu alfa kanalu. Hodnota alfa se miize
pohybovat od 0 (zcela prlihledné) do 255 (zcela neprdhledné).

Poznamka

Oblasti dat pro barvu ohraniCeni a vypIné Ize zadat pouze pro sloupcové, fadkové,
vyseCoveé, bublinové a Carové grafy.

Kromé pfimého pfifazovani barev pouzijeme k definovani kritérii pro pouZiti konkrétnich barev
také podminéné formatovani. (Podminéné formatovani je popséno v kapitole 2, Zadavani,
Upravy a forméatovani dat.)

Obrazek 94 ukazuje priklad pouziti podminéného forméatovani k ur€eni barev. Funkce COLOR v
Prdvodci funkci byla pouzita k vytvoreni podminéné funkce
=IF(B2>100, COLOR(240,240,0,20), COLOR(150,0,150,20))

Tento vzorec fika, Ze kdyZ je hodnota ve sloupci B nad 100, pouZije se prvni nastaveni RGB k
zabarveni datového bodu v grafu. Pokud hodnota ve sloupci B je 100 nebo méné, pouZije se
vychozi barva (150, 0, 150). Tento vzorec je ve viech burkéach sloupce C. Cisla, ktera se
objevuji ve sloupci C, jsou hodnoty RGB vypoctené pomoci podminéného vzorce (s
odpovidajicim zplisobem zménénymi odkazy na buriky).

Teplota Cislo Barva Cislo vs. teplota

20 67 345374870 120
25 78 345374870 100
80

30 90 345374870
{% 60
35 101351334400 % 0
40 111 351334400 20
45 106 351334400 0

20 25 30 35 40 45 50 55
50 08 345374870
Teplota
55 87 345374870

Obréazek 94: Urceni barvy pomoci funkce COLOR a podminéného vzorce

Graf na pravé strané obrazku 94 ukazuje, jak se barvy méni, aby odrazely podminéné
formatovani.

Formatovani datovych bod

Pomoci dialogového okna Datovy bod upravime vzhled jednotlivych datovych bodd, napfiklad
sloupce nebo pruhu. U vétsiny typd grafli obsahuje dialogové okno stejné stranky Oblast,
Prihlednost a Ohrani¢eni jako v dialogovém okné Datova fada zobrazeném na obrazku 92 na
strané 147. Pro ¢arové, bodové, sitové a burzovni grafy obsahuje dialogové okno stejné
moznosti jako karta Cara dialogového okna Datova fada zobrazena na obrazku 93 na strané
148.

Formatovani datovych bodu:
1) Dvojitym klepnutim na graf pfejdeme do rezimu Uprav. Kolem grafu by se nyni mél objevit
Sedy ramecek.
2) Dvakrat klepneme (ale ne pifilis rychle) na datovy bod, ktery chceme formatovat. Datovy
bod zobrazi Gchyty vybéru.
3) Dialogové okno Datovy bod otevieme jednim z nasledujicich zplsob(:
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— Prejdeme do Forméat > Format vybéru.

— Pravym tlaCitkem mysSi klepneme na datovy body a z mistni nabidky vybereme
Format datového bodu.

— Klepneme na ikonu Format vybéru na nastrojové listé Formatovani.
4) Moznosti formatovani nastavime podle potfeby.

5) Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

6 Tip

Jak je zobrazeno na obrazku 95, umisténim kurzoru na datovy bod zobrazime €islo
datového bodu, Cislo fady a hodnoty X a Y datového bodu.

60
50
40
30

20 Datovy bod 6
10 Datova fada 'Motorové'
0 Hodnoty: &wn 52

led (no bfe dub kvé ¢vn

Obréazek 95: Tip zobrazujici informace o datovém
bodu

Osy

Pridani nebo odebrani popisti os

Pro pridani nebo odebrani popiski os, jako jsou ¢isla nebo kategorie, pouzijeme dialogové okno
Osy, zobrazené na obrazku 96. (Informace o zméné nazvl os najdeme v ¢asti ,Nadpisy,
podnadpisy a ndzev os” na strané 137).

Pouziti dialogového okna Osy:

1) Dvojitym klepnutim na graf pfejdeme do rezimu Gprav. Kolem grafu by se nyni mél objevit
Sedy rdmecek.

2) Otevieme dialogové okno Osy jednim z nasledujicich zplsob(:
— V hlavni nabidce pfejdeme do Vlozit > Osy.
— Klepneme pravym tlacitkem mysi na graf a z mistni nabidky zvolime Vlozit/smazat

osy.

3) Zaskrtneme nebo zrusime zaskrtnuti pro zobrazeni popist os. Zaskrtavaci pole Osa Z je
aktivni pouze v pfipadé, Ze byl vytvoifen 3D graf.

4) Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.
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Vedlejsi osy
[]0sa X
[1OsaY
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Obrazek 96: Dialogové okno Osy

Vybér vedlejsi osy X nebo vedlejsi osy Y v tomto dialogovém okné vytvofi duplicitni popisy na
opacné strané grafu, jak je znadzornéno na obrazku 97. Pokud chceme urcit odliSné jednotky
nebo intervaly pro vedlejsi osu, pouzijeme kartu Méfitko v rozSifeném dialogovém okné Osy,
které je popséano v nasledujici Casti.

S vedlejSi osou Y je také mozné zarovnat jednu nebo vice datovych fad. Tohoto dosahneme
pomoci dialogového okna Datova fada popsaného v €asti ,Zarovnani dat k vedlejSi ose Y" na
strané 145.

led ano bie dub kvé cvn
60 60
50 50
40 40
30 30
20 20
10 ‘ ' 10

0 0
led ano bie dub kvé cvn

Obréazek 97: Obé vedlegjsi osy jsou povoleny.

Uprava a formatovani os

>~

RozSifené dialogové okno Osa obsahuje kromé vySe uvedeného i moznosti pro interval mrizky,
umisténi osy, formatovani ¢ar os, umisténi popiskl os a definici méfitka. Dialogové okno
pouzijeme pro konkrétni osy nebo pro vsechny osy. MoZnosti zobrazené v dialogovém okné
zavisi na vybrané ose, typu grafu a na tom, zda je graf 2D nebo 3D.

Otevieni rozSifeného dialogového okna Osy:
1) Dvojitym klepnutim na graf pfejdeme do rezimu Uprav. Kolem grafu by se nyni mél objevit
Sedy rdmecek.
2) Dialogové okno konkrétni osy (obrazek 98) otevieme jednim z nasledujicich zptsobd
(nékteré moznosti neumoznuji vybér vSech os):

— V hlavni nabidce pfejdeme do Format > Osy a vybereme pozadovanou osu (Osa X,
OsaY, Osa Z, VedlejSi osa X, VedlejSi osa Y nebo VSechny osy).

— Klepnutim pravym tlacitkem mysi na poZadovanou osu v grafu otevieme mistni
nabidku. Poté vybereme Format osy.
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— Klepneme na osu v grafu nebo vybereme osu v rozeviracim seznamu Zvolte prvek
grafu na nastrojové listé Formatovani a klepneme na sousedni ikonu Format vybéru.
Nebo zvolime v hlavni nabidce Format > Format vybéru.

— Na néstrojoveé listé Formatovani klepneme na ikonu Osa X, Osa Y nebo Osa Z. Nebo
klepneme na volbu VSechny osy napravo od téchto ikon.

3) Pro provedeni potfebnych zmén klepneme na kartu pfislusné stranky. MoZnosti pro
kazdou ze stranek jsou vysvétleny dale.

4) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno. Pokud chceme
rezim Uprav opustit, klepneme mimo graf.

Méritko
L] Obraceny smér

[ Logaritmické méfitko

Minimum 0 - [ Automaticky
Maximum 60 - | B Automaticky
Hlavni interval 10 - | [ Automaticky
Pocet vedlejiich intervald 2 - | ) Automaticky
MNapovéda Obnovit OK Zrusit

N

Obréazek 98: Dialogové okno Osa Y — karta Méritko

v v

Definovani méritka
Pro Upravu automaticky generovaného méritka pro hlavni osy pouzijeme kartu Méritko. Kromé

toho pouzijeme kartu Méfitko pro vedlejSi osy, které urCuji méfitka odliSna od hlavni osy. Toto
mUzZe byt uzite¢né napriklad pro zobrazeni stupnic Celsia a Fahrenheita v jednom grafu nebo pro
pripady, kdy jsou data zarovnana k vedlejSi ose Y (viz ,Zarovnani dat k vedlejSi ose Y" na strané

145).
Obsah karty Méritko (obrazek 98) se mize lisit, ale karta mdZe obsahovat nasledujici moZnosti:

Obraceny smér
Definuje pofadi hodnot podél osy. Pokud tato volba neni zvolena, jsou na ose X zobrazeny
vlevo niz8i hodnoty a na ose Y jsou nizZ3i hodnoty zobrazeny dole. Pokud je tato volba
vybrana, pak je orientace zobrazeni dat obracena, jako na obrazku 99.

s

Logaritmické méfitko
Urcuje, Ze osa ma byt logaritmicky rozdélena. Logaritmické méfitko zplsobuje, Ze ¢ary
mriZky jsou od sebe vzdaleny stejné, ale hodnoty mezi jednotlivymi Carami stejné nejsou.
Tuto moznost pouZijeme pfi praci s hodnotami, které se od sebe vyrazné Ilisi.
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Pronajem vybaveni
Mésic

uno cvn

led bie dub kvé
0
10 1 . B Kanoe
o 20 B Cluny
\UTI

Motorové

60

Obréazek 99: Viysledek pri obraceni sméru na ose Y

Minimum/Maximum
Nastavuje prvni/posledni hodnoty pro osu. Pokud chceme tuto moZnost nastavovat ru¢né,
volba Automaticky nesmi byt vybrana.

Hlavni interval
Definuje intervaly pro hlavni rozdéleni osy. Tyto intervaly se pouZiji pro oznaceni intervalu
(definované na karté Umisténi v dialogovém okné Osa) a mfizky. Pokud chceme tuto
moZnost hastavovat ru¢né, volba Automaticky nesmi byt vybrana.

Vedlejsi pocet intervalli
Definuje pocet intervalll (nikoliv hodnoty mezi intervaly), ktery rozdéli hlavni intervaly.
Stejné jako pro hlavni intervaly se i zde pouzije definovany pocet intervalll pro znacky
intervalu (specifikované na karté Umisténi v dialogovém okné Osa) a mrizky. Pokud
chceme tuto moznost nastavovat ruéné, volba Automaticky nesmi byt vybrana.

U nékterych typt grafdi mohou byt k dispozici i dal$i moZnosti:

Typ
UrCuje, zda jsou popisy osy text, datum nebo maji byt detekovany automaticky.

Rozliseni
Pro typ datum by kroky intervalu mély byt dny, mésice nebo roky.

6 Tip

Pokud osa X nezobrazuje ¢as dle o¢ekavani, miize nam pomoci tento problém
vyfeSit ruéni zadani minimalniho a maximalniho ¢asu na karté Méritko.

Umisténi os, popisk( a znacek intervalu
Pomoci karty Umisténi (obrazek 100) uréime umisténi popiskl os a znacek intervald.
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MEefitko Umlstenl Céra Popisek Cisla Pismo Efekty pro pismo Asijska typografie

Pfimka osy

Protnout dalii osu v |Kategorie ~ | |led |~
Popisky

Umisténi popiskd PobliZ osy ™

Znacky intervalu

Hilavni: Ovnitini [ Vnéjsi

Vedlejsi: Ovnitini  CIVnéjsi

Umisténi znacek U osy a popiski

MNapovéda Obnovit QK Zrusit

Obréazek 100: Dialogové okno Osy — karta Umisténi

Pfimka osy
Pomoci této volby nastavujeme, kde se osy protinaji, jak je znazornéno na obrazku 101.
Moznosti v rozeviracim seznamu jsou Za€atek, Konec nebo Kategorie. Pokud vybereme
volbu Kategorie, zobrazi se dalSi rozeviraci nabidka umoziujici vybér poZzadované

hodnoty.

1206
]

8100 -
- - 80 =
[ ] 60
40
20

0
10 20 30 40 50 60 70
Obrazek 101: Osa Y je nastavena na kiizeni osy Y v
konkrétni hodnoté

Popisky
Pomoci této volby nastavujeme, kde budou umistény popisky osy. Umisténi popisk(
uréime pomoci rozeviraciho seznamu Umisténi popisk(. Moznosti Mimo zacatek a Mimo
konec pouZzijeme pro umisténi popiskl na ose se zapornymi Gisly, jak je zobrazeno na
obrazku 102.

Znacky intervalu
— HlavnilVedlejsi — ur€uje, zda se znacky intervalu zobrazuji pro hlavni/vedlejsi

v

intervaly. Tyto intervaly jsou definovany na karté Méritko, jak bylo popsano vyse.

— VnitfnilVnéjsi — urCuje, zda jsou znacky intervalu umistény na vnitfni nebo vnéjsi
strané osy. Znacky intervalu jsou na obrazku 102 na obou stranach.

— Umisténi zna¢ek — urCuje, kde budou znacky umistény: U popiski, U osy nebo U
osy a popisku. (Horni dva grafy na obrazku 102 zobrazuji popisky podél os. Znacky
jsou tedy jak na ose, tak u $titkd. Znacky ve spodnich dvou grafech jsou umistény u
popisku.)
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PobliZ osy

PobliZ osy (opaéna strana)

15 15
1 1

0.5 056 $ PP REERS S S
0 0
059 PP PP PP 0,5
-1 -1
-1,5 15

Mimo zacatek Mimo konec

15 s P PA P Pe
1 15
0,5 1
0 05
-0.5 0
-1 0,5
-1,5 1
SR PR RR SRS PP 1,5

Obrazek 102: Umisténi popisk( osy

Karta Céra
Karta Cara nabizi moznosti pro

v sy

formatovani stylu ¢ary, barvy, Sif

obrazku 93 na strané 148 kromé& moznosti v ¢asti /kona.

Karta Popisek
Na karté Popisek (obrazek 103)

vybereme, zda se maji popisky zobrazit nebo skryt a ur€ime, jak

s nimi zachazet, kdyz se do grafu nehodi. Jednotlivé moZnosti jsou popsany dale.

Méfitko Umisténi Cara P‘ Cisla Pismo Efekty pro pismo Asijska typografie
Zobrazit popisky
Usporadani Tok textu
) DlaZdice [ Presah
) Pfedsunout liché L Zalomeni
) Pfedsunout sudé
® Automaticky
Orientace textu
At [ Svisle zarovnané
BT %o > Stupné
'H/ ) L
Smér textu:  |PouZit nastaveni nadrazeneho objektu |~
Napovéda Obnovit oK Zrusit

Obrazek 103: Dialogové okno Format osy — karta Popisek
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Zobrazit popisky
Nastavuje, zda se maji zobrazit nebo skryt popisky os.

Usporadani
Definuje vodorovné nebo svislé zarovnani popiskl na ose X nebo Y. Tyto moZnosti jsou
dostupné pouze pro 2D grafy.

— Dlazdice — usporada popisky na ose jeden vedle druhého.

— Predsunout liché — pfedsune popisky na ose tak, Ze popisky se sudym poradim
posune nize nez popisky s lichym pofadim (na svislé ose posune popisky se sudym
pofadim vice doleva).

— Predsunout sudé — prfedsunuté popisky na ose tak, Ze popisky s lichym pofadim
posune nize nez popisky se sudym poradim (na svislé ose posune popisky s lichym
pofadim vice doleva).

— Automaticky — popisky na ose usporada automaticky.

Poznamka

Problémy se zobrazenim $titk mohou nastat, pokud je graf pfilis maly. Tomuto se
vyhneme bud zvétSenim grafu nebo zmenSenim velikosti pisma.

Tok textu
UrCuje tok textu v popiscich.

— Presah — umoziuje popiskiim osy pfesahovat.

— Zalomeni — umoziiuje zalomeni textl, aktivuje zalomeni textu na novy fadek v
dostupnych mezerach.

Orientace textu
Ur€uje smér a orientaci textu v popisku.

Svisle zarovnané
Zarovna znaky svisle tak, Ze text ¢teme shora dold.

Kolo ABCD
Urcuje orientaci textu klepnutim a pretaZzenim ukazatele na kole. Orientace znakd "ABCD"
na kole odpovidaji novému nastaveni.

Stupné
Zobrazuije Uhel orientace textu uréeny koleckem ABCD nebo manualnim zadanim stupiili
do tohoto pole.

Smeér textu
Ur€uje smeér pro jakykoliv text, ktery pouziva komplexni rozvrzeni textu (CTL). CTL je
dostupné pouze tehdy, kdyz je zapnuta moznost Nastroje > MozZnosti > Jazykova
nastaveni > Jazyky > Vychozi jazyky pro dokumenty > Komplexni rozvrZeni textu.

Cisla

Karta Cisla (obrazek 104) umoZfiuje nastaveni atributl pro jakakoliv &isla pouZitd na ose Pokud
je vybrana volba Format zdroje (jako je tomu ve vychozim nastaveni), jsou Cisla formatovana
pfesné tak jako v tabulce. Pokud tuto moznost odzna¢ime, mame moznost zménit formatovani

Cisel. Vice informaci o forméatovani Cisel nalezneme v kapitole 2, Zadavani, Upravy a formatovani
dat v této pfiruCce a v online napovédeé.
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Méfitko Umisténi Céra Popisek Cisla Pismo Efekty pro pismo Asijska typografie
Kategorie Format Jazyk
Vie Vichozi - Cestina |
Definovane uZivatelem -1235 DFDrmatzerJe
Procento -1235
Ména -1 234,57
Datum -1 234,57
Cas -1234,57 h
Veédecky -1235€
Zlomek -1235€
Booleovska hodnota -1234,57 €
Text -1 234,57 €
-1 234,57 123457
-123457 € v '
MozZnosti
Desetinna mista; 2 OZaporna ¢isla cervend
Uvodni nuly: |1 = L Oddeélovac tisici
Formatovaci kod
Standard
Definovane uZivatelem
MNapoveéda Obnovit oK Zrusit

Obrézek 104: Dialogové okno Osy — karta Cisla

Pismo a efekty pisma

Karty Pismo a Efekty pro pismo pouzijeme pro nastaveni pisma a efektd pisma pro popisky osy.
Tyto karty obsahuji stejné moznosti jako karty pro uréeni pisem a efektll pisem v buiikach. Dalsi
informace nalezneme v kapitole 2, Zadavani, Uprava a formatovani dat.

Asijska typografie

Nastaveni Asijské typografie pro popisky osy. Tato karta je stejna jako karta pro urCeni Asijskych
moznosti typografie pro buriky. Dalsi informace nalezneme v kapitole 2, Zadavani, Gprava a
forméatovéni dat.

Hierarchické popisy os

Vice Urovni kategorie je mozné podél osy grafu zobrazit hierarchicky. Hierarchické popisky os
jsou vytvareny automaticky, pokud je prvni sloupec nebo fadek dat definovan jako text (na rozdil
od situace, kdy je prvni fadek nebo sloupec definovan jako popisek). Pfiklad hierarchickych
popiskl je uveden na obrazku 105. V tomto pripadé aplikace Calc automaticky definuje rozsah
dat pro kategorie jako prvni dva sloupce v tabulce. To se odrazi i v grafu, ktery ukazuje
hierarchicky vztah mezi Ctvrtletimi a mésici.
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Pronajem vybaveni

Kanoe Cluny Motorové
1. Ctvrtleti  led 12 23 a7
ano 9 31 54
bfe 14 27 56
2. Gtvrtleti dub 17 28 435
kvé 13 19 39
évn 8 27 52
60
50
40

30 W Kanoe

2 m Cluny
10 ‘ ' Motorové
0
led

uno | bfe | dub | kvé | &vn
1. Ctvrtleti 2. Ctvrtleti

Obrazek 105: Priklad hierarchického oznaceni
0s

(=]

Popisky dat

Popisky dat zobrazuji informace vedle datovych bodUl v grafu. Tyto popisky mohou byt docela
uzite€né pro zvyraznéni konkrétnich dat pfi pfedkladani podrobnych informaci. Budme vSak
velmi opatrni, abychom nevytvorili graf, ktery bude spiSe nepfehledny, nez aby byl 1épe Citelny.

Pridavani a formatovani popiski dat pro datové rady

Pridani nebo formatovani datovych popiski pro datové fady:

1) Dvojitym klepnutim vybereme graf a prfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) Konkrétni datovou fadu vybereme jednim z nasledujicich zplsobd:
— Klepneme jednou kdekoliv v datové fadé.

— V rozbalovacim seznamu Zvolte prvek grafu v nastrojové listé Formatovani vybereme

nazev datové rady.

4 Poznamka

Pokud neni vybrana zadna datova fada, budou popisky pfidany ke vSem datovym
fadam.

3) Dialogové okno Datové popisky (obrazek 107) otevieme jednim z nasledujicich zptsob:
— V hlavni nabidce pfejdeme do Vlozit > Popisky dat. Pokud vybereme datové fady,

aplikace Calc zobrazuje ve vychozim nastaveni popisky dat pro tyto datové fady, a
zobrazuje dialogové okno Popisky dat pro zvolené datové fady. V tomto pfipadé
zlistanou popisky dat zobrazeny i tehdy, kdyZ v dialogovém okné stiskneme tlagitko
Cancel. Pokud nebyly vybrany datové fady, aplikace Calc zobrazi dialogové okno
Popisky dat pro vSechny datové fady (obrazek 106). Ovladaci prvky v tomto
dialogovém okné jsou podobné jako na karté Popisky dat v dialogovém okné Popisky
dat, které je popsano dale.

Nejprve klepneme pravym tlacitkem mySi na zvolenou datovou fadu v grafu a z mistni
nabidky vybereme Vlozit popisky dat. Aplikace Calc zobrazi popisky dat s vychozim
nastavenim. Poté znovu klepneme pravym tlacitkem mysi a z mistni nabidky
vybereme Format popiskt dat.
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— Vybereme zamyslené popisky dat v grafu nebo v rozeviracim seznamu Zvolte prvek
grafu a zvolime Format > Format vybéru v hlavni nabidce nebo stiskneme ikonu
Format vybéru na nastrojové listé Formatovani.

Popisky dat pro vsechny datové fady

Vlastnosti textu

Zobrazit hodnotu jako &islo; Format €isla...

] Zobrazit hodnotu jako procento Format procenta...
[]Zobrazit kategorii
Ll Zobrazit Kli¢ legendy

] Automaticky zalomit text

Oddélovac

Mezera |

Umisténi  Nad v|
Otoéit text
|
. s
= e |0° > stupiid
-~ -

Smér textu |PouZit nastaveni nadfazeného objektu| ~

MNapovéda QK £rudit

Obrazek 106: Dialogové okno popisky dat pro
vSechny datové rady
4) Vybereme pozadované moznosti. MoZnosti jsou vysvétleny nize.

5) Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

0 Tip

Datovou fadu vybereme tak, Ze klepneme na sloupec, pruh nebo jinou grafickou
reprezentaci datové fady. Jeden datovy bod pak vybereme tak, Ze chvili pockame a
znovu na né€j klepneme.

VétSina stranek dialogového okna Popisky dat se pouZiva v jinych dialogovych oknech a jsou
snadno pochopitelné. Vyjimkou je karta Popisky dat (obrazek 107), ktera obsahuje nasledujici
moZzZnosti:

Zobrazit hodnotu jako Cislo

Zobrazi Ciselnou hodnotu datového bodu. Pokud je tato volba vybrana, aktivuje se tlacitko
Format cisla.

Format Cisla 3
Otevie dialogové okno Format Cisla. Toto dialogové okno je stejné jako karta Cisla v
dialogovém okné Formét buriky, ktera byla popisovana v kapitole 2, Zadavéni, prava a
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formatovani dat. ZruSenim vybéru volby Format zdroje aktivujeme mozZnosti v dialogovém
okné Formét Cisla.

Popisky dat pro datovou fadu ‘Motorové’

Ohranic¢eni Popisky dat Pismo Efekty pro pismo Asijska typografie

Vlastnosti textu

[iZobrazit hodnotu jako ¢islo: Formét éisla..

[ Zobrazit hodnotu jako procento  Format procenia..
[ Zobrazit kategorii

[ Zobrazit kli¢ legendy

L] Automaticky zalomit text

Oddélovac |Mezera

Umisténi Mad e
Otodit text
ol
—_' ABCD ' 0 = stupnd
.-'/ 4

Smér textu |PouZit nastaveni nadfazeného objektu | ~

MNapovéda Obnovit oK Zrusit

Obrazek 107: Karta Popis dat v dialogovém okné Popisky dat

Zobrazit hodnotu jako procenta
Zobrazi procentualni hodnotu datovych bodd ve viech datovych fadach. Pokud je tato
volba vybrana, aktivuje se tlaCitko Format procenta. Uvédomme si, Ze uvedené procento
je hodnota Y datového bodu jako procento z celkovych hodnot Y pro konkrétni kategorii
nebo hodnotu. Na Obrazku 108 je pro kdnoe v Unoru zobrazena hodnota 10% (Ciselna
hodnota je 9) z celkové Uunorové hodnoty 94 (soucet hodnot 9, 31 a 54).

Format procenta
Otevre dialogové okno Format Cisla pro procentualni hodnotu. Toto dialogové okno je
stejné jako karta Cisla v dialogovém okné& Format buriky, které bylo popisované v Kapitole
2, Zadavani, aprava a formatovani dat. ZruSenim vybéru volby Format zdroje aktivujeme
moznosti v dialogovém okné Format Cisla pro procentualni hodnotu.

Zobrazit kategorii
Vedle kazdého datového bodu se zobrazi kategorie. Tato volba je aktivni pro vSechny
popisky dat na obrazku 108. VSechny popisky s Udaji tedy zobrazuji mésic. Text popiski
dat vychazi z kategorie datovych fad a v grafu jej neni mozné zménit. Lze jej zménit pouze
v datech tabulky.
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0
led ino bre dub kvé tvn

Obrazek 108: Ukazky moZnosti popisku dat

Zobrazit kli¢ legendy
Vedle kazdého datového bodu zobrazi ikonu legendy odpovidajici datové fady. Obrazek
108 zobrazuje kliCe legendy pro motory a ¢luny, ale ne pro kanoe.

Automaticky zalomit text
V pfipadé potfeby zalomi text popisku dat.

Oddélovacé
Pomoci této volby uréime, co bude pouzito k oddé&leni vice textovych fetézcl v pripadé, Ze
budou vybrany alespor dvé vySe uvedené moznosti. Obrazek 108, pro popisky dat datové
fady kanoi je jako oddélovac nastaven stiednik, pro popisky dat datové fady motorovych
¢lund je jako oddélovac pouzit Novy fadek a pro popisky datové fady ¢lund je jako
oddélovac pouzita Carka (s vyjimkou popisku Cerven, ktery byl upraven). Dal$i moZnosti
jsou Mezera a Obdobi.

Umisténi
Urcuje umisténi popiskl dat vzhledem k datovym boddim. Na Obrazku 108 jsou popisky dat
umistény pod grafem datové fady kanoe, nad grafem datové rady Cluny a vpravo u grafu

datové fady motorové ¢luny. DalSi dostupné moznosti jsou zavislé na typu grafu, ale
mohou obsahovat Vlevo, Na stfed, Vné, Uvnitf a Pobliz poc¢atku.

Otocit text
Nastaveni orientace textu popiskll dat pomoci ¢iselniku nebo zadanim Uhlu natoceni.

Smér textu
UrCuje smér pro jakykoliv text, ktery pouziva komplexni rozvrzeni textu (CTL).

Popisky dat pro jednotlivé datové body
Nékdy je vhodné pouzit popisky dat na jeden nebo nékolik datovych bodd, a ne na vSechny

MrLw N s

Pridani jednoho datového popisku
Popisek dat pro jeden datovy bod vloZime nasledujicim zplsobem:
1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Gprav. Kolem grafu by se nyni
meél objevit Sedy ramecek.
2) Klepneme jednou na datovy bod, pockame a opakovanym klepnutim tento datovy bod
vybereme. (P¥ilis rychlé klepnuti otevie dialogové okno Datova fada.)
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3) Pravym tlaCitkem mysi klepneme na datovy bod a z mistni nabidky zvolime Vlozit jeden
popisek dat. Popisek dat bude mit vychozi nastaveni.

4) Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Formatovani popisku pro jeden datovy bod

Pokud chceme forméatovat existujici popisek jednoho datového bodu, postupujeme podle pokyn(
vyse, ale misto kroku 3 otevieme dialogové okno Popisek dat nasledujicim zptisobem (obrazek
107): klepneme pravym tlacitkem mySi na datovy bod a z mistni nabidky zvolime Format
jednoho popisku dat.

Moznosti v dialogovém okné Popisky datovych fad jsou stejné jako v dialogovém okné Popisky
dat, které bylo popsano vySe.

K dialogovém oknu Popisky datovych fad se dostaneme také tak, Ze klepneme na popisek dat,

pockdme a klepneme na néj znovu. Potom klepneme pravym tlaCitkem mySi a z mistni nabidky
zvolime Format jednoho popisku dat.

Odstranéni popiski dat

Odstranéni popisku jednoho datového bodu, jedné datové fady nebo viech datovych bodd
pomoci jedné z nasledujicich moZznosti.

Pred provedenim nékterého z nasledujicich krok{ nejprve vybereme graf dvojitym klepnutim na
néj a prejdeme do rezimu Uprav. Kolem grafu by se nyni mél objevit Sedy ramecek. Kdyz
skon&ime, pokud chceme, klepneme mimo graf a opustime rezim Gprav.

Odebrani vsech popisk( dat z jedné datové rady
Metoda jedna

Pravym tlaCitkem mySi klepneme nékde v datové fadé a z mistni nabidky zvolime Smazat
popisky dat.
Metoda dva
1) Jednim z nasledujicich zplsob( otevieme dialogové okno Popisky dat (obrazek 107):

— Klepnutim kdekoliv v datové fadé tuto datovou fadu vybereme. V hlavni nabidce
prejdeme do VloZit > Popisky dat.

— V rozeviracim seznamu Zvolte prvek grafu v nastrojové listé Formatovani vybereme
nazev datové fady, pro kterou chceme pridat popisky dat nebo vybereme jeden z
popiskd datové fady. Poté klepneme na sousedni ikonu Format vybéru nebo zvolime
Format > Format vybéru v hlavni nabidce.

— Klepneme pravym tlaCitkem mysi na datovou fadu a z mistni nabidky zvolime Format
popiskl dat.

2) Na karté Popisky dat odznaCime vSechny moznosti a klepneme na tlacitko OK.

Odebrani popisku dat z jednoho datového bodu

1) Klepneme jednou na datovy bod, chvili po€kdme a klepneme na stejny datovy bod znovu,
abychom otevreli dialogové okno Popisky dat.

2) Klepnutim pravého tlacitka mySi otevieme mistni nabidku a vybereme Smazat jeden
popisek dat.

Odebrani vsech popiski dat
1) Ujistime se, Ze neni vybran zadny popisek dat nebo datova fada.
2) V hlavni nabidce pfejdeme do VloZit > Popisky dat.
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3) V dialogovém okné Popisky dat pro vSechny datové fady zruSime oznaceni vSech
moZznosti pro popisky dat, abychom odstranili popisky dat, a poté klepneme na tlacitko
OK

MFizky
MFiZka oddéluje intervaly podél os, aby bylo moZné odhadnout hodnoty datovych bodd. Hlavni a

vedlejsi mfiZzky jsou zobrazeny na obrazku 109. Tmavsi Cary s Cisly tvofi hlavni mfizku, zatimco
svétlejSi Cary mezi nimi tvori vedlejSi mfizku. VSimneme si, Ze ve vychozim nastaveni je aktivni

~r~

hlavni ¢ara mfizky na ose Y.
100

0
0 1 2 3 4 5 4] T

Obréazek 109: Hlavni a vedlejsi mfiZky pro osy Xa Y
MFizky jsou k dispozici pro vSechny typy grafli s vyjimkou grafli vysecovych.

Pfidanilodebrani ¢ar mfizky
1) Nejprve vybereme graf dvojitym klepnutim na néj a vstoupime do reZimu Uprav. Kolem
grafu by se nyni mél objevit Sedy rdmecek.
2) Provedeme jeden z nasledujicich krokd:

v

— V hlavni nabidce zvolime Vlozit > MFizky a otevieme dialogové okno Mfizky (obrazek
110). ZaSkrtneme/zrusSime zaSkrtnuti poli¢ek podle potfeby. Zaskrtavaci pole Osa Z je
aktivni pouze pro 3D graf. Klepnutim na OK dialogové okno zavieme.

Hlavni mrizky Vedlejsi miizky
[10sa X [1i0sa X
Osa ¥ CosaY
MNapovéda OK Zrusit

Obrazek 110: Zakladni dialogové okno
Mrizka
— Klepneme na ikonu Vodorovné mfizky nebo ikonu Svislé mtizky; obé najdeme na
nastrojové listé Formatovani. Jednim klepnutim zapneme hlavni mfizky. Druhym
klepnutim zapneme také vedlejsSi mfizky. DalSim klepnutim mfizky vypneme.

3) Pokud chceme rezim Gprav opustit, klepneme mimo graf.

"/ Poznamka

Na nastrojové listé Formatovani najdeme ikony Vodorovné mfizky a Svislé mfizky,
které zobrazi ¢ary mrizky pro osu Y, resp. pro osu X. To mize byt zavadgjici, protoze
jak osa 'Y, tak osa X mohou byt vodorovné nebo svislé, v zavislosti na typu grafu. U

sloupcového grafu tedy klepneme na ikonu Vodorovné mfizky pro ovladani svislé
mrizky.
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Formatovani mrizky
Kromé dialogového okna MFiZzky zobrazeného na obrazku 110, najdeme dalSi dialog pro
formatovani mfizek. Otevieni dialogového okna formatovani mfizky:

1) Dvojitym klepnutim vybereme graf a prfejdeme do rezimu uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) V hlavni nabidce zvolime Format > Mfizka, vybereme odpovidajici typ mfizky a tim
otevieme dialogové okno Formatovani mrizky (obrazek 111).

Hlavni mfizka osy Y

Cara

Vlastnosti cary

Styls ;
Barva: [ #B3B3B3 v
Sitka: 0,04 cm

s
-
s
-

Prihlednost: |0 %

Mapoveda Obnovit oK Zrusit

Obrézek 111: Dialogové okno Forméatovani mriZky
3) Mame moZnost nastavit moznosti formatovani pro styl ¢ary, barvu, Sitku a prihlednost.

4) Klepnutim na OK okno zavieme. Pokud chceme rezim Gprav opustit, klepneme mimo
graf.

@ Poznamka

Pro uréeni intervalll mezi ¢arami mrizky pouZijeme kartu Méritko v dialogovém okné

Osa. To je popsano v ¢asti ,Definovani méfitka” na strané 152.

3D grafy

Nastaveni 3D vzhledu

Sloupcové, pruhové, vysecové a plosné grafy mohou byt zobrazeny ve formatu 3D. Nastaveni
pro vytvoreni 3D grafu je na prvni strance Prlivodce grafem. Pokud byl jiZ graf vytvoren,
vytvofime 3D vzhled nasledujicim zplisobem:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) Provedeme jeden z nasledujicich kroki:
— Zvolime Format > Typ grafu.
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3)
4)

5)
6)

— Klepneme na ikonu Typ grafu na nastrojové listé Formatovani.
— Klepneme pravym tlacitkem mySi na graf a z mistni nabidky zvolime Typ grafu.
V dialogovém okné Typ grafu zvolime 3D vzhled.

Z rozeviraciho seznamu vybereme zakladni schéma pro vykresleni grafu - Jednoduchy
nebo Realisticky

Pro sloupcové a fadkové grafy vybereme tvar: Kvadr, Valec, Kuzel nebo Jehlan.

Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.

Nastaveni 3D zobrazeni

Chceme-li provést zmeény v 3D grafu, pouZijeme dialogové okno 3D pohled (obrazek 112).

3D pohled

Perspektiva Vzhled Osvétleni

[ Pravouhlé osy

Otoceni X 11° =
Otoceni' Y 25° =
Otoceni Z =

1

MNapovéda oK £rusit

Obréazek 112: Dialogové okno 3D pohled — karta
Perspektiva

Pomoci dialogového okna 3D pohled mizeme zménit 3D vzhled, vEetné perspektivy, zobrazeni a
osvétleni. Mé&jme na pameéti, Ze graf musi byt jiz nastaven tak, aby mél nastaven 3D vzhled, jak
je popséano vyse. Dialogové okno 3D pohled otevieme takto:

1)

2)

3)
4)

Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
meél objevit Sedy ramecek.

Provedeme jeden z nasledujicich krokd:

— Klepneme pravym tlacitkem mysi na graf a z mistni nabidky vybereme 3D pohled.
— V hlavni nabidce zvolime Format > 3D pohled.

— Klepneme na ikonu 3D pohled na nastrojové |isté Formatovani.

Provedeme poZzadované zmény.

Klepnutim na OK okno zavieme. Pokud chceme rezim Uprav opustit, klepneme mimo
graf.
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Toto dialogové okno ma tfi karty, kterou jsou vysvétleny dale.

Rotace a perspektiva

Neékolik rad pro pouZzivani karty Perspektiva (obrdzek 112) pro otaCeni 3D grafu nebo zmény
perspektivy:

* Pro ¢elni pohled na graf nastavime vSechny Ghly na 0 stupid. Vysecové grafy a
prstencové grafy jsou zobrazeny jako kruhy.

* S aktivni volbou Pravouhlé osy Ize graf otacet pouze ve sméru X a Y; to znamena
rovnobézné s hranicemi grafu.

* Hodnota 90 stupiid pro otoeni X a hodnota O stupiili pro otoeni Y a Z nam poskytne
pohled z horni ¢asti grafu. Kdyz je hodnota X nastavena na -90 stupid, ziskdme pohled
ze spodni ¢asti grafu.

* Rotace se aplikuje v nasledujicim pofadi: nejprve osa X, poté osa Y a nakonec osa Z.

* KdyZ je povoleno stinovani (viz nize) a graf se otaci, osvétleni se otaci jako by bylo
pevné spojeno s grafem.

* QOsy otaceni se vzdy vztahuji ke strance, nikoliv k osdm grafu. Toto je rozdil od jinych
program{ na tvorbu grafa.

* Vybérem volby Perspektiva mame moznost zobrazit graf v centralni perspektivé jako
prostfednictvim objektivu kamery (na rozdil od pouZiti paralelni projekce). Ohniskovou
vzdalenost nastavime pomoci otocného bodu nebo do pole zadame Cislo. Pfi nastaveni
100 % vypada vzdalena hrana grafu pfiblizné polovi¢ni proti blizké hrané.

Interaktivni rotace 3D graf(

Kromé pouzivani karty Perspektiva dialogového okna 3D pohled miizeme otacet 3D grafem i
interaktivné a to nasledujicim zplsobem:

1) Dvojitym klepnutim vybereme graf a pfejdeme do reZzimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) Klepneme jednou na zed grafu, coz zpUsobi, Ze se zobrazi kulaté tchyty vybéru. Kurzor
se zméni na ikonu rotace.

3) Stiskneme a drzime levé tlaCitko mysi a soucasné tdhneme pozadovanym smérem.
Zobrazi se ¢arkovany obrys grafu, ktery pomahé zobrazit, jak bude vypadat vysledek
otoceni.

4) AZ budeme s oto€enim grafu spokojeni, uvolnime tlaCitko mysi.
5) Klepnutim mimo graf opustime rezim Upravy.

Vzhled

Kartu Vzhled dialogového okna 3D pohled (obrazek 113) pouzijeme pro Upravu nékterych
moZznosti vzhledu dat ve 3D grafu.

Nejprve vybereme schéma z rozeviraciho seznamu Schéma - Realisticky (vychozi) nebo
Jednoduchy. Vybrané schéma nastavuje moznosti a svételné zdroje. V zavislosti na vybraném
schématu nemusi byt k dispozici vSechny moznosti. Pokud chceme vytvofrit vlastni schéma,
vybereme nebo zrusime vybér kombinace moznosti Stinovani, Okraje objektli a Zaoblené
hrany.

Nékolik rad:

* Vybérem Stinovani pouzijeme Gouraudovu metodu pro renderovani povrchu. Jinak se
pouzije plocha metoda. Plochd metoda nastavuje pro kazdy mnohouhelnik jednu barvu a
jas. Hrany jsou viditelné, ale mékké pfechody a bodova svétla nejsou mozna.
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pouziti stinovani najdeme v pfiruéce Privodce programem Draw.
Vybérem volby Okraje objektd vykreslime ¢ary podél okrajd.
Vybérem Zaoblené hrany vyhladime okraje jednotlivych tvard.

3D pohled

Perspektiva Vzhled Osvétleni

Stinovani
L] Qkraje objekti
[l Zaoblené hrany

Mapovéda OK Zrusit

Obrézek 113: Dialogové okno 3D pohled — karta Vzhled

Osvétleni

Kartu Osvétleni (obrazek 114) dialogového okna 3D pohled pouzivame k ovladani svételnych
zdrojd pro 3D pohled.

Zde jsou jednotlivé moznosti s doporu¢enimi:

Klepnutim na kterékoliv z osmi tlaCitek zapneme nebo vypneme zdroj svétla.
Prvni svételny zdroj promita odraz svétla se zvyraznénim.

Druhy svételny zdroj je ve vychozim nastaveni zapnuty. Je to prvni ze sedmi normalnich,
rovnomérnych zdrojll svétla.

U vybraného zdroje svétla vybereme barvu z prvniho rozeviraciho seznamu pod osmi
tlaCitky zdroje svétla. Jinou moznosti je stisknuti sousedniho tlaCitka pro vybér barvy
pomoci dialogového okna Vyberte barvu. Méjme na paméti, Ze hodnoty jasu vSech svétel
se sCitaji, takze pfi povoleni vice svétel pouzijeme tmavé barvy.

Maly nahled v dialogu ukazuje vysledek pfemisténi svételného zdroje.
KaZdy vybrany svételny zdroj se objevi jako mal& barevna koule v ur€ené barvé. Koule je
vétsi, kdyZ je zdroj svétla aktivné vybran.

Kazdy svételny zdroj vzdy nejprve sméfuje doprostied objektu. Posunutim svislého
posuvniku upravime Uhel osvétleni. Vodorovny posuvnik otaci svétlo kolem objektu.
Kromé toho klepneme na zdroj svétla a pretahneme jej na pozadované misto.

Klepnutim na tlacitko v pravém dolnim rohu nahledu pfepneme model vnitfiniho osvétleni
mezi kouli a kvadrem.

Pouzijeme rozeviraci seznam Ambientni osvétleni pro definovani okolniho svétla, které
sviti s jednotnou intenzitou ze vSech smérl. Jinou moznosti je stisknuti sousedniho
tlaCitka pro vybér barvy pomoci dialogového okna Vyberte barvu.

Vice informaci o nastaveni osvétleni najdeme v pfiru¢ce Privodce programem Draw.
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3D pohled

Perspektiva Vzhled Osvétleni

Zdroj osvétleni

AREIREIRE
1 T I O T I o I ™, U .

I ndigova v | &
Ambientni osvétleni
B Tmavé seda 1 v | @
Napovéda QK Zrusit

Obréazek 114: Dialogové okno 3D pohled — karta Osvétleni

Spojnice trendu a pfimky stfedni hodnoty

Spojnice trendu pomahaji zobrazit vztahy mezi rozptylenymi datovymi body datové fady. Aplikace
Calc ma dobry vybér typt regrese pro tvorbu spojnic trendu: linearni, logaritmicka, exponencialni,
mocninna regrese, polynomicka a klouzavy primeér. Vybereme typ, které je nejblize priichodu
v8emi viemi body v datové fadé.

Spojnice trendu miZeme pridat do v3ech typl 2D grafl s vyjimkou vysecovych, sitovych a
burzovnich grafl. Po vloZeni do grafu se v legendé grafu automaticky zobrazi reprezentace
spojnic trendu.

@ Poznamka

Pro typy graf(, které pro osu X pouZzivaji kategorie (jako sloupcové, pruhové nebo
Céarové grafy), se jako hodnoty pro vypocet spojnic trendu pouZivaji Cisla 1, 2, 3.
Naproti tomu typy grafd XY (bodovy) zobrazuji podél osy X spiSe data neZ kategorie.
Vyznamné regresni rovnice tak mohou zobrazovat pouze typy grafd XY.

Pridavani a uprava spojnic trendu
Spojnice trendu je mozné v jeden okamzik pfidavat pouze k jedné datové rfadé. Postup pridani
spojnic trendu do datové fady:
1) Dvojitym klepnutim na graf vstoupime do rezimu Uprav. Kolem grafu by se nyni mél
objevit Sedy rdmecek.
2) Datovou fadu vybereme jednim z nasledujicich zplsobd:
— Klepneme jednou na znazornéni datové fady (sloupec, pruh, ¢aru nebo bod).

— Datovou fadu vybereme z rozeviraciho seznamu Zvolte prvek grafu v nastrojové listé
Formatovani.

3) Jednim z nasledujicich zplisobl otevieme dialogové okno Spojnice trendu (obrazek 115):
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— V hlavni nabidce zvolime Vlozit > Spojnice trendu.

— Klepneme pravym tlacitkem mysi na datovou fadu a z mistni nabidky zvolime Vlozit
spojnici trendu.

4) Vybereme typ regrese a pozadované moznosti. Tyto moznosti jsou vysvétleny dale.

5) Klepneme na tlacitko OK pro zavieni dialogového okna a umistime spojnici trendu do
grafu. Pokud chceme rezim Gprav opustit, klepneme mimo graf.

Regresni typy

Ve vychozim nastaveni se x pouZziva pro vodorovné hodnoty a f(x) pro svislé hodnoty. Zménime
nazvy pod Nazev proménné X a Nazev proménné Y v dialogovém okné Spojnice trendu.

Linearni spojnice trendu
Regrese pomoci rovnice y = a - x+b. Absolutni ¢len mdze byt vynucen.

Polynomicka spojnice trendu
Regrese pomoci rovnice y = Zi (ai - xi). Absolutni ¢len a0 mdze byt vynucen. Stupei
polynomu musi byt uveden (nejméné 2).

Logaritmicka spojnice trendu
Regrese pomoci rovnice y = a - In(x) + b. Pouzivaji se pouze kladné hodnoty x.

Exponencialni spojnice trendu
Regrese pomoci rovnice y = b - exp(a - x).Tato rovnice je ekvivalentni s rovniciy = b - mx,
kde m = exp(a). Absolutni ¢len midZe byt vynucen. UvaZuji se pouze kladné hodnoty y, s
vyjimkou pfipadd, kdy jsou vSechny hodnoty y zaporné. V takovém pfipadé je pouzita
rovnice y = -b-exp(a - x).

Mocninna spojnice trendu
Regrese pomoci rovnice y = b - xa. V Uvahu se berou pouze kladné hodnoty x. Uvazuji se
pouze kladné hodnoty y, s vyjimkou pfipadd, kdy jsou vSechny hodnoty y zaporné. Vv
takovém pfipadé je pouZita rovnice y = -b - xa.

Klouzavy primér spojnice trendu
Jednoduchy klouzavy préimér pro n predchozich hodnot y, kde n je obdobi. Pro tuto spojnici
trendu neni k dispozici zadna rovnice.

Vice informaci o téchto typech regrese nalezneme v systému Napovédy. Hledejme vyraz
"Spojnice trendu" v seznamu.
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MoZnosti spojnic trendu

Spojnice trendu pro datovou fadu ‘Motorové’

Typ Cara
Typ regrese
" ®lineami /v © Polynomicka
) IE’Lr:J_qari’[mick;:i Stuperi |2 =
' Dgxponenciélni Dglouzawj pramér
. | @ Mocninna Obdobi 2 3
MozZnosti

Nazev spojnice trendu

Extrapolovat dopfedu 0

4

[

Extrapolovat zpét 0

L]

3

L1 Vynutit absolutni élen |0 —
L] Zobrazit rovnici

[ Zobrazit koeficient determinace (R®)

MNazev proménné X X
MNazev proménné Y )
MNapovéda Obnovit OK Zrusit

Obréazek 115: Dialogové okno Spojnice trendu — karta Typ

Néazev spojnice trendu
UrCuje nazey, ktery se pouZzije pro oznaceni rovnice v legendé; viz obrazek 116.

Extrapolovat dopredu / zpét
UrCuje pocet jednotek, o které by méla byt spojnice trendu prodlouZzena dopfedu nebo zpét.
Toto funguje pouze pro grafy, které maji podél osy X Ciselné hodnoty nikoliv kategorie.

Vynutit absolutni ¢len
Pfinuti ¢aru projit osou Y pfi zadané hodnoté.

Zobrazit rovnici
Zobrazi rovnici v grafu, jak je znazornéno na obrazku 116.

Zobrazit koeficient determinace (R2)
Zobrazuje koeficient determinace v grafu. Na Obrazku 116 je toto zndzornéno
polynomickou rovnici.

Nazvy proménné X a Y
Umoziuje zménit nazvy proménnych X nebo Y pro zobrazeni rovnice v grafu. MoZnost
Zobrazit rovnici musi byt zaSkrtnuta, aby byla tato moznost aktivni.

Spojnice trendu a pfimky stfedni hodnoty | 149



120
|
[ |
100
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Obrazek 116: Spojnice trendu zobrazujici riizné rovnice

Vybérem spojnice trendu zobrazime informace o této spojnici ve stavovém fadku, jak je
znazornéno na obrazku 117. Stavovy fadek je obvykle umistén ve spodni ¢asti seSitu.
<+ Casadochazka Seznam prodeje Vykaz Grafy

Vybran Spojnice trendu f(x) = 41,27 In(x) — 76,61 s pfesnosti R* = 0,9844
Obrazek 117: Informace o rovnici zobrazené ve stavovém radku

Formatovani spojnic trendu

Po vloZzeni méa spojnice trendu stejnou barvu jako odpovidajici datova fada. Chceme-li zménit
styl, barvu, $ifku nebo prdhlednost spojnice trendu, pouzijeme kartu Céra v dialogovém okné&
Spojnice trendu (obrazek 118). Jednotlivé moznosti jsou snadno pochopitelné nebo
prozkoumatelné.
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Spojnice trendu pro datovou rfadu 'Cluny'

Typ Cara

Vlastnosti cary

Styl: _
Barva: B #rra20E v
Sifka: 0,10 cm

LRLAINIE B

Prihlednost: |0 %

Napovéda Obnovit OK Zrusit

Obrazek 118: Dialogové okno Spojnice trendu — karta
Céra

Formatovani rovnice spojnice trendu

Rovnici v grafu zobrazime pomoci vybéru moznosti Zobrazit rovnici na karté Typ v dialogovém
okné Spojnice trendu (obrazek 115). MoZnosti rovnice spojnice trendu umozniuji formatovani
okraje kolem rovnice, vyplnéni oblasti, prihlednost, pismo a zarovnani. Lze také urdit styl
islovani - to mdze byt uzitecné obzvlast pro uréeni poctu desetinnych mist.

Formétovani rovnic spojnic trendu:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
2) Dialogové okno Rovnice otevieme jednim z nasledujicich zplsobU:

— Pomoci rozeviraciho seznamu Zvolte prvek grafu vybereme rovnici a nasledné
klepneme na ikonu Format vybéru, kterou najdeme hned vedle rozeviraciho
seznamu na nastrojové listé Formatovani. Nebo zvolime Format > Format vybéru v
hlavni nabidce.

— Klepneme jednou na rovnici a tim ji vybereme. Potom klepneme na ikonu Format
vybéru na nastrojové listé Formatovani nebo v hlavni nabidce zvolime Format >
Format vybéru.

— Klepneme pravym tlaCitkem mysi na rovnici a z mistni nabidky zvolime Format
rovnice spojnice trendu.

3) V dialogovém okné vybereme pozadované moznosti. Funkce jednotlivych moznosti jsou
snadno pochopitelné. Karta Cisla ma stejné moznosti jako karta Cisla v dialogovém okné
Osa, obrazek 104 na strané 157.

4) Klepnutim na OK okno zavieme.
5) Pokud chceme reZim Uprav opustit, klepneme mimo graf.
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Mazani spojnic trendu

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Gprav. Kolem grafu by se nyni
meél objevit Sedy ramecek.

2) Provedeme jeden z nasledujicich krokd:
— Vybereme spojnici trendu a stiskneme klavesu Delete.

— Klepneme pravym tlacgitkem my3i na spojnici trendu a z mistni nabidky vybereme
Smazat spojnici trendu.

3) Pokud chceme rezim Gprav opustit, klepneme mimo graf.

Pfimky stfedni hodnoty

PFimky stfedni hodnoty jsou zvlaStnim typem spojnice trendu. Pokud chceme vytvorit jednu
spojnici, aplikace Calc vypogita primér datové fady a umisti barevnou ¢aru na tuto hodnotu v
grafu, jak je znazornéno na obrazku 119. Spojnice mohou byt vytvofeny pouze pro 2D grafy a
nemohou byt vytvofeny pro grafy kolaCové, sitové nebo burzovni.

60

50

40 . Kanoe
Pramérova (Kanoe)

30 e Cluny
Primérova (Cluny)
20 .
Motorove
10 ' Primé&rova (Motorové)
0
led dub  kvé

uno  bre
Obrazek 119: Primky stredni hodnoty

&vn

VloZeni pfimek stfedni hodnoty

Pro vSechny datové fady (pokud neni vybrana datova fada, vlozi se pfimky stfedni hodnoty pro
vSechny datové fady):

1) Dvojitym klepnutim vybereme graf a prejdeme do reZimu Gprav. Kolem grafu by se nyni
mél objevit Sedy rdmecek.

2) V hlavni nabidce zvolime VloZit > Pfimky stfedni hodnoty.

3) Pokud chceme rezim Gprav opustit, klepneme mimo graf.
Pro jednu datovou fadu:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Gprav. Kolem grafu by se nyni
meél objevit Sedy ramecek.

2) Datovou fadu vybereme jednim z nasledujicich zptsobd:
— Klepneme jednou kdekoliv v datoveé fadé.

— Datovou fadu vybereme z rozeviraciho seznamu Zvolte prvek grafu v nastrojové listé
Formatovani.

3) PFimku stfedni hodnoty pfiddme jednim z nasledujicich zplsob:
— V hlavni nabidce zvolime Vlozit > Pfimky stfedni hodnoty.

— Klepneme pravym tlacitkem mysi na datovou fadu a z mistni nabidky zvolime Vlozit
pfimku stfedni hodnoty.
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4)

Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Uprava pFimky stfedni hodnoty
Po viloZeni ma pfimka stfedni hodnoty stejnou barvu jako odpovidajici datova fada. Pokud
chceme upravit styl, barvu, $itku nebo prihlednost pfimky stfedni hodnoty, postupujeme takto:

1)

2)

3)
4)

Dvojitym klepnutim na graf vstoupime do rezimu Uprav. Kolem grafu by se nyni mél
objevit Sedy ramecek.
Dialogové okno Pfimka stfedni hodnoty otevieme jednim z nasledujicich zplsobd

(dialogové okno ma stejné moznosti jako karta Céra dialogového okna Spojnice trendu
na obrazku 118):

— Pravym tlacitkem mySi klepneme na pfimku stfedni hodnoty a z mistni nabidky
zvolime Format pfimky stiedni hodnoty.

— Klepneme levym tlaCitkem mysi na pfimku stfedni hodnoty nebo vybereme
odpovidajici pfimku stfedni hodnoty z rozeviraciho seznamu Zvolte prvek grafu na
nastrojové listé Formatovani. Potom klepneme na ikonu Format vybéru na
nastrojové listé formatovani nebo vybereme v hlavni nabidce Format > Format
vybéru.

Provedeme poZadované zmény.

Klepnutim na OK okno zavieme. Pokud chceme rezim Gprav opustit, klepneme mimo
graf.

Mazani pfimky stfedni hodnoty

1)

2)

3)

Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
Provedeme jeden z nasledujicich krokd:

— Klepneme levym tlaCitkem mysSi na pfimku stfedni hodnoty nebo vybereme
pozadovanou pfimku stfedni hodnoty z rozeviraciho seznamu Zvolte prvek grafu na
nastrojové listé Formatovani. Nasledné stiskneme klavesu Delete.

— Pravym tlacitkem mySi klepneme na datovou fadu a z mistni nabidky zvolime Smazat
pfimku stfedni hodnoty.

Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Chybové usecky
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30 I ® Cluny
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Obrazek 120: Chybove UsecCky rozptylu (Kanoe), smérodatné
odchylky (Cluny) a standardni chyby (Motorové ¢&luny).

Chybové tsecky | 153



Chybové Usecky, zndzornéné na obrazku 120, mohou byt uzitené pro prezentaci dat, kterd maji
znamou pravdépodobnost chyby, jako jsou socialni prizkumy pouzivajici konkrétni metodu
vzorkovani nebo pro zobrazeni pfesnosti méfeni pouzitého nastroje. Chybové Usecky mohou byt
vytvofeny pouze pro 2D grafy a nemohou byt vytvofeny pro kolacové, sitové nebo burzovni

grafy.

Vkladani chybovych usecek

Pokud neni vybrana zadna datova fada, jsou do vSech datovych fad viozeny chybové tsecky X
nebo Y. Chceme-li pfridat chybové Usecky pro vSechny datové fady, postupujeme nasledovné:

1) Dvojitym klepnutim vybereme graf a prejdeme do reZimu Gprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) V hlavni nabidce zvolime VloZit > Chybové tuse€ky X nebo Vlozit > Chybové usecky Y
a otevieme dialogové okno Chybové Usecky (obrazek 121). Karta Céra neni k dispozici,
pokud vklada chybové Usecky pro vSechny datové fady; za této okolnosti se objevi
specialni moznost Zadné v &asti Chybové kategorie.

3) Vybereme poZzadované moznosti nastaveni. DalSi informace o moznostech nastaveni
nalezneme nize.

4) Klepnutim na tlagitko OK zavieme dialogové okno a pfidame chybové Usecky do grafu.
Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Chybové Usecky Y pro datovou fadu 'Motorove'

Chybové secky Y Cara
Chybova kategorie Ukazatel chyby
() Konstantni hodnota } @ Kladné a zaporné
) Procentualng
B : * O Kladné
@ Smérodatna odchylka V|
O 7 tabulky dat T O Zapome
Parametry
ladné (+ =
Zapomné (-) (0,0 =
Stejna hodnota pro obé
Mapovéda Obnovit QK Zrusit

Obrézek 121: Dialogové okno Chybové tsecky - karta
Chybové usecCky

Pokud chceme pfidat chybové Usecky pro jednu datovou Ffadu, postupujeme nasledovné:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) Datovou fadu vybereme jednim z nasledujicich zplsobd:
— Klepneme jednou na pruh, sloupec, ¢aru nebo jiné grafické vyjadreni datové rady.

— Na néstrojoveé listé Formatovani vybereme v rozeviracim seznamu Zvolte prvek grafu
datovou fadu.
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3) Jednim z nasledujicich zplsobU otevieme dialogové okno Chybové Usecky (obrazek
121):

— V hlavni nabidce zvolime Vlozit > Chybové usecky X nebo Vlozit > Chybové
usecCky Y.

— Klepneme pravym tlaCitkem mysi na datovou fadu a z mistni nabidky vybereme
Vlozit chybové tsecky X nebo Vlozit chybové tsec€ky Y.

4) Vybereme poZzadované moznosti nastaveni. Dalsi informace o téchto moZnostech
nalezneme nize.

5) Klepnutim na tlagitko OK zavieme dialogové okno a pridame chybové Usecky do grafu.
Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Dialogové okno Chybové usecky
V ¢asti Chybova kategorie miizeme vybrat pouze jednu z nasledujicich moznosti.
Zadné — nezobrazi zadné chybové Gsecky.

Konstantni hodnota — zobrazuje chybu jako konstantni kladnou a / nebo zapornou
hodnotu (hodnoty). Tyto hodnoty zadame v Casti Parametry.

Procentualné — zobrazuje chybu v procentech z datovych bod(. Hodnoty procent zadame
v Casti Parametry.

Rozeviraci seznam obsahuje ¢tyfi miry chybové hodnoty:
— Standardni chyba
— Smérodatna odchylka
— Rozptyl
— Hranice chyby — pouZije hodnotu hranice chyby definovanou v ¢asti Parametry.

Oblast bunék — pouziva chybové hodnoty definované v oblasti bunék. Oblast bunék
zadame v Casti Parametry.

V Casti Parametry zadame kladné a zaporné hodnoty nebo oblasti pro chybové usecky.
Konstantni hodnota, Procentualné, Hranice chyby nebo Oblast bunék musi byt zvolena, aby
byly tyto volby aktivni.

V Casti Ukazatel chyby vybereme, zda grafické vyjadfeni chyby zobrazi kladné i zaporné chyby
nebo pouze kladné chyby nebo pouze zaporné chyby.

Na karté Cara miZeme nastavit styl, barvu, $ifku a priihlednost ¢ary chybovy Gsecek.

Uprava chybovych useéek

Pomoci dialogového okna Chybové tusecky mohou byt chybové Usecky v jeden okamzik ménény

pouze pro jednu datovou fadu (obrazek 121). Dialogové okno Chybové Usecky otevieme jednim
z nasledujicich zplsobd:

1) Dvojitym klepnutim vybereme graf a prejdeme do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.
2) Dialogového okno Chybové Usecky otevieme jednim z nasledujicich zpUsobu:
— Klepneme jednou na datovou fadu a tim ji vybereme. Potom v hlavni nabidce zvolime
Vlozit > Chybové usecky X nebo Vlozit > Chybové usecky Y.

— Pomoci rozeviraciho seznamu Zvolte prvek grafu v nastrojové listé Formatovani
vybereme chybové UseCky pro konkrétni datovou fadu. Potom zvolime Format >
Format vybéru nebo klepneme na ikonu Forméat vybéru na nastrojove listé
Formatovani.
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— Klepneme pravym tlaCitkem mysSi na datovou fadu a z mistni nabidky vybereme
Format chybovych useéek X nebo Format chybovych tsedek Y.

3) V dialogovém okné Chybove usecky vybereme pozadované moznosti na karte¢ Chyboveé
usecky a Céra.

4) Klepnutim na tlaCitko OK zavieme dialogové okno a aktualizujeme chybové tsecky pro
vybranou fadu. Pokud chceme rezim Uprav opustit, klepneme mimo graf.

Odstranéni chybovych useéek
Pokud chceme smazat chybové UseCky X nebo Y pro vSechny datové rady:

1) Dvojitym klepnutim vybereme graf a pfejdeme do rezimu Uprav. Kolem grafu by se nyni
meél objevit Sedy ramecek.
2) V hlavni nabidce zvolime VloZit > Chybové usecky X nebo Vlozit > Chybové usecky Y

a otevieme dialogove okno Chybove Usecky (obrazek 121). Pokud neni vybrana zadna
datova fada, obsahuje dialogové okno v ¢asti Chybova kategorie volbu Zadny.

3) Vybereme Zadny.
4) Klepnutim na tla¢itko OK zavieme dialogové okno a odstranime chybové Usecky.
5) Pokud chceme reZim Uprav opustit, klepneme mimo graf.

Pokud chceme odstranit chybové Usecky pro jednu datovou fadu, postupujeme podle stejnych
krok( jako vySe, ale misto krok( 2) az 4) klepneme pravym tlacitkem mysi na datovou fadu a
vybereme Smazat chybové tse€ky X nebo Smazat chybové tse€ky Y z mistni nabidky.

Pridani objektl kresby do grafti

Pomoci nastrojové listy Kresba pfidame tvary jako jsou Cary, obdélniky, kruhy, textové objekty

vvvvvv

vysvétlujici poznamky, zvyraznit mista v grafu nebo dokonce skryt urcita data nebo text.

Vybérem Zobrazit > Nastrojové liSty > Kresba otevieme nastrojovou liStu Kresba. Tuto
nastrojovou listu mizeme presouvat na libovolné misto pracovni plochy. Dalsi informace o
pouzivani nastrojové listy Kresleni a objektl kresby nalezneme v Kapitole 5, Pouzivani grafiky a
také v Privodci kresleni.

Nastrojova liSta Kresba se zobrazi, pokud je graf v reZimu Uprav (dvojitym klepnutim na néj).

6 Tip

Pokud chceme do grafu umistit Sipky, text nebo jiné nakreslené objekty, ujistime se,
Ze je graf v rezimu Uprav. Jinak nebude objekt pfipojen ke grafu a nebude mozné jej
spolu s grafem pfesouvat.
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1. Vybrat 6. Cary od ruky 11. Sipky

2. Vlozit ¢aru 7. Vlozit textové pole 12. Vyvojovy
diagram

3. Céra kon¢i Sipkou 8. Bubliny 13. Bubliny

4. Vlozit obdélnik 9. Zakladni tvary 14. Hvézdy a
napisy

5. Vlozit elipsu 10. Symboly

Obrazek 122: Nastrojova lista Kresby pro graf v reZimu tuprav

VétSina z téchto moznosti je zfejma nebo je Ize snadno prozkoumat, zejména pak v pfirucce
Prdvodce programem Draw. Klepnutim na ikonu zménime vzhled kurzoru v zavislosti na zvolené
moznosti. Klepnutim a tazenim kurzoru vytvofime v grafu poZadovany graficky objekt. Nasledu;ji
informace, které mohou byt uzite€né pro grafy.
Vlozit €aru
Nakresli rovnou ¢aru ve sméru, kterym tahneme.

.4 Poznamka

Pokud kreslime ¢aru v sesitu (mimo jakykoliv graf), mizeme bé&hem taZeni podrZet
klavesu Shift. Tim omezime Uhly ¢ary na nasobky 45 stupnd. Tuto vlastnost neni
moZzné pouzit pfi vkladani ¢ary do grafu.

Dvojitym klepnutim na Caru napiSeme nebo vioZime text na ¢aru. Pokud je text pfilis nizko,
stiskneme klavesu Enter a posuneme jej nad caru.

Vlozit textové pole
Nakresli textové pole s vodorovnym smérem textu. Pokud chceme umistit text pod néjakym
uhlem, klepneme na textové pole jednou (tim jej vybereme), klepneme na textové pole
pravym tlacitkem my3i a z mistni nabidky zvolime Umisténi a velikost. Uhel uréime na
karté Otoceni.

Bubliny
Nakresli ¢aru, ktera konci obrazkem, ve kterém mdze byt umistény text. Pomoci bubliny
popiSeme nebo upozornime na konkrétni bod nebo oblast. Dvojitym klepnutim na bublinu
priddme do bubliny text. Na Obrazku 122 volba 8 Bubliny vytvofi vychozi bublinu, zatimco
volba 13 otevie paletu nastrojl stylt bubliny.

Klepnutim na Sipku dold umisténou vedle ikony 9 (Sestd moznost zprava) na obrazku 122
otevieme palety nastrojl zobrazené na obrazku 123.
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Zakladni tvary Symboly Sipky
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Obrazek 123: Palety nastroju, které Ize otevrit z nastrojové listy Kresba

Zmény velikosti, presouvani a umisténi grafi

Pokud chceme zmenit velikost grafu nebo jej pfesunout, klepneme na graf jednou a pfepneme jej
do rezimu vybéru. Zménit velikost grafu nebo jej pfesunout miZzeme dvéma zpdlsoby:
interaktivnim nebo pomoci dialogového okna Umisténi a velikost. Uzitecna mdze byt kombinace
obou metod. Nejprve umistime graf interaktivné pro rychlé a snadné zmény, potom pouzijeme
dialogové okno Umisténi a velikost pro pfesné stanoveni velikosti a umisténi.

Interaktivni zmény

Zména velikosti
Interaktivni zména velikosti grafu:

1) Klepneme jednou na graf a vybereme jej. Kolem grafu se zobrazi ¢tvercové Uchyty
vybéru.
2) Klepneme a pretahneme jeden z Gchytl vybéru. Kurzor oznacuje smér pro zvétSeni nebo

zmensSeni velikosti grafu. Klepnutim a tazenim rohu se zachova pomér vodorovné a
svislé velikosti.

3) Po dokonceni klepneme mimo graf a rezim vybéru opustime.

Presouvani
Interaktivné pfesuneme graf pomoci jedné ze dvou moznosti:
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Pro maly pfesun
1) Klepneme jednou na graf a vybereme jej. Kolem grafu se zobrazi Ctvercové Uchyty
vybéru.
2) Stiskneme klavesu se Sipkou a presuneme graf najednou o nékolik pixeldl ve sméru Sipky
nebo stiskneme Alt + klavesu se Sipkou a pfesuneme graf o jeden pixel ve sméru Sipky.
3) Po dokonceni klepneme mimo graf a rezim vybéru opustime.

Pro vétsi presun
1) Klepneme jednou na graf a vybereme jej. Kolem grafu se zobrazi ¢tvercoveé Gchyty
vybéru.
2) Umistime kurzor kdekoliv na graf, dokud se nezméni vzhled kurzoru na symbol pfesunu
(tvar zavisi na nastaveni pocitace).
3) Klepneme a pfetahneme graf na nhové misto.
4) Jakmile je graf na pozadovaném misté, uvolnime tlac¢itko mysi.

5) Po dokonceni klepneme mimo graf a rezim vybéru opustime.

Dialogového okno Umisténi a velikost
Dialogové okno Umisténi a velikost obsahuje moznosti pro ur€eni polohy grafu na strance,
urceni velikosti grafu, oto¢eni grafu a naklonéni grafu.

Poznamka

Dialogové okno Umisténi a velikost Ize kromé grafli pouZzit také k Gpravé a umisténi
dal$ich grafickych prvkd, jako jsou napriklad prvky dostupné na nastrojové listé
Kresba.

Pro zménu velikosti nebo presun grafu pouzijeme dialogové okno Umisténi a velikost takto:

1) Klepneme na graf pravym tlacitkem mysSi a z mistni nabidky zvolime Umisténi a
velikost. Tim otevieme dialogové okno Umisténi a velikost (obrazek 124).

2) V tomto dialogovém okné vybereme poZzadované moznosti na kartach Umisténi a
velikost, Otoceni a Naklonéni a polomér rohu. DalSi informace o mozZnostech nastaveni
nalezneme nize.

3) Klepnutim na tlacitko OK zavieme dialogové okno a ulozime zmény.
4) Po dokonceni klepneme mimo graf a rezim vybéru opustime.
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Umisténi a velikost

Umisténi a velikost Otoceni Naklonéni a polomér rohu
Umisténi
Pozice X: |6,84 cm = |# * *
Pozice Y: |57,85cm = & ~ l
]
Fakladni bod;
Velikost
Sitka: 12,04 cm = |# * *
Vyika: 5,64 cm = | A - i
[] Zachovat pomeér ‘ ‘
&~ ~ o
Fakladni bod;
Zamknout Pfizplsobit
L] Umisténi Sitka podle textu
[ Velikost Vyska podle textu
Napovéda Obnovit QK Zrusit

Obréazek 124: Dialogové okno Umisténi a velikost — karta

Umisténi a velikost
Klepneme na jeden z bod( v ¢asti Zakladni bod. Tento bod graficky odpovida umisténi, které ma
byt pouZito k ukotveni polohy grafu nebo jeho velikosti.
Upozorifiujeme, Ze umisténi nebo velikost Ize chranit pfed nechténymi zménami klepnutim na
prFislusnou volbu v ¢asti Zamknout. Jedna nebo obé vybrané moznosti zlistanou aktivni i po
zavfeni dialogového okna. Naproti tomu aplikace Calc po uzavieni dialogového okna resetuje
zékladni bod na vychozi umisténi.

Umisténi a velikost
Moznosti dostupné na karté Umisténi a velikost (obrazek 124) jsou tyto:

Karta Umisténi
Ur€uje umisténi grafu na strance. Umisténi grafu je ur€ovano relativné vzhledem k fixnimu

bodu (zakladnimu bodu). Ve vychozim nastaveni je tento zakladni bod umistén v levém
hornim rohu grafu. Pro zjednoduSeni umistovani grafu je mozné zékladni bod do¢asné
zménit.

— Pozice X — urCuje vodorovné umisténi grafu vzhledem k zékladnimu bodu.

— Pozice Y — urCuje svislé umisténi grafu vzhledem k zakladnimu bodu.

— Zéakladni bod — urCuje doCasny zakladni bod grafu.
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Velikost

UrCuje hodnotu, o kterou se mé velikost vybraného grafu zménit s ohledem na vybrany
zakladni bod.

Sitka — nastavi $ifku vybraného objektu.
Vyska — nastavi vySku vybraného objektu.
Zachovat pomér — pfi zméné velikosti grafu zachovava pomeér mezi Sifkou a vyskou.

Zakladni bod — urCuje sméry, ve kterych se bude velikost grafu zvétSovat nebo
zmensovat.

Zamknout
Zabranuje neamysinym zménam umisténi nebo velikosti grafu.

Umisténi — zabraruje neamysinému posunuti grafu.
Velikost — zabrafuje neiimysiné zméné velikosti grafu.

Prizplsobit
UrCuje, zda by velikost méla byt upravena tak, aby odpovidala velikosti zadaného textu.
Dostupnost téchto moznosti zavisi na kontextu.

Otoceni

Sitka podle textu — rozsifuje Sitku objektu na $ifku textu, pokud je objekt mensi nez
text.

VySka podle textu — zvétSuje vySku objektu na vySku textu, pokud je objekt mensi nez
text.

Moznosti karty Otoceni (obrazek 125) jsou nasledujici:
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Umisténi a velikost

Umnisténi a velikost Otodeni Naklonéni a polomér rohu
Stied otoéeni
Pozice X; 12,86 cm = | * *
Pozice Y; (60,67 cm = l = l
. ]
Vychozi nastavent:
Uhel otoéeni
Uhel: 0,00 . e
. .
gy - P
Vychozi nastavent:
Napovéda Obnowvit QK Zrusit

Obrazek 125: Dialogové okno Umisténi a velikost - karta OtoCeni

Stied otoceni
Graf Ize otacCet kolem stfedu otoceni. Vychozi stfed otoCeni je ve stfedu grafu.

Upozoriujeme, Ze pokud neni dostatek mista pro otoceni grafu, mdize byt graf otoen
mimo stranku.

— Pozice X — urCuje vodorovnou vzdalenost od levého okraje stranky ke stfedu otocCeni.
— Pozice Y — urCuje svislou vzdalenost od horniho okraje stranky ke stfedu otoceni.

— Vychozi nastaveni — nastavuje umisténi stfedu otoCeni. Stfed oto€eni je mozné
docCasné zmenit. Kdyz se vSak dialog otevie znovu, bude stfedem otoceni vychozi
umisténi ve stfedu grafu a pozice X a Y budou odrazet vychozi umisténi.

Uhel otoéeni
Urcuje otoCeni grafu ve stupnich.

— Uhel - zobrazuje Cislo ve stupnich udavajici otoceni grafu (v rozsahu od 0 do 359
stupiil). Cislo Ize zadat pfimo nebo jej Ize nastavit pomoci ukazatele oznaceného
Vychozi nastaveni.

— Vychozi nastaveni — graficky ukazuje uhel natoCeni grafu. Uhel Ize nastavit klepnutim
a tazenim ukazatele. Cislo udavajici oto€eni ve stupnich je zobrazeno v poli Uhel.
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Naklonéni a polomér rohu

Moznosti karty Naklonéni a polomér rohu (obrazek 126) jsou nasleduijici:

Polomér rohu

Tato moZznost neni pro grafy dostupna.

Zkoseni

Nakloni graf podle osy. UrCime Uhel osy (v rozsahu od -89° do +89°).

Ovladaci body

Tyto mozZnosti nejsou pro grafy dostupné.

Umisténi a velikost

Polomér rohu

Polomér:

Ovladaci bod 1

X 0,00 cm

0,00 cm

Mapovéda

Umisténi a velikost OtoEenfENaklonéni a polomér rohu§

Zkoseni

> Unel: 0,00° =

Ovladaci bod 2

= X 0,00 em =

0,00 cm

Ao et

Obrézek 126: Dialogové okno Umisténi a velikost
- karta Naklonéni a polomér rohu

Vicenasobny vybér grafu

Vice grafll vybereme tak, Ze nejprve klepneme na prvni graf, poté stiskneme tlacitko Shift a
klepnutim oznacime dalsi grafy. Neviditelny obdélnik vybéru zahrnuje vSechny vybrané grafy a
tadhla vybéru se objevuiji v rozich a uprostfed mezi rohy. S vice grafy nyni pracujeme jako s
jedinym objektem a mizeme provadét nasledujici ¢innosti.

* Vyjmout a vlozit nebo pretdhnout grafy do novych umisténi.

* PouZijeme dialogové okno Umisténi a velikost, které bylo popsano v pfedchazejici Casti.

* Pomoci nastrojové listy Vlastnosti objektu kresby miizeme v3echny grafy zarovnat,
formatovat ohrani¢eni nebo ukotvit grafy ke stejné burice nebo strance.

Zména celkového vzhledu grafii

Pokud je graf vybran (jednim klepnutim na néj), mdze byt formatovan jako objekt. Nastrojova
liSta Vlastnosti objektu kresby (obrazek 127) se obvykle zobrazuje pod Standardni nastrojovou
liStou (umisténi vSak zavisi na nastaveni) a zobrazuje nastroje dostupné pro viechny objekty,

véetné grafd.
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VétSina moznosti je zfejma nebo je Ize snadno prozkoumat. Viz kapitola 5, Pouzivani grafiky, a
Prdvodce kresleni pro dalsi informace. Zde je nékolik tipli pro pouziti téchto nastrojd s grafy.

Ukotvit

Pripoji graf tak, aby na strance zUstal na stejné pozici nebo aby se presunoval spolu s

burikou (kdyZ jsou fadky nebo sloupce vkladany nebo odstrafiovany). Pokud je vybrana
volba K bunce (ménit velikost s bunkou), graf nebo objekt se zvétSuje nebo zmenSuje
podle toho, jak je zvétSena nebo zmen3ena burika.

Zarovnani

Klepnutim na ikonu otevieme moZnosti pro zarovnani vice grafdi vodorovné (vlevo, na
stfed, vpravo) nebo svisle (nahoru, stfed nebo dol(l). Tato volba je aktivni pouze tehdy,

pokud jsou vybrany dva nebo vice grafd (nebo jinych objektd).

Pfenést do popiedi/ O jednu vpied / O jednu zpét /| Odsunout do pozadi

Pfesouva grafy nebo jiné objekty pfed nebo za jiné objekty.

g » ’ dnd 000 em = 7] = [280n -
1. Ukotvit 7. Na popredi 13. Barva vyplné
2. Zarovnani 8. Na pozadi 14. Styl Sipky

3. Prenést do popredi 9. Styl ¢ary 15. Otocit

4. O jednu vpred 10. Sitka ¢ary 16. Body

5. O jednu zpét 11. Barva cary 17. Seskupit

6. Odsunout do pozadi

12. Styl / vypln oblasti

Obréazek 127: Nastrojova lista Vlastnosti objektu kresby, ktery se zobrazi po vybéru grafu

Na popredi / Na pozadi
Umisti grafy nebo skupiny grafli do popredi nebo do pozadi. Objekty v pozadi jsou v
aplikaci Calc za mfizkou bunék a mliZe byt obtiZzné je vybrat. PouZijeme nastroj Vybrat
(ikona s Sipkou) na nastrojové listé Kresba (obrazek 122) pro vybér téchto objektd.

Styl &ary | Sitka ¢ary | Barva &ary
Formatuje vnéjsi okraje graf(.

Styl oblasti / vyplh oblasti a barva vypiné
Obarveni objektd jako jsou Sipky, tvary a bubliny. U grafll pouZijeme moZnosti vypiné
dostupné v rezimu Uprav.

Styl Sipky
Urcuje vzhled Car Sipek a Car. Nevztahuje se na blokové Sipky zndzornéné na obrazcich
122 a 123.

Otocit
Otoci graf kolem zékladniho bodu. Pokud je moznost vybrana, umisti kolem kaZzdého tahla
v rohu grafu symbol pro otoCeni. Pfesunem téchto tahel otofime graf. Pfesunem malého
kruhu veprostfed grafu zménime zakladni bod. Pfesunem tahel uprostfed mezi rohy grafu
naklonime graf nebo jiny objekt.

Body
Méni tvar zakfiveni objektll. Pfesuneme body do tvaru kfivek vytvofenych pomoci nastroje
KFivka na nastrojové listé Kresba.
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Seskupit
Seskupi nebo zrusi skupinu dvou nebo vice objektd. KdyZ jsou objekty seskupeny, je
mozné je pfesouvat spolecné a Ize na né aplikovat globalni zmény. Zleva doprava jsou tyto
Ctyfi ikony: Seskupit, Upravit skupinu, Opustit skupinu a Zrusit skupinu.

Kopirovani, export a mazani grafii

Kopirovani grafli do stejného dokumentu tabulky

Kdyz graf kopirujeme, zachovava si propojeni se zdrojovymi daty, ze kterych vychazi. Toto plati
pouze ve stejném dokumentu. To tedy znamenad, ze zmény ve zdrojovych datech se projevi v
grafu.

Kopirovani a vkladani grafu je snadné. Staci na graf klepnout jednou a vybereme jej, pak
stiskneme Ctrl + C nebo klepneme pravym tlacitkem na graf a z mistni nabidky vybereme
moznost Kopirovat nebo klepneme na ikonu Kopirovat na Standardni nastrojové listé nebo
vybereme Upravy > Kopirovat. Pokud chceme vloZit graf na poZzadované misto, stiskneme
kombinaci klaves Ctrl + V nebo klepneme pravym tlacitkem mySi a z mistni nabidky zvolime
Vlozit nebo klepneme na ikonu Vlozit na Standardni nastrojové listé nebo zvolime Upravy >
Viozit.

Kopirovani do jiného dokumentu LibreOffice

Pokud je graf zkopirovan a viozen do jiného dokumentu LibreOffice, dojde ke ztraté propojeni k
datlim, na nichz je graf zaloZen. Data jsou uchovavana v grafu a nazyvaji se tabulkou dat spiSe
nez oblasti dat. Obrazek 128 ukazuje priklad jednoduché tabulky dat.

4 Poznamka

Zkopirovany graf propojuje nebo uchovava sva data, pouze pokud je vloZen do
dokumentu LibreOffice. Pokud chceme zachovat data nebo odkazy mimo
LibreOffice, pouZijeme vkladani nebo propojeni, jak je vysvétleno v kapitole 10,
Propojeni dat aplikace Calc.

Zachovani piivodnich dat

Pokud je cilem pouzit pivodni data pro graf, zkopirujeme a vlozime graf do jiného dokumentu
podle stejného postupu uvedeného vySe. Neni potfeba nic dalSiho.

Uprava ptivodnich dat
Pokud je tfeba upravit plivodni data pro graf, postupujeme nasledovné:

1) Dvojitym klepnutim vybereme graf a vstoupime do rezimu Uprav. Kolem grafu by se nyni
mél objevit Sedy ramecek.

2) Klepneme pravym tlaCitkem mysSi na graf a vybereme Tabulka dat. Tim otevieme tabulku
dat zobrazenou na obrazku 128.

3) Upravime data dle potfeby. Kromé& zmény ¢isla v datech mdzeme pomoci voleb vkladat,
pfesouvat nebo mazat sloupce nebo radky.

4) Klepnutim na OK okno zavieme.
5) Pokud chceme reZim Gprav opustit, klepneme mimo graf.
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Tabulka dat

5950 6% 0N | BR 62
J.l_ Kénoe J.l_ Cluny J.l_ Motorové
Kategorie | Hodnoty Y | Hodnoty Y | Hodnoty Y |
1 |led 12 23 47
2 |uno 9 31 54
3 |bfe 14 27 56
4 |dub 17 28 48
5 |kvé 13 19 39
6 |Cvn 8 27 52
MNapovéda Zavrit

Obrazek 128: Tabulka dat pri kopirovani grafu do jiného dokumentu

PretaZeni nahradnich dat

Pokud je graf stale v aplikaci Calc a nahrazena data jsou ve stejné tabulce, vybereme a
pretahneme nova data do grafu. Toto je popsano v Casti ,Nahrazeni dat pfetazenim” na strané
143.

@;& Poznamka

Aplikace Calc neposkytuje pfimy zplsob, jak uloZit nastaveni grafu pro vytvoreni
dalSiho grafu v LibreOffice. Zde jsou tfi moznosti pouziti stejného nastaveni grafu: 1)
zkopirujeme a vioZime graf do jiného souboru; 2) uloZime soubor obsahujici graf
jako novy soubor; a 3) ulozime graf do Sablony. V zavislosti na pouzité metodé
vytvofime novy graf Gpravou rozsahu dat nebo tabulky tdajd.

Export obrazkl grafu

Grafy je mozné, pro pouZiti v jinych dokumentech, exportovat v rliznych obrazovych formatech.
Typy soubord zahrnuji BMP, EMF, EPS, GIF, JPEG, PDF, PNG, SVG, SVM, TIFF a WMF.

PFi exportu grafu do forméatu obrazku postupujeme nasledovné:

1) Klepneme pravym tlacitkem mySi na vybrany graf a z mistni nabidky zvolime Exportovat
jako obrazek. Timto otevieme dialogové okno UloZit jako obrazek.

2) V dialogovém okné zadame nazev grafického souboru, vybereme umisténi pro ulozeni
souboru a vybereme pozadovany graficky format.

3) Klepneme na tlacitko Ulozit a obrazek grafu bude exportovan do zadaného umisténi.

Mazani grafti

Pokud chceme graf odstranit, kiepneme na né&j jednou a vybereme jej. Ctvercova tahla vybéru se
zobrazi na hranicich grafu. Potom stiskneme klavesu Delete.
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Galerie typll grafi

| kdyZ Ize data prezentovat pomoci rliznych grafd, zaméfime se na zobrazované informace v
grafu a uréime, jaky typ grafu pouzit. V nasledujicich ¢astech jsou uvedeny priklady typt graf(,
které aplikace Calc poskytuje, s poznamkami o pouZiti kazdého z nich.

Sloupcové grafy

Sloupcovy graf zobrazuje svislé sloupce, pficemz vyska kazdého sloupce je imérna jeho
hodnoté. Osa X zobrazuje kategorie a osa Y zobrazuje hodnotu pro kazdou z kategorii.

Sloupcové grafy se bézné pouZzivaji pro zobrazeni dat, kterd ukazuji vyvoj v €ase. Jsou dobré pro
zobrazeni relativné malého mnoZstvi datovych bodu. Je to vychozi typ grafu, ktery aplikace Calc

byl vhodnéjSi Carovy graf.
Sloupcovy graf ma tfi varianty s nahledem pro kazdou z nich, jak je zndzornéno na obrazku 129.

Typ grafu
£ Radkovy

Vysecowvy I I
| Plosny
|~ Carovy
[~ XY (bodowy)
|* Bublinowy [ 3D vzhled
X Paprskovy Tvar
[i* Burzovni
it Sloupcovy s ¢arami

Valec

KuZe

Jehlan

Napovéda oK Znsit

Obrazek 129: Dialogové okno Typ grafu — Sloupcovy
Po klepnuti na nahled se jeho okraje zvyrazni a nazev se zobrazi nize. 2D varianty jsou:
Bézny
Zobrazuje vSechny datové hodnoty patfici do dané kategorie vedle sebe. Hlavni dlraz je
kladen na jednotlivé absolutni hodnoty ve srovnani s kazdou jinou hodnotou.

Skladany
Zobrazuje datové hodnoty kategorii nad sebou. Hlavnim zaméfenim je celkova hodnota
kategorie a individualni pfinos kazdé hodnoty v kategorii.

Skladany (procenta)
Zobrazuje relativni procento kazdé datové hodnoty s ohledem na soucet jeji kategorie.
Hlavni zaméfeni je relativni prispévek kazdé hodnoty k celkovému souctu kategorie.

Dal$i moZnosti vytvareni sloupcovych grafli jsou:

3D vzhled
Pokud je toto pole zaskrtnuto, budou v rozeviracim seznamu k dispozici dvé moZznosti:
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— Realisticky — snazi se dat nejlepsi 3D vzhled.
— Jednoduchy — snazi se napodobit zobrazeni grafu jinych produktd.

Pokud zaSkrtneme pole 3D vzhled, zobrazi se Ctvrta varianta nazvana Prostorovy. Tento
typ grafu ukazuje hodnoty dat kazdé kategorie sefazené jedna za druhou.

Tvar
Nabizi moZnosti pro tvar sloupcti ve 3D grafech. Na vybér jsou: Kvadr, Valec, Kuzel a
Jehlan.

Radkové grafy

Radkovy graf je jako sloupcovy graf, ktery je otogeny o 90 stupfifi. Tento graf zobrazuje
vodorovné pruhy na misto svislych sloupctl. Na rozdil od nékterych jinych typl grafd je osa Y
vodorovna a osa X je svisla. Dialogové okno Typ grafu pro pruhovy graf je v podstaté stejné jako
pro sloupcovy graf, jak je popsano vySe, s ndhledem upravenym pro zobrazeni vodorovnych
pruhd.

Sloupcové grafy mohou mit okamZity vizualni dopad, kdyZ ¢as neni ddlezitym faktorem —
napfiklad pfi porovnani popularity nékolika produktd na trhu. Radkové grafy mohou byt
upfednostiiovany pred sloupcovymi grafy, pokud jsou nazvy kategorii dlouhé nebo existuje-li
vyznamny pocet kategorii.

V prikladech na Obrazku 130 nize:

« Pro vytvoreni prvniho grafu po pouziti Privodce grafem, pfejdeme do rezimu Gprav a
vybereme Vlozit > Mfizky, odznaCime Osa Y a zvolime VloZit > Pfimky stfedni
hodnoty. Na kazdou pfimku stfedni hodnoty klepneme pravym tlacitkem mysi a zvolime
Format pfimky stfedni hodnoty pro zvétSeni Sifky ¢ar. Pomoci nastrojové liSty Kresba
vytvorime obdélniky, které pokryji pfimky stfedni hodnoty v legendé. Klepneme pravym
tlagitkem mysi a vybereme Céara a potom Oblast, abychom je obarvili na bilo.

* Druhy graf je 3D graf vytvofeny s jednoduchym ohraniCenim a ve tvaru valce. Plocha
grafu je otocena (popsano v Casti ,Rotace a perspektiva" na strané 166).

* Ve tfetim grafu je vynechana legenda, kterd je nahrazena popisky se jmény spolecnosti
na ose Y. Zatimco prvni dva grafy povazuji data za samostatné datové fady, v tomto
grafu jsou data povaZzovana za jednu datovou fadu, aby bylo mozné oznacit kategorii pro
osu X. SpiSe nez barvy se pro pruhy pouZije barevny vzor vodorovného Srafovani.

Podil na trhu Podil na trhu Podil na trhu

L __F:N1)
—— Priimérova 0 5 10 1520 25 30 35 40 45 AT

1 | | | I ‘ I mAIJT

REN REN

m /0T
mlJing £0T

Jiné

Primérova
(Jiné)

0 5 10152025 30 35 40 45 50 0 5 10152025 3035404550

Obrazek 130: Priklady pruhovych graf(

Vysecové grafy
Vysecovy graf zobrazuje hodnoty ¢asti kruhu. Plocha kaZzdé Casti je umérna jeji hodnoté.

Vysecové grafy jsou vynikajici pro porovnani proporci — napfiklad srovnani vydaji oddéleni. Tyto
grafy umi dobfe pracovat s mensim poctem hodnot, asi az do pul tuctu. Pokud chceme zobrazit
vice hodnot, vizualni efekt se zacina ztracet.
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Typ grafu

ls. Sloupcowy

o o A D

ks Plogny
i Carovy B&zny
|- XY (bodowy)

" Bublinovy [43D vzhled
7k Paprskovy

li. Burzovni

|l Sloupcowy s Earami

oK Zrusit

Obrazek 131: Dialogové okno Typ grafu - Vysecovy
Varianty vysecového grafu jsou zobrazeny na obrazku 131:
Bézny
Zobrazuje hodnoty jako c¢asti celého kolace s moznosti oddéleni jednotlivych vyseci.
Klepnutim na vnéjsi okraj vysece ji oddélime od zbyvajiciho kold€e nebo ji k nému
pfipojime zpét.

RozloZeny vysecovy
Zobrazuje vSechny vysece oddélené od sebe. Klepnutim a taZzenim libovolné vysece ji
pfesuneme podél kruhové linie ze stfedu vysece.

Prstencovy
Zobrazuje vice datovych fad. KaZzda datova fada je zobrazena jako jeden prstencovy tvar s
otvorem uvnitt, kde mlize byt zobrazena dalsi datova fada. Klepnutim a tazenim vnéjsi
vysece ji presuneme podél kruhové linie ze stfedu prstence.

RozloZeny prstencovy
Zobrazuje vysecCe oddélené od zbyvajici ¢asti prstence. Klepnutim a taZzenim vnéjsi vysece
ji pfesuneme podél kruhové linie ze stfedu.

Privodce grafem na zacatku odhaduje, jak by méla byt data v grafu prezentovana. Na strankach
Oblast dat a Datové fady v Prlivodci grafem nebo pomoci dialogového okna Oblasti dat mame
moznost upravit zplsob prezentace dat.

S vysecovym grafem mizeme délat nékteré zajimavé véci, zejména pokud se z néj stane 3D
graf. MUZe byt naklonén, doplnén stiny a obecné proménén v umélecké dilo. Nesmime to vSak
pfehnat, aby se neztratila vypovidaci schopnost grafu. Také budme opatrni, aby naklonéni
nenarusilo relativni velikosti segmentd.

V Prlivodci grafem si midzZeme vybrat variantu rozloZzeného vysecového grafu, ale tato volba
rozlozi vSechny casti (na rozdil od nadhledu zobrazeného na obrazku 131). Pokud je cilem
zddraznit pouze jednu vyseé, oddélime vyse¢ pomoci zvyraznéni a pretazenim ze skupiny. Poté
bude mozna nutné zvétsit plochu grafu, aby se obnovila plvodni velikost vysedi.
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Obréazek 132: Priklady vysecového grafu
Efekty ukazané na obrazku 132 jsou vysvétleny nize.

2D vysecovy graf s jednou oddélenou vyseci
V rezimu Uprav zvolime Vlozit > Legenda a zruSime oznaceni pole Zobrazit legendu.
Prejdeme do Vlozit > Popisky dat. Ozna¢ime volby Zobrazit hodnotu jako Cislo a také
Zobrazit kategorii. Klepneme na hranu vysece (vysec€ bude zvyraznéna Ctverecky) a
pretahneme ji od zbytku vyseci. Velikost sekci se zmensi. V pfipadé potfeby zvyraznime
sténu grafu a tazenim za roh zvétSime velikost.

3D rozloZeny vysecovy graf s realistickym schématem a riiznymi efekty vyplné
V rezimu Uprav prejdeme do Format > Typ grafu a vybereme 3D vzhled. Pfejdeme do
Vlozit > Popisky dat a oznacime volbu Zobrazit hodnotu jako procento. Poté peclivé
vybereme kazdou €asti tak, aby byl zvyraznén dratovy model. Klepneme pravym tlacitkem
mysSi a v dialogovém okné Datovy bod vybereme Format datového bodu. Zvolime kartu
Oblast. llustrace na obrazku 132 zobrazuje jednu ¢ast formatovanou pomaoci rastru, druhou
s kruhovym pfechodem, tfeti s 50% prlhlednosti a ¢tvrtou se vzorem.

Prstencovy graf a jeho varianta rozlozeny prstencovy graf, zndzornéné na Obrazku 133, se
pouzivaji pro zobrazeni dvou souvisejicich informaci, napfiklad dvouletych finan¢nich udajl. Tato
varianta mlze byt pro srovnani ¢iselnych udaji zavadeéjici, protoze vnitfni kruhy jsou mensi. Pro
vétSi rozmanitost pouzijeme 3D vzhled.

Vydaje za dvé ctvrtleti

) m UdrZba
mUdrzba B Pevné vydaje
. B Pevné vydaje Vybaveni
’ = Vybaveni B Texty
B Texty '

<

Obréazek 133: Priklady prstencového grafu

PloSné grafy

Stejné jako Carovy nebo sloupcovy graf zobrazuje i ploSny graf hodnoty jako body na ose Y a
kategorie na ose X. Hodnoty Y kazdé datové fady jsou spojeny ¢arami a oblasti pod Carami jsou
barevné.

170 | Pfirucka Calc 7.0



Plosné grafy zdUrazniuji objem zmén z jedné kategorie do druhé. Maji vétsi vizualni dopad nez
carové grafy, ale pouzitd data budou odliSna.

M| A Ps

Prostorowy

3D vzhled |Realisticks EA3D vzhled |Realisticky |
Obréazek 134: Dialogové okno Typ grafu - Plosny 2D a 3D graf
Varianty plosnych grafli jsou zobrazeny na obrazku 134 :
Bézny
Pokud neni volba 3D vzhled oznacena, vykresli vS8echna data jako absolutni hodnoty Y.
Nejprve vykresli oblast posledni datové fady v oblasti dat, potom pfedposledni atd.
Nakonec je nad ostatnimi daty nakreslena prvni datova rfada. VysSi hodnoty v prvni datové

e

fadé tak skryji niz8i hodnoty v dalSich datovych Ffadach.

Prostorovy
Pokud je vybrana varianta 3D vzhled, zobrazuje se prvni datova fada vpfedu a dalSi
datové fady jsou za ni.

Skladany
Skladany typ ploSného grafu kumuluje hodnoty jednu na druhou. Tim je zajiSténo, Ze jsou
viditelné vSechny hodnoty a Zadna mnoZzina dat neni skryta jinou mnozinou dat. Hodnoty Y
vSak jiz nepfedstavuji absolutni hodnoty, s vyjimkou prvni datové fady, ktera je zobrazena
ve spodni ¢asti skladanych oblasti.

Skladany (procenta)
Hodnoty kumulativné sklddané na sobé a upravené v méfitku podle procentuéiniho
zastoupeni ze soucCtu kategorie.

Rocny stav snéhu Rocny stav snéhu Rocni stav snéhu
1500 1500
1200
1000 1000
1000
00 h00 800
0 0 800
dub  kvE &wn Ewc  sm ozArl dub  kwEé Cwn  &vc  sm zal 400 i
200 I("J'aT:II;J::IJ' zkok
B Ztraceny pristav @ Kiva dalina 0 Ftraceny pristay O Kiva dalina 0 _;-_tmrg'% pFigti\.r
Jandv skok Janiv skok dub kv B Bwc sp zdf

Obrazek 135: Priklady plosnych grafi

Bézné plosné grafy

Plosné grafy mGze byt nékdy obtizné vytvorit. UZitecné mdze byt pouziti hodnot priihlednosti.
Pokud chceme vytvorit grafy na obrazku 135, nastavime nejprve zakladni graf pomoci Priivodce
grafem. Graf vlevo ukazuje vysledek. Kvli prekryvani dat jsou néktera skryta za prvni datovou
fadou. To pravdépodobné neni zadouci. DalSi priklady jsou lepSim feSenim.

Vytvoreni prostfedniho grafu:

Po zruSeni vybéru mrizky osy Y postupné klepneme pravym tlacitkem mySi na kazdou
datovou fadu a vybereme Format datové fady. Na kart& Prihlednost nastavime hodnotu
Prdhlednost na 50 %. Prlihlednost usnadiiuje vidét data skryta za prvni datovou fadou.
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Postup vytvoreni grafu vpravo:

Po provedeni vySe uvedenych krokl klepneme pravym tlacitkem mysi a vybereme Typ
graf. Vybereme volbu 3D vzhled a z rozeviraciho seznamu vybereme Realisticky. Oblast
grafu otoCime pomoci dialogového okna 3D pohled. Misto legendy pouZzijeme popisky na
ose Z.

Skladané plosné grafy

DalSimi zplsoby vizualizace stejnych datovych fad jsou skladany plosny graf a procentualni
skladany ploSny graf (obrazek 136). V prvnim prikladu je kazdy bod v datové fadé pfidan do dalsi
datové fady, aby se zobrazila celkova plocha. Druhy pfiklad ukazuje procentualni skladany graf,
zobrazujici kazdou hodnotu v fadé jako procento z celku.

Snih - 1998 Snih — 1998
3000
2500

2000 Jantv skok Jan(iv skok
B Kfiva dolina m Kiiva dolina

1500 B Ztraceny W Ztraceny

1000 pristav piistav

500

0
kvéten cervenec  zafi
duben cerven srpen

Obrazek 136: Skladané grafy a procentualni skladané grafy

Carové grafy

Cérovy graf je uziteény pro zobrazeni trend(i nebo zmén v &ase, pokud chceme zddraznit
kontinuitu. Hodnoty jsou zobrazeny jako body na ose Y a kategorie jsou zobrazeny na ose X -
Casto se jedna o data Casovych fad. Hodnoty Y kazdé datové fady mohou byt spojeny Carou.

./ Poznamka
Rozdil mezi Carovymi grafy, popsany v této ¢asti, a XY (bodovymi) grafy, popsanymi

v nasledujici €asti, je tento: Carové grafy zobrazuji kategorie podél osy X, zatimco
XY (bodové) grafy zobrazuji hodnoty podél osy X.

Jak je zndzornéno na obrazku 137, jsou k dispozici Ctyfi varianty:

Pouze body
Vykresli pouze body.

Body a €ary
Vykresli body a spoji body stejné datové rady primkou.
Pouze ¢ary
Vykresli pouze Cary.
3D cary
Spojuje body stejné datové fady pomoci 3D cary.
Pokud je vybrana volba Skladana fada, zobrazuji se kumulativni hodnoty Y nad sebou. Moznosti
jsou:

* Nahofe — umisti hodnotu kazdé datové fady nad ostatni. Hodnoty Y jiz nepfedstavuji
absolutni hodnoty, s vyjimkou prvni datové fady, ktera je zobrazena ve spodni Casti
grafu. Toto je vychozi nastaveni.
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* Procento — upravi hodnoty Y v méfitku podle procentualniho zastoupeni ze souctu
kategorie.

Typ grafu

lal Sloupcovy

= Radkowy
Vysecovy ‘

L Plogny

- Carovy

[-* XY (bodowy)
|22 Bublinovy [ Sklddané fady
7K1 Paprskovy ® Nahore

it Burzowni ) Procento

J.I_ SlDUpCDW < carami

Body a cary

MNapovéda 0K Zrusit

Obréazek 137: Dialogové okno Typ grafu - Carovy

Rozeviraci seznam Typ ¢ary ma tfi moznosti, které uréuji zplsob pfipojeni datovych bodd:
Pfimé
Nakresli pfimky mezi body.
Vyhladit
Spojuje body kfivkami namisto ¢arami. Pokud je tato moznost vybrana, klepnutim na

tlacitko Vlastnosti otevieme dialogového okno Vyhlazené spojnice (obrazek 138) a dale
ur¢ime kfivky.

Pro vyhlazené spojnice existuji dva typy Car: Kubicky splajn nebo B-splajn. Jedna se o
matematické modely, které spojuji segmenty polynomd a zobrazuji kfivky. U ¢ar typu B-
splajn existuje moznost nastaveni stupné& polynomda. Pro plynulejsi kiivky vybereme vy3si

rozliseni.
Vyhlazené spojnice
Typ Cary:
Rozliseni: 41 =
Stupefi polynoma: |3 =
Napovéda 0K Zrusit
Obréazek 138: Dialogové okno Vyhlazené
spojnice
Stupnové

Spojuje body pouze vodorovnymi nebo svislymi ¢arami. Klepnutim na tlacitko Vlastnosti
dale specifikujeme format Car (obrazek 139). Moznosti jsou samovysveétlujici.
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Stupriové spojnice

Typ stupi

1 @Eaﬁl’najl’cfmdmrovnmu carou. |['L. DEDHEfoVDdDFDVHDUEarDU

T C Stupefi na vodorovném stiedu | o Stupefi na svisly stfed

Napovéda 8] 4 Zrusit

Obrazek 139: Dialogové okno Stupriové spojnice

Co délat se spojnicemi: midZzeme je zahustit, vyhladit kontury, pouZit pouze body nebo je vytvaret

ve 3D. 3D spojnice vSak mohou divaka zmast, takZe tlustSi ¢ary Casto funguji 1épe. Obrazek 140
ukazuje nékolik prikladd ¢arovych grafd.

Trendy v obchodovani s ménou Trendy mé&novych hodnot
800 300
250
600 —_—/M 200
150
400 1o .ﬁ: @
—— | | — T — 1]
0 dub kvé ¢&vn &vc srp  zar  fij lis
dub kvé <&vn &vc srp  zar ] lis
—&— Austr. dolar Linearni (Austr. dolar)
- eled [ Britska libra Linearni (Bntska libra)
Austr. dolar Britska libra —&— Franc. frank Linearni (Franc. frank)
Franc. frank Jap yen —m— Jap yen Linearni (Jap yen)

Obrazek 140: Priklady ¢arovych graf(

Bodové grafy nebo XY grafy

Na rozdil od ¢arovych, sloupcovych a fadkovych grafd, které zobrazuji ¢iselné hodnoty na ose Y
a kategorie na ose X, bodové nebo XY grafy zobrazuji hodnoty podél obou os. Jsou velmi
uZite€né, zejména pro pochopeni vztahll mezi daty, kterd jsou pfesna a komplexni. Graf XY
mUlZe obsahovat vice neZ jednu datovou fadu a mlze provadét mnoho Ukoll, jako je generovani
kfivky parametrd nebo kresleni grafu funkce.

6 Tip

Pri vykreslovani Casu na ose X se ujistime, ze se nejedna o text a Ze je zapsan ve
spravném formatu pro pouzivané narodni prostfedi. Napfiklad misto "Leden"
pouzijeme "1/1/2022". Format narodniho prostfedi zkontrolujeme v Nastroje >
MozZnosti > Jazykové nastaveni > Jazyky > Masky pro rozpoznani data.

Grafy XY se nejCastéji pouzivaji k prozkoumani statistickych souvislosti mezi kvantitativnimi
proménnymi. Casto existuje konstantni hodnota, vici které se Gidaje porovnavaji, napfiklad Udaje
0 pocasi, reakce za rliznych Grovnich kyselosti nebo podminky v riznych nadmorskych vyskach.

0 Tip

Pokud je jedna z proménnych bud fizena experimentatorem nebo se meéni
konzistentné (napfiklad €as), je povazovana za nezavislou proménnou a vykreslena
na ose X.
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Varianty XY grafu

Typ grafu

lal Sloupcovy
£ Radkovy -
Vysecovy ‘ : ‘ ‘
ks Plogny
L= Carowy

Body a cary

= XY (bodovy)
|2 Bublinowy
% Paprskovy
| Burzavni Sefadit podle hodnot X
li. Sloupcovy s carami

Typ cary |Primeé ™ W

[at]
L
—
=
]
tn

Napovéda OK Zrusit

Obrazek 141: Dialogové okno Typ grafu — XY (bodovy)

Jak je zndzornéno na obrazku 141, kdyz je jako typ grafu vybran XY (bodovy), pak jsou k
dispozici nasledujici varianty:

Pouze body
Zobrazuje ikonu pro kazdy datovy bod. Aplikace Calc pouZiva pro kaZzdou datovou Ffadu
vychozi ikony s rliznymi tvary a barvami. Vychozi barvy je mozné nastavit v Nastroje >
MoZnosti > Grafy > Vychozi barvy. Zmé&na barev a ikon je popséna v ¢asti “Céary, oblasti
a ikony datovych bodid” na strané 147.

Body a €ary
Zobrazuje body i Cary.

Pouze c¢ary
Nakresli pfimky z jednoho datového bodu do dalSiho. Datové body nejsou oznaCeny
ikonami. Ve vychozim nastaveni je pofadi kresleni stejné jako poradi v datové fadé, ale za
povSimnuti stoji moZnost tfidéni podle hodnot X.

3D cary
Cary budou vypadat jako pasky. Datové body nejsou zobrazeny ikonami. V hotovém grafu
pouzijeme dialogové okno 3D pohled pro nastaveni vlastnosti jako je osvétleni a
perspektiva.

K dispozici jsou nasledujici moznosti:

Seradit podle hodnot X
Nakresli ¢ary v poradi hodnot X. To m{ze byt uzite¢né, pokud datové fady v tabulce nejsou
v Ciselném poradi.

Typ Cary - Pfimé
Nakresli rovné usecky.

Typ €ary - Vyhlazené
Nakresli kfivky misto pfimkovych segmentl. Klepneme na tla¢itko Vlastnosti pro
podrobnéjsi nastaveni kfivek.

— Kubicky splajn interpoluje datové body pomoci polynoml tfetiho stupné. Pfechody
mezi polynomialnimi ¢astmi jsou hladké a maji stejny sklon a zakfiveni.
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— Rozli$eni urtuje, kolik segmentli ¢ar se pocita, aby vykreslily kus polynomu mezi
dvéma datovymi body. Hodnota v rozsahu 1 az 100. Klepnutim na libovolny datovy
bod zobrazime mezilehlé body.

— B-splajn pouziva parametrické interpolované kfivky B-splajn. Kfivky jsou vytvoreny z
polynomU. Polozka Stupen polynom nastavuje stupen téchto polynomd. Hodnota je
v rozsahu 1 az 15.

Typ ¢ary - Stupnové
Pouziva pouze vodorovné a svislé ¢ary. Klepnutim na tlacitko Vlastnosti nastavuje
podrobnosti pro stuprovité spojnice.

Po vytvoreni rozptylového grafu Ize jeho vychozi nastaveni zménit nasledujicim zptsobem.
Nezapomeime nejprve dvakrat klepnout na graf a vstoupit do rezimu Uprav. V zavislosti na
moznosti mize byt také tfeba poklepat na datovy bod nebo datovou fadu.

* Styly ¢ar a ikon — dvojitym klepnutim nebo klepnutim pravym tlacitkem mySi na datovou
fadu v grafu otevieme dialogové okno Datova fada. Vice informaci najdeme v Casti

O 1

,Cary, oblasti a ikony datovych bodd” na strané 147.

* Chybové usecky — pro 2D grafy vybereme Vlozit > Chybové usecky Y nebo Chybové
usecky X pro zobrazeni chybovych Usecek. Vice informaci najdeme v ¢asti ,Chybové
Usecky” na strané 174.

* PFimky stfedni hodnoty a Spojnice trendu — Povoluje zobrazeni pfimek stfedni
hodnoty nebo spojnic trendu pomoci pfikazi v nabidce VloZit. Vice informaci najdeme v
¢asti ,Spojnice trendu a pfimky stfedni hodnoty” na strané 168.

Priklady XY grafi nebo bodovych grafi

Ve vychozim nastaveni je na ose X znazornén prvni sloupec nebo fadek dat (v zavislosti na tom,
zda jsou data usporadana ve sloupcich nebo fadcich). Zbytek fadkd dat se pak porovna s prvnim
fadkem dat.

Bodové grafy mohou prekvapit ty, ktefi je neznaji, tim, jak pracuji. To je vidét na pfikladech s
pouzitim nésledujicich dat (obrazek 142), které jsou zobrazeny s datovymi fady v fadcich.
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Obrazek 142: Priklady XY (bodového) grafu
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Oblast dat pro graf vlevo na obrazku 142 zahrnuje buriky obsahujici mésice. Mésice se vSak v
grafu neobjevuji, protoZe v XY (bodovych) grafech Ize pouzit pouze hodnoty a aplikace Calc je
nahrazuje kardinalnim &islem.

Oblast dat pro graf vpravo nezahrnuje buriky obsahujici mésice. Aplikace Calc pfedpoklada, Ze
prvni fadek (nebo sloupec) dat obsahuje hodnoty pro osu X. Hodnoty Y ostatnich datovych fad
jsou sparovany s kazdou z téchto hodnot X. To znamena4, Ze neexistuji zadné datové body pro
japonsky jen, ale kazda z ostatnich mén je zobrazena ve srovnani s jenem, protoZe poskytuje

hodnoty X.

Bublinové grafy

Bublinovy graf je variaci rozptylového grafu, ktery mlZe zobrazit tfi proménné ve dvou
rozmérech. Datové body jsou znazornény bublinami. Podél os X a Y jsou vykresleny dvé
proménné, zatimco tfeti proménna je reprezentovana relativni velikosti bublin. Tyto grafy se
¢asto pouzivaji k prezentaci finanénich nebo socialnich/demografickych tdajt.

Jednu nebo vice datovych fad Ize zahrnout do jediného grafu. Dialogové okno datovych fad pro
bublinovy graf ma polozku definujici oblast dat, ktera urCuje velikost bublin.

MUZe byt nutné vytvorit bublinovy graf ruéné na strance datovych fad v Priivodci grafy. Obrazek
143 ukazuje, jak Ize nastavit oblasti dat pro bublinovy graf.

Al e [ ¢ [ o [ ¢
Oblast dat Daiowve fady 1 | Denny prodej a odpracované hodiny
Datové fady: Olast dar. 2 |Den John Jane |
zl::v‘wlné §Denni prode) & cdpracovan hoding $852 ¢ 2 derac' : Odprac.
) Velikost bublin §Dennl prode) a odpracované hodiny' 5052 SN IR Prodej  hodiny | Prodej | hodiny
Hodnoty X §Denni prodej a odpracovand hodimy SAS2A 4 l 4 6 1- 4
< > ] T
Diblaet pro Vedikost bublin 5 2 7 7 2 5
§Thenni prode) a ordpracovand hodiny $C$25C$12 2] | 6 | 3 12 9 1| 5]
Popigy da 7| 4 15 8 23 10
$ Dennl prode a odpracovans nadiny $AS2:5A412 = 8 5 21 (8] 31! 11
A 9 6 7 7 16 9
oeat | 10| 7 9 6 12 7
11 8 10 8 7| 5
Hoonis e 2 | 9 2 5 7 5

Obrazek 143: Zaznamy datovych rad pro bublinovy graf

Graf na obrazku 144 je zaloZen na datech zobrazenych na obrdzku 143. Pro formatovani grafu
jsou datové fady nastaveny s prihlednosti 50 % a s radialnim prfechodem. Popisky jsou
formatovany jako ¢isla s umisténim ve stfedu datovych bodd (bublin).

(_/ Poznamka
Pamatujme si, Ze bublinové grafy vyZaduji numerick& data. Pokud datové fady pro

osu X obsahuji text (nebo data, ktera nejsou forméatovana jako cisla), budou pro
popisky os pouzita kardinalni €isla.
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Obréazek 144: Priklad bublinového grafu

Paprskové grafy

Paprskové grafy jsou také znamé jako pavouci, polarni nebo radarové grafy. Zobrazuji hodnoty
dat jako body na radialnich paprscich, pficemz kazdy paprsek predstavuje proménnou.
Porovnavaji Gidaje, které nejsou ¢asovymi fadami, ale ukazuiji rizné okolnosti jako jsou napfiklad
proménné ve védeckém experimentu. Jsou zvlasté uziteéné pro zobrazovani shlukl a
osamocenych hodnot.

Obrazek 145 ukazuje priklad jednoduchého paprskového grafu. Radialni paprsky paprskového
grafu jsou ekvivalentni osam Y jinych graf(i. VSechny hodnoty dat jsou zobrazeny ve stejné
stupnici, takze vSechny hodnoty dat by mély mit pfiblizné stejnou velikost.

Forma distribuce X

Sever
Severozapad 100 Severovychod
- 5 #
'
Zapad L 0 B¢ Vychod
.
| , L}
Jihozapad Jihovychod

Jih

®mDuben # Rijen

Obréazek 145: Priklad jednoduchého
paprskového grafu

Obecné je nejlepsi tfi az osm os; pfi vice osach je tento typ grafu matouci. Pfedchozi
a nasledujici hodnoty (nebo napt. o€ekavané a skute€né) mohou byt vykresleny na stejném
grafu, vysledky, takZe rozdily je mozné porovnat.

Obrazek 146 ukazuje moznosti pro vytvofeni paprskového grafu. Ty jsou podobné ploSnym a
liniovym graflim popisovanym vyse. Mé&me vSak na paméti, Ze se oblast zvétSuje se ¢tvercem
vzdalenosti podél linearnich paprski. Paprskové grafy proto mohou zkreslit oblasti predstavujici
data. Pfi vybéru skladané datové fady budme obzvlasté opatrni. V tomto pfipadé datové rady
zobrazuiji stale vétSi oblasti, které nejsou Umérné jejich hodnotam.
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Typ grafu

il Sloupcowy
=" Radkowy
Vysecowy
= Ploiny
=<3 Ca'rcw)'r
XY (bodowy)

i Burzovni
L Sloupcovy s carami

Nipovéda

Pouze body _
[ Skladané fady

MNahofe

Procento

Zrusit

Typ grafu

il Sloupcovy

=" Radkowy
Vysedowy

= Ploimy

=3 Ca'n:w)?

|- XY (bodowy)

|=7 Bublinowy

il Burzowni
nl Sloupcovy s Earami

S wyplni
[ Skladané fady
Mahore

Procento

Zrugit

Obréazek 146: Dialogové okno Typ grafu - Paprskovy graf

Obrazek 147 ukazuije priklady dvou typd paprskovych grafd.

* Priklad vlevo je paprskovy graf s vyplni. Barva jedne z datovych fad je z 50 % prdhledna.
Céstecna prihlednost je ¢asto nejlepsi pro zobrazeni vSech fad.

» Priklad vpravo je paprskovy graf s ¢arami a body. Ikony datovych bodd jsou pievzaty z
Galerie a maji 3D vzhled.

OranZové |

Modré

OranZové

Obréazek 147: Paprskovy graf s vypini a paprskovy graf s ikonami datovych
bod(i ve 3D

Burzovni grafy

Burzovni graf ilustruje trendy na burzovnim nebo akciovém trhu uvedenim oteviraci ceny,

e

obvykle pfedstavuje ¢asovou fadu.

Pfi nastavovani burzovniho grafu v Prlivodci grafem by méla byt data uspofadana tak, jak je
zobrazena na obrazku 148. UrCuje, které sloupce by meély obsahovat oteviraci ceny, nejnizsi
ceny, nejvyssi ceny a zavérecné ceny akcii a objem transakci. P¥i definovani datovych fad vSak
mdZe byt stale nutné provést ru¢ni Upravy.

Pondéli
Utery
Stieda
Civriek
Patek

Kabat
Ohjem
2500
3500
1000
2200
4600

Otevieni Nizke Vysoké Zavieni
20 15 25 17
32 22 37 30
17 15 17 17
40 30 47 35
27 20 32 31

Sarkafarka
Objem Otevieni Nizke Vysoké Zavieni
1700 15 10 20 17
2700 16 5 25 16
4100 10 7 17 10
3300 18 12 26 19
3500 20 16 32 21

Obrazek 148: Priklad usporadani dat pro burzovni grafy
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Burzovni graf uspofadava datové fady dvéma zakladnimi zpdsoby. Prvni zplsob neni pouzit v
vytvori jednu datovou jednotku v grafu. Jedna datova fada se sklada z nékolika fadk
obsahuijicich takovéto datové jednotky. Sloupce obsahujici objemy transakci jsou druhym
zplisobem, ktery se pouZiva k usporadani datovych fad. Toto je znamy zpUlsob pouZivany i v
jinych typech graf.

Obrazek 148 tedy zobrazuje data pro Ctyfi série dat: 1) Udaje o cenach Kabat, které obsahuji
sloupce pro oteviraci, nizké, vysoké a zaviraci ceny, 2) Udaje o cenach Sarkafarka, které

obsahuiji sloupce pro oteviraci, nizké, vysoké a zaviraci ceny, 3) jeden sloupec obsahujici Gdaje
0 objemu transakce Kabat a 4) jeden sloupec obsahujici Udaje o objemu transakce Sarkafarka.

Varianty burzovniho grafu

Priivodce grafem nabizi Ctyfi varianty burzovnich graf(, jak je zndzornéno na obrazku 149.
Neékteré z nich nevyuZzivaji vSechny sloupce dat.

Typ grafu

[l Sloupcovy

=" Radkowy
\Vysecovy

L Plogny

L Carovy

|- XY (bodovy)

|- Bublinovy

%7 Paprskovy

bt LY
i
P J_Ll J_Ll

Zahajeni-miminum-maximurm-zaver

li. Sloupcovy s carami

oK Zrusit

Obrazek 149: Dialogové okno Typ grafu - Burzovni graf

Tabulka Gdajli na obrazku 148 je pouzita pro ilustraci jednotlivych variant:

Burzovni graf 1
Pokud je tato varianta zaloZzena pouze na Udajich ve sloupcich nizké a vysoké, zobrazuje
se vertikalni ¢arou vzdalenost mezi dolni cenou (nizkou) a horni cenou (vysokou). Kdyz je
také zahrnut sloupec se zaviracimi hodnotami (obrazek 150), je zobrazena dodate¢na
vodorovna znacka pro zaviraci cenu.
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Burzovni graf varianta 1

50
45
40
35

30 Kabat
25 = Sarkafarka

A

Pondéli Utery  Stieda Civriek Patek
Obrazek 150: Burzovni graf varianta 1 zobrazujici nizké, vysokeé a zaviraci ceny

Cena

o

n

Burzovni graf 2
Na zakladé oteviracich, nizkych, vysokych a zaviracich sloupc vytvafi tato varianta
tradicni graf ve tvaru svicnu (obrazek 151). Zobrazuje svislou ¢aru mezi nejnizSimi a

¥ v s

nejvy3simi cenami a pred ni pfidava obdélnik, ktery ukazuje rozsah mezi oteviraci a
zaviraci cenou. Pro rostouci hodnoty (oteviraci cena je nizSi nez zaviraci cena) je barva
vyplné bila. Pro klesajici hodnoty je barva vyplné Cerna.

Burzovni graf varianta 2

50
45
40
35
30 Kabat

25 ——— Sarkafarka
2 -
: *

Cena
[ 45 -

10

[ %]

Pondéli Utery  Sifeda Civriek Patek

Obréazek 151: Burzovni graf varianta 2 zobrazujici nizké a vysoké ceny a rozmezi
mezi oteviracimi a zaviracimi cenami

Burzovni graf 3
Pomoci sloupcll nizké, vysoké a zaviraci vykresli graf podobny burzovnimu grafu 1, ale
prida dalSi sloupce s objemem transakce. Jak je zndzornéno na obrazku 152 umoZzniuje
vedlejsi osa Y zobrazeni objemu transakci a ceny na svislych oséch.
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Burzowvni graf varianta 3

5000 50
4500 45
4000 40
3500 35

Objem
Cena

wn

u
3000 30
2500 |' 25
2000 20
1500 I' |_ 15
1000 I- 10
500 .
0

Pondéli Utery Stfeda Civriek Patek

o

. Kabat Objem Sarkafarka Objem
Kabat Cena Sarkafarka Cena

Obrézek 152: Burzovni graf varianta 3 zobrazuje nizké, vysoké a zaviraci ceny
a také objem transakci

"/ Poznamka

Varianty 3 a 4 automaticky zarovnavaji data k vedlejsi ose Y. Vice informaci o
vedlejSi ose Y najdeme v Casti ,Zarovnani dat k vedlejSi ose Y” na strané 145.

Burzovni graf 4
Na zakladé vSech péti sloupcli dat (objem, oteviraci cena, nizk& cena, vysoka cena a
zaviraci cena) kombinuje tato varianta Burzovni graf varianta 2 se sloupcovym grafem pro
objem transakci (obrazek 153).

Burzowvni graf varianta 4

5000 50
4500 45
4000 ’— 40
3500 - 35
E 3000 30
& 2500 T 25 E
8 2000 . . 1 ;. 20 S
1500 N | 15
1000 I i 10
500 5
0 0
Pondélf Utery Streda Ctvrtek Patek
N Kabat Objem Sarkafarka Objem
Kabat Cena Sarkafarka Cena

Obrazek 153: Burzovni graf varianta 4 zobrazujici oteviraci, nizké, vysoké a
zaviraci ceny a také objemy transakci.

Sloupcové grafy s Carami

Sloupcovy graf s Carami je uziteCny pro zobrazeni dvou nebo vice odliSnych, ale souvisejicich
datovych fad, jako je napf. prodej v €ase (sloupce) a trendy rozpéti zisku (Cary). Mohl by také

zobrazovat konstantni ¢ary minima a maxima, jako napfiklad pfi Iékafskych testech nebo
kontrolach kvality.
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V dialogovém okné Typ grafu ur€ime pocet €ar grafu. Ve vychozim nastaveni jsou prvni fadek
nebo sloupec dat kategorie a posledni sloupce nebo fadky dat jsou Cary.

Vybereme si mezi dvéma variantami:

Sloupce a €ary
Jak je vidét na obrazku 154, jsou sloupce nakresleny vedle sebe, aby bylo mozné snadno
porovnat jejich hodnoty.

Dvé &tvrtleti riistu zisku

o0 2 I Kabat dej
250 JEL procig

e Sarkafarka prodej
— K abat zisky
e Sarlcatarka zisky

200

Prodeje
Profit

150
100
50

led Gno bfe dub kvé &vn

Obrazek 154: Sloupcovy graf s Carami a vedlejsi osou Y

Skladané sloupce a ¢ary
Sloupce jsou naskladany nad sebou, takze vySka sloupce zobrazuje soucet datovych
hodnot.

Grafy na obrazcich 154 a 155 zobrazuji Udaje o prodeji a zisku dvou firem za urcité asové
obdobi. VSimneme si, Ze pfi prvnim vytvofeni byly pro stejnou spole€nost Cary jiné barvy nez
sloupce. Chceme-li odraZet vztah Udajd k jedné spole¢nosti, zménime barvy ¢ar klepnutim na
¢aru a z mistni nabidky (pomoci klepnuti pravym tlacitkem mysi) vybereme Format datovych
fad a na karté Céra nastavime pozadovanou barvu a velikost Gary.

Pro nastaveni pozadi klepneme pravym tlacitkem mySi na sténu grafu, vybereme Format stény
grafu a na karté Format, na strance Pfechod vybereme poZzadované moznosti. Informace o
zarovnani dvou datovych fad s vedlejSi osou Y najdeme v ¢asti ,Zarovnani dat k vedlejSi ose Y”
na strané 145.
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Dveé civrtleti ristu zisku

400 35

350 30

300 o5

250 i e Sarkafarka prode)
T 200 | I = Kabit zisky
o il c Sarkafarka zisky
& 150 | "

100 10

50 | >

0 0

led UGno bfe dub kvé d&vn
Obrazek 155: Sloupcovy graf s Carami se skladanymi sloupci

Kontingenéni grafy

Kontingenc&ni tabulky jsou speciélni typy datovych tabulek, které zjednodusuji manipulaci a
analyzu dat. Tyto tabulky jsou Siroce pouzivany pro zpracovani velkého mnozstvi dat.
Kontingen€ni grafy jsou zaloZzeny na kontingencnich tabulkach a vytvareji se vybérem VloZit >
Graf z hlavni nabidky nebo klepnutim na ikonu Vlozit graf na standardni nastrojové listé.
Nejprve vsak klepneme levym tlaCitkem mySi na buriku uvnitf kontingenc¢ni tabulky. Kontingencni
grafy pfebiraji mnoho vlastnosti jinych typl grafi popsanych v této kapitole, ale maiji také dalsi
vlastnosti, které jsou popsany v kapitole 8, PouZiti kontingencnich tabulek.
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j LibreOffice

Prlivodce programem Calc

Kapitola 4
Pouzivame styly a sablony

Pouziti konzistentniho formatovani



Co jsou styly? Proc€ je pouzivame?

Styly jsou sadou formatd, které mizeme vyuzit na vybrané jednotky v dokumentu, abychom
rychle zménili jejich vzhled. PouZiti stylu ¢asto znamena, Ze pouZijeme sadu formatovani
najednou.

Mnoho lidi formatuje bunky tabulky a stranky manualné bez toho, aniz by vénovali pozornost
styllim, a jsou zvykli forméatovat dokumenty podle fyzickych atributl. Napfiklad pro obsah bunék
muazeme specifikovat rodinu pisma, velikost pisma a jakéhokoliv znaku nebo forméatovat jako
tucné nebo kurziva.

Pouzitim styll minime to, Ze prestaneme aplikovat atributy a znaky individualné (napriklad
velikost pisma 14 pt, Times New Roman, tu¢né, vystredéné) a zatneme pouZzivat styly, napriklad
Nadpis. Pouziti atributli a charakteristika jsou asové narocné a nachylné k chybam. Naproti
tomu, vyuziti stylu, ktery byl definovan tak, aby obsahoval atributy a charakteristiky, které
chceme, ndm Setfi Cas a poskytuje vétsi konzistenci pfi formétovani.

Styly také usnadnuji zasadni zmény ve formatovani. Napfiklad rozhodneme-Ili se zménit vzhled
vSech mezisouctd v tabulce na 10 pt Arial misto 8 pt Times New Roman poté, co jsme vytvorili
15strankovou tabulku. Za predpokladu, Ze jste vdechny mezisoudty naformatovali ur€itym stylem,
mdzete vSechny mezisoucty v dokumentu zménit jednoduse zménou vlastnosti daného stylu.

Navic program Calc také poskytuje styly stranek, jak je popsano dale.

Mlzeme zménit atributy dodanych styld a definovat tolik novych styll, kolik potfebujeme.
Vytvareni, Gprava a pristup ke stylim jsou vysvétleny v nasledujicich sekcich.

PFimé formatovani a formatovani pomoci styll
Pfimé forméatovani (nazyvané také rucni formatovani) mé pfednost pfed styly. Pfimé formatovani
neni mozné odstranit pouzitim stylu.

KdyZ chceme odstranit ru¢ni formatovani, vybereme text a pak pouzijeme jednu z nasledujicich
mozZnosti:

* Klepneme pravym tlacitkem mySi a z mistni nabidky vybereme Vymazat pfimé
formatovani.

* Zmackneme Ctrl + M.

* Klepneme na ikonu Vymazat pfimé formatovani na Standardni nastrojové listé.

* V hlavni nabidce zvolime Format > Vymazat pfimé formatovani.

Druhy styli programu Calc

Zatimco nékteré komponenty LibreOffice umoZiiuji mnoho typl stylll, Calc poskytuje pouze dva:
styly bunék a styly stranek. Tyto typy styll jsou popséany v nasledujicich sekcich.

Styly bunék

Styly bunék jsou podobné stylim odstavci pouzivanych v LibreOffice Writer. Jsou
nejzakladnéjsimi typy stylu v programu Calc. Styly bunék jsou pouzivany k aplikovani pisma,
zarovnani, okrajd, pozadi, formatd Cisel (napfiklad ména, datum, ¢islo), a k ochrané bunék pred
formatovanim dat v bunkéach.

Zakladni oblast styl(i bunék je dodavana s programem Calc. Mnohé z téchto stylll jsou zobrazeny
v nabidce Styly na listé nabidek a vSechny tyto styly pak najdeme na postranni listé v panelu
Styly. Kdyz vytvofime novy styl buriky, ukdze se ndm na postranni listé. Pokud chceme tento styl
pridat na nabidky Styly, najdeme informace v Kapitole 14, Nastaveni a pfizplsobeni.
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Zpocatku jsou zakladni styly nakonfigurovany tak, Ze pokud zménime vlastnosti stylu buriky
Viychozi styl buriky, vSechny ostatni styly, které z néj vlastnosti dédi, se zmeéni tak, aby
odpovidaly tomuto vychozimu stylu.

Styly stranek

Styly stranek v Calc jsou pouzivany na listy. PfestoZe se mize jeden list vytisknout na nékolik
stranek, na stranku se mize pouzit pouze jeden styl stranky. Pokud soubor tabulky zahrnuje vice
nezZ jeden list, miZeme na kazdy list pouzit odlidny styl stranek. Tabulky mohou napfiklad
obsahovat néktere listy k tisku v orientaci na Sifku a jiné listy k tisku v orientaci na vysku.

Program Calc podporuje dva styly stranek: Vychozi styl a Sestava. Styly stranek nam umoznuji
nastavit velikost stranek, jejich orientaci, okraje stranky, zahlavi a zapati, ohrani¢eni a pozadi
a poradi tisku listQ.

Pouziti styli bunék

Chceme-li pouzit styly bunék v programu Calc, mizeme pouZzit nabidku Styly v hlavni nabidce,
kartu Styly na postranni listé, reZzim vypliovani formétu, rozbalovaci seznam PouZit styl na
nastrojové listé Formatovani a klavesové zkratky.

Nabidka styl(

Ve vychozim nastaveni obsahuje nabidka Styly (obrazek 156) seznam mnoha styld bunék
podporovanych programem Calc. Chceme-li pouzit styl bunék, vybereme buriku nebo skupinu
bunék, kterou chceme naformétovat, a pak vybereme Styly a klepneme na poZadovany styl.

Styly List Data Nastroje (
A Vychozi
[N Zvjraznéni 1
Zwyraznéni 2
A Zwjraznéni 3
Hs Nadpis 1
MNadpis 2
Dobré
Spatné
Meutralni
Chyba
Warovani

PO & n A F

Poznamka pod Carou
Poznamka

/5 Aktualizovat vybrany styl
-+ Nowy styl z vybéru

M Spravovat styly F11
Obréazek 156: Nabidka
Styly

Karta styly na postranni listé
Karta Styly na postranni listé obsahuje seznamy a volitelné zobrazuje nahledy dostupnych styld.

1) Jestlize neni karta Styly na postranni listé oteviena, otevieme ji jednim z nasledujicich
zpUsobd:
— V hlavni nabidce zvolime Zobrazit > Styly.
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— V hlavni nabidce zvolime Styly > Spravovat styly.
— Stiskneme funkéni klavesu F11.

— Pokud je v postranni liSté oteviena jina karta, pouZijeme pro otevieni ikonu Styly,
ktera se nachazi na pravé strané postranni listy.

2) Klepneme na ikonu Styly bunék v horni ¢asti karty Styld a otevieme seznam styl(

bunék. Obrazek 157 zobrazuje kartu s viditelnymi styly bunék.

3) V tabulce zvyraznime bunku nebo skupinu bunék, kde chceme pouzit styl bunék.

4) Dvakrat klepneme na nazev stylu buriky na karté styly a atributy formatovani stylu se
aplikuji na data zahrnuta ve zvyraznénych burikach.

Rezim vyplné

Rezim vyplIné je uzite¢ny, kdyz chceme aplikovat tentyz styl na mnoho rozptylenych bunék.

i Styly
[

Accent
Accent 1
Accent 2
Accent 3
Bad
Error
Footnote
Good
Heading

Heading 1

Heading 2
Hyperlink
MNeutral
MNote
Result

Status

Text

Warning

Zobrazit nahledy

‘Vﬁechny styly

v ‘

Obréazek 157: Karta styly na postranni listé

zobrazujici styly bunék

1) Prejdeme na kartu styly na postranni liSté (obrazek 157).
2) Vybereme styl, ktery chceme aplikovat.
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3)

4)
5)

Klepneme na ikonu ReZim vyplfhiovani formatu, kterou najdeme vpravo nahofe na karté
Styly. Kurzor zmeéni tvar.

Klikneme na kazdou buriku, kde chceme aplikovat vybrany styl.

Kdyz mame formatovani bunék dokoncéeno, klepneme na ikonu Rezim vyplnovani
formatu a rezim ukoncime.

Upozornéni

KdyZ je rezim vyplné aktivni, kliknutim pravym tlacitkem mySi kamkoliv v dokumentu
deaktivujeme posledni akci formatovani vyplné. Musime davat pozor, abychom
omylem neklepli pravym tlacitkem mySi na jakékoliv formatovaci akce, které chceme
zachovat.

Seznam PouZit styl

Rozeviraci seznam Styl neni ve vychozim formatovacim panelu nastrojii Calc zahrnut, ale
mUzeme jej pfidat nasledujicim zplsobem:

1)

2)

Klikneme pravym tlacitkem na jakoukoliv ikonu nastrojové liSty Formatovani a z mistni
nabidky vybereme Viditelna tla€itka (obrazek 158).

Klikneme na Pouzit styl. Kontextova nabidka se uzavie a seznam PouZit Styl se zobrazi
na levém konci nastrojové listy Formatovani.

Viditelna tlacitka v | A Styly
Prizplsobit listu.. Pouzit styl
Ukotvit listu A Nazev pisma
Ukotvit viechny lity

Zamknout umisténi listy
Zavrit listu

Obrazek 158: Pridani seznamu PouZit styl do nastrojové liSty
Formatovani

Chceme-li pouZzit styl pomoci rozeviraciho seznamu PouZit styl.

1)
2)

3)

Vybereme bunku nebo skupinu bunék v tabulce.

Klepneme na Sipku dold na pravé strané seznamu PouZit styl a otevieme rozeviraci
nabidku (obrazek 159).

Vybereme pozZadovany styl. Atributy formatovani tohoto stylu jsou aplikovany na vybrané

buriky.

Odstranit formatovani

Heading 1

Wychozi

Dalai styly...

Obrazek 159: Pouziti
seznamu PouZit styl
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V seznamu se zobrazuji pouze styly, které se momentalné pouzivaji. Klikneme na Vice stylU
a prejdeme do nabidky Styly, kde jsou dostupné vSechny styly bunék.
Klavesové zkratky

Abychom pouzili béZné vyuzivané styly bunék nebo stranek, véetné jakychkoliv vlastnich styld,
které jsme si vytvorili, mGzeme vytvorit klavesové zkratky. Pro dalsi informace viz kapitolu 14,
Nastaveni a pfizplsobeni.

PouZivame styly stranky

Styl stranek pouzity na list v tabulce je uveden na stavovém fadku, jak je zobrazeno na obrazku

160.
18

<

4  List1 List2 List3
List 2z 3 Wychozi Cestina
Obrazek 160: Styl stranky (Vychozi) uveden na stavovém radku

Chceme-li pouzit odlidny styl stranky:
1) Klinutim na kartu listu vybereme pozadovany styl.
2) Prejdeme na kartu styly na postranni listé (obrazek 157).
3) V horni Casti karty Styly klepneme na ikonu Styly stranky.
4) Dvakrat klikneme na pozadovany styl stranky.

Vytvoreni novych (vlastnich) stylu

Chceme-li vytvofit novy (vlastni) styl, postupujeme podle postupu popsaného v této sekci.

4 Poznamka

VSechny nové (vlastni) styly a vSechny zmény existujiciho stylu pouzijeme jen na
pouzivanou tabulku. Pokud chceme uloZzit nové styly a Sablony, vice informaci
najdeme v Casti ,Vytvoreni Sablony” na strance 231.

1) Prejdeme na kartu styly na postranni listé (obrazek 157).

2) K vytvofeni nového stylu buriky klikneme na ikonu Styly bunék nebo pro vytvoreni
nového stylu stranky klikneme na ikonu Styly stranky.

3) Chceme-li otevrit dialogové okno stylu buriky a stylu stranky, pravym tlaCitkem mysi
klepneme na kartu styly a z mistni nabidky vybereme Novy.

4) Chceme-li nastavit atributy nového stylu, pouzijeme rdizné stranky s kartami
v dialogovych oknech. Pro vice informaci viz ,Atributy styld bunék” dale a ,Atributy stylu
stanek” na strané 226.

5) Chceme-li zavrit dialogové okno a uloZit novy styl, klikneme na OK.

/ Poznamka

Nazvy styll rozlisuji velikost pismen. Mlzeme definovat napfiklad styl nazvany
Cervena a jiny styl nazvany Cervena. Aby nedoslo k zameéné, ujistime se, Ze vSechny
nazvy styld jsou dostatecné odligné.
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Atributy styll bunék

Nasledujici atributy jsou dostupné na zalozkach stanek v dialogovém okné Styl buriky (obrazek
161).

Karta Organizator

* Nazev — zobrazuje jméno vybraného stylu. Chceme-li vytvofit nebo zménit vlastni styl,
zadame nazev stylu. NemlzZeme zménit nazev preddefinovaného stylu.

« Rodicovsky — miZeme vybrat souvislost s novym stylem a existujicim stylem a pak
pozménit jeho nékteré atributy. Pokud toto udélame, zména atributu nadfazeného stylu
ovlivni novy styl. Napfiklad mizeme vytvorit identické styly kromé barvy pisma; pokud
pozdéji zménime rodinu pisma nebo nadfazeny styl, nova rodina stylu se také zméni.

* Upravit styl — umozZnuje ndm zobrazit a upravit vlastnosti rodiCovského stylu.

+ Kategorie — zobrazuje kategorii aktualniho stylu. Pokud vytvafime nebo ménime novy
styl, vybereme ze seznamu Vlastni styly. Nem{zeme zménit kategorii preddefinovaného
stylu.

* Obsahuje — popisuje forméatovani pouzité ve stylu.

Styl buriky

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohrani¢eni Pozadi Ochrana buriky

Styl

MNazewv: |Bez ndzvu?

Rodicovsky: Upravit styl
Kategorie: [Vlastni styly o |
Obsahuje
Napovéda Obnovit Standardni oK Lrusit

Obréazek 161: Dialogové okno Styl buriky — karta Organizator

Karta Cisla
* Kategorie — vybereme kategorii ze seznamu.
* Format — vybereme, jak chceme, aby se zobrazoval obsah vybranych bunék.

KdyZ vybereme Ménu jako kategorii, potfebujeme vybrat ménu z rozeviraciho seznamu
a pak vybrat format, ktery chceme vyuZzit z dostupnych moZznosti pro tuto menu.

Format mény je zavisly na jazyku, ktery si vybereme v poli Jazyk. Vychozi format mény
pro buriku je ur€en mistnim nastavenim naSeho operacniho systému.

+ Jazyk — specifikuje jazyk nastaveni pro vybranou burku. S vychozim nastavenim jazyku
Calc automaticky aplikuje Ciselny formét spojeny s vychozim nastavenim jazyka
systému. Nastaveni jazyka zajistuje, Zze formaty data a mény jsou zachovany, i kdyz
bude dokument otevien v operacnim systému, ktery vyuziva jiné vychozi nastaveni
jazyka.

* Moznosti — specifikace moznosti pro zvoleny format:

— Desetinna mista — zadame pocet desetinnych mist, kterd chceme zobrazit.
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— Uvodni nuly — zadame maximalni pocet nul, které chceme zobrazit pfed desetinnou
carkou.

— Zaporna Cisla Cervené — vybereme, jestli chceme zmeénit barvu negativnich &isel na
Cervenou.

— Oddélovac tisicl — vybereme, chceme-li oddélova¢ mezi tisici. Typy oddélovace
(napfiklad ¢arka nebo mezera) zavisi na nastaveni jazyka.

« Formatovani kédu — zobrazuje forméatovaci kéd ¢isla vybraného formatu. Mzeme také
zadat vlastni formét.

» Pridat — prida kod formatu Cisla, ktery jsme zadali do kategorie definované uzivatelem.
* Upravit komentar — pfida komentar k vybranému formatu Cisla.

* Odstranit — odstrani vybrany format Cisla.

* Pole ndhledu — zobrazuje nahled aktualniho vybéru.

Styl buriky

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohrani¢eni Pozadi Ochrana buriky

Kategorie Format Jazyk
Vse Vychozi - Cestina |
Definované uZivatelem -1235
Procento -1 235
Ména -1 234,57
Datum -1 234,57
Cas
Védecky
Zlomek
Booleovska hodnota
Text
-1234,56789012346

Moznosti
Desetinna mista: *| OZapoma ¢isla cervend
Uvodni nuly: |1 < | L oOddélovac tisicd

Formatovaci kod

Standard

Napovéda Obnovit Standardni OK Zrudit

Obréazek 162: Dialog Styl buriky — karta Cisla

Karta pismo

V zavislosti na vasem jazykovém nastaveni miZete na této karté zmeénit formatovani
nasledujicich typl pisma - Pismo pro zapadni text (latinské znakové sady), Pismo pro asijsky
text (Cinské, japonské nebo korejské znakové sady) a Komplexni pismo rozlozeni textu (smér
textu zprava doleva). Obrazek 163 zobrazuje kartu Pismo dialogového okna Styl buriky, pokud
jsou vybrany moznosti Asijské a Komplexni rozvrzeni textu v ¢asti Viychozi jazyky pro
dokumenty na strdnce Nastroje > MoZnosti > Jazykova nastaveni > Jazyky. RozvrZeni karet
Pismo a Efekty pro pismo je upraveno, pokud neni kterdkoliv z téchto dvou moZznosti vybrana.
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Pismo — ze seznamu vybereme nainstalované pismo.

+ Styl — vybereme formatovani, které chceme vyuzit, napfiklad tu¢né, kurziva nebo
podtrzené.

* Velikost — vybereme nebo zadame velikost pisma, které chceme pouzit. U Skalovani
pisem mlzeme také zadat desetinné hodnoty. Pokud chceme vytvofit styl, ktery je
zaloZen na jiném stylu, mliZeme zadat procentuaini hodnotu nebo bodovou hodnotu
(napfiklad 2 pt nebo 5 pt).

» Jazyk — nastavuje jazyk, ktery ma pouzit kontrola pravopisu. Kontrola pravopisu funguje
pouze tehdy, kdyZ mame nainstalovan odpovidajici jazykovy modul. Pokud je kontrola
pravopisu pro dany jazyk aktivovana, je pred poloZkou jazyk zaskrtnuti.

* Funkce — néktera pisma nabizeji funkce jako jsou volitelné slitky a vodorovny kerning.
Klikneme na toto tlaCitko a otevieme dialogové okno Vlastnosti pisma (neni zobrazeno)
a vybereme z funkci.

* Nahled — zobrazuje nahled aktualniho vybéru.

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi Ochrana buriky

Pismo pro zapadni text

Pismo: Styl: Welikost: Jazyk:
Liberation Sans ~ | Bé&Ziné ~ 10 pt |~ ||Cestina s
Stejné pismo bude poufito na tiskdrné i na obrazovce. Vlastnosti...

Pismo pro asijsky text

Pismo: Styl: Welikost: Jazyk:
Microsoft YaHei ~ 1|10 pt [ Cingtina (zjedn) ~
Stejné pismo bude pouZito na tiskarné 1 na obrazovce. Vlastnosti...

Pismo pro komplexni rozvrzeni textu (CTL)

Pismo: Styl: Welikost: Jazyk:
Anal ~ | lobyCejné 110 pt [~ Hindstina =
Stejné pismo bude poufito na tiskdrné i na obrazovce. Vlastnosti...

Loremipsum AZ#]HFE nav na g

MNapovéda Obnovit Standardni QK Zrusit

Obréazek 163: Dialogové okno Styl buriky — karta Pismo

Karta efekty pisma

* Barva pisma — nastavuje barvu textu. Pokud vybereme Automaticka, barva textu se
nastavi na ¢ernou na svétlém pozadi a na bilou pro tmaveé pozadi.

¢ Prlihlednost — slouzi k nastaveni prihlednosti pisma. Hodnota 100 % znamend Uplnou
prihlednost; hodnota 0 % znamend, Ze pismo neni prdhledné viibec.
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* Nadtrzeni — vybereme styl nadtrzeni, které chceme pouzit. Chceme-li pouzit nadtrzeni
pouze na slova (ne mezery mezi nimi), vybereme Jednotliva slova.

* Barva nadtrZeni — vybereme barvu pro nadtrZzeni. Automaticka odpovida barvé pisma.
* Preskrtnuti — vybereme styl pfeskrtnuti pro zvoleny text.

* Podtrzeni — vybereme styl podtrZeni, ktery chceme pouzit. Chceme-li pouZzit podtrzeni
pouze slov (ne mezer mezi nimi), vybereme Jednotliva slova.

Chceme-li pouzit podtrzeni na text horniho indexu, podtrZzeni se zvySi na Uroven horniho
indexu. Pokud je horni index zahrnut ve slové s normalnim textem, podtrzeni neni
zvyseno.

* Barva podtrzeni — vybereme barvu podtrzeni. Automaticka odpovida barvé pisma.

* Jednotliva slova — pozije vybrany efekt pouze na slova a ignoruje mezery.

* Reliéf — vybereme efekt reliéfu, ktery chceme aplikovat na text. Reliéf vytvafi zobrazeni
znakd v podobé vyvyseni nad strankou. Rytina vytvori zobrazeni znakU jako by byly
vtlaCeny do stranky.

« Obrys — zobrazuje obrys znak(. Tento efekt nefunguje u kazdého pisma.
e Stin — pridava stin, ktery je vrzen pod a napravo od znakd.

» Znacka zvyraznéni — vybereme znak, ktery se méa zobrazit pod nebo nad celou délkou
oznaceneho textu.

* Umisténi — urCime, kde bude zobrazena znacka zvyraznéni.
* Nahled - zobrazuje nahled aktualniho vybéru.
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Styl buriky

Barva pisma

Barva pisma:

Prahlednost:

Dekorace textu

NadtrZeni:
Preskrtnuti:

PodtrZeni:

Efekty
Reliéf:

Umistén:

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijskd typografie Ohrani¢eni Pozadi Ochrana buriky

B Cervena -
0% —
(Zadng) w Automaticks
(Zadng) w
(Zadné) e Automaticka

Jednotliva slova

(Zadny)

v| Oobrys Ostin

Znacka zvjraznéni: |(Zadna)

> |

|Na|:| textem

Loremipsum AZ#]#HAE mw na o

Napovéda

Obnovit Standardni oK

Obrézek 164: Dialogové okno Styl buriky — Karta Efekty pisma

Karta Zarovnani

* Zarovnani textu — nastavuje moznosti zarovnani obsahu aktualni buriky nebo vybranych

bunék.

— Vodorovné — vybereme moZznost vodorovného zarovnani, kterou chceme pouzit na
obsah bunky:

— Vychozi — zarovnava Cisla napravo a text nalevo.
— Vlevo — zarovnava obsah buriky nalevo.

— Doprostred — horizontalné vystfedi obsah buriky.
— Vpravo - zarovnava obsah buriky doprava.

— Do bloku — zarovnava obsah bunék do nalevo a napravo k okrajlim buriky.

—  VWyplnit — opakuje obsah buriky (Cislo a text), dokud neni viditelna ¢ast buriky
vypInéna. Tato vlastnost nefunguje na textu, ktery obsahuje konce radka.

— Zalomeni — vyrovnava obsah rovnomeérné po celé burice. Na rozdil od zarovnani
Do bloku také vyrovnava Upliné posledni fadek textu.

— Odsazeni — odsadi od levého okraje bufky rozsahem, ktery zadame.
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— Svislé — vybereme moznost svislého zarovnani, kterou chceme pouZzit na obsah
bunky:
— Vychozi — zarovnava obsah burky ke spodni ¢asti buriky.
— Nahoru — zarovnava obsah bunky do horni ¢asti okraje buriky.
— Dolli — zarovnava obsah buriky ke spodnimu okraji buriky.
— Doprostred — vertikalné vycentruje obsah bunky.
— Do bloku — zarovnava obsah buriky k hornim a spodnim okrajiim buriky.

— Rozprostifené — podobné zarovnani Do bloku, pokud neni text orientovan svisle.
Pak se chova podobnym zplisobem jako horizontalni nastaveni Rozprostrené,
pfiCemz je zarovnan Uplné posledni fadek.

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijské typografie Ohranic¢eni Pozadi Ochrana buriky

Zarovnani textu

Vodorovné: Qdsazeni: |0 pt =

Orientace textu

[ Svisle zarovnané

ReZim asijského rozvrieni
il

M " ( s

. - -
Stupné: 0° = 8 -
- ABCD @
Zakadna: [g]o|o | I

“ ~

Vlastnosti
[ Automaticky zalomit text
Déleni slov aktivni

[JZmensit podle velikosti buriky

Smér textu: |PouZit nastaveni nadfazeného objektu| ~

e T arror W S T

Obrazek 165: Dialogové okno Styl buriky — karta Zarovnani

* Orientace textu — definuje smér textu obsahu v buice.

— Kolo ABCD - klikneme kdekoliv na kolo, abychom urcili orientaci textu. Znaky “ABCD”
na kole souhlasi s novym nastavenim.

— Vertikalné poskladané — pfifadi bunécnému obsahu vertikalni orientaci textu.

— ReZim asijského rozvrZeni — tato volba je k dispozici pouze v pfipadé, Ze je povolena
podpora Asijskych jazyk( a smér textu je nastaven na svisly. Zarovna Asijské znaky
pod sebe ve vybrané bufice, resp. vybranych burikach. Pokud burika obsahuje vice
nez jeden fadek textu, radky jsou prevedeny na sloupce textu, které jsou usporadany
zprava doleva. Zapadni znaky jsou v pfevedeném textu oto¢eny o 90 stupiili doprava.
Asijské znaky otoCeny nejsou.
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— Stupné — umoznuji nam manualné zadat orientaci Ghlu.
— Zakladna — specifikujeme okraj buriky, od kterého se otoeny text bude psat:

— Text vychazi z dolniho okraje buriky — zapiSe otoCeny text od spodni hrany buriky
smérem ven.

— Text vychazi z horniho okraje buriky — zapiSe otoCeny text od horniho okraje
bunky smérem ven.

— Text z(stane uvnitf buriky — zapi$e otoCeny text pouze v burice.
» Vlastnosti — urcuji tok textu v burice.

— Automatické zalamovani textu — zalamuje text do dalSiho fadku na okraji buriky. PocCet

radkd je zavisly na Sifce buriky. Chceme-li vioZit manualni zalomeni, stiskneme
v bunce Ctrl + Enter.

~7s vz

— Aktivni déleni slov — umoznuje déleni slov pro zalamovani na dalSi fadek.
— Zmensit podle velikosti buriky — zmensuje viditelnou velikost pisma tak, aby se obsah

7 Moy

buriky vesel do aktualni $ifky buriky. Tento pfikaz nemUZeme pouzit na buriky
obsahujici konce radka.

— Smér textu — volby jsou Zleva doprava, Zprava doleva, a Pouzit nastaveni
nadfazeného objektu (nastaveni pouzita v pfedchozi burice).

Karta Asijska typografie

Organizator Cisla Pismo Efekty pro pismo Zarovnani ?ﬁ«sijské typografie§ Ohraniceni Pozadi Ochrana buriky

Zména fadky
L] PouZit seznam zakazanych znakd na zatatek a konec radky
Povolit zavésenou interpunkci

PouZit rozestup znakd mezi asijskym a jinym textem

Napovéda Obnovit Standardni QK Zrusit

Obrazek 166: Dialogové okno Styl buriky - karta Asijska typografie

Pokud je pouZzita podpora Asijského jazyka, zobrazi se v dialogovém okné Styl buriky karta
Asijska typografie. Vice detailll o dostupnych moZnostech na této karté najdeme v popisech
odpovidajici karty v dialogovém okné Forméat buriky v Kapitole 2, Zadavani, Gprava

a forméatovani dat.

Karta okraje
Nastavuje pfedvolby okrajd u vybrané buriky.

s s W

» Usporadani ¢ar — vybereme prednastaveny styl nebo definujeme svou vlastni kombinaci
pomoci kliknuti na schéma.

« Cara — vybereme styl ¢ary, tloustku a barvu, kterou chceme vyuzit. Styl je pouZit na
okraje vybrané v nahledu.

* Vnitini okraje — specifikuji mnoZstvi mista, které chceme nechat mezi okrajem
a obsahem buriky. Kazdou vzdalenost (vlevo, vpravo, nahore, dole) miiZzeme nastavit
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samostatné nebo mizeme zvolit Synchronizovat, abychom pouZili stejné vnitfni okraje
na vSechna ohranice, kdyz zadame novou hodnotu.

« Styl stinu — pouziva stinovy efekt na okraje. MiZeme specifikovat pozici stinu (vpravo
dole, vpravo nahore, vlevo dole nebo vlevo nahofe), vzdalenost prodlouZeni stinu
a barvu stinu.

Styl buriky

Crganizéator Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohranlﬁe Pozadi Ochrana buriky

Uspofadani car Okraj
Predlohy: | o1 = x| Ve 0,35 mm
Definované uZivatelem: Vpravo: 0,35 mm

Nahofe: 0,35 mm
Dole; 0,35 mm

Synchronizovat

L0 L0 E0 LA LN L

& £l

Sousedni’ buriky:

Odstranit chraniceni

Cara Styl stinovani
Styl: A Umisténi: | I:| ” ] ” ] ” I |
Barva: | Cema - Barva: Seda -
Sitka: 005pt = Vzdalenost: |1,76 mm =
MNapovéda Obnovit Standardni oK Zrusit

Obrazek 167: Dialogové okno Styl buriky - karta Ohrani¢eni

Karta pozadi

Klikneme na Barva abychom vybrali barvu, kterou chceme pouzit na pozadi pro formatované
buriky. MGzeme vybirat z nékolika palet. Abychom zmenili barvu, vybereme jinou. Abychom
odstranili barvu pozadi, vybereme Zadna.
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Styl buriky: Bez nazvu2

Organizator Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni P

* Ochrana buriky

Zadna Barva

Barvy

Alktivni

Paleta: |5ta ndard

COeeEEEEEEec
N

[(CDeEEEEEEesC
[[CeEEEEEEEn
[ PEEEEEEEE®
fEEEEEEEEEEN
SEEEEEEEEEEE

Posledni barvy
e ][]

Vlastni paleta

Pridat Smazat

Napovéda

R [255

G |215

B |215
HTML |ffd7d7

Nova

|7
rJ
9
o

[
(1) ] [«

[==]
[xe}
iy
%,

Vybrat

Cbnovit Standardni OK Zrusit

Obréazek 168: Dialogové okno Styl buriky — karta Pozadi

Karta ochrana bunék
Ochrana

» Skryt vSe — skryva vzorce a obsah vybranych bunék.

» Zamknuto — chrani vybrané burky pfed jejich zménou. Tato ochrana buriky se projevi
pouze, pokud méate také chranény list.

» Skryt vzorec — skryva vzorce ve vybranych bunkach.

Tisk

» Skryt pfi tisku — chrani vybrané bunky pfed vytisknutim.
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Styl buriky: Bez nazvu2 X

Organizéitor Cisla Pismo Efekty pro pismo Zarovnani Asijska typografie Ohraniceni Pozadi O'

Ochrana
[ Skryt vie Uzamceni buriky se uplatni, pouze je-li aktivni
Ml Zamknuto uzamceni pfisluiného listu.

[ Skryt vzorec  Vyberte polozku ‘Uzamknout list’ z nabidky ‘Nastroje”.
Tisk
[ Skryt pri tisku ~ Vybrané buriky budou pii tisku vynechény.

Napovéda Cbnovit Standardni Zrusit

Obrazek 169: Dialogové okno Styl buriky — karta Ochrana buriky

Obnoveni atributd stylu bunék
Tlagitka ve spodni ¢asti dialogového okna Stylu bunky maji nasledujici funkce:

* Obnovit — vrati hodnoty, které byly na aktualni karté zménény od otevieni dialogového
okna.

* Standardni — u stylu, ktery zdédi nastaveni z nadfazeného stylu, aktualizuje nastaveni
na aktualni karté tak, aby odpovidalo nastaveni nadfazeného stylu.

*  Zrusit — zruSi vSechny provedené zmeény (na vSech kartach v dialogovém okné) od
posledniho uloZeni tohoto dialogového okna (kliknutim na OK).

* OK - uklada vSechny vytvorené zmény (na vSechny zalozky v dialogovém okné).

Atributy stylu stanek
Nasleduijici atributy jsou k dispozici na kartach dialogového okna Styl stranky (obrazek 170).

Karta Organizator

Tato karta je podobna karté Organizator v dialogové okné Styl bunky, styly stranek vSak
nemohou zdédit nastaveni z jinych styld.

* Nazev — zobrazuje jméno vybraného stylu. Pokud vytvofime nebo zménime vlastni styl,
mlZeme zadat nebo zménit jméno tohoto stylu. NemUlZeme zménit nazev
preddefinovaného stylu.

+ Kategorie — zobrazuje kategorii aktualniho stylu. Pokud vytvarfime nebo ménime novy
styl, vybereme ze seznamu Vlastni styly. NemUzeme zménit kategorii pro
preddefinovany styl.

* Obsahuje — popisuje formatovani pouzité ve stylu.

Karta stranka

MUGzZeme definovat rozloZeni stranky pro jednostrankové nebo vicestrankové tabulky, stejné jako
Cislovani stranek a formaty papiru.

« Format papiru — vybereme ze seznamu preddefinovanych formatd papiru, nebo
definujeme vlastni format papiru.

— Format — vybereme preddefinovanou velikost papiru, nebo vytvofime vlastni format
zadanim rozmérd papiru do poli Vyska a Sitka.
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Sitka — zobrazuje itku vybraného formatu papiru. Ke specifikaci vlastniho
(uzivatelského) formatu zadame Sifku zde.

VySka — zobrazuje vysku vybraného formatu papiru. K definovani vilastniho
(uzivatelského) forméatu zvolime vySku zde.

Orientace:
— Na vySku — zobrazuje a tiskne tabulku s papirem orientovanym svisle.

— Na Sitku — zobrazuje a tiskne tabulku s papirem orientovanym vodorovné.

Smér textu — vybereme smér textu, ktery chceme pouzit v naSem dokumentu. Pfi
sméru "zprava doleva (svisle)" se vSechno nastaveni vzhledu otoci doprava o 90
stupnll kromé zahlavi a zapati. Tato moznost je dostupna pouze tehdy, kdyz je
vybrana volba Komplexni rozvrzeni textu v nabidce Nastroje > Moznosti >
Jazykova nastaveni > Jazyky.

Pole nahledu — zobrazuje nahled aktualniho vybéru.

Zasobnik papiru — vybereme zdroj papiru pro nasi tiskarnu. Rzné zasobniky papiru
mUzZeme pfifadit jinym styllm stranek. MGzeme napfiklad pfifadit jiny zasobnik pro
styl prvni stranky v tabulce a nacist zadsobnik s hlaviCkovym papirem.

» Okraje — specifikuji prostor mezi okraji papiru a obsahem tabulky.

Levy/vnitini — prostor mezi levym okrajem stranky a seSitem. Pouzivame-li rozlozeni
stranky Zrcadlit, pracujeme s prostorem mezi vnitfnim okrajem papiru a sesitem.
Pokud budeme stranky dérovat nebo svazovat, budeme mozné chtit mit okraj Sirsi.

Pravy/VnéjSi — prostor mezi pravym okrajem papiru a tabulkou. Pouzivame-li
rozloZeni Zrcadlit, pracujeme s prostorem mezi vnéjSim okrajem papiru a seSitem.

Horni — pracujeme s prostorem mezi hornim okrajem papiru a seSitem.
Dolni — pracujeme s prostorem mezi dolnim okrajem papiru a seSitem.

* Nastaveni rozvrzeni — vybereme styl rozvrzeni stranky, ktery chceme pouzit na sesit.

RozvrZeni stranky:

— Prava a leva — obé liché (pravé) a sudé (levé) stranky maji stejné okraje na vSech
étyfech stranach.

— Zrcadleni — liché a sudé stranky s vnitfnimi a vnéjSimi okraji podle specifikace.
Pouzijeme rozlozeni, pokud chceme svazané stranky tisknout jako knihu. Zadame
mezeru vazby jako Vnitrni okraj.

— Pouze pravé — aktualni styl strAnky zobrazuje pouze liché (pravé) stranky. Sudé
stranky jsou zobrazeny jako prazdné stranky.

— Pouze levé — aktudlni styl stranky zobrazuje pouze sudé (levé) stranky. Liché
stranky jsou zobrazeny jako prazdné stranky.

Cisla stranek — vybereme format Cislovani stranek, ktery chceme pouZzit jako styl
stranky. Typicky to bude 1,2,3 nebo a,b,c nebo i,ii,iii.

Zarovnani tabulky:
— Vodorovné — vystiedi burnky vodorovné na tisténou stranku.

— Svislé — vystfedi buriky svisle na tiSténou stranku.
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Styl stranky: Test stylu stranky

Organizator Stranka Ohraniceni Pozadi Zahlavi Zapati List
Format papiru
Format: : o e
Sitka: 21,00 cm =
Vyika: 29,70 cm =
Orientace: ® Na vyiku
) Na 5itku Zasobnik papiru: |[Z nastaveni tiskarny] |~ |
Okraje MNastaveni rozvrzeni
Vlevo: 2,00 cm = RozvrZeni stranek: |Pravé i levé ~ |
Vpravo:  200ecm = Cisla stranek: |1J 2,3 . ~ |
Nahore: 2,00 cm 2 Zarovnani tabulky: [ vodorovné
Dole: 2,00 cm = [ svislé
MNapovéda Obnovit OK Zrusit

Obrézek 170: Dialogové okno Styl stranky - karta Stréanka

Karty Ohraniceni a pozadi

Karty OhraniCeni a Pozadi v dialogovém okné Styl stranky jsou podobné kartam v dialogovém
okné Styl bunky. Informace o nastaveni ohranieni a pozadi pro styly stranek nalezneme v ,Karta
okraje" a ,Karta pozadi" v ¢asti ,Atributy stylli bunék". Styly stranky mohou mit rastrové pozadi,
které neni dostupné pro styly buriky.

Karty Zahlavi a Zapati

Pridava do stylu stranky zahlavi a zapati. Zahlavi je mistem na hornim okraji stranky, kde
mUlzeme pridat text nebo grafiku. Zapati je podobné misto vespod okraje stranky. Vice informaci
najdeme v Kapitole 6, Tisk, export, odesilani e-mailem a podepisovani.

Karta listu
Specifikuje elementy, které maji byt zahrnuty k tisku vSech listd se stylem stranky. Dale mdzeme

> v,

nastavit poradi tisku, Cislo prvni stranky a méfitko stranky. Vice informaci najdeme v Kapitole 6,
Tisk, export, odesilani e-mailem a podepisovani.

Sprava stylu

Uprava stylt
1) Prejdeme na kartu Styly na postranni listé a klikneme na ikonu pro typ stylu, ktery
chceme zménit.

2) Klepneme pravym tlaCitkem mySi na nazev stylu a z mistni nabidky vybereme Upravit,
abychom otevreli bud' dialogové okno Styl buriky (obrazek 161) nebo dialogové okno Styl
stranky (obrazek 170).

3) Provedeme dllezité zmény ve stylu atribut(l. DalSi informace o atributech stylu viz
LJAtributy styl( bunék” na strané 217 a ,Atributy stylu stanek” na strané 226.

4) Klepnutim na tlacitko OK uloZime zmény a zavieme dialogové okno.
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Poznamka

Prikaz Upravit neni k dispozici, pokud je jeden nebo vice listli chranéno, i kdyZ je
styl buriky, ktery se ma zménit, pouzivan v nechranéném listu.

PFejmenovani styli
MU{Zeme prejmenovat viastni styly, ale ne styly dodavané s programem Calc.

1) Prejdeme na panel Styly na postranni li5té (obrazek 157) a klikneme na ikonu typu stylu,
ktery chceme pfejmenovat.

2) Klepneme pravym tlaCitkem mysSi na styl, které chceme prejmenovat, a z mistni nabidky
zvolime Upravit, abychom otevieli bud dialogové okno Styl buriky nebo dialogové okno
Styl stranky.

3) Na karté Organizator pfejmenujeme styl a klepneme na OK.

Mazani styll

MU{Zeme odstranit vlastni styl, ale ne styl dodavany s programem Calc. Vlastni styly buriky
mohou byt smazany pouze tehdy, pokud nejsou pouzity. Jestlize je pouZzity styl stranky smazan,
vSem listlm, u kterych byl styl pouzit, se nastavi Viychozi styl stranky.

1) PFejdeme na kartu Styly na postranni liSté (obrazek 157) a klikneme na ikonu s typem
stylu, ktery chceme odstranit.

2) Klikneme pravym tlaCitkem na styl, ktery chceme odstranit a vybereme z mistni nabidky
Odstranit.

3) Pokud se zobrazi varovna zprava, vybereme Ano.

Skryvani a zobrazovani stylil bunék

MUGzZeme zkréatit seznam styl( bunék skrytim nékterych z nich. Skryt mdiZzeme pouze styly, které
v tabulce nepouzivame.

1) Prejdeme na kartu Styly na postranni listé a klikneme na ikonu Styly bunék.

2) Klepneme pravym tla€itkem na nepouzivany styl buniky a z mistni nabidky vybereme
Skryt. Styl je pak pfemistén do kategorie Skrytych stylii na karté styly.

Zobrazeni skrytych styl( bunék:
1) Na postranni listé pfejdeme na kartu Styly.
2) Klikneme na rozeviraci nabidku v horni ¢asti panelu a vybereme Skryté styly z nabidky.

3) Pro vraceni stylu klepneme pravym tlacitkem mySi na skryty styl, ktery chceme zobrazit,
a z mistni nabidky vybereme Zobrazit.

Filtrovani seznamu styl{
MUGzeme filtrovat seznam styld nasledujicim zplsobem:

1) Na postranni listé pfejdeme na kartu Styly.
2) Klikneme na rozeviraci seznam v dolni ¢asti panelu.
3) Vybereme kategorii stylll k zobrazeni na karté Styly:
— Hierarchicky — seznam styl( v jejich hierarchickém uspofadani, napfiklad Nadpis 1
a Nadpis 2 pod Nadpis nebo Zvyraznéni 1, Zvyraznéni 2, Zvyraznéni 3 pod
Zvyraznéni.
— VSechny styly — seznam styll, které jsou dostupné v aplikaci Calc a v seSitech,
s vyjimkou skrytych styl(, v abecednim poradi.
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— Skryté styly — uvadi vSechny styly, které byly skryty v seSitu.

— Pouzité styly — uvadi pouze styly, které byly pouzity v seSitu. Nelze pouZzit pro styly
stranky.

— Vlastni styly — uvadi pouze uzivatelsky definované styly definované v sesitu.

Co je Sablona? Proc€ ji pouzivat?

Sablona je model, ktery pouZivame k vytvoreni dalSich dokument(i ve standardnim formatu.
Napriklad miZeme vytvofit Sablonu pro faktury, kterd ma logo nasi firmy a adresu v horni ¢asti
stranky. To znameni, Ze jakékoliv nové tabulky (faktury) vytvofené z této Sablony, budou mit logo
firmy a adresu na prvni strdnce seSitu.

Sablony mohou obsahovat cokoliv, co miZe obsahovat b&Zny dokument, jako je text, grafika,
styly a uZivatelsky specifické nastaveni informaci jako je méfeni jednotek, jazyk, vychozi
tiskarna, nastrojova lista a uzivatelsky upravené menu.

VSechny dokumenty v baliku LibreOffice jsou vytvareny na zakladé Sablon. MiZeme vytvofit
nebo stahnout a instalovat tolik Sablon, kolik si pfejeme. Pokud neur€ime Sablonu, kdyZz
zaCiname pracovat s novou tabulkou, je tato nova tabulka zaloZena na vychozi Sabloné pro
tabulky. Tato Sablona je soucasti aplikace Calc. Tato vychozi Sablona se sklada z Cisté tabulky,
kterou miZzeme prizpdsobit dle svych potfeb a poté, pokud si pfejeme, ji pouzijeme jako zaklad
pro vytvoreni vlastni vychozi Sablony.

Pouzivani Sablon pro vytvareni sesitu

Nova instalace LibreOffice nemusi obsahovat Zadné jiné Sablony tabulek s vyjimkou vychozi
Sablony aplikace Calc. MGzeme vSak vytvorit svou vlastni $ablonu (viz ,Vytvoreni $ablony" na
strané 231) nebo mizeme instalovat Sablony ziskané z jinych zdrojl (viz ,Pridavani Sablon

HEA

ziskanych z jinych zdroju" na strané 233).

Kdyz mame Sablonu tabulky dostupnou, mUZeme z ni vytvorit novy sesit pomoci dialogového
okna Sablony nebo pomoci Uvodni obrazovky LibreOffice.

Vytvoreni tabulky z dialogového okna Sablony
Pouziti Sablony k vytvoreni tabulky:

1) Z hlavni nabidky vybereme Soubor > Novy > Sablony nebo klepneme na malou Sipku
vedle ikony Novy a vybereme Sablony nebo stiskneme Ctrl + Shift + N. Otevie se
dialogové okno Sablony (obrazek 171).

2) Ze seznamu Filtrovat v horni ¢asti dialogového okna Sablony vybereme Sesity
a kategorii Sablony, kterou chceme vyuzit. VSechny Sablony v kategorii jsou pak
vyjmenovany na strance, jak je zobrazeno na obrazku 171.

3) Vybereme poZadovanou Sablonu a klepneme na Otevfit nebo klepneme na vybranou
Sablonu nebo klepneme pravym tlacitkem mysi na pozadovanou Sablonu a z hlavni
nabidky zvolime Otevfit. Otevie se nova tabulka zaloZzena na Sabloné.

Sablonu, na které je tabulka zaloZzena, najdeme v Soubor > Vlastnosti > Obecné. Propojeni
Sablony a seSitu pretrvava, dokud neni Sablona upravena. P¥i pfistim otevieni tabulky zalozené
na této Sabloné mlZzeme zvolit, zda chceme tabulku aktualizovat nebo neaktualizovat tak, aby
odpovidala upravam.
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Sablony

Hledat... Filtrovat |Sesity V| |‘u’§echny kategorie e

Rocnfinvestice Mazev: Rocni investice

Kategorie: Moje sablony

L_.\@e. Presunout Exportovat Ej Importovat

Mapovéda Oteviit Zrusit

Obréazek 171: Dialogové okno Sablony zobrazujici vybranou $ablonu

Vytvoreni seSitu ze Sablony na uivodni obrazovce

Sesit mizeme vytvorit z ukazky Sablon na uvodni obrazovce LibreOffice, jez jsou viditelné, kdyz
neni otevfen jiny dokument. (Viz kapitola 1, Uvod.)

Klikneme na tlagitko Sablony vievo v podokné a ikony jsou zobrazeny na Gvodni obrazovce pro
vSechny dostupné LibreOffice Sablony. Tlacitko také nabizi rozeviraci seznam k vybéru Sablon
daného typu dokumentu. Pokud vybereme ze seznamu moznost Sablony sesitu, dostupné
Sablony tabulky jsou zobrazeny na Uvodni obrazovce. Klikneme na poZzadovanou Sablonu,
abychom vytvofili dokument zaloZzeny na Sabloné.

Vytvoreni Sablony

Sablonu miizeme jednodude vytvofit z jakékoliv tabulky:
1) Otevieme novou nebo existujici tabulku, kterou chceme pouzit jako zaklad Sablony.

2) Pridame potfebny preddefinovany obsah, ktery chceme, aby se zobrazil v tabulce
pokazdé, co pouZzijeme tuto novou Sablonu, napfiklad firemni logo a jméno, informace
o firmé&, Cisla stranek atd. Vymazeme veSkeré informace, které v tabulce nechceme

3) Vytvofime nebo zménime styly bunky a stranky, které chceme v Sabloné pouZit.

4) Z hlavni nabidky vybereme Soubor > Sablony > Ulozit jako $ablonu nebo klepneme na
Sipku dold na pravé strané tlacitka UloZit na standardni nastrojové listé a vybereme
Ulozit jako Sablonu nebo stiskneme Shift + F11. Otevie se dialogové okno Ulozit
Sablonu jako (obrazek 172) zobrazuijici existujici kategorii Sablony a pole s nazvem.

5) NapiSeme jméno nové Sablony a vybereme poZzadovanou kategorii Sablony. Mizeme ji
také nastavit jako vychozi (viz ,Nastaveni vychozi Sablony” na strané 234 ).

6) Klikneme na UloZit a uloZime novou Sablonu.
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UloZit jako Sablonu

Mazev Sablony

Kategorie sablony

Zadna

éMDjE Sablony

Obchodni korespondence
Osobni korespondence a dokumenty
Ostatni obchodni dokumenty

Prezentace
Styly
L] Nastavit jako vychozi
MNapovéda UloZit £rusit

Obrazek 172: Dialogové okno UloZit Sablonu
jako

@ Poznamka

Ackoliv dialogové UloZit Sablonu jako neukazuje typ dokumentu pfi ukladani nové
Sablony jakéhokoli typu, Sablona se po navratu k dialogovému oknu Sablony zobrazi
na spravné karté (v tomto pfipadé sesity).

Neni nutné ukladat soubor seSitu, ktery jsme pouzivali k vytvofeni nové Sablony.
MUzZe se bezpecéné uzaviit bez uloZeni.

@ Poznamka

Sablonu mGZeme také uloZit prostfednictvim dialogového okna UloZit jako, které je
pristupné rliznymi zplsoby vcetné volby Soubor > UloZit jako v hlavni nabidce
nebo stisknutim Ctrl + Shift + S. Vybereme moznost Sablona sesitu ODF v nabidce
Ulozit jako typ.

Uprava Sablony

Styly a obsah Sablony miizeme upravovat. Pokud chceme, midZeme nové styly pouzit na tabulky
vytvorené z plvodni Sablony (podrobnosti viz nize).

Chceme-li Sablonu upravit:

1)  Z hlavni nabidky vybereme Soubor > Sablony > Spravovat Sablony nebo stiskneme
Ctrl + Shift + N, abychom otevreli dialogové okno Sablony.

2)  Prejdeme na Sablonu sesitu, kterou chceme upravit. Pomoci klepnuti pravym tlacitkem
mysSi otevieme mistni nabidku a zvolime Upravit (viz obrazek 173). Sablona se otevie
v programu Calc.
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3) Upravime Sablonu jako bychom upravovali jakoukoliv jinou tabulku. Provedené zmény
uloZzime pomoci volby Soubor > Ulozit v hlavni nabidce nebo pomaoci jiné odpovidajici
akce. Pokud chceme ulozit upravenou Sablonu jako novou Sablonu, zvolime Soubor >
Ulozit jako Sablonu nebo provedeme jinou odpovidajici akci.

Sablony

Hledat... Filtrovat |Sedity ~ | |Moje sablony %

Dteviit

Upravit l}

Obnovit vychozi

Pfejmenovat

Smazat
© [d (4 Presunout [ Exportovat | Importovat
Mapovéda Otevrit Zrusit

Obrézek 173: Dialogové okno Sablony — Upravy Sablon

Aktualizace stylli ze zménéné Sablony

Pokud provedeme néjaké zmeény v Sabloné a jejich stylech, zobrazi se pfi pfistim otevieni seSitu,
ktery byl vytvofena pfed zménou Sablony, potvrzovaci zprava.

1) Klikneme na Aktualizovat styly, abychom aplikovali zménéné styly v Sabloné na seSit.

2) Klikneme na Zachovat staré styly, pokud nechceme aplikovat zménéné styly v Sabloné
na sesit.

Upozornéni

Pokud vybereme Zachovat staré styly, potvrzovaci zprava se pfi pfistim otevieni
tabulky pomoci stejné zménéné Sablony znovu nezobrazi. Pfestoze je stale Sablona
zobrazena pod Soubor > Vlastnosti > Obecné, tabulka jiZ neni propojena se
Sablonou, takZe se jiz neaktualizuje. Styly miiZzeme stale importovat manualné

z Sablony, ale ke znovupropojeni tabulky k Sabloné ji budeme muset zkopirovat do
prazdného dokumentu zaloZzeného na Sabloné.

Pridavani Sablon ziskanych z jinych zdroju

Do oficialniho Ulozisté Sablon LibreOffice se miZzeme dostat pouzitim tlacitka Prochazet
Sablony online v levé spodni ¢asti dialogového okna Sablony, jak je zobrazeno na obrazku 174
nebo zadanim https://extensions.libreoffice.org/en do adresniho fadku prohlizece..

Na jinych strankach mlizeme najit kolekce Sablon, které byly zabaleny do rozsifenych (.OXT)
souborll. Takové Sablony se instaluji odliSné&, jak je uvedeno dale.
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s} I__,‘a, (2 Pfesunout E'_> Exportovat Dj Importovat

Loy’

i . Prochazet Sablony online " =
Mapovéda Otevfit Lrusit

Obrazek 174: Pridani sablon do LibreOffice

Instalace jednotlivych Sablon

Do své kolekce mizeme importovat a pfidat Sablony nasledujicim zplsobem:
1) Najdeme a stdhneme Sablonu, kterou chceme vyuZit, jak je popsano v predchozi ¢asti.
2) Otevieme dialogové okno Sablony a klikneme na ikonu Importovat vpravo dole.

3) Ve vyskakovacim dialogovém okné vybereme kategorii, kde chceme Sablonu uloZit.
(Mdzeme to pozdéji zménit, jak je popsano v asti ,Presun Sablony” na strance 237.)

4) Prohlize¢ soubor( se otevie. Pfejdeme do umisténi stazené Sablony.

5) Vybereme Sablonu a klikneme Otevfit. Po importu se Sablona zpfistupni v dialogovém
okné Sablony.

6 Tip

Nové Sablony miizeme kopirovat do slozek $ablon také ru¢né. Umisténi zavisi na
operacnim systému pocitace. Abychom ho zjistili, zvolime Nastroje > Moznosti >
LibreOffice > Cesty.

Instalace vice Sablon

Spravce rozsifeni nabizi snadny zplsob instalace sad $ablon, které byly pfipraveny jako
rozSifeni. Postupujeme nasledovné:
1) Stdhneme balik s rozSifenim (soubor .OXT) a uloZime ho nékam do pocitace.

2) V LibreOffice v hlavni nabidce vybereme Nastroje > Spravce rozsifeni nebo stiskneme
Ctrl + Alt + E. V dialogovém okné Spravce rozSifeni klikneme na P¥idat a otevieme okno
prohlizec¢e soubor(.

3) Najdeme a vybereme balik se Sablonami, ktery chceme nainstalovat, a klepneme na
Oteviit. Balik se zacne instalovat. M(Ze se zobrazit vyzva k souhlasu s licenénim
ujednéanim.

4) Po dokonceni instalace baliku restartujeme LibreOffice. Sablony jsou dostupné pomoci
dialogového okna Sablony a rozSifeni je uvedeno v seznamu ve Spravce rozSifeni.

Pro vice informaci o Spravci rozsiteni, viz kapitola 14, Nastaveni a PrizpUsobeni.

6 Tip

Néktera rozSifeni jsou zabalena jako soubory .ZIP.

Nastaveni vychozi Sablony

Pokud vytvofime novou tabulku pomoci Soubor > Novy > SeSit z hlavni nabidky nebo jinou
odpovidajici akci, aplikace Calc vytvofi dokument z vychozi Sablony pro tabulky. Jako vychozi
Sablonu miiZzeme nastavit jakoukoliv Sablonu. Mizeme také obnovit vychozi $ablonu do vychozi
Sablony Calc.
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Nastaveni vlastni Sablony jako vychozi

VétSina vychozich nastaveni, jako jsou velikost stranky a okraje strdnky mohou byt zménény, ale
tyto zmény se normalné aplikuji pouze na tabulku, se kterou zrovna pracujeme. K vytvoreni
téchto vychozich nastaveni tabulek potfebujeme nahradit vychozi Sablonu Calc za novou.

Jakoukoliv $ablonu zobrazenou v dialogovém okné Sablony Ize pro dany typ dokumentu nastavit
jako vychozi:
1) V hlavni nabidce zvolime Soubor > Sablony > Spravovat $ablon nebo stiskneme Ctrl +
Shift + N.

2) V dialogovém okné Sablony otevieme kategorii zahrnuijici $ablonu, kterou chceme
nastavit jako vychozi.

3) Klepneme pravym tlacitkem mysi na Sablonu a zvolime Nastavit jako vychozi (viz
obrazek 173). Sablona je nyni indikovana zelenym zaskrtnutim vievo nahore.

Az pristé vytvofime seSit vybérem Soubor > Novy, klepnutim na ikonu Novy ve Standardni
nastrojové listé nebo stisknutim Ctrl + N, bude vytvoren z této Sablony.

Obnoveni vychozi Sablony

Chceme-li nastavit vychozi Sablonu tabulky zpatky do vychozi Sablony podporované programem
Calc:

1) V dialogovém okné Sablony klepneme na ikonu Nastaveni, kterou najdeme vlevo dole
(obrazek 175).

2) V rozeviraci nabidce klepneme na Obnovit vychozi Sablonu a nasledné klepneme na
Sesit. Zelené zaskrtnuti je odstranéno ze Sablony.

Tato volba se neobjevuje, pokud byla vlastni Sablona nastavena jako vychozi, jak je popsano
v pfedchozi ¢asti.

Mova kategorie
Piejmenovat kategorii
Smazat kategorii

Obnovit
Obnovit vychozi $ablonu » Sesit
1y
0y |_:.! [l Pfesunout E‘_} Exportovat E{j Importovat
Napovéda Otevfit Zrusit

Obréazek 175: Obnoveni vychozi Sablony pro sesity
Nasledujicim zplisobem mliZzeme také obnovit vychozi Sablonu:

1) Jdeme do dialogového okna Sablony a otevieme kategorii obsahujici $ablonu, kterou
jsme nastavili jako vychozi. Je oznacena zelenou znaCkou zaskrtnuti.

2) Pravym tlaCitkem mysi klepneme na tuto Sablonu a z mistni nabidky zvolime Obnovit
vychozi. Pfi pfistim vytvofeni nové tabulky bude vytvofena za pomoci vychozi Sablony
Calc.
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Poznamka

Obnoveni vychozi Sablony zpét na vychozi Sablonu Calc je moZzné pouze tehdy,
pokud byla vychozi zménéna dfive.

Sprava Sablon

LibreOffice mdize spravovat pouze 3ablony, které jsou v jeho slozkach (kategoriich) $ablon, i kdyz
mUZeme vytvorit tabulku z Sablony, ktera neni v zadné z t&chto slozek. MliZeme vytvofit nové
sloZky Sablon a pouZit je k uspofadani svych Sablon a importu Sablon do téchto slozek. Napfriklad
mUzeme mit jednu slozku $ablony na prodejni $ablony a jinou na Sablony faktur. Mizeme také
exportovat Sablony.

6 Tip

Umisténi slozek Sablon v LibreOffice zavisi na operacnim systému pocitaCe. Pokud
chceme zjistit, kde jsou slozky Sablon umistény, jdeme do Nastroje > Moznosti >
LibreOffice > Cesty.

Zacneme vybérem Soubor > éqblony > Spravovat Sablony, nebo stiskneme Ctrl + Shift + N,
aby se otevfelo dialogové okno Sablony.

Vytvoreni kategorie Sablon
1) Klikneme na tla¢itko Nastaveni ve spodni levé ¢asti dialogového okna Sablony.
2) V mistni nabidce klepneme na Nova kategorie (viz obrazek 176).

3) Ve vyskakovacim okné (neni zobrazeno), napiSeme nazev nové kategorie a klikneme na
OK. Nova kategorie se nyni zobrazi v listu kategorii.

() Nova kategorie 1}
Smazat kategorii

Obnovit

Obnovit vychozi 5ablonu »

) L_,ﬂ! (2l Pfesunout [ Exportovat [ Importovat

MNapovéda Otevrit Zrusit

Obrazek 176: Vlytvoreni nové kategorie

Poznamka

Uvnitf kategorie Sablony nelze vytvofit podkategorii.

Smazani kategorie Sablon

Kategorie Sablon dodavané s balikem LibreOffice nelze smazat. Nelze odstranit ani kategorie
pridané Spravcem rozSifeni, pokud nejprve neodebereme rozsifeni, které je vytvofilo.

Avsak mizeme odstranit kategorii, kterou jsme vytvorili:

1) Klepneme na tla¢itko Nastaveni v dialogovém okné& Sablony a z mistni nabidky
vybereme Odstranit kategorii (viz obrazek 176).
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2) V dialogovém okné Odstranit kategorii (neni zobrazeno) vybereme kategorii, kterou
chceme odstranit a klikneme na OK.

3) Odstranéni potvrdime vybérem moznosti Aho v potvrzovacim okné.
4) Pokud neni mozné kategorii odstranit, zobrazi Calc varovnou zpravu.

Pfesun Sablony
Pfesunuti Sablony z jedné kategorie Sablon do jiné:

1) Otevieme dialogové okno a vybereme Sablonu, kterou chceme presunout.

s w7

2) Klepneme na ikonu Pfesunout v dolni ¢asti dialogového okna, z vyskakovaciho
dialogového okna vybereme cilovou kategorii (obrazek 177) a klepneme na OK. Vybrana
Sablona se presune do slozky. MGzeme také vytvorit novou kategorii a $3ablonu do ni
pfesunout.

Vyberte kategorii

Vyberte z existujici kategorie

Moje sablony

Obchodni korespondence

Osobni korespondence a dokumenty
Ostatni obchodni dokumenty
Prezentace

Styly

nebo vytvorte novou kategorii

Mapovéda QK Zrusit

o [a (2 Presunout | Exportovat [/ Importovat
Obrazek 177: Presun Sablon do jiné kategorie

Smazani Sablony

Sablony dodavané s balikem LibreOffice smazat nelze. Nelze smazat ani $ablony vytvofené pii

instalaci rozsifeni, pokud nejprve nesmazeme rozsiteni, které je nainstalovalo. MiZeme odstranit
pouze Sablony, které mame vytvorené nebo importované.

7 oz

1) V rozeviracim seznamu Filtrovat v horni ¢4sti dialogového okna Sablony vybereme
kategorii, obsahujici Sablonu, kterou chceme odstranit.

2) Pravym tlacitkem mySi klepneme na Sablonu, kterou chceme odstranit. Tim otevieme
mistni nabidku a klepneme na Odstranit (obrazek 173).

3) Zobrazi se okno se Zadosti 0 potvrzeni smazani. Klepneme na Ano.
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Poznamka

Pfesunuti nebo odstranéni Sablony nemé Zadny vliv na dokumenty, které byly
vytvofené pomoci této Sablony. Tabulka zachova definice styll, které zdédila

z pfesunuté/odstranéné Sablony. PoloZka Sablona na strance Soubor > Vlastnosti
> Obecné mUze i nadale zobrazovat jméno Sablony, ktera jiz neexistuje.

Exportovani Sablony
Nejjednodussi zplisob, jak poslat Sablonu nékomu jinému, nebo ji uchovat na siti, je exportovat ji:
1) Otevieme dialogové okno Sablony a najdeme Sablonu, kterou chceme exportovat.

2) Vybereme Sablonu a klikneme na ikonu Exportovat.

3) Otevre se dialogové okno Vybrat sloZzku. Pfejdeme na misto, kde chceme exportovat
Sablonu a klikneme na Vybrat sloZku. MZeme Sablonu také prejmenovat.

Poznamka

Exportovani $ablony ji neodstrani z dialogového okna Sablony. Akce umisti kopii
Sablony do uvedeného mista.

212 | Prirucka Calc 7.0



N
| LibreOffice
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Kapitola 5
Pouziti grafiky



Uvod

Aplikace Calc se pouziva k prezentaci a analyze dat a k vytvareni pfedpovédi a predpokladd.
Grafika mlZe proménit prdimérnou tabulku v nezapomenutelny dokument. Aplikace Calc mlze
importovat riizné formaty vektorovych (vykresovych ¢ar) a rastrovych (bitmapovych nebo
fotografickych) soubort. Nejcast&ji pouzivané grafické forméty jsou GIF, JPG a PNG. Uplny
seznam formétd, které mdze Calc importovat, najdeme v napovédeé LibreOffice.

Grafika v Calc je tfi zakladnich typQ:

« Obrazové soubory, véetné fotografii, kreseb a naskenovanych obrazkd.

« Diagramy vytvorené pomoci kreslicich nastroji baliku LibreOffice.

e Grafy vytvofené pomoci nastroje pro tvorbu grafli v LibreOffice; dalsi informace viz
Kapitola 3 — Vytvareni graf(i

PouZziti grafiky v programu Calc je podobné jako v jinych komponentach LibreOffice. Podrobnéjsi
popis nalezneme v pfirucce ZaCiname s LibreOffice nebo pfiru¢ce Draw Guide.

Poznamka

V LibreOffice oba terminy grafika a obrazky odkazuji na objekty obrazku a kresby.
Obrazky slov se Casto pouzivaji pfi odkazovani na obrazky a jiné grafiky, které
nejsou objekty kreshy.

Vkladani obrazkd do sesitu

N e

Obrazky, jako jsou firemni loga a fotografie, jsou pravdépodobné nejcastéjSimi typy grafiky
pridavanymi do seSitu. Mohou byt stazeny z internetu, naskenovany, vytvoreny grafickym
programem, fotografie pofizené digitalnim fotoaparatem nebo klipartem v galerii.

Vkladani souboru s obrazkem

Pokud je obrazek v souboru ulozeném v poéitaci, miiZzeme jej vlozit do tabulky pomoci jedné
Z nasledujicich metod.

PretaZeni
1) Otevieme prohlize¢ soubor( a pfemistime se na obrazek, ktery chceme vloZit.
2) Pretdhneme obrazek do tabulky a pustime tam, kde se ma zobrazit.

Timto zplsobem obrazek do dokumentu skuteéné viozime, tj. uloZzime v ném jeho Kkopii.
Chceme-li namisto obrazku vlozit pouze odkaz, pfi pfetahovani obrazku podrzime klavesy Ctrl +
Shift. Vice informaci viz ,Propojeni nebo vioZeni obrazového souboru” na strance 244.

Dialogové okno VioZit obrazek
1) V sesitu klepneme, kde chceme vlozit obrazek.
2) Z hlavni nabidky vybereme VloZzit > Obrazek.

3) V dialogovém okné VloZit obradzek (obrdzek 178) pfejdeme na soubor, ktery chceme viozit
a vybereme jej.

4) Moznost Odkaz vybereme, pokud potfebujeme vlozit odkaz na soubor na misto viozeni
souboru.

5) Vybereme pozadovanou moznost v nabidce Ukotvit:: K bunce, K bunice (ménit velikost
s bunkou) nebo Ke strance. Dalsi informace o téchto moznostech najdeme v ¢asti
,Ukotveni obrazk(” na strané 252.

6) Klepneme na Otevfit. Obrazek je vioZen do seSitu.
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Q Poznamka

Pokud jsme se rozhodli pro propojeni obrazku, Calc miZe zobrazit potvrzovaci
dialog s moZnostmi pokracovat s odkazem nebo vloZit obrazek. V tomto dialogovém
okné je k dispozici moznost, jak zabranit jeho budoucimu zobrazeni.

VloZit obrazek

DAGRAFIKAYWALLPAPERS v || Servery.. || b
Mista MNazev . |Typ Welikost
1'r Dokumenty i) 0001.jpg Obrazek (jpg) 1,56 MB ~
17 IKONY iul 0002,jpg Obrazek (jpa) 8575 kB
2] 0003.jpg Obrazek (jpg) 1,49 MB
17 LOGA iul 0004.jpg Obrazek (jpg) 1,82 MB
iw 0005,jpg Obrazek (jpg) 1,62 MB
iu) 0006,jpg Obrazek (jpg) 1,57 MB
i) 0007 jpg Obrazek (jpag) 2,18 MB
i) 0008,jpg Obrazek (jpg) 1,95 MB
By 0009.jpg Obrazek (jpa) 1,23 MB
& W = iul 0010jpg Obrazek (jpa) 1,07 MB

Nazev souboru: |0009.jpg ™ | Otevrit |

Typ souboru: |<‘u’§echny obrazky= (bmp;.dxf,.emf,.eps;.gif.jpg;. ~ ‘

Zrusit

Ukotveni: |K burce ~ ‘

MNapoveéda
[ Odkaz MNahled

Obrazek 178: Dialogové okno VloZit obréazek

Propojeni nebo vloZeni obrazového souboru

VloZenim obrazku do tabulky se obrazek stane trvalou soucasti tabulkového souboru. Jakékoliv
zmény vloZzeného obrazku se zobrazi pouze v této tabulce; plivodni obrazek nebude ovlivnén.

Pokud v dialogovém okné Vlozit obrazek vybereme moznost Odkaz nebo béhem pFetahovani
obrazku pouzijeme kombinaci klaves Ctrl + Shift, vytvofi program Calc odkaz na soubor
obsahujici obrazek na misto vloZzeni samotného obrazku. Obrazek je v dokumentu zobrazen;
kdyz je ale dokument uloZen, obsahuje pouze odkaz na soubor s obrazkem, nikoli samotny
obrazek. Dokument a obrazek z(stavaji dvéma samostatnymi soubory a jsou spojeny
dohromady az tehdy, kdyZ dokument znovu otevieme.

Odkazovani na obrdzky méa dvé vyhody a jednu nevyhodu:

« Vyhoda — Soubor s obrazkem miZeme upravovat samostatné. Upraveny obrazek se

objevi pfi pristim otevieni tabulky. To mize znamenat velkou vyhodu, pokud obrazky (my
nebo nékdo dalsi, napfiklad grafik) aktualizujeme.

« Vyhoda — Propojeni mize snizit velikost tabulky pfi uloZeni, protoZze samotny obrazovy
soubor neni zahrnut. Na modernich pocitaCich vSak velikost souboru obvykle neni
problém a Calc dok&ze snadno zpracovat velké soubory.

* Nevyhoda — Pokud dokument odeSleme nékomu jinému nebo jej pfesuneme do jiného
pocitaCe, musime soucasné poslat obrazové soubory a zachovat stejnou strukturu
souborll. MiZeme napfiklad uloZit obrazové soubory do podsloZzky pojmenované
Obrazky uvnitf stejné slozky obsahujici dokument Calc. Kazdy pfijemce seSitu musi
umistit obrazové soubory do podsloZky se stejnym nadzvem, ve stejné pojmenované
sloZce jako mé sesit.
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& Poznamka

Pfi vicenasobném vkladani stejného obrazku do jednoho dokumentu mze byt
tvofeni odkazll uzite¢né. To vSak neni nutné, protoze LibreOffice vlozi do dokumentu
pouze jednu kopii obrazového souboru. Odstranéni jedné nebo vice kopii neovlivni
ostatni kopie stejného souboru.

Vkladani odkazovanych obrazki
Pokud jsme obrazky jednou propoijili, miZzeme je snadno vloZit pozdéji.
1) Otevieme seSit v programu Calc.

2) Pro otevieni dialogového okna Upravit odkazy vybereme Upravy > Odkazy na externi
soubory v hlavni nabidce (obrazek 179). Dialogové okno zobrazuje vSechny propojené
soubory.

Upravit odkazy

Zdrojovy soubor  filey///D:/GRAFIKA/WALLPAPERS/0009.1pa

Prvek:
Typ: Obrazek
Aktualizace: Automaticka Rucni
Napovéda Upravit... Rozpojit odkaz Aktualizovat Zavfit

Obrazek 179: Dialogové okno Upravit odkazy
3) Vybereme soubory, které chceme zménit z propojenych na viozené.

4) Klepneme na Prerusit odkaz a potvrdime, Ze chceme vybrany odkaz odebrat. Soubor se
stane soucasti tabulky.

& Poznamka

Pfevést vloZené obrazky na propojené neni tak snadné. Musime je zménit jeden po
druhém a pfi opétovném vkladani kazdého souboru vybrat moznost Vlozit jako
odkaz.

Vkladani obrazki ze schranky

Pomoci schranky mdZeme kopirovat obrazky do seSitu Calc z jiného dokumentu LibreOffice
nebo z jinych programd. Provedeme to nasledovné:

1) Otevieme zdrojovy a cilovy dokument.

2) Ve zdrojovém dokumentu zkopirujeme obrazek do schranky — pfesné interakce se budou
liSit programu od programu.

3) Klepnutim umistime kurzor do buriky, kde mé& byt obrazek ukotven.
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4) V hlavni nabidce zvolime Upravit > VloZit nebo klepneme na ikonu VloZzit na Standardni
néastrojové listé nebo klepneme pravym tlacitkem mysi a z mistni nabidky vybereme
Vlozit. Nebo stiskneme kombinaci klaves Ctrl + V.

Upozornéni

Pokud je aplikace, ze které byl obrazek zkopirovan, uzaviena pred jeho vliozenim do
cilového souboru, mize ve schrance dojit k jeho ztraté.

Vkladani obrazkd s pouzitim skeneru

Pokud je k pocitaci pfipojen skener, mize LibreOffice oteviit aplikaci pro skenovani a vloZit
naskenovanou poloZzku do dokumentu LibreOffice jako obrazek. Chceme-li zah4jit tento postup,
zvolime Vlozit > Multimédia > Skenovat > Vybrat zdroj. Po vybéru skeneru umistime kurzor na
misto, kde chceme obrazek vlozit, a zvolime VloZzit > Multimédia > Skenovat > Dotaz.

Ackoliv je tento postup rychly a snadny, pravdépodobné pomoci né€j neziskdme kvalitni obrazek
o spravné velikosti. Lepsiho vysledku dosahneme, kdyz obrazek naskenujeme a vycistime
v grafickém programu pred tim, nez je do baliku LibreOffice viozime.

Vkladani obrazki z galerie

Galerie (obrazek 180) umoziiuje pohodIné vytvaret skupiny znovu pouZitelnych objekt, jako jsou
obrazky a zvuky, které poté miZzeme vkladat do dokument(. Galerie je k dispozici ve vSech
komponentach LibreOffice. MZeme pfidat své vlastni obrazky, stejné jako obrazky dodané
balikem LibreOffice. Pro vice informaci viz pfirucka Zaciname s LibreOffice, kapitola 11 —
Obrazky a grafika.
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! Galerie

Nowy motiv vzhledu...

Podnikové procesy (BPMN) ~
Sit

7 Sipky

Tvary

\Wvojovy diagram

Zvuky v
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:
/
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® || & [H]

fx

Obrazek 180: Galerie v postrannim panelu

Vlozeni obrazku z Galerie:

1)

2)
3)
4)
5)

Vybereme motiv vzhledu.
Jednoduchym klepnutim vybereme objekt.
Pretdhneme obrazek do dokumentu.

Alternativné mizeme klepnout pravym tlacitkem mysi na objekt v Galerii a z lokalni
nabidky vybereme Vlozit. V takovém pfipadé bude obrazek umistén do vybranych bunék

o Tip

Jestlize chceme pouzit galerii obrazk( z pfedchozich verzi LibreOffice, prejdeme na
https://extensions.libreoffice.org/ a budeme vyhledavat s filtrem pro tag “Galerie”.

Na postranni listé klepneme na ikonu Galerie nebo zvolime Zobrazit > Galerie v hlavni
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https://extensions.libreoffice.org/

Uprava obrazk

Kdyz vlozime novy obrazek, mozna bude nutné jej upravit tak, aby do dokumentu dobfe zapadl.
Jakékoli zmény provedené v programu Calc nemaji vliv na plvodni obrazek, at uz se jedna
o0 vloZeny nebo propojeny soubor obrazku.

Calc nabizi pro praci s obrazky nékolik nastrojd. Tyto nastroje jsou pro vétsinu operaci
dostacuijici. Pro profesionalni vysledky je vSak obecné lepsi pouZzit Draw, nebo jiny software
uréeny k Gpravé obrazovych soubor( a vysledek pak vloZit do programu Calc.

Nastrojova lista Obrazek

KdyZ vloZzime obrazek nebo vybereme ten, ktery se jiz v seSité nachazi, nahradi nastrojova lista
Obrazek (obrazek 181) nastrojovou listu forméatovani. Pokud se neobjevi, pfejdeme v hlavni
nabidce do Zobrazit > Nastrojova liSta > Obrazek. Nastroje dostupné na nastrojové listé
Obrazek jsou popsany nize.

i-E 150D S DE L Bz-BwPl B 7 vl E <A Rehs H e

Obréazek 181: Nastrojova lista Obrazek

Poznamka

Zmény ve vlastnostech obrazku ovliviiuji pouze zobrazeni a tisk obrazku. Plvodni
obrazovy soubor zlstava nezménén.

* Ukotveni — vybereme mezi ukotvenim obrazku k burice (v€etné nebo beze zmény
velikosti) a na stranku. Viz ,Ukotveni obrazkd“ na strance 252.

« Zarovnani — pokud jsou vybrany dva nebo vice obrazkl, mizeme upravit jejich
vzajemné vodorovné &i svislé zarovnani. Viz ,Zarovnani obrazkd“ na strance 252.

« Sest tla¢itek pro usporadani (umisténi obrazkl v poradi pfekryvani): Pfenést do
popfeni, O jednu vpred, O jednu vzad, Odsunout do pozadi, Na popfredi, Na pozadi.
Viz “Usporadani obrazkd” na strané 252.

« Styl &ary, Sitka &ary, Barva &ary — nastaveni atribut(i ohrani¢eni obrazku.

» Styllvypli oblasti — nastavuje barvu nebo jiné vlastnosti pozadi obsahujiciho obrazek,
nikoliv samotného obrazku. Chceme-li mit zobrazené pozadi, musime nastavit vhodnou
hodnotu prdhlednosti obrazku. Dalsi informace tykajici se Gpravy oblasti viz pfirucka
Draw Guide.

 Stin — nastavi vychozi stinovy efekt okolo obrazku. Chceme-li prizplsobit efekt stinu,
otevieme dialogové okno Oblast (Format > Objekt > Oblast) a vybereme kartu Stin.

* Filtr — otevie panel nastrojl Filtr obrazku. Podrobnosti o obrazovych filtrech viz pfirucka
Draw Guide.

« ReZim obrazku — méni zobrazeni obrazku z barevného (Vychozi) do odstin( Sedé,
¢erné a bilé nebo jako vodoznak. Toto nastaveni ovlivni pouze zobrazeni a tisk obrazku;
plvodni obrazovy soubor z{stava nezménén.

* Ofiznout obrazek — umisti kolem obrazku ofezové Uchyty. PfetaZzenim dUchytu ofizneme
(skryjeme) okraje obrazku.

* Preklopit vodorovné a Preklopit svisle — méni orientaci obrazku.
* OtocCit — umisti kolem obrazku uchyty pro otaceni.

* Pruhlednost — upravuje stupen prihlednosti obrazu mezi 0 % (neprdhledny) a 100 %
(zcela prihledny).

* Barva — otevie panel nastroji Barva (obrazek 182) k Gpravé hodnot ¢ervené barvy,
zelené barvy, modré barvy, jasu, kontrastu a hodnoty gamma.
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Barva hd X
Eo% =
=0% =
=o% =
0% =
©Cox =
1,00 =
Obrazek 182:
Nastrojova
lista Barva

Pouzivani karty Vlastnosti v postranni listé

Neéktera nastaveni na nastrojoveé listé Obrazek jsou k dispozici také na karté Vlastnosti
v postranni listé, kdyzZ je obrazek vybran. Moznosti na karté Vlastnosti obsahuji nastaveni Barvy,
Cary, Priihlednosti a Umisténi a velikosti.

Pridavani textu
Do obrazku nebo objektu kresby mlizeme pfidat text. Pfi pfemistovani obrazku se tento text

bude pohybovat spolu s obrazkem. Dalsi informace o pridavani textu do obrazk( nalezneme
v pfiru€¢ce Draw Guide.

1) Dvoji klepnuti na obrazek. Textovy kurzor blik& ve stfedu obrazku. Nastrojova lista
Formétovani textu se automaticky otevie v horni ¢asti tabulky.

Obrazek 183: Nastrojova lista pro formatovani textu pro obrazky

2) Zadame text a naformatujeme jej pomoci nastrojd na nastrojové listé Formatovani textu.
Vétsina nastroju je stejna jako nastroje pro formatovani textu v burkach.

3) Chceme-li upravit pozici textu, nebo jeho vzhled v obrazku, klepneme pravym tlacitkem
mySi na obrazek (kdyz textovy kurzor blikd) a vybereme z mistni nabidky Text, ¢imzZ se
otevre dialogové okno Text (obrazek 184).

4) Provedeme potfebné zmény a klepnutim na OK zavieme dialog.
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Text Animace textu

Text objektu kresby
[ Sitka podle textu
L] Vyska podle textu
L1 Velikost podle ramce

Vzdalenost k ohraniceni Ukotveni textu
Vlevo: 0,00 cm = 0 O 0
Vpravo: 0,00 cm = i o l
Nahofe: 0,00 cm = l n l
Dole: 0,00 cm *|  [OPIn4 sitka
Napovéda Obnovit OK Zrusit

Obrazek 184: Dialogové okno Text

Umisténi, zména velikosti a usporadani obrazkii

Pomoci mysi

Chceme-li obrazek prfesunout na nové misto v seSitu, klepneme na obrazek a pretdhneme jej na
nové misto. Obrazek bude stale ukotven tak, jak byl plivodné (tj. Do buriky, Do buriky (zména
velikosti pomoci buriky), nebo Na stranku).

Chceme-li zménit velikost obrazku:

1) Klepnutim na obrazek zobrazime Uchyty vybéru.

2) Umistime kurzor na jeden z Gchytd vybéru. Kurzor méni tvar a graficky znazorni smér
zmény velikosti. Rohové uchyty méni velikost Sifky i vySky obrazku soucasné. Horni,
dolni, leva a prava uchytka méni velikost pouze jedné dimenze.

3) Klepnutim a pfetazenim zménime velikost obrazku.

6 Tip

Chceme-li zachovat plvodni proporce obrazku, klepneme a pretdhneme jeden
z rohovych Uchytll. Pokud chceme zmeénit plvodni proporce, pouzijeme Shift +
klepnuti na jeden z rohovych Gchytll a potahneme.

Pouziti dialogového okna Umisténi a velikost

Chceme-li pfesné umistit a zménit velikost obrazku v sesitu, klepneme na obrazek a poté
prejdeme na Format > Objekt > Umisténi a velikost v hlavni nabidce nebo klepneme pravym
tlacitkem mySi na obrazek a vybereme z mistni nabidky moznost Umisténi a velikost.
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Na karté Umisténi a velikost (obrazek 185) dialogového okna Umisténi a velikost mizeme
nastavit tyto hodnoty:

* Umisténi — umisténi vybraného obrazku v sesitu.

v

— Pozice X — vodorovna vzdalenost od zakladniho bodu vybraného v mfizce.
— Pozice Y — svisla vzdalenost od zakladniho bodu vybraného v mfizce.

* Velikost — Sitka a vySka obrazku vzhledem k vybranému zakladnimu bodu.

» Zamknout — Chceme-li zabranit nAhodnému pohybu nebo zmeéné velikosti obrazku,
vybereme prislusnou moznost.

Mérné jednotky pouzité pro soufadnice X/Y a Sifka a vySka obrazku jsou nastaveny pomoci
Nastroje > MoZnosti > LibreOffice Calc > Obecné > Mérna jednotka.

Vychozi umisténi zakladnich bod( pro polohu a velikost je levy horni roh sesitu. Tento zakladni
bod mizZeme doCasné zmeénit, aby se zjednodusilo uréovani polohy nebo kétovani klepnutim na
pozici odpovidajici umisténi zakladniho bodu, ktery chceme pouzit. Tato zména zékladniho bodu
je platna pouze pro jedno pouZiti a zakladni bod je po zavieni dialogové okna Umisténi a velikost
resetovan na standardni polohu levého horniho rohu.

MUlzeme také otoCit nebo naklonit obrazek (pomoci karet Otocit nebo Naklonéni a polomér rohu
na dialogovém okné Umisténi a velikost). Vice informaci najdeme v pfiru¢ce Draw Guide.

Umisténi a velikost

Umisténi a velikost Otoceni Maklonéni a polomér rohu
Umisténi
Pozice X: (9,12 cm = |®
PoziceY: |1,89 cm = |4 ~ i
| |
Zakladni bod:
Velikost
Sitka: 16,70 cm = |#
Vygka: 10,82 cm = |k p i
4 Zachovat pomér | |
o~ L
Zakladni bod:
Zamknout Prizphsobit
L1 Umisténi Sitka podle textu
[ Velikost Vyika podle textu
Mapovéda Obnovit oK Zrusit

Obrazek 185: Dialogové okno Umisténi a velikosti — karta
Umisténi a velikost
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Usporadani obrazkd
Kazdy obrazek, ktery umistime do seSitu, je postupné naskladan na predchozi obrazek, at se
prekryvaji nebo ne. Pomoci prikaz(l usporadat miizeme zménit poradi prekryvani obrazkil. Nelze
zménit poradi prekryvani textu.

1) Vybereme obrazek, ktery chceme zmeénit.

2) V hlavni nabidce pfejdeme na Format > Usporadat nebo klepneme pravym tlagitkem
mysi na obrazek a vybereme z mistni nabidky Uspofadat. \Vybereme jednu z nize
uvedenych moZznosti uspofadani.

3) Pripadné mizeme klepnutim na jednu ze Sesti ikon usporadani na nastrojové listé
Obrazek rychle presunout obrazek nahoru nebo dold v pofadi prekryvani.
Moznosti uspofadani jsou nasleduijici:
* Prenést do popredi — pfesune vybrany obrazek na zacatek pofadi pfekryvani tak, aby
byl pfed jinymi obrazky.

» O jednu vpred — pfesune vybrany obrazek o jednu Uroven vyse, aby byl blize k horni
vrstvé pofadi prekryvani.

« O jednu zpét — pfesune vybrany obrazek o jednu Uroveii doll, aby byl blize ke spodni
vrstvé poradi prekryvani.

* Odsunout do pozadi — pfesune vybrany obrazek na konec poradi prekryvani, aby byl za
ostatnimi obrazky.

* Na popfredi — pfesune vybrany obrazek pred text.

* Na pozadi — pfesune vybrany obrazek za text. Chceme-li vybrat obrazek na pozadi,
abychom jej mohli upravit nebo nahradit, musime pouzit Navigéator. Jiné metody vybéru,
napriklad klepnuti nebo poklepani, nefunguiji.

Ukotveni obrazki
Ukotvime obrazky, aby zUstaly ve své poloze ve vztahu k ostatnim polozkam.

+ Ke strance — ukotvime obrazek na strdnku a umistime jej na konkrétni misto. Po pridani
nebo odstranéni bunék se obrazek nepohybuje; na strance, kde je umistén, zlstane
vZdy na stejné pozici.

« K buiice — ukotveni obrazku k burice, aby se zajistilo, Ze obrazek vzdy zlstane
s obsahem, ke kterému byl plivodné ukotven. Pokud je obrazek ukotven k burice B10
a nad radek 10 je vloZen novy fadek, bude obrazek ukotven k burice B11.

* K bunice (ménit velikost s bunkou) - podobné jako K bunce, kterd zméni velikost
obrazku pfi zméné velikosti buriky, ke které je ukotven.

Chceme-li ukotvit vybrany obrdzek nebo zmeénit typ pouZzitého ukotveni:

* V hlavni nabidce zvolime Forméat > Ukotveni nebo klepneme pravym tlaCitkem mysi na
obrazek a z mistni nabidky vybereme Ukotveni nebo klepneme na ikonu Ukotveni na
nastrojové listé Obrazek.

* V nabidce vybereme Ke strance, K burnice nebo K burnice (ménit velikost s burikou).

Zarovnani obrazki

Pokud mame v sesitu vice nez jeden obrazek, miiZzeme tyto obrazky zarovnat a vytvorit tak
profesionalni vzhled. Existuji tfi moZnosti pro vodorovné zarovnani obrazkd (vlevo, na stred,
vpravo) a tfi pro svislé zarovnani obrazkl (nahofe, uprostied, dole).

1) Vybereme vSechny obrazky, které chceme zarovnat (vybereme jeden a podrzime klavesu
Shift pfi vybéru ostatnich).
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2) V hlavni nabidce zvolime Format > Zarovnat nebo klepneme na Sipku dold vpravo na
ikoné Zarovnat na nastrojové listé Obrazek nebo klepneme pravym tlacitkem na jeden
z obrazkd a z mistni nabidky zvolime Zarovnat.

3) Vybereme jednu z dostupnych moznosti pro zarovnani.

6 Tip

Stiskneme hlavni oblast na ikoné Zarovnat na nastrojové listé Obrazek (vlevo od
Sipky dold) a vybrany obrazek rychle zarovname vlevo.

Seskupovani a oddélovani obrazku
Chceme-li seskupit nékolik obrazk( tak, aby se z nich stal jediny objekt v tabulce:

1) Vybereme obrazky, které chceme seskupit (vybereme jeden a pfi vybéru ostatnich
podrzime Shift).

2) V hlavni nabidce pfejdeme do Format > Seskupit > Seskupit nebo klepneme pravym
tlaCitkem mysi na obrazek a z mistni nabidky vybereme Seskupit.

Pro zru$eni skupiny obrazk:
1) Vybereme skupinu obrazkd, kterou chceme oddélit.

2) V hlavni nabidce pfejdeme do Format > Seskupit > Zrusit skupinu nebo klepneme
pravym tlacitkem mysi na obrazek a z mistni nabidky vybereme Zrusit skupinu.

Chceme-li upravit obrazek ve skupiné:
1) Vybereme skupinu obrazk(, ve které chceme upravit obrazek ve skuping.

2) V hlavni nabidce pfejdeme do Format > Seskupit > Upravit skupinu nebo klepneme
pravym tlaCitkem mysi na obrazek a z mistni nabidky vybereme Upravit skupinu.

3) Vybereme obréazek, ktery chceme zménit a provedeme zmény.

4) V hlavni nabidce pfejdeme do Forméat > Seskupit > Opustit skupinu nebo klepneme
pravym tlacitkem mysSi na obrazek a z mistni nabidky vybereme Opustit skupinu.

PouZiti kreslicich nastroju baliku LibreOffice

Calc, stejné jako vSechny ostatni komponenty LibreOffice, ma fadu nastrojl k vytvareni kreseb,
jako jsou jednoduché diagramy, pouziti obdélnik(, kruznic, ¢ar, textu a dalSich tvarl. MGzeme
seskupit nékolik kreslenych objektl, abychom se uijistili, Ze si udrzuji svou relativni polohu

a pomer, pokud je pfesuneme nebo zménime jejich velikost.

Nastroje kresleni mizeme také pouzit k anotaci fotografii, snimk{ obrazovky nebo jinych ilustraci
vytvorenych jinymi programy, ale toto se nedoporucuje. Pokud potfebujeme vytvofit sloZité
vykresy, doporucuje se pouzit LibreOffice Draw a vlozit kresbu do seSitu. Vice informaci se
nachazi v pfiru€ce Draw Guide.

Nastrojova lisSta Kresba

Chceme-li zacit pouzivat nastroje pro kresleni, pfejdeme na Zobrazit > Nastrojové listy >
Kresba, ¢imZ otevieme nastrojovou liStu Kresba, ktera se zobrazi v jeji vychozi poloze ve spodni
Casti seSitu. Tuto nastrojovou listu mdizeme zménit na plovouci a pfesunout ji na vhodnéjsi misto.

KdyZ se nastrojova lista Kresba otevie, otevie se s vychozi sadou nastrojd, jak je zndzornéno na
obrazku 186. Umisténim ukazatele mySi na nastroj zobrazime text popisujici jeho funkci. lkony

s malymi Sipkami na pravé strané oteviraji palety s nastroji. Chceme-li pfidat nastroje na
nastrojovou liStu Kresba, klepneme pravym tlacitkem mySi do prazdné oblasti na nastrojové listé
a z mistni nabidky vybereme Viditelna tlacitka.
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Obrazek 186: Nastrojova lista Kresba

Chceme-li pouzit kreslici nastroj:

1)

2)

3)

4)

Klepneme na nastroj na nastrojové listé Kresba (obrazek 186). Kurzor mySi se zméni na
kurzor kreslicich nastrojd v podobé kfizku a béZna nastrojova lista Formatovani se zméni
na nastrojovou listu Vlastnosti objektu kresby (obrazek 187).

Pfesuneme kfiZzek na misto v dokumentu, kde chceme, aby se objekt kresby zobrazil,
a poté klepnutim a pretazenim kresbu vytvofime. Uvolnime levé tlaCitko mysi. Vybrana
kreslici funkce zlstava aktivni, miizeme proto nakreslit jiny objekt téhoz typu.

Chceme-li vybranou kreslici funkci zrusit, stiskneme klavesu Esc nebo klepneme na ikonu
Vybrat (Sipka) na nastrojové listé Kresba.

Nyni miZeme zmeénit vlastnosti kresby (barvu vypIné, druh a tloustku ¢ary, ukotveni
apod.), a to bud pomoci nastrojove listy Vlastnosti kresby (187), nebo pomoci voleb
a dialogovych oken pfistupnych po klepnuti pravym tlacitkem na kresbu.

Nastaveni viastnosti objektli kresby
Dalsi informace o vlastnostech objektll kreseb nalezneme v pfiru¢ce Draw Guide.

Pred nakreslenim objektu mizeme nastavit nékteré vychozi vlastnosti pro objekt kresby. Tyto
vychozi vlastnosti se pouZiji pouze na aktualni seSit a pfi zavieni seSitu se nezachovaji.
Vlastnosti se vztahuji pouze na objekty kresby.

1)
2)

Na nastrojové listé Kresba klepneme na Vybrat (obrdzek 186).

Na nastrojové listé Vlastnosti objektu kresby (obrazek 187) nastavime hodnoty, které
chceme pouzit pro kazdou vlastnost. KdyZ vybereme vlastnosti oblasti nebo Cary, oteviou
se dialogova okna, kde miiZeme nastavit hodnoty pouzité pro oblast nebo ¢aru.

——JocomBE [~ [Bava  [v e eo— - = - | [ C

Obréazek 187: Nastrojova lista Vlastnosti objektu kresby - ovladaci prvky dostupné pro
nastaveni vychozich viastnosti

3) Po nakresleni objektu nebo seskupeni s jinym objektem se aktivuji dalSi vlastnosti. Ty se

objevi na nastrojové listé (obrazek 188) a nékteré jsou zobrazeny na karté Vlastnosti na
postranni listé (obrazek 189).

I~ E- 20N BB ~looocmE [Z] *[Barva |~ - = - | [ O I

Obrazek 188: Nastrojova lista Vlastnosti objektu kresby po vioZeni objektu

Nyni mdzeme zménit vlastnosti kresby (barvu vypiné, druh a tloustku ¢ary, ukotveni apod.)
pomoci nastrojové listy Vlastnosti objektu kresby (obrazek 187), karty Vlastnosti na postranni
listé nebo pomoci mistni nabidky po klepnuti pravym tlacitkem mySi na objekt kresby.
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! Vlastnosti
~ QOblast I
Vyplr: |Bar\.ra L ‘
Ay
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Prihlednost: (Zadna v
I 0% = @
~ Zare fX
Polomér: Opt =
Barva: Cemna
Prihlednost: |0 % =
~ Stin =
O Povolit
Uhel:
Vzdalenost: |0 pt =
Barva: Cerna
Prihlednost:

09 :
 Mékky okraj
Polomér. 0 pt =
~ Cara S
Cara: —_—
Sitka: —_—
Barva: =< I ~
Prihlednost; 0% =
> Umisténi a velikost. M

Obréazek 189: Karta Vlastnosti postranni
listy pro objekt kresby

Zména velikosti objektl kresby

Vybereme objekt a klepneme na jeden z Uchytl vybéru a pretdhneme objekt do nové velikosti.
Chceme-li pfi zméné velikost zachovat pomeér stran, vybereme jeden z tchytl na vrcholech,

a kdyz uchyt pretahujeme na nové misto, podrzime klavesu Shift. DalSi informace nalezneme
v Gasti ,Umisténi, zména velikosti a usporadani obrazk(“ na strance 250.

Seskupovani a oddélovani objektl kresba

Informace o seskupovani, zruSeni seskupeni a Upravach seskupenych objektd kreseb
nalezneme v ¢asti ,Seskupovani a oddélovani obrazkl“ na strance 253.
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DalSi nastroje

Neékteré dalsi nastroje jsou k dispozici, kdyz klepneme pravym tla¢itkem mysi na obrazek nebo
objekt kresby a otevieme mistni nabidku.

Popis
K obrazku mizeme pridat metadata ve formé& nazvu a popisu. Tyto informace pouzivaji
nastroje pro usnadnéni pfistupu (napfiklad software pro ¢teni z obrazovky), a pokud
exportujeme dokument do HTML jako atributy ALT (alternativni text).

Nazev
MlZeme pridat vlastni nazev, ktery ma byt pfitazen k obrazku; tim usnadnime nalezeni
obrazku v Navigatoru. Pfifazeni jmen obrazklm je také pomaha identifikovat, kdyz tymy lidi
pracuji na stejném vicestrankovém sesitu.

Otocit nebo preklopit
Obrazek mizeme otodit nebo prevréatit vodorovné nebo svisle.

Pfifadit makro
Otevie dialogové okno Prifadit makro, takze miiZzeme do grafiky pfidat programovatelné
funkce. Calc ma velmi dobrou podporu maker. Dalsi informace nalezneme v kapitole 12 —
Makra.

Upravit hypertextovy odkaz
Hypertextovy odkaz z obrazku na jiné misto mizeme definovat v tabulce, jiném dokumentu
nebo na webové strance. Vybérem Upravit hypertextovy odkaz z mistni nabidky
otevieme dialogové okno Hypertextovy odkaz. DalSi informace o hypertextovych odkazech
nalezneme v kapitole 10 — Propojeni dat.

Komprimovat
Obrazky mizeme komprimovat a zmensit tak velikost tabulky. Vybérem Komprimovat
z mistni nabidky otevieme dialogové okno Komprimovat obrazek, kde mizeme nastavit
moznosti komprese. (MoZnost neni k dispozici pro objekty kresby.)

Upravit externim nastrojem
Obrazek mézeme upravit pomoci externiho nastroje. Dialog, ktery se otevie, bude zaviset
na nastaveni naseho pocitace. (Moznost neni k dispozici pro objekty kresby.)

Pismomalba

Pismomalba umoZziuje vytvaret grafické textové objekty, které dokument Cini atraktivnéjSim.
Mame na vybér z velkého mnozstvi rliznych nastaveni téchto textovych objektl (¢ara, oblast,
umisténi, velikost a dalsi).

Pismomalba je k dispozici v kaZzdé soucasti baliku LibreOffice, nicméné ve zpUsobu, jakymi ji
kazda soucast zobrazuje, jsou drobné rozdily.

Vytvoreni objektl pismomalby

1) Na nastrojové listé Pismomalba (Zobrazit > Nastrojové listy > Pismomalba, viz
obrazek 190) nebo nastrojova lista Kresba (Zobrazit > Nastrojové listy > Kresba
klepneme na ikonu Vlozit text pismomalby.

FI>~Aal = - B¢

Obrazek 190: Nastrojova lista
Pismomalba

2) V Galerii pismomalby (obrazek 191) vybereme styl pismomalby a poté klepneme na OK.
V dokumentu se objevi objekt pismomalby.
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3) Poklepeme na objekt a upravime text pismomalby (obrazek 192). Vybereme text a Cerny
népis Fontwork, ktery se zobrazuje pres objekt, nahradime vlastnim textem.

4) Klepneme kamkoliv na volné misto nebo stiskneme klavesu Esc, abychom zmény uloZili.

Galerie pismomalby

Vyberte styl pismomalby

r_'n.ﬂﬂ‘}p

Stvle - Spow  Siume

blue Sidow Open  Oudine

Napovéda QK Zrusit

Obrazek 191: Galerie pismomalby

o

[m]

Obréazek 192: Uprava textu
pismomalby

Uprava objekt pismomalby

Jakmile je objekt pismomalby vytvoren, mizeme upravit nékteré jeho vlastnosti. Chceme-li to
provést, miiZzeme pouzit nastrojovou litu Pismomalba, nastrojovou listu Formatovani nebo
moznosti nabidky. DalSi informace nalezneme v kapitole 11— Obrazky a grafika, v pfirucce
Zaciname s LibreOffice.
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Tisk

Rychly tisk

Pokud chceme tabulku rychle vytisknout, klepneme na ikonu Vytisknout pfimo na Standardni
nastrojové listé a odeSleme cely seSit na vychozi tiskarnu, kterou mame na pocitaci nastavenu.

Poznamka

Akci provadénou klepnutim na ikonu PFfimy tisk miZzeme také zménit. Na misto
odesilani dokumentu na vychozi tiskarnu naseho pocitace miiZzeme definovat
tiskarnu pro dany dokument. Toto provedeme v nabidce Nastroje > MoZnosti >
Nacist/Ulozit > Obecné a zvolime moZnost S dokumentem nacist nastaveni
tiskarny.

0 Tip

Ve vychozim nastaveni LibreOffice neni ikona Vytisknout pfimo na Standardni
nastrojové listé viditelna. Zobrazeni této ikony miZzeme provést podle pokyn(
uvedenych v Kapitole 14, Nastaveni a pfizplsobeni.

Ovladani tisku

Pro vétsi kontrolu nad tiskem vybereme v hlavni nabidce Soubor > Tisk, stiskneme Ctrl + P
nebo klepneme na ikonu Tisk na Standardni nastrojové li5té a otevieme dialogové okno Tisk
(obrazek 193).

Poznamka

Moznosti vybrané v dialogovém okné Tisk se vztahuji pouze na aktualni tisk tohoto
dokumentu.

Pokud chceme specifikovat vychozi nastaveni tisku pro LibreOffice, pfejdeme do
nabidky Nastroje > MozZnosti > LibreOffice > Tisk a Nastroje > MoZnosti >
LibreOffice Calc > Tisk. Podrobnosti najdeme v Kapitole 14, Nastaveni

a prizptsobeni aplikace Calc.

Dialogové okno Tisk ma vice karet, kde si mlizeme vybrat fadu moznosti, jak je popsano

v nasledujicich ¢astech. V zavislosti na opera¢nim systému naseho pocitate se mize pocet
karet a rozvrzeni jednotlivych karet lisit od ilustraci uvedenych v této kapitole. Na nékterych
instalacich je v dialogovém okné Tisk k dispozici tlacitko Dal$i moZnosti.

Dialogové okno Tisk obsahuje zaSkrtavaci pole Nahled, které zapina a vypina nahled, jak budou
data zobrazena na tiSténé strance. Nahled se zobrazi na levé strané dialogového okna.
Sousedni ovladaci prvky umoZzniuji prochazet strankami dlouhych sesitQ.

Karta Obecné

Na karté Obecné v dialogovém okné Tisk (obrazek 193) si miZzeme vybrat z nasledujicich
moZnosti:

* Tiskarna

— Ze seznamu dostupnych tiskaren vybereme tu, kterou chceme pouzivat.

— Stiskneme tlaCitko Vlastnosti pro zménu pozadovanych nastaveni vybrané tiskarny.
Moznosti dostupné prostfednictvim této volby zavisi na pouzivané tiskarné a systému.

* Rozsah a kopie
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— Vybereme listy a stranky, které chceme vytisknout, jednostranny nebo oboustranny
tisk, pocCet kopii, které chceme vytisknout, zda maji byt kopie sefazeny a poradi
stranek pro tisk. (viz ,Vybér rozsahu tisku” na strané 266.)

* Rozvrzeni stranek

— Vybereme vlastnosti rozvrZeni stranky, napfiklad velikost papiru, orientaci na vySku
nebo na Sifku, kolik stranek se vytiskne na list papiru, pofradi, v jakém jsou stranky
vytistény na list papiru, a zda se kolem kazdé stranky nakresli ohraniceni.

Obecné LibreOffice Calc
Tiskarna
210 mm (A4) St il
Stav: Viychozf tiskama Viastnosti...
Rozsah a kopie
® iechny stranky
O Stranky:
) Sudé stranky
O Liché stranky
= dalsi
E Od které: Vytisknout vybrané listy bl |
,.E_ Mahled je zakazany Strany papiru: Tisknout jednostranné v |
= |
L] T -
Pocet kopif: |1 = | o)
Porfadi: ] Wytisknout v opaéném pofadi
Rozvrieni stranky
Velikost papiru: A4 210mm x 297mm v]
Orientace: Automaticky ~ |
- daldf
Stranek na list: |1 b
Pofadi: Zleva doprava, potom doll e 1
] Nahled NEH 2P [ Nakreslit okraj kolem kaZdé stranky
Napovéda Dalsi moZnosti... oK Lrusit

Obréazek 193: Dialogové okno Tisk — karta Obecné

Karta LibreOffice Calc

Na karté LibreOffice Calc v dialogovém okné Tisk (obrazek 194) mdzeme zvolit, zda potladit
vystup prazdnych stranek pfi tisku sesitu.

Obecné LibreOffice Calc

Stranky:
[ Potlacit vystup prazdnych stranek

Obréazek 194: Dialogové okno Tisk — karta LibreOffice Calc
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Dialogové okno Vice mozZnosti tisku

Stisknutim tlaCitka DalS§i moZnosti otevieme dialogové okno Vice moznosti tisku (obrazek 195).
V tomto dialogovém okné si miizeme vybrat, zda chceme vytvorit samostatné tiskové ulohy pro
sefazeny vystup.

Vice moZnosti tisku

L1 Vytvoiit samostatné tiskové tlohy pro sefazeny vystup

Zrusit

Obréazek 195: Dialogové okno Vice moZnosti tisku

Tisk vice stranek na jeden list papiru
Pro tisk vice stranek tabulky na jeden list papiru postupujeme takto:

5) V hlavni nabidce zvolime Soubor > Tisk, klepneme na ikonu Tisk na Standardni
nastrojové listé, nebo stiskneme Ctrl + P a otevieme dialogové okno Tisk.

6) V sekci RozvrZeni stranek na karté Obecné vybereme z rozeviraciho seznamu Stranek
na list pocet stranek, které se vytisknou na jeden list papiru. Panel nahledu na pravé
strané zobrazi, jak budou stranky vypadat v tiSténém dokumentu.

7) Pritisku vice neZ dvou stranek na list vybereme v poradi, v jakém jsou stranky vytistény
na list z rozeviraciho seznamu Poradi (obrazek 196).

8) Chceme-li rozliSit kazdou stranku na listu, vybereme volbu Nakreslit okraj kolem kazdé
stranky.

9) Klepneme na Tisk.

RozvrzZeni stranky

Velikost papiru: |A4 210mm x 297mm b ‘
Orientace: |Aut0maticky b ‘
=l dalsi
Stranek na list: |9 v[|1T 2 3
4 5 b
Pofad 789

Shora doli, potom vpravo
Shora dolid, potom vievo
Zprava doleva, potom dold

Obrazek 196: Tisk vice neZ jedna stranky sesitu
na list papiru

@ Tip
Chceme-li mit pfistup k dalSim volbam na karté Obecné v dialogovém okné Tisk

budeme moZna muset klepnout na na jednu z voleb dalsi: Pro zjednoduSeni jsou
tato klepnuti zamérné vynechana z popist v této kapitole.
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Vybér rozsahu tisku

Chceme-li vytisknout vSechny listy v dokumentu, vybereme v dialogovém okné Tisk v sekci
Rozsah a kopie na karté Obecné z rozeviraciho seznamu Od které polozku Vytisknout vSechny
listy. Kromé tisku celého seSitu si mizeme pro tisk vybrat i jednotlivé listy, vice listl a vybér
bunék pro tisk.

PTi tisku jednotlivych listl postupujeme takto:

1) V okné programu Calc klepnutim na zalozku vybereme list, ktery chceme vytisknout.

2) V hlavni nabidce zvolime Soubor > Tisk, klepneme na ikonu Tisk na Standardni
nastrojové listé nebo stiskneme Ctrl + P a otevieme dialogové okno Tisk.

3) V dialogovém okné Tisk v sekci Rozsah a kopie na karté Obecné vybereme
z rozeviraciho seznamu Od které polozku Viytisknout vybrané listy.

4) Klepneme na Tisk.
Pro tisk vybéru listd postupujeme takto:

1) V programu Calc vybereme listy,které chceme vytisknout. Podrobnosti o tom, jak vybrat
vice listll, najdeme v kapitole 1, Uvod.

2) V hlavni nabidce zvolime Soubor > Tisk, klepneme na ikonu Tisk na Standardni
néastrojové listé nebo stiskneme Ctrl + P a otevieme dialogové okno Tisk.

3) V dialogovém okné Tisk v sekci Rozsah a kopie na karté Obecné vybereme Vytisknout
vybrané listy z rozeviraciho seznamu Od které.

4) Klepneme na Tisk.
Pro tisk vybranych bunék postupujeme takto:
1) V tabulce vybereme burky, které chceme vytisknout.

2) V hlavni nabidce zvolime Soubor > Tisk, klepneme na ikonu Tisk na Standardni
nastrojové listé nebo stiskneme Ctrl + P a otevieme dialogové okno Tisk.

3) V dialogovém okné Tisk v sekci Rozsah a kopie na karté Obecné vybereme Vytisknout
vybrané bunky z rozeviraciho seznamu Od které.

4) Klepneme na Tisk.

Tisk v odstinech Sedé na barevné tiskarné

MUGZeme chtit vytisknout tabulku v odstinech Sedé na barevné tiskarné. Mzeme to udélat dvéma
zpUsoby.

Poznamka

Neékteré barevné tiskarny mohou tisknout barevné bez ohledu na zvolené nastaveni.

U jednotlivych souborl mizeme zménit nastaveni tiskarny tak, aby se tisklo ¢ernobile nebo ve
stupnich Sedi nasledovné:

1) V hlavni nabidce zvolime Soubor > Tisk, klepneme na ikonu Tisk na Standardni
nastrojové listé nebo stiskneme Ctrl + P a otevieme dialogové okno Tisk.

2) Klepneme na tlagitko Vlastnosti, ¢imz otevieme dialogové okno Vlastnosti tiskarny.
Dostupné moznosti se u jednotlivych tiskaren lisi, méli bychom v3ak najit moznost
nastaveni barev. Vice informaci o tiskarné najdeme v napovédé k tiskarné nebo v jeji
uZivatelské pfirucce.

3) Nastaveni barev by mélo obsahovat moZnost Cerné a bila nebo odstiny Sedi. Vybereme
odstiny Sedé.

4) Stisknutim tlacitka OK nastaveni potvrdime a vratime se do dialogového okna Tisk.
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5) Zde stiskneme tlacitko OK a vytiskneme dokument.
Mlzeme také zménit nastaveni LibreOffice a tisknout jakykoliv barevny text a grafiku v odstinech
Sedé:

1) Zvolime Nastroje > MoZnosti > LibreOffice > Tisk.

2) Zvolime volbu Pfevést barvy na odstiny Sedi. Klepnutim na tlacitko OK uloZime zménu.

Upozornéni

Timto zmeénime nastaveni tisku pro vSechny aplikace LibreOffice, nejen pro Calc.

Nahled stranllist( pred tiskem
Pokud pred tiskem chceme zobrazit nahled listd v programu Calc:

1) V nabidce volime Soubor > Nahled tisku, klikneme na ikonu Pfepnout nahled tisku na
standardni nastrojové listé nebo stiskneme kombinaci klaves Ctrl + Shift + O.

2) Calc nyni namisto nastrojové liSty Formatovani zobrazuje nastrojovou liStu Nahled tisku.

Co Ikl - J +| @
Obréazek 197: Nastrojova lista Nahled tisku

3) Chceme-li v tomto zobrazeni vytisknout dokument, vybereme v hlavni nabidce Soubor >
Tisk, stiskneme Ctrl + P nebo klepneme na ikonu Tisk na Standardni nastrojové listé
a otevieme dialogové okno Tisk.

4) Zvolime poZzadované moZznosti tisku a potom klepneme na tlacitko Tisk.

5) Klepneme znovu na ikonu Pfepnout nahled tisku nebo klepneme na ikonu Zavfit
nahled na pravé strané nastrojové listy Nahled tisku a vratime se zpét do normalniho
zobrazeni sesitu.

Pouziti oblasti tisku

MUGZeme urdit, ktera oblast bunék v tabulce se ma vytisknout nebo exportovat do PDF. Buriky na
listu, které nejsou soucasti definované oblasti tisku, se nevytisknou ani nevyexportuji. Stejné tak
nejsou vytistény ani exportovany zadné listy bez definované oblasti tisku. Chceme-Ili nastavit
uzivatelem definovanou oblast tisku, ktera nahradi existujici definovanou oblast tisku:

Definovani a tisk oblasti tisku
Nastaveni uzivatelem definovaného rozsahu tisku:

1) Vybereme oblast bunék, které maji byt pouZzity v oblasti tisku.

2) V hlavni nabidce zvolime Format > Oblasti tisku > Definovat. Pokud je povoleno
Nastroje > Moznosti > LibreOffice Calc > Zobrazeni > Zalomeni stranky, na
obrazovce se pak zobrazi fadky automatického zalomeni stranky, které definuji buriky,
které jsou zahrnuty v oblasti tisku.

3) Klepneme na ikonu Vytisknout pfimo na Standardni nastrojové listé abychom vytiskli
definovanou oblast tisku nebo otevieme dialogové okno Tisk a klepneme na OK pro tisk
definované oblasti tisku.
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6 Tip

Oblast tisku miiZzeme zkontrolovat pomoci Pfepnout nahled tisku nebo
v dialogovém okné Tisk v ¢asti Nahled. Aplikace Calc zobrazi pouze buriky v oblasti
tisku. Viz ,Zobrazeni oblasti tisku” na strané 269.

Uprava oblasti tisku

Oblast tisku mtiZzeme kdykoliv upravit. Napfiklad pridat nebo odebrat buriky, nebo definovat Fadky
a sloupce, které se maji opakovat (napfiklad zahlavi sloupcl nebo radkd). Dalsi detailu jak

definovat fadky a sloupce, které se maji opakovat, viz ,Zopakovani tisku fadkl a sloupcl” na
strdnce 271.

1) V hlavni nabidce zvolime Format > Oblasti tisku > Upravit a otevieme dialogové okno
Upravit oblasti tisku (obrazek 198).

Upravit oblasti tisku

Oblast tisku

] |

‘— definovana uZivatelem - | | SAS1:SHE210

Opakovat Fadky

] |

‘- definované uZivatelem - | | $1

Opakovat sloupce

e |

- 23dné - v]

Napovéda OK Zrusit

Obrazek 198: Dialogové okno Upravit oblasti tisku

2) Pokud je definovana pouze jedna oblast, pak se po klepnuti kdekoliv v textovém poli
Oblast tisku zvyrazni definovana oblast modrym ohrani¢enim, jak je zndzornéno na

obrazku 199.
A | B

m‘q‘a‘m‘h‘u‘md

9
Obrazek 199: Jedina oblast
tisku oznacena
ohranic¢ovacim rameckem

3) Vice oblasti bunék Ize definovat také oddélenim kazdé oblasti jednou ¢arkou. To lze
provést pomoci klavesnice zadanim ¢arky a odkazl na buriky ve stejném formatu, jak
jsou definovany oblasti tisku v textovém poli Oblasti tisku. Nezapominejme oddélit adresy
bunék pomoci dvojtecky. Nové oblasti bunék Ize pfidat také podrzenim klavesy Ctrl
bé&hem vybéru oblasti bunék pomoci kurzoru.

4) Pokud chceme odstranit oblast tisku, vybereme oblast v textovém poli Oblast tisku
a smazeme ji. Ujistime se, Ze zbyvajici oblasti tisku maji jako oddélova¢ pouze jednu
¢arku a Ze na konci sekvence neni Carka.

5) Klepnutim na OK uloZime nové nastaveni a okno zavieme.
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Zobrazeni oblasti tisku

Po definovani oblasti tisku jsou tyto oblasti formatovani automatickym zalomenim stranky. Pokud
chceme zobrazit konce stranek, prejdeme v hlavni nabidce do Zobrazit > Zalomeni stranky
a otevieme nahled (obrazek 200).

Oblasti tisku jsou standardné vyznaceny modrym rameckem a obsahuiji uprostfed kazdé stranky

svétle Sedé Cislo stranky. Netisknutelna oblast tabulky ma obvykle Sedé pozadi.

Pokud chceme ukoncit nahled konce stranky, pouZijeme v hlavni nabidce volbu Zobrazit >
Normalni.

A | B ! C [ o | E F
1 Datum [*| Hodnota prodeje [*| Kategorie |*| Region [*| famestnanec ||
2 | 18.01.2008 52,052 Golf Zapad Brigitte
3 |29.01.2008 53,491 Golf Jih Brigitte:
4 | 20.02.2008 41,660 Golf Jih Brigitte
5 | 27.02.2008 81146 Golf Zapad Brigitte
f | 27.02.2008 81,790 Golf Wychod Brigitte
7 | 18.03.2008 £3,814 Golf Sever Brigitte
A | 04.04.2008 &4 (45 Golf Zipad Brigitte
g | 18.04.2008 43,060 Golf Zapad Brigitte
10 |28.04 2008 £1.316 Golf Zapad Brigitte
11 5. 0 gitie
12 | 02.08.2008 £2.213 Galf Wychod Brigitte
13 | 03.06.2008 51,818 Golf Vychod Brigitte
14 | 25.01.2008 53,116 Jachting Zapad Brigitte
15 | 27.01.2008 £2,085 Jachting Sever Brigitte
16 | 28.01.2008 5155 Jachling Zapad Brigitte
17 | 27.02.2003 54,433 Jachting Zapad Brigitte
18 | 02.04 2008 $1,355 Jachting Sever Brigitte
19 | 25.04.2008 32 564 Jachting Sever Brigitte
a0 | 12052008 55,007 - acﬁimg Jikb Hrgitie
21 | 15082008 $520 Jachting Saver Brigitta
22 |04.06.2008 82 135 Jachting Wychod Brigitte:
23 |20.06.2008 53617 Jachting Sever Brigitte:
24 | 28.06.2008 $545 Jachting Jih Brigitte
25 | 03.01.2008 4 872 Tenis Wychod Brigitte
26 |02.022008 81,218 Tenis Zapad Brigitte
27 | 11.02.2008 $2,565 Tenis Zapad Brigitte
28 | 28.02 2008 83,145 Tenis Zapad Brigitte
29 | 03.03.2008 §3,085 Tens Sever Brigitte
30 | 07.06.2008 $769 Tenis Zapad Brigitte
21 UG, 7 ENiS ngitte
| 32 |07.01.2008 £3,739 Galf Jih Fritz

Obrazek 200: Nahled zalomeni stranky

Pojmenované oblasti tisku

Kromé definovani obsahu tisku pro kazdou tiskovou tlohu mizeme také definovat oblast bunék,
které se maji opakované pouzivat, aniz bychom museli pokazdé oblast bunék vybirat. To je
uzitec¢né, pokud odliné oblasti velkého seSitu musi byt vytistény pro rlizné sestavy; pro spinéni
této potfeby Ize definovat nékolik pojmenovanych oblasti tisku.

Definovat nazev

Definujte ndzev a oblast nebo vzorec.

Nazewv:

Oblast nebo vzorec:

$'Hermeneqgilda - celkovy prodej'.$A%$2:5D%8 =
Rozsah platnosti;
Dokument (globalni) s

MoZnosti oblasti

Napovéda Pridat Zrusit

Obrazek 201: Dialogové okno Definovat nazev
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Definovani a pojmenovani
1) Vybereme buriky, které chceme pojmenovat jako oblast tisku. Potom v hlavni nabidce
zvolime List > Pojmenované oblasti a vyrazy > Definovat a otevieme dialogové okno
Definovat nazev (obrazek 201). VVybrané buriky jsou zobrazeny v poli Oblast nebo vzorec.

Pripadné otevifeme dialogové okno Definovat nazev a pak vybereme buniky, které
chceme pojmenovat jako pojmenovanou oblast. Vybrané burky jsou pak zobrazeny v poli
Oblast nebo vzorec.

2) Do pole Nazev napiSeme nazev oblasti. V ndzvu pouzivame pouze pismena, Cisla
a podtrzitka; nejsou povoleny zadné mezery, spojovniky ani jiné znaky.

3) Pokud je to potfeba, miZzeme upravit nebo nastavit oblast vybranych bunék pro oblast
tisku v poli Oblast nebo vzorec. Vice informaci najdeme v ¢asti ,Uprava oblasti tisku” na
strané 268.

4) Uijistime se, Ze v rozeviracim seznamu Rozsah platnosti je vybrana hodnota Dokument
(globélni).

5) Pro oznaCeni oblasti jako tiskove, zvolime Oblast tisku v Casti MoZnosti oblasti.
6) Klepnutim na tlacitko PFfidat potvrdime svou volbu a zavieme dialogové okno.

Tisk pojmenované oblasti
Pokud chceme vybrat pojmenovanou oblast pro tisk, postupujeme takto:

1) V hlavni nabidce zvolime Format > Oblasti tisku > Upravit a otevieme dialogové okno
Upravit oblasti tisku (obrazek 202).

2) Zrozeviraciho seznamu Oblast tisku vybereme definovanou a pojmenovanou oblast
tisku.

3) Klepnutim na OK okno zavieme.

4) Otevieme dialogové okno Tisk, které v Casti nahledu zobrazi pouze pojmenovanou
oblast. Klepneme na Tisk.

Upravit oblasti tisku

Oblast tisku

= |

éTe.st_pc:jmenc:vané_c:bla.sti_ti.sk SAS167:5DS178
- 7adna -

- cely list -

- definovana uZivatelem -
- vybér -
Test_pojmenované_oblasti_tisku

] |

- 7adné - & =

Napovéda QK Zrusit

Obrazek 202: Vybér pojmenované oblasti pro tisk

Odstranéni pojmenované oblasti tisku
Pokud jiZ neni pojmenovana tiskovéa oblast dale potfeba a chceme ji odstranit, postupujeme
takto:
1) V hlavni nabidce zvolime List > Pojmenované oblasti a vyrazy > Spravovat nebo
zmackneme Ctrl + F3, C¢imz otevieme dialogové okno Spravovat nadzvy (obrazek 203).

2) Vybereme pojmenovanou oblast tisku, kterou chceme odstranit, a v ¢asti MoZnosti oblasti
zkontrolujeme, Ze se jedna o oblast tisku.
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3) Klepneme na tlacitko Smazat a poté klepneme na tlacitko OK, ¢imz dialogové okno
zavieme.

Spravovat nazvy

‘Oblast nebo vzorec Rozsah

Nazew:
Test_pojmenované_oblasti_tisku
Oblast nebo vzorec,

$'Lulu-celkové prodeje’ $A$167:3D5178

= |

Rozsah platnosti:

Dokument (globalni) w

MoZnosti oblasti

Pridat Smazat

MNapovéda QK Zrusit

Obréazek 203: Dialogové okno Spravovat nazvy

Odstranéni oblasti tisku

Odstranit definovanou oblast tisku mdze byt potfeba, napfiklad pokud je nutné pozdéji vytisknout
cely list nebo jiz nechceme nékteré pfidané oblasti tisknout.

V hlavni nabidce zvolime Format > Oblasti tisku > Vymazat a tim odstranime vSechny
definované tiskové oblasti v seSité, kromé pojmenovanych tiskovych oblasti. Po odstranéni
rozsahu tisku se na obrazovce zobrazi vychozi ¢ary preruSeni stranky pro zvolenou velikost
papiru (za pfedpokladu, Ze je povoleno Nastroje > MozZnosti > LibreOffice Calc > Zobrazeni >
Zalomeni stranky).

Jak odstranit pojmenovanou oblast tisku najdeme vySe v ¢asti ,Odstranéni pojmenované oblasti
tisku”.
Zopakovani tisku fadkul a sloupct

Pokud je tabulka tiSt&na na vice stranek, midzeme definovat konkrétni fadky nebo sloupce
(napfiklad zahlavi), aby se opakovaneé tiskly na kazdou stranku.

238 | Prirucka Calc 7.0



Pou?ziti oblasti tisku

1)

2)

3)

4)

Upravit oblasti tisku

Oblast tisku

a

‘- definovana ufivatelem - ~ | $AS1:SES157

Opakovat fadlky

)

‘— definované ufivatelem - |~ | $1

Opakovat sloupce

‘— definované uZivatelem - ~ | SASE El

Napovéda QK Zrusit

Obrazek 204: Opakovany tisk radks a sloupct

V hlavni nabidce zvolime Format > Oblasti tisku > Upravit a otevieme dialogové okno
Upravit oblasti tisku (obrazek 204).

V poli Opakovat radky zadame adresy rfadka, které chceme tisknout opakované.
Napriklad pro opakovani fadkd 1, 2 a 3 zadame $1:$3. Timto se automaticky zméni
hodnota rozeviraciho seznamu Opakovat radky z - Zadné - na - definované uZivatelem -.

MUdZeme také umistit kurzor do pole Opakovat rfadky a potom pomoci mysi vybrat buriky
v kazdém z Fadkd, které chceme opakované tisknout. Neni nutné vybirat cely radek.

V poli Opakovat sloupce zadame adresy sloupcl, které chceme tisknout opakované.
Pokud chceme napfiklad opakovat sloupec A, zadame $A. Timto se automaticky zméni
hodnota rozeviraciho seznamu Opakovat sloupce z - Zadné - na - definované uZivatelem

MUGzeme také umistit kurzor do pole Opakovat sloupce a potom pomoci mysi vybrat
buriky v kazdém ze sloupcl, které chceme opakované tisknout.

Klepnutim na OK ulozime nové nastaveni a okno zavieme.

PouZiti pojmenované oblasti tisku
Pojmenované oblasti tisku mdzeme definovat pro opakovany tisk fadkd nebo sloupct takto:

1)

2)
3)
4)
5)

6)

Definujeme a pojmenujeme fadky a/nebo sloupce, které chceme pfi tisku opakovat. Viz
»Pojmenované oblasti tisku“ na strance 269 pro vice informaci. Podobné jako

u uzivatelem definovanych oblasti tisku staci vybrat jednu buriku z Fadku nebo sloupce,
ktery chceme opakované tisknout.

Pro definovani sloupct a/nebo radkd pro opakovany tisk v dialogovém okné Definovat
nazev vybereme Opakovat sloupec a/nebo Opakovat fadek v MoZnosti oblasti
(obrazek 201 na strance 269).

Klepnutim na tlaCitko PFidat potvrdime svou volbu a zavieme dialogové okno.

V hlavni nabidce zvolime Format > Oblasti tisku > Upravit a otevieme dialogové okno
Upravit oblasti tisku (obrazek 204).

Vybereme definované a pojmenované rozsahy tisku z rozeviracich seznamt Opakovat
radky a/nebo Opakovat sloupce.

Klepnutim na OK uloZime nové nastaveni a okno zavieme.

PouZiti oblasti tisku | 239



Zalomeni stranky

PrestoZe definovani oblasti tisku mdze byt uzite¢nym nastrojem, mdze byt nékdy nutné ruéné
upravit konce stranek tak, abychom zajistili, Ze se seSit vytiskne tak, jak chceme. Do seSitu
mdzeme vlozit dva typy zalomeni stranky:

s vz

e Zalomeni fadku - vlozi vodorovné zalomeni stranky nad vybranou buriku v fadku. Pokud
napfiklad vybereme bunku H15, pak se zalomeni fadku vlozi mezi fadky 14 a 15.

* Zalomeni sloupce - vloZi svislé zalomeni stranky vlevo od vybrané buriky ve sloupci.
Pokud napfiklad vybereme buriku H15, pak se zalomeni slupce vlozZi mezi sloupce G
aH.

Kdyz je vloZzeno rucni zalomeni, objevi se na monitoru jako modra ¢ara nebo tu¢na Cara mezi
fadky nebo sloupci. Skute€ny vzhled zavisi na nastaveni naSeho pocitace. Pokud chceme Iépe
vidét ¢ary ru¢niho zalomeni na monitoru, mizeme zménit jejich vzhled. V hlavni nabidce zvolime
Nastroje > MoZnosti > LibreOffice > Barvy aplikaci a pfesuneme se dolll do ¢asti Sesit, kde
mlZeme zménit zobrazeni zalomeni stranky.

VloZeni zalomeni stranky

1) Vybereme bunku, do které chceme vlozit rucni zalomeni.
2) V hlavni nabidce zvolime List > VloZit zalomeni stranky.

3) Pro vilozeni zalomeni fadku nad vybranou bufiku zvolime Zalomeni fadku. Pro vioZeni
zalomeni sloupce vlevo od vybrané buriky zvolime Zalomeni sloupce.

V hlavni nabidce pfejdeme na volbu Zobrazit > Zalomeni stranky. Vybereme burku, kde
chceme vlozit ruéni zalomeni, klepneme pravym tlacitkem v seSitu a vybereme z mistni nabidky

moznost Zalomeni fadku nebo Zalomeni sloupce. Nezapomerime pomoci volby Zobrazit >
Normalni v hlavni nabidce zménit zobrazeni seSitu na standardni.

Odstranéni koncl stranky

1) Vybereme buriku, ve které chceme odstranit ru¢ni zalomeni ze seSitu.
2) V hlavni nabidce zvolime List > Smazat zalomeni stranky.

3) Pro odstranéni zalomeni fadku nad vybranou burikou zvolime Zalomeni Fadku. Pro
odstranéni zalomeni sloupce vlevo od vybrané buriky zvolime Zalomeni sloupce.

Poznamka

7 vz

Volby Zalomeni sloupce nebo Zalomeni fadku jsou zaSedlIé v pfipadé, Ze nebyla
vybrana odpovidajici burika, vpravo od zalomeni sloupce nebo pod zalomenim
fadku.

Odstranéni vice zalomeni stranek

Ve stejné tabulce mlZe existovat vice ru¢nich zalomeni fadkl a sloupct. Pokud chceme
z tabulky odstranit vSechna zalomeni:

1) PFejdeme v hlavni nabidce na volbu Zobrazit > Zalomeni stranky.

2) Klepneme pravym tlaCitkem mysi v seSitu a vybereme Smazat zalomeni stranek
z mistni nabidky a tim odebereme v8echny ru¢ni zalomeni stranky ze seSitu.

3) V hlavni nabidce zvolime Zobrazit > Normalni a vratime se ke standardnimu zobrazeni
tabulky.
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MoZnosti tisku styll stranky

P¥i pouziti styl( stranek pro tabulky mdzeme do stylu stranky zahrnout moznosti tisk.. Napfiklad
poradi stranek, podrobnosti, méfitko pro tisk atd. Pouziti styld stranek umoZziiuje rychle nastavit
a zménit moznosti tisku rdznych listd v sesitu. Dalsi informace o stylech stranek nalezneme

v kapitole 4, Pouzivani styl( a Sablon.

Styl stréanky: Vychozi

QOrganizator Stranka Chrani¢enl Pozadi Zahlavi Zapati List
Uspofadani stranky
® Shora dold, potom vpravo
() Zleva doprava, potom dold
Cislo prvni stranky: 1 =
Tisk
L] Zahlavi sloupch a fadkd Grafy
LI Miizka Objekty kresby
L] Komentare []Vzorce
Objekty/obrazky Nulové hodnoty
Meéritko
Re7im nastaveni méfitka: |Upravit méfitko tisku ~
Méfitko: 100% =
MNapovéda Obnovit QoK Lrusit

Obréazek 205: Dialogové okno Styl stranky — karta List

Pfed nastavenim moznosti tisku se ujistime, Ze jsme v tabulce vybrali spravny list. V hlavni
nabidce zvolime Format > Stranka a otevieme dialogové okno Styl stranky. Potom klepneme na

kartu List (obradzek 205) a nastavime moznosti tisku stranky. Dialogové okno oznacuje, jaky styl
stranky se chystame zmeénit.

@ Tip
Dialogové okno Styl stranky mizeme také otevfit v postranni listé na karté Styly

klepnutim na odpovidajici styl stranky a vybérem polozky Upravit z mistni nabidky.
DalSi moznost je poklepat na nazev stylu stranky ve stavovém fadku.

* Poradi stranky - definuje poradi, ve kterém jsou data v listu o€islovana a vytisténa,
pokud se nevejdou na jednu vytisténou stranku. Nahled poradi stranek je zobrazen na
obrazku v pravém hornim rohu dialogového okna na obrazku 205.

— Shora doli, potom vpravo - tiskne se svisle od levého sloupce ke spodni ¢asti listu.

— Zleva doprava, potom dolt — tiskne se vodorovné od horniho fadku do pravého
sloupce.
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— Cislo prvni stranky — tuto moznost zvolime, pokud chceme, aby prvni stranka méla
jiné Cislo nez 1. Do pole zadame Cislo prvni stranky.

» Tisk - definujeme, které prvky tabulky maji byt vytistény.
— Zahlavi sloupci a Fadkd — tiskne zahlavi sloupc a radka.

Yoy N

— M¥iZzka — vytiskne hranice jednotlivych bunék jako mfizku. Pro zobrazeni na
obrazovce provedeme vybér v LibreOffice > MoZnosti > LibreOffice Calc >
Zobrazit > M¥izky.

— Komentare — vytiskne komentare definované v seSitu. Komentafe budou vytiStény na
samostatné strance spolu s odpovidajicim odkazem na buriku.

— Objekty/Obrazky — zahrnuje do tisku tabulky vSechny vloZené objekty (pokud jsou
tisknutelné) a grafiku.

— Grafy — vytiskne grafy, které byly vioZeny do tabulky.
— Objekty kresby — zahrne do tisku vSechny kreslené objekty.
— Vzorce — vytiskne vzorce obsazené v bunikach namisto vysledk( téchto vzorcu.

— Nulové hodnoty — urCuje, Ze buiky s nulovou hodnotou jsou vytistény s hodnotou
nula (0) v burice.

* Meé¥itko — definuje méfitko stranky pro tiSténou tabulku.

— RezZim nastaveni méfitka — z rozeviraciho seznamu zvolime rezim nastaveni méfitka.
PFisluSné ovladaci prvky pro vybrany rezim nastaveni méfitka se zobrazi pod
rozeviracim seznamem.

vvs N

i) Upravit méFitko tisku — urCuje meéfitko pro vSechny tiSténé stranky. Do pole
zadame faktor zmény méfitka v procentech od 10 % do 400 %. Hodnota mensi
nez 100 % stranky zmensi, vySSi hodnota stranky zvetsi.

i) PFizplsobit oblast tisku vyScelSifce — ur¢uje maximalni pocet stran na Sitku
a na vysku, na které bude kazdy list s aktualnim stylem stranky vytiStén.

Oblasti tisku jsou vZdy upraveny proporcionalng, takze vysledny pocet stranek
mUZe byt mensi, nez je uvedeno. Pokud zrusime jedno z poli, pak nedefinovana
dimenze pouZzije tolik stranek, kolik je potfeba. Jestlize zruSime obé pole, bude
meéfitko 100 %.

iy PFizplsobit oblast tisku poétu stranek — uréuje maximalni pocet stranek, které
se maiji vytisknout pro kazdy list, ktery pouziva stejny styl stranky. Méfitko bude
zmenSeno podle potfeby tak, aby odpovidalo definovanému poctu stranek.

Zahlavi a zapati

Zahlavi a zapati jsou preddefinované Casti textu, které jsou vytistény na horni nebo dolni strané
listu mimo oblast listu. Zahlavi a zapati se nastavuji stejnym zplisobem a na levych a pravych
strankadch mdzeme mit odlidny obsah, ktery pouziva stejny styl stranky.

Nastaveni zahlavi a zapati
Zapnuti zahlavi nebo zapati na strance:
1) Vybereme list, kde chceme zapnout zahlavi nebo zapati.
2) Otevieme dialogové okno Styl stranky pomoci jedné z nasledujicich metod:
— V hlavni nabidce zvolime Format > Stranka.

— V postranni li5té na karté Styly klepneme pravym tlacitkem na odpovidajici styl
a vybereme z mistni nabidky Upravit.
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3)

4)
5)

6)

— Poklepeme na nazev stylu stranky ve stavovém radku.

Vybereme kartu Zahlavi nebo Zapati (obrazek 206). Karty Zahlavi a Zapati v dialogovém
okné Styl stranky jsou identické.

Zaskrtneme Zahlavi zapnuto nebo Zapati zapnuto.

Zadame hodnoty dalSich moZznosti dle nasich pozadavkd. Tyto moznosti jsou popsany
nize.

Klepnutim na OK uloZime nové nastaveni a okno zavieme.

Styl stranky: Vychozi

Organizator Stranka Ohraniéeni Pozadi Zahlavi Zapati List
Zahlavi
Zahlavi zapnuto
Stejny obsah na levych a pravych strankach

Levy okraj: 0,00 cm = e
Pravy okraj: 0,00 cm =
Mezery: 0,25 cm =
Vyska: 0,50 cm =

Automaticka Uprava vysky

Vice... Upravit...

Napovéda Obnovit OK Zrusit

Obrazek 206: Dialogové okno Styl stranky — karta Zahlavi

Zahlavi zapnuto nebo Zapati zapnuto — do aktualniho stylu stranky pfida zahlavi nebo
zapati.

Stejny obsah na levych a pravych strankach — tato volba zp(sobi, Ze levé a pravé
stranky budou mit stejny obsah zahlavi nebo zapati. Pokud chceme levym a pravym
strdnkam pfifadit jiné zahlavi nebo zapati, zruSime vybér této moznosti a poté klepneme
na tla€itko Upravit. Pro vice informaci viz ,Obsah zahlavi a zapati“ na strance 277.

Levy okraj — zadame velikost mezery, ktera se ma ponechat mezi levym okrajem stranky
a levym okrajem zahlavi nebo zapati.

Pravy okraj — zadame velikost mezery, kter4 se ma ponechat mezi pravym okrajem
stranky a pravym okrajem zahlavi nebo zapati.

Mezery — zadame velikost mezery, ktera se ma udrZzovat mezi spodnim okrajem
zahlavim a hornim okrajem sesitu.

Vyska — zadame vysku zahlavi nebo zapati.

Automaticka uprava vysky — automaticky upravi vySku zahlavi nebo zapati podle
obsahu.

Pole nahledu - je zobrazeno na pravé strané obrazku 206, tato oblast zobrazuje nahled
aktualniho vybéru.

Vice — otevie dialogové okno Ohranieni/Pozadi, kde mizeme definovat zobrazeni
ohrani¢eni a barev pozadi nebo obrazk( pro zahlavi nebo zapati. Vice informaci
najdeme v Kapitole 4, Pouzivani styl( a Sablon.
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Upravit — otevie dialogové okno Zahlavi nebo Zapati, kde mdzeme pfidat upravit nebo
formatovat text, ktery je umistény v zahlavi nebo zapati. Vice informaci viz ¢ast ,Obsah
zahlavi a zapati" dale.

Obsah zahlavi a zapati

Zahlavi a zapati v tabulce aplikace Calc ma tfi sloupce pro text. Kazdy sloupec mdze byt prazdny
nebo mdze mit jiny obsah neZ ostatni sloupce.

1)
2)

3)

4)

5)

6)

7
8)

9)

Vybereme list, kde chceme zapnout zahlavi nebo zapati.

Otevieme dialogové okno Styl stranky (obradzek 206), vybereme kartu Zahlavi zapnuto
nebo Zapati zapnuto a nastavime moznosti pro zahlavi nebo zapati. Viz ¢ast ,Nastaveni
zahlavi a zapati" vyse.

Klepneme na tlacitko Upravit a otevieme dialogové okno Zahlavi nebo Zapati (obrazek
207). Pokud je v dialogovém okné Styl stranky zruSeno zaskrtnuti volby Stejny obsah na
levych a pravych strankach, bude dialogové okno Zahlavi nebo Zapati obsahovat dvé
karty, které si vybereme, zda chceme nastavit zahlavi nebo zapati pro pravé nebo levé
stranky.

Pokud chceme do zahlavi nebo zapati zadat standardni obsah, vybereme nékterou
Z moznosti rozeviraciho seznamu Zahlavi nebo Zapati.

Chceme-li zadat pfizplsobeny obsah do zahlavi nebo zapati, klepneme do jednoho z poli
a zadame text nebo klepneme do jednoho z poli a klepneme na jednu z ikon Vlastni
zahlavi nebo Vlastni zapati. Tyto ikony jsou vysvétleny déle.

Pokud chceme zmeénit vzhled textu v zahlavi nebo zapati, klepneme na ikonu Atributy
textu a otevieme dialogové okno Atributy textu, kde miizeme nastavit pismo, efekty pro
pismo a umisténi pisma.

Klepnutim na tladitko OK uloZzime zmény atributll textu a zavieme dialogové okno
Atributy textu.

Klepnutim na tlacitko OK uloZime zmény v obsahu zahlavi nebo zapati a zavieme
dialogové okno Zahlavi nebo Zapati.

Klepnutim na tlacitko OK ulozime zmény v zahlavi nebo zapati a zavieme dialogové
okno Styl stranky.
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Zahlavi (Styl stranky: Viychozi)

Vlevo Uprostied Vpravo
Listl
Zahlavi List1 ~|
Vlastni zahlavi =~ B |G| B C
Poznamka
PouZijte tlacitka ke zméné pisma nebo vloZeni poli jako je datum, ¢as apod.

Obréazek 207: Dialogové okno Zahlavi
Moznosti dostupné v fadku Viastni zahlavi nebo Viastni zapati jsou nasledujici:
+ Atributy textu — otevie dialogové okno Atributy textu, kde najdeme volby pro

formatovani nového nebo vybraného textu. Dialogové okno Atributy textu obsahuje karty
pro Pismo, Efekty pisma a Pozice.

» Titulek — vlozi do vybrané oblasti zastupné znaky pro nazev souboru. Klepneme
a z otevieného rozeviraciho seznamu zvolime Titulek, Nazev souboru nebo Cesta
a nazev souboru. Pokud tabulce nebyl pfifazen nazev, bude misto néj vlozen nazev
souboru sesitu.

* Nazev listu — vloZi do vybrané oblasti zastupné znaky pro nazev listu vybraného listu
Vv sesitu.

» Stranka — vloZi do vybrané oblasti zastupné znaky pro &islo stranky. Toto umoZnuje
nepretrzité Cislovani stranek v tabulce.

* Stranky - vlozi do vybrané oblasti zastupné znaky pro celkovy pocet stranek v seSitu.

» Datum - vloZi zastupny symbol do vybrané oblasti pro aktuélni datum, které se bude
opakovat v zahlavi/zapati na kazdé strance seSitu.

+ Cas - vlozi zastupny symbol do vybrané oblasti pro aktudlni ¢as, ktery se bude opakovat
v zahlavi/zapati na kazdé strance sesitu.

Export do PDF

Aplikace Calc mlze exportovat dokumenty do PDF (Portable Document Format). Tento
standardni souborovy forméat je idealni pro odeslani souboru pro prohlizeni pomoci prohlizece
Adobe Reader nebo jinych prohlize¢d PDF.

Upozornéni

Dokument ve formatu PDF neni ve vychozim nastaveni chranén pfed neopravnénym
zasahem nebo Upravou obsahu. Obsah dokumentu PDF Ize upravovat pomoci
specialnich softwarovych nastrojd véetné LibreOffice Draw.
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0 Tip

Na rozdil od volby Ulozit jako vytvofi pfikaz Exportovat kopii aktualniho dokumentu
v podobé nového souboru s vybranym formatem, ale ponech& aktualni dokument
a format otevieny.

Rychly export do PDF

Klepnutim na ikonu Pfimy export do PDF na Standardni nastrojové listé exportujeme celou
tabulku do PDF s pouZzitim nastaveni, které bylo naposledy vybrano v dialogovém okné MoZnosti
PDF (viz niZze). Budeme vyzvani k zadani jména souboru a vybéru umisténi pro PDF, ale
nemame moznost vybrat rozsah stranek, kompresi obrazk( nebo dalsi moznosti.

Nastaveni obsahu a kvality PDF

Pokud chceme vlastnosti exportovaného PDF dokumentu ovlivnit, zvolime Soubor > Exportovat
jako PDF. Tim se otevie dialogové okno MoZnosti PDF. Toto dialogové okno ma Sest karet
(Obecné, Vychozi zobrazeni, UZivatelské rozhrani, Odkazy, Zabezpeceni a Elektronické
podpisy). Vybereme pfislusna nastaveni a klepneme na tlac¢itko Exportovat. Poté zadame
umisténi a nazev PDF souboru, ktery chceme vytvorit, a klepneme na tlacitko Ulozit. Tim
provedeme export do souboru.

6 Tip

Dialogové okno mozZnosti PDF mizeme také oteviit v hlavni nabidce Soubor >
Exportovat a nasledné vybérem polozky PDF - Portable Document Format
v rozbalovaci nabidce UloZit jako typ dokumentu.

Dialogové okno MoZnosti PDF — karta Obecné

Na karté Obecné (obrazek 204) mlzeme vybrat stranky pro export, typ komprese obrazkd
(ovliviiuje kvalitu obrazk( v PDF) a dal$i moZnosti. Pro vice informaci viz pfiru¢ku Zaciname
s LibreOffice nebo Napovédu. Ve vétsiné pripadd budou vychozi hodnoty to, co potiebujeme.
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Moznosti PDF

Obecné Vychozi zobrazeni UZivatelské rozhrani Odkazy Zabezpeéeni Elektronické podpisy

Rozsah Obecné
2 Vie O Hybridni PDF (vloZit soubor ODF)
) Stranky: ] Archivni (PDF/A, I1SO 19005)
® Vyb&r/Vybrané listy PDF/A-2b PDF/A-1b
| Zobrazit PDF po dokonéeni exportu O Tagované PDF (se strukturou dokumentu)
; Vytvofit PDF formul&F
Obrazky
fe s Format odeslani:  |FDF e
) Bezztratova komprese
® Komprese JPEG [ Povolit shodné nazvy poli
Kvalita: 90 % = Struktura

Exportovat zaloZky

[] Komentafe jako poznamky PDF

O] Cely list na jednu stranku

L) Podepsat vodoznakem Exportovat automaticky vioZené prazdné stranky
] PouZit odkazy XObject

<

Zmeniit rozlideni obrazkd 300 DPI

Vodoznak

Napovéda Exportovat Zrusit

Obrazek 208: Dialogové okno MoZnosti PDF — karta Obecné

Cast Rozsah
» VSe: Exportuje cely dokument do PDF.

» Stranky: Chceme-li exportovat rozsah stranek na vybraném listu, pouzijeme format 3-6
(stranky 3 az 6). Pokud chceme exportovat jednotlivé stranky, pouzijeme format 7;9;11
(stranky 7, 9 a 11) nebo kombinaci obou formétd.

* Vybér/Vybrané listy: Exportuje vybrany materiél (list nebo Cast listu).
» Zobrazit PDF po dokonceni exportu: Pokud je tato volba vybrana, otevie se vychozi

rv

prohlize€ PDF a zobrazi nové exportovany PDF soubor.

Cast Obrazky
+ Bezztratova komprese: Obrazky jsou ukladany bez ztraty kvality. Pokud se v souboru
nachazeji fotografie, mdze pouZiti této moznosti vést k velkym soubortim. Tato volba je
doporucena pro jiné druhy obrazkd nebo grafiky.

« Komprese JPEG: UmozZiiuje nastaveni riiznych stupnd kvality v rozsahu od 1 do 100 %.
Nastaveni 90 % je vhodné pro fotografie (mensi velikost souboru, nepatrnd ztrata
kvality).

» ZmensSit rozliSeni obrazku: VVybereme poZzadovanou hodnotu v rozeviracim seznamu.

Nizsi DPI (dots per inch) ma za nasledek nizsi kvalitu obrazka. Vyssi nastaveni DPI
mdZe vyrazné zveétsit velikost exportovaného souboru.

Cast Vodoznak
* Podepsat vodoznakem: Pokud je vybrana tato moznost, na kazdé strance PDF souboru
se objevi prihledné prekryti textem, ktery zadame do textového pole.

Cast Obecné
* Hybridni PDF (vlozit soubor ODF): Toto nastaveni pouZijeme k exportu dokumentu jako
PDF souboru obsahujiciho soubory ve dvou forméatech: PDF a ODF. Takovy soubor se
v PDF prohliZeCich otevfe stejné jako bézny soubor PDF, v LibreOffice vSak bude plné
editovatelny.
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* Archivni (PDFI/A, ISO 19005): PDF/A je standard ISO pro dlouhodobé uchovavani
dokumentd tak, Ze vklada do vysledného souboru vSechny informace nezbytné pro
vérnou reprodukci (jako jsou pisma) a zarover zakazuje dalsi prvky (véetné formulard,
zabezpec€eni a Sifrovani). ZapiSou se i PDF znacky. Také vybereme, kterou verzi normy
pouzit, PDFIA-1b, PDF/A-2b nebo PDF/ A-3b.

* Tagované PDF: Tagované PDF obsahuje dodatec¢né informace o struktufe obsahu
dokumentu. To mGze pomoci zobrazit dokument na zafizenich s odliSnou obrazovkou
a pfi pouZiti hlasového vystupu. Mezi znacky, které se exportuji, patfi obsah,
hypertextové odkazy a Fidici prvky. Tato volba miZze vyznamné zvétsit velikost
dokumentu.

* Vytvofit PDF formularF - Format odeslani: V rozeviraci nabidce vybereme forméat
odesilani formulard v souboru PDF (FDF, PDF, HTML nebo XML).

* Povolit shodné nazvy poli — Pokud je povoleno, Ize stejny nazev pole pouZzit pro vice
poli v generovaném souboru PDF. Po odskrtnuti pole budou pfi exportu vytvoreny
jedine€né nézvy poli.

* Exportovat zalozky: Obecné se v aplikaci Calc nepouZziva.

* Komentare jako poznamky PDF: Exportuje komentafe jako poznamky PDF. Je mozné,
Ze toto neni to, co chcemel!

* Cely list na jednu stranku: Toto nastaveni umoznuje exportovat tabulku aplikace Calc
do PDF tak, Ze se cely list exportuje jako jednéa stranka v souboru PDF. Tato volba neni
ur€ena pro tisk, ale umoZiiuje snadno zobrazit a zkontrolovat cely obsah dokumentu
sesitu ve formatu PDF bez obvyklého roziezavani listli na tisknutelné stranky. Nahledové
stranky budou mit r(izné velikost, stejné jako zdrojové listy.

Poznamka:

Vybér volby Cely list na jednu stranku zpUsobi, Ze aplikace Calc bude ignorovat
dalSi nastaveni v dialogovém okné MozZnosti PDF.

* Exportovat automaticky vioZzené prazdné stranky: V aplikaci Calc neni k dispozici.

* Pouzit odkazy XObject: Odkazy XObject umoznuji jednomu souboru PDF importovat
obsah z jiného PDF souboru. Vice informaci nalezneme v €asti 8.10.4 specifikace PDF,
ISO 32000-2:2017 (https://www.iso.org/standard/63534.html). Pokud nejsme
obeznameni s pouzitim odkazl XObject, ponechame toto policko nezaskrtnuté.

Dialogové okno MoZnosti PDF - karta Vychozi zobrazeni

Na karté Vychozi zobrazeni (obrazek 209) miiZzeme vybrat, jak se soubor PDF ve vychozim
nastaveni otevie v prohlize€i PDF. Jednotlivé moZznosti by mély byt samovysvétlujici.

248 | Prirucka Calc 7.0


https://www.iso.org/standard/63534.html

MozZnosti PDF

Obecné Vychozi zobrazeni UZivatelské rozhrani Odkazy Zabezpefeni Elektronické podpisy

Panely Rozvrzeni stranek

® Pouze stranka ® Vychozi

(0 ZaloFky a stranka ) Jedna stranka

2 Nahledy a stranka ) Souvislé

Oteviit na stréance: |1 2| O Souvislé po dvou
Priblizeni

® Vychozi

) Pfizplsobit oknu

) Pfizplsobit Sifce

() Pfizplsobit viditelné

O Mira pfiblizeni: 100

Napovéda Exportovat Zrusit

Obrazek 209: Dialogové okno MoZnosti PDF — karta Vychozi zobrazeni

Dialogové okno MozZnosti PDF — karta UZivatelské rozhrani

Na karté UZivatelské rozhrani (obrazek 210), miZeme vybrat mozZnosti pro ovladani zplsobu,
jakym prohlize¢ PDF soubor zobrazi. Nékteré z téchto mozZnosti jsou uzitecné, kdyz vytvarime
PDF, které se bude pouZzivat jako prezentace nebo pro zobrazeni v kiosk médu.

MoZnosti PDF

Obecné Vychozi zobrazeni éUiivatelské rozhranl’é Odkazy Zabezpeceni Elektronické podpisy

Nastaveni okna Nastaveni uZivatelského rozhrani
L] Zménit velikost okna podle Gvodni stranky [ Skryt hlavni nabidlku
L Vystredit okno na obrazovce L] Skryt nastrojovou listu
L] Oteviit v refimu na celou obrazovku [ Skryt ovladaci prvky okna

Zobrazit nazev dokumentu

Piechody ZaloZky
PouZit pfechodové efekty ® Viechny urovné zalozek
o Viditelné drovné zaloZelk: |1 =
Napovéda Exportovat Zrudit

Obréazek 210: Dialogové okno MoZnosti PDF — karta UZivatelské rozhrani
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Nastaveni okna

Zmeénit velikost okna podle tvodni stranky: v okné prohlize€e PDF se zobrazi cela
prvni stranka.

Vystredit okno na obrazovce: PDF se zobrazi v okné prohlize€e vycentrované na
obrazovce.

Otev¥it v reZimu na celou obrazovku: okno PDF prohlizeCe je zobrazen nad viemi
ostatnimi okny.

Zobrazit nazev dokumentu: PDF se zobrazi s ndzvem dokumentu v zahlavi prohlizece.

Pfechody — v programu Calc se nepouziva.

Nastaveni uzivatelského rozhrani

Skryt hlavni nabidku: skryje v PDF prohliZzeci listu nabidky, kdyZ je dokument aktivni.
Skryt nastrojovou listu: skryje liStu nastrojl prohlizece PDF, kdyzZ je dokument aktivni.

Skryt ovladaci prvky okna: skryje ovladaci prvky okna prohlizeCe, kdyz je dokument
aktivni.

Zalozky

VSechny Grovné zalozek: zobrazuje vSechny Urovné zalozek, kdyz otevieme PDF

v prohlize¢i.

Viditelné urovné zalozek: zobrazuje Urovné zalozek az na vybranou Uroven (v rozsahu
1 az 10), kdyz prohlize¢ otevie PDF.

@;& Poznamka

Zalozky se obecné se v programu Calc nepouzivaji.

Karta Odkazy dialogového okna MoZnosti PDF

Na karté Odkazy (obrazek 211) mdzeme vybrat, jakym zplsobem budou zalozky a hypertextové
odkazy exportovany do PDF.

MoZnosti PDF

Obecné
[] Exportovat zéloZky jako pojmenované cile
[ Pievést odkazy na dokumenty na odkazy na PDF

Exportovat URL relativné k souborovému systému

Odkazy mezi dokumenty
® Vychozi reZim
() Oteviit aplikaci pro éteni PDF

) Oteviit v internetovém prohlizeéi

MNapovéda Exportovat Zrusit

Obréazek 211: Dialogové okno MoZnosti PDF — karta Odkazy
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Exportovat zalozky jako pojmenované cile
Pokud jsme v aplikaci Calc definovali nazvy listl, pomoci této moznosti je exportujeme jako
.pojmenované cile", ke kterym se mohou webové stranky a dokumenty PDF pfipaijit.
Obecné se v programu Calc nepouziva.

Pfevést odkazy na dokumenty na odkazy na PDF
Mame-li v dokumentu odkazy na jiné dokumenty s OpenDocument pfiponami
(jako .odt, .ods, a .odp), pfevedou se v exportovaném PDF dokumentu na .pdf.

Exportovat URL relativné k souborovému systému
Jestlize jsme definovali v dokumentu relativni odkazy, tato volba exportuje tyto odkazy do
PDF souboru. Vice informaci najdeme v Napovédé aplikace Calc v kapitole Relativni
odkazy.

Odkazy mezi dokumenty
Definuje, jak se v exportovaném dokumentu chovaji odkazy po klepnuti. Mzeme si vybrat
z téchto alternativ:

— Vychozi rezim: S PDF odkazy je zachazeno tak, jak je to specifikovano v operacnim
systému.

— Oteviit aplikaci pro ¢teni PDF: Stejny program, jako ten, ktery byl pouzit k zobrazeni
dokumentu, bude pouzit i na zobrazeni dokumentu, na ktery se odkazuje.

— Oteviit v internetovém prohlize€i: Na zobrazeni odkazovaného dokumentu se
pouzije vychozi webovy prohlizec.

Karta Zabezpeceni dialogového okna MoZnosti PDF

Kartu Zabezpeceni (obrazek 212) pouZzijeme k zaSifrovani a nastaveni hesla pfi exportovani
seSitu a vytvoreni PDF souboru. Nastaveni Sifrovani a hesel také umoZziuje omezit tisk
a moznost provadét v PDF souboru zmény nebo ze souboru kopirovat.

MoZnosti PDF

Obecné Vychozi zobrazeni UZivatelské rozhrani Odkazy Zabezpedeni Elektronické podpisy

Sifrovani souboru a opravnéni Tisk

) Nepovoleno
) Nizké rozliseni (150 dpi)

Heslo pro otevieni nastaveno ® Vysoké rozlizeni
PDF dokument bude zasifrovan

Nastavit hesla. .

Zmény

Heslo pro opravnéni nastaveno
P P ) Nepovoleno

Pristup k PDF dokumentu bude omezen
") Vkladani, mazani a otaceni stranek

) Vyplnovani poli formulare
) Komentare, vypliiovani poli formulaie

i Vse kromé vyjmuti stranek

Obsah
Povolit kopirovani obsahu

Povolit pristup k textu pro zpfistupnéni

MNapovéda Exportovat Lrusit

Obréazek 212: Dialogové okno MoZnosti PDF — karta Zabezpeceni
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Klepneme na tlacitko Nastavit hesla a otevieme dialogové okno Nastavit hesla (obrazek 213),
kde zadame hesla. Mizeme zadat heslo pro otevieni souboru (Nastavit heslo pro otevieni)
a volitelné heslo pro omezeni, co mohou ¢tenafi s PDF souborem délat (Nastavit heslo pro
opravnéni).

¢ Pokud do pole Nastavit heslo pro otevieni zadame heslo, exportovany soubor mizeme
otevfit pouze pomoci tohoto hesla. Po otevieni souboru neni uzivatel nijak omezovan
v tom, co mlze s dokumentem udélat (napfiklad tisk, kopirovani nebo zména).

e Pokud nastavime heslo pro opravnéni, mize PDF soubor oteviit kdokoliv, ale jeho
opravnéni budou omezena. Viz obrazek 212. Po nastaveni hesla pro opravnéni budou
na karté Zabezpeceni dostupné dalSi volby.

* Pfi souCasném zadani hesel pro otevieni a nastaveni opravnéni Ize PDF soubor otevfit
pouze po zadani spravného hesla, pficemz opravnéni mohou byt omezena.

Moznosti na karté Zabezpeceni bude dostupné pouze tehdy, kdyz zadame hesla.

Poznamka

Nastaveni opravnéni jsou G¢inna pouze tehdy, pokud je respektuje uZivatellv PDF

prohlizec.
Nastavit hesla X

MNastavit heslo pro otevieni

Heslo:
Potvrzent:

Mastavit heslo pro opravnéni
Heslo:

Potvrzeni:

Napovéda Zrusit

Obréazek 213: Dialogové okno
Nastavit hesla

Karta Elektronické podpisy v dialogovém okné MozZnosti PDF

Karta Elektronické podpisy obsahuje moZznosti souvisejici s exportem digitalné podepsaného
PDF.

Elektronické podpisy slouZi k potvrzeni autorstvi PDF dokumentl a faktu, Ze dokument nebyl po
podpisu zménén.

Podepsany export PDF pouZziva kliCe a certifikaty X.509, uloZené v naSem vychozim aloZzisti

v PC nebo na Cipové karté (tokenu). Pouzité Ulozisté Ize vybrat v nabidce Nastroje > MoZnosti >
LibreOffice > Zabezpec€eni > Cesta pro certifikaty. (Neni k dispozici v systémech Microsoft
Windows, kde LibreOffice pfistupuje k UloZisti systémovych certifikatl.) Pfi pouZivani ¢ipové karty
musi byt karta nakonfigurovana pro pouziti v Ulozisti kli¢l. To se provadi béhem instalace
softwaru od dodavatele tokenu. Podrobnosti o pouzivani téchto funkci jsou mimo rozsah této
kapitoly.
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MozZnosti PDF

Obecné Vychozi zobrazenl UZivatelské rozhrani Odkazy Zabezpedeni Elektronickeé podpisy
Certifikat

Pro podepisovani dokumentl PDF pouZit tento certifikat:

Vybrat... Vymazat

Heslo certifikatu:
Umisténi:
Kontaktni informace;

Davod:

Autorita €asowch razitek: |[7adna

Napovéda Exportovat Zrusit

Obrazek 214: Dialogové okno MoZnosti PDF — karta Elektronické podpisy

Pomoci tohoto certifikatu miZeme digitalné podepisovat dokumenty PDF:
Klepnutim na tlacitko Vybrat otevieme dialogové okno Vybrat certifikat, kde jsou
zobrazeny v8echny certifikaty, které se nachazi ve vybraném ulozisti kli¢d. Pokud je
certifikat chranén heslem, budeme vyzvani k jeho zadani. Podobneé tak i v pfipadé, Ze
pouzivame token chranény PIN kédem.

Vybereme certifikat pro elektronicky podpis exportovaného PDF a klepneme na Vybrat.
VSechna dalSi pole na karté Elektronické podpisy se zpfistupni po vybéru certifikatu.

Heslo certifikatu: Zadame heslo pouzité k ochrané soukromého klice pfifazeného
k vybranému certifikatu. Obvykle je to heslo Glozisté certifikat(. Pokud jiz bylo heslo
Ulozisté certifikatl v dialogovém okné Vybrat certifikat zadano, je UloZisté certifikatd
odemc&eno a neni vyZadovano opakované zadani hesla.

Pokud pouzivame Cipovou kartu, zaddme zde jeji PIN. V zavislosti na nastaveni softwaru
Cipové karty mizeme byt pred podpisem opét vyzvani k zadani PIN kddu.

Umisténi, Kontaktni informace, Dlivod: Volitelné zadame dalsi informace

o elektronickém podpisu PDF dokumentu. Informace budou vioZeny do pfislusnych poli
PDF souboru a budou viditelné pfi prohlizeni exportovaného PDF souboru. Kazdé nebo
v8echna tfi pole mohou byt ponechana prazdna.

Autorita ¢asovych razitek: Umoziuje volitelné vybrat adresu URL autority ¢asového
razitka (TSA). Béhem elektronického podpisu bude TSA poZzadana o zaslani
elektronického Casového razitka, které se stane soucasti podpisu. P¥i prohlizeni PDF
mlZeme z tohoto ¢asového razitka zjistit, kdy byl dokument podepsan.

Seznam URL adres autorit TSA se vytvari v nabidce Nastroje > MoZnosti > LibreOffice
> Zabezpeceni > Autority ¢asovych razitek. Pokud neni vybrana Zadna autorita TSA
(vychozi nastaveni), podpis nebude obsahovat Casové razitko, ale pouZije se aktualni
¢as z naSeho pocitace.
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Export do jinych formati

LibreOffice pouziva pojem ,exportovat* pro nékteré souborové operace, které zahrnuji zménu
typu souboru. Pokud chceme pouZit jiny format souboru tabulky (napfiklad Microsoft Excel),
pouzijeme volbu Soubor > Ulozit jako. Pokud chceme z tabulky vytvofit webové stranky,
pouZzijeme volbu Soubor > Exportovat.

Odeslani dokumentu e-mailem

LibreOffice nabizi nékolik zplsobd, jak rychle a snadno odesilat dokumenty jako pfilohu e-mailu
ve forméatu OpenDocument (vychozi formét LibreOffice), v jinych tabulkovych forméatech nebo
jako soubor PDF. Dokument také mdizeme odeslat nékolika pfijemctm. Vice informaci najdeme
v privodci Zaciname s LibreOffice.

Odeslani tabulky e-mailem:

1) V hlavni nabidce zvolime Soubor > Odeslat a vybereme si z nasledujicich mozZnosti.
LibreOffice otevie vychozi e-mailovy program (pokud je nastaveny) se seSitem v pfiloze
ve zvoleném formétu.

— Odeslat dokument e-mailem: seSit je odeslan v aktualnim formatu.
— E-mail jako seSit OpenDocument: sesit je odeslan ve forméatu ODF.
— E-mailem jako Microsoft Excel: seSit je odeslan ve forméatu Excel (.xIsx).

— E-mailem jako PDF: Otevie se dialogové okno MoZnosti PDF. Vybereme parametry,
které se maji pouzit pro soubor PDF. Viz ,Nastaveni obsahu a kvality PDF* na strance
279.
2) V e-mailovém programu zadame pfijemce, pfedmét, télo zpravy a potom zpravu
odeSleme.

Elektronické podepisovani dokumentu

Pokud chceme elektronicky podepsat dokument, potfebujeme osobni podpisovy certifikat.
Osobni kli¢ je uloZen v pocitaci jako kombinace soukromého klice, ktery musi byt utajen,

a verejného klice, ktery pridavame do svych dokumentd, kdyZ je podepisujeme. Certifikéat
ziskdme od certifikaéni autority, coz mdze byt soukroma spolecnost nebo instituce statni nebo
verfejné spravy.

PTi pouziti elektronického podpisu dokumentu se vypocita kontrolni soucet z obsahu dokumentu
a personalniho klice. Tento kontrolni souCet a nas verejny kli¢ se ulozi s dokumentem.

KdyZz nékdo pozdéji otevie dokument na jakémkoliv pocitaci pomoci nékteré z novéjSich verzi
LibreOffice, program znovu spocita kontrolni soucet a porovna jej s ulozenym kontrolnim
souctem. Pokud jsou oba stejné, program signalizuje, Ze vidime plvodni, nezménény dokument.
Navic si miZzeme zobrazit informace o vefejném kli¢i a certifikatu. Verejny kli¢ miiZzeme porovnat
s verejnym klicem, ktery je zvefejnén na webu certifikacni autority.

Kdykoliv nékdo v elektronicky podepsaném dokumentu provede zménu, dojde k poruSeni
elektronického podpisu.

V operacnich systémech Windows se k ovéfeni podpisu pouZzivaji funkce Windows. V systémech
Linux se k ovéfeni podpisu pouZzivaji soubory poskytované programy Mozilla Thunderbird nebo
Firefox. Podrobnéjsi popis, jak ziskat a spravovat certifikat a ovéfit podpis, najdeme v Casti

O elektronickych podpisech v napovédé LibreOffice.
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Pouziti elektronickych podpist

Nasledujici postup je pouze pfikladem toho, jak elektronicky podepsat dokument. Skute¢ny
postup zavisi na nastaveni pocitace a operacnim systému pocitace.

1) Otevieme soubor, ktery chceme elektronicky podepsat.
2) V hlavni nabidce zvolime Soubor > Elektronické podpisy > Elektronické podpisy.

Pokud mame nastaveny LibreOffice tak, aby nas upozornil, kdyZz dokument obsahuje
komentare (viz ,Odstranéni osobnich Gdaji" na strané 290), mliZe se zobrazit okno
s dotazem, zda chceme pokraCovat v podepisovani dokumentu. Pro pokracovani
klepneme na Ano. Klepnutim na Ne ukon&ime proces podepisovani a miizeme
podniknout pfislusné kroky k odstranéni soukromych informaci a restartovani tohoto
postupu.

Pokud jsme dokument od posledni zmény neuloZili, zobrazi se okno s upozornénim.
Klepnutim na tlacitko OK uloZzime zmény. Po ulozeni souboru se otevie dialogové
okno Elektronické podpisy (obrazek 215).

3) Klepnutim na Podepsat dokument otevieme dialogové okno Vybrat certifikat (obrazek
216).

Vybereme certifikat, ktery chceme pouzit, a klepnutim na Podepsat zavieme dialogové
okno Vybrat certifikat.

Pouzity certifikat je zobrazen v dialogovém okné Elektronické podpisy s ikonou vedle jeho
néazvu. Tato ikona indikuje stav elektronického podpisu.

Ikona s Cervenou peceti oznacCuje, Ze dokument byl podepsan a certifikat byl ovéren.
Ikona se Zlutym vystraznym trojuhelnikem prekryvajici ¢ervenou pecet oznacuje, ze
dokument je podepsan, ale Ze certifikat nelze oveéfit.

Ikona se samotnym Zlutym vystraznym trojahelnikem oznacuje neplatny elektronicky
podpis.

4) Klepnutim na Zavf¥it zavieme dialogové okno Elektronické podpisy a soubor elektronicky
podepiSeme.

Ikona ve stavovém fadku indikuje stav dokumentu podepsaného elektronickym podpisem.
Poklepem na ikonu miiZzeme zobrazit certifikat. K dokumentu Ize pfidat i vice neZ jeden podpis.

Poznamka

Pokud po elektronickém podpisu provedeme v dokumentu jakékoliv zmény,
elektronicky podpis se automaticky odstrani. Pro podepsani dokumentu je pak nutné
znovu zopakovat postup vyse.
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Elektronické podpisy

Obsah tohoto dokumentu podepsali:

Podepsal Elektronicke ID vydal Datum Popis

08.07.2020 20:51:26

[Lg Podpisy v tomto dokumentu jsou platné
PouZit podpis odpovidajici AdES, je-li to moZné

Zobrazit certifikat... Podepsat dokument... QOdstranit Spustit spravce certifikatu...

Napovéda Zaviit

Obrazek 215: Dialogové okno Elektronické podpisy

Wybrat certifikat

Vyberte certifikat, ktery chcete pouZit pro podepisovani:

Vydan pro Vydal Typ Platnost do Poufiti certifikatu
X509 13.04.2030 Elektronicky podpis, Nepop

< >

Zobrazit certifikat...

Popis:

MNapovéda Podepsat Lrusit

Obrazek 216: Dialogové okno Vybrat certifikat

vicenasobné podepisovani jednim podpisem

V minulosti LibreOffice zakazoval vytvareni dokument( s vicenasobnym podpisem stejného
autora, protoze nebyl diivod podepisovat stejny dokument vicekrat. LibreOffice nyni umoziiuje
vloZit popis podpisu, takze je nyni povoleno vice podpisl od stejného autora v jednom
dokumentu. Kazdy podpis miZe mit jiny vyznam.

Pokud vybereme Soubor > Elektronické podpisy > Elektronické podpisy, je v dialogovém
okné (obrazek 215) uveden seznam existujicich podpist spolu s jejich popisem (pokud existuje).

Kdyz klepneme na tlaCitko Podepsat dokument, dialogové okno (obrdzek 216) pro vybér
certifikatu nyni vyzZaduje i volitelny popis.
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Zmeéna hodnoty existujiciho popisu zrusi platnost podpisu.

Elektronicky podepsana makra

Obvykle jsou makra soucasti dokumentu. Pokud podepiSeme dokument, jsou makra uvnitf
dokumentu podepsana automaticky. Pokud chceme podepsat pouze makra, ale nikoliv cely
dokument, zvolime v hlavni nabidce volbu Nastroje > Makra > Elektronicky podpis.

Odstranéni osobnich tdaji

Nékdy mdze byt vhodné odstranit osobni tidaje, verze, poznamky, skryté informace nebo
zaznamenané zmeény ze soubor( dfive, nez je nékomu poSleme nebo z nich vytvofime PDF.

« V nabidce Nastroje > MoZnosti > LibreOffice > Zabezpeceni > MoZnosti miZeme
nastavit program Calc tak, aby nam pfipomneél, kdy soubory obsahuiji ur€ité informace
a aby automaticky odstranil osobni Udaje pfi uloZeni.

* Pokud chceme odstranit osobni a nékteré dalSi Udaje ze souboru, pfejdeme na Soubor >
Vlastnosti. Na karté Obecné zruSime vybér Pouzit uzivatelské udaje a pak klepneme
na Obnovit vlastnosti. Timto se odstrani vSechna jména ve vytvofenych a upravenych
polich, odstrani se data zmény a tisku a resetuje se Celkovy ¢as Uprav na nulu, datum
vytvoreni na aktualni datum a ¢as a Cislo revize se nastavi na 1.

* Pokud chceme odebrat informace o verzi, pfejdeme v hlavni nabidce na Soubor >
Verze, vybereme verzi ze seznamu a klepneme na Smazat nebo pouzijeme volbu
Soubor > UloZit jako a uloZime soubor s jinym jménem.
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j LibreOffice

Prlivodce programem Calc

Kapitola 7
Pouziti vzorcl a funkci



Uvod

V predchozich kapitolach jsme do kazdé burky zadavali jeden ze dvou zakladnich typ( dat: ¢isla
a text. Nebudeme vSak vzdy védét, jaky by mél byt obsah. Obsah jedné buriky Casto zavisi na
obsahu ostatnich bunék. K feSeni této situace pouzivame tfeti typ dat: vzorec. Vzorce jsou
vyrazy, jejichz vysledek je vypocitan pomoci Cisel a proménnych. V seSitu jsou proménné
umisténi bunék, kterd obsahuji data potfebna pro dokonc&eni rovnice.

Funkce je pfeddefinovany vypocet vioZeny do burky, umoZziujici analyzovat Ci zpracovavat data.
Jediné, co musime udélat, je zadat argumenty funkce a vypocet se provede automaticky. Funkce
pomahaiji pfi vytvareni vzorcl, pomoci kterych ziskame pozadovany vysledek.

Nastaveni seSitu

Pokud v programu Calc nastavujeme vice nez jednoduchy systém jednoho listu, vyplati se trochu
dopfedu planovat. Nezapomeneme:

« Vyvarujeme se zadavani pevnych hodnot do vzorcd.

» Zahrneme dokumentaci (poznamky a komentéare) popisujici, co systém déla, vCetné
toho, jaky vstup je vyZzadovan a odkud pochézeji vzorce (pokud nebyly vytvoreny od

nuly).
« Zahrneme systém kontroly chyb vzorcd a ovéfime, zda vzorce délaji to, co je zamysleno.

Problém pevnych hodnot

Mnoho uZivatel(l nastavuje dlouhé a sloZité vzorce s pevnymi hodnotami zadanymi pfimo do
vzorce.

Napfiklad pfevod z jedné mény na druhou vyZaduje znalost aktuélniho konverzniho kurzu. Pokud
do burnky C1 zadame vzorec =0,75*B (napfiklad pro vypocet hodnoty v eurech z ¢astky USD
dolaru v burice B1), budeme muset vzorec upravit, kdyZz se sménny kurz zméni z 0,75 na jinou
hodnotu. Je mnohem snazSi nastavit vstupni buniku se sménnym kurzem a odkazem na burku

v jakémkoli vzorci, ktery potfebuje sménny kurz. Vypocty typu ,co kdyz" jsou také zjednoduSeny:
co kdyz se sménny kurz méni od 0,75 do 0,70 nebo 0,807 Neni nutna Zadna Uprava vzorcl a je
jasné, jaky kurz se pouZziva ve vypoctech. Rozdé&leni komplexnich vzorc( na lépe zvladnutelné

Casti, coz je popsano nize, také pomaha minimalizovat chyby a pomaha pfi feSeni problémd.

Nedostatek dokumentace

Nedostatek dokumentace je velmi ¢astym bodem selhani. Mnoho uzivatel( vytvori jednoduchy
Ucel a metodika Casto nejasna a obtizné rozlustitelna. V tomto pfipadé je obvykle snazsi zacit
znovu od zacatku a zahodit dfive provedenou préaci. Pokud do bunék vloZzime komentare

a pouzijeme Stitky a nadpisy, mliZzeme seSit pozdéji upravit sami nebo nékdo jiny a usetfi se tak
mnoho Casu a usili.

Vzorce pro kontrolu chyb

Pridani sloupct dat nebo vybé&ru bunék z listu vede ¢asto k chybam zplsobenym vynechanim
bunék, nespravnym uréenim rozsahu nebo dvojim pocitanim bunék. Proto je uziteCné zavést

v sesitech kontroly. Napfiklad nastavime tabulku pro vypodcet sloupcl ¢isel a pomoci SUM
vypocteme soucty jednotlivych sloupcl. Vysledek mizZete zkontrolovat vytvorenim (v netisknutém
sloupci) sady souctd fadkad a jejich celkovym souétem. Obé hodnoty — soucet v Fadcich

a celkovy soucet ve sloupci — musi souhlasit. Pokud tomu tak neni, mame nékde chybu.

MUGzeme dokonce nastavit vzorec pro vypocet rozdilu mezi dvéma soucty a nahlasit chybu
v pfipadé, Ze je vracen nenulovy vysledek (viz obrazek 217).
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Demonstrace kontroly chyb souétd sloupcli A, Ba C
A B C Souéty radkd
i) 0,64 0,02 0,66
I 043 0.23 0,75 1.41
0,91 0,57 0,59 2.07
0,07] 0,07 0,45 0,59
0,37 0,33 0,04 0,74
0,34 0,06 0,98 1,38
0,95 0,34 0,65 1,94
0.93 0,08 0.63 1.64
L 0,61 0,82 0,17 1,6
Souéty sloupci =SUM(BG:B13) 4,26
CELKEM:
CHYBA Il!

Obrazek 217: Kontrola chyb vzorc(

Tvorba vzorcu

Vzorce miZeme zadavat dvéma zplsoby: Jedna moznost je pouzit Priivodce funkci nebo
obdobnou funkci na karté Funkce postranni liSty. Druh&d moZnost je napsat vzorec pfimo do
bunky nebo Vstupniho fadku. Vzorce musi zaCinat symbolem =. Pfi pfimém psani musime zacit
vzorec symbolem =. Pokud v3ak vzorec zaCina + nebo — (napfiklad -2*Al), poté Calc
automaticky prida symbol =. Znak rovnitka = se nepfida, pokud zadavame kladna ¢i zaporna
¢isla (napriklad -2 nebo +3). Jakykoliv jiny znak na zacatku zplsobi, Ze bude vzorec povaZzovan
za text.

Operatory ve vzorcich

Kazda burika v listu mlZe byt pouzita jako nositel dat nebo misto pro vypocet dat. Chceme-li
zadat data, jednoduse piSeme do buriky a pfesuneme se na dalSi buriku nebo stiskneme Enter.
U vzorcli znaménko rovna se znamena, Ze burka bude pouzita pro vypocet. Priklad
matematického vypoctu 15 + 46 je znazornén na obrazku 218.

Zatimco vypocet vlevo pouZival pouze jednu buiiku, ukazka mozZnosti je zobrazena vpravo, kde
jsou data umisténa do bunék a vypocet je provadén pomoci odkazll na buriky. V tomto pfipadé
byly buriky B3 a B4 nositeli dat, s burikou B5, kde byl vypocet proveden. VSimneme si, Ze vzorec
byl zobrazen jako =B3+B4. Znaménko plus znamena4, Ze obsah bunék B3 a B4 se selte

a vysledek je v burice, kde je zapsan vzorec. VSechny vzorce vychazeji z této koncepce. DalSi
zpUsoby pouziti vzorcl jsou uvedeny v tabulce 5.

Tyto odkazy na buriky umoZniuji vzorclim pouZzivat data odkudkoli na zpracovavaném listu nebo
z jakéhokoli jiného listu v otevieném dokumentu. Pokud by byla potfebna data v riznych listech,
odkazovala by se na nazev listu, napfiklad =$Sheet2.B12+$Sheet3.A11.

/ Poznamka

Chceme-li zadat symbol = za jinym G&elem, nez je vytvoreni vzorce, jak je popsano
v této kapitole, zadame pfed znak = apostrof nebo jednoduchou uvozovku. Napfiklad
poloZka '= znamena rdizné véci pro rlizné lidi, Calc povazuje za text vSe po apostrofu
vCetné znaménka =.
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Jednoduchy vypocet v jedné burice Vypocet referenci

A | B | C A | B | C
1 1
2 z
3 =15+46] 3 15
4 4 4R
s ¥ ; —
3 3 [
4 B | C A B | C
1 1
2 Z
3 E1 3 15
5 5 =h3+hd
& &
A B | C
1
z
3 15
4 45
5 B1
b
Obrazek 218: Jednoduchy vypocet
Tabulka 5: BéZné zplisoby pouZiti vzorcl
Vzorec Popis
=A1+10 Zobrazuje obsah burky Al plus 10.
=A1*16% Zobrazuje 16 % obsahu Al.
=A1*A2 Zobrazuje vysledek vynasobeni obsahu Al a A2.
=ROUND(AZ1;1) Zobrazuje obsah buriky Al zaokrouhleny na jedno desetinné
misto.
=EFFECT(5%;12) Vypocita efektivni trok pro 5% rocni nominalni trok s 12
platbami ro¢né.
=B8-SUM(B10:B14) Vypocita B8 minus soucet bunék B10 az B14.
=SUM(B8;SUM(B10:B14)) Vypocita soucet bunék B10 az B14 a pfipoc¢te hodnotu B8.
=SUM(B1:B1048576) Secte vSechna Cisla ve sloupci B.
=AVERAGE(BloodSugar) Zobrazuje prdmér pojmenované oblasti definované pod nazvem

BloodSugar. Je také mozné stanovit oblasti pro zahrnuti jejich
pojmenovanim pomoci List > Pojmenované rozsahy a vyrazy >
Definovat, napfiklad BloodSugar predstavujici rozsah B3:B10.
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Vzorec Popis

=IF(C31>140, “HIGH”", “OK") Logické funkce mohou byt také provadény tak, jak jsou
reprezentovany prikazem IF, ktery ma za nasledek podminénou
odpoved na zakladé dat v identifikované burice. Pokud je obsah
C31 veétsi nez 140, zobrazi se HIGH, jinak se zobrazi OK.

Typy operatorti
V programu Calc miiZzeme pouZit nasledujici typy operator(: aritmetické, srovnavaci, textové
a referencni.

Aritmetické operatory

Operéatory scitani, odcitani, nasobeni a déleni vraceji Ciselné vysledky. Operatory negace
a procenta identifikuji charakteristiku Cisla nalezeného v burice, napriklad -37. Priklad pro
umocnéni ilustruje, jak zadat Cislo, které je samo o sobé nasobeno, napfiklad 23 = 2*2*2.

Tabulka 6: Aritmetické operatory

Operator Nazev Priklad
+ (plus) Scitani =1+1

— (minus) Odcitani =2-1

— (minus) Negace -5

* (hvézdicka) Nasobeni =2*2

/ (lomitko) Déleni =10/5
% (procento) Procento 15%

N (stfiSka) Umocnéni =2"3

Porovnavaci operatory

Srovnavaci operatory se nachazeji ve vzorcich, které pouzivaji funkci IF a vraceji bud pravdivou
nebo faleSnou odpovéd; napfiklad, =IF(B6>G12;127;0) coz, volné pfeloZzeno, znamena, pokud je
obsah buriky B6 vétSi nez obsah buriky G12, pak vratte €islo 127, jinak vratte €islo 0.

Pfimou odpovéd PRAVDA nebo NEPRAVDA Ize ziskat zadanim vzorce jako =B6>B12. Pokud
jsou Cisla nalezena v odkazovanych burnkach pfesné reprezentovana, je vracena odpovéd
PRAVDA, jinak je vracena NEPRAVDA.

Tabulka 7: Porovnavaci operatory

Operator Nazev Priklad
= Rovno Al=B1
> Vétsi nez Al1>B1
< Méné nez Al<B1
>= VétSi nebo rovno Al1>=B1
<= Mensi nebo rovno Al<=B1
<> Nerovnost Al<>B1l
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Pokud burika Al obsahuje €iselnou hodnotu 4 a bufika B1 obsahuje ¢iselnou hodnotu 5, vyse
uvedené priklady by pfinesly vysledky NEPRAVDA, NEPRAVDA, PRAVDA, NEPRAVDA,
PRAVDA a PRAVDA.

Textové operatory

Je bézné, Ze uzivatelé vkladaji text do tabulek. Aby byla zajiSténa variabilita v tom, co a jak se
tento typ dat zobrazuje, Ize text spojit z kust pochazejicich z rliznych mist v tabulce. Obrazek
219 ukazuje priklad.

SUM ~ || fx =C2&" "&B2&" " &D2

AT s [ c[ o[ ¢ NENEEN o |
1
# Cerven 23 2020 =C2&"."&B2&""&D2
3

F2 v fx ¥ or= =&t &B2&T&D2

Al e c o[ c NENCEEN |
1

# Cerven 23 2020 23. Cerven 2020

3

Obréazek 219: Zretézeni textu

V tomto prikladu byly konkrétni ¢asti textu nalezeny ve tfech rliznych burikach. Pro spojeni
téchto segmentll vzorec také obsahuje poZadované mezery a interpunkci uzavienou

v uvozovkach, coz ma za nasledek vzorec =B2 & "" & C2 & ", " & D2. Vysledkem je zfetézeni na
datum naforméatované v konkrétni posloupnosti.

Program Calc ma funkci CONCATENATE, ktera provadi stejnou operaci.

Referencni operatory

Jednotliva burika je identifikovana identifikatorem sloupce (pismenem) umisténym podél horni
Casti sloupcl a identifikatorem Fadku (Cislem) na levé strané tabulky. V tabulkach ¢tenych zleva
doprava je odkaz na levou horni bufiku Al.

Odkaz ve své nejjednodussi formeé tedy odkazuje na jednu buriku, ale odkazy mohou také
odkazovat na obdéInikovou nebo 3D oblast nebo odkaz v seznamu odkaz(. K vytvoreni takovych
odkaz(l potfebujete referenéni operatory.

Operator referenéniho rozsahu

Operator oblasti je zapsan jako dvojteCka. Vyraz pouzivajici operator rozsahu ma nasledujici
syntaxi:

referencni horni levy: referencni dolni pravy

Operator oblasti sestavuje odkaz na nejmensi oblast zahrnujici jak buriky odkazované na levy
odkaz, tak buriky odkazované na pravy odkaz.

V levém hornim rohu obrazku 220 je zobrazen odkaz A1:D12, ktery odpovida burikdm zahrnutym
Vv operaci pfetazeni mysi pro zvyraznéni oblasti.
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[A1:D12 [[] 5 =]

12 —1]

Ob;gzek 220: Referencni operator pro oblast
Tabulka 8: Priklady operatoru referencniho rozsahu

Priklad Popis

A2:B4 Odkaz na obdélnikovou oblast se 6 burikami, Sirokou 2 sloupce x 3
fadky na vySku. Pokud klepneme ve vstupnim fadku na referenci ve
vzorci, ohrani¢eni oznacuje obdélnik.

(A2:B4):C9 Odkaz na oblast tvaru obdélniku s burikou A2 vlevo nahore a buiikou C9
vpravo dole. Oblast tedy obsahuje 24 bunék, 3 sloupce Sirokou x 8
radkd vysokou. Tento zplisob adresovani rozsifuje pocatecni rozsah
z A2:B4 na A2:C9.

Sheetl.A3:Sheet3.D Odkaz na 3D rozsah s 24 burikami, o Sifce 4 sloupct x 2 fadky x
4 hloubkou 3 list(. (Pfedpokladame, Ze se listy Sheetl, Sheet2 a Sheet3
zobrazuji v tomto poradi v oblasti Karty list(.)

B:B Odkaz na vSechny buriky sloupce B.
A:D Odkaz na v8echny buriky sloupct A az D.
20:20 Odkaz na vSechny buriky v fadku 20.
1:20 Odkaz na v8echny buriky z fadkd 1 az 20.

Pokud zadame pfimo B4:A2, B2:A4 nebo A4:B2, Calc ji pfepne na A2:B4. Leva horni burka
oblasti je tedy vlevo od dvojtecky a prava dolni bunika vpravo od dvojtecky. Pokud ale
pojmenujeme burnku B4 napfiklad pomoci _start a A2 ndzvem _end, mizeme pouZzit _start: _end
bez jakékoli chyby.

Operator referencni zietézeni

Operétor zfetézeni je psan jako vinovka. Vyraz pouZzivajici operator zfetézeni ma nasledujici
syntaxi:

leva reference ~ prava reference

Vysledkem takového vyrazu je seznam referenci, ktery je usporadanym seznamem odkaz(.
Neékteré funkce mohou vzit referenéni seznam jako argument, napfiklad SUM, MAX nebo
INDEX.

Referencni zfetézeni se nékdy nazyva 'union'. Nejedna se vSak o spojeni téchto dvou sad 'leva

reference' a 'prava reference’, jak je obvykle chapano v teorii mnozin. COUNT(A1:C3~B2:D2)
vrati 12 (= 9+3), ale méa pouze 10 bunék, pokud je povazovano za spojeni dvou sad bunék.
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VSimnéme si, Ze SUM(A1:C3,B2:D2) se liSi od SUM(A1:C3~B2:D2) ackoli davaji stejny vysledek.
Prvni je volani funkce se 2 parametry, z nichZ kazdy je odkazem na oblast. Druhy je volani
funkce s 1 parametrem, cozZ je seznam referenci.

Referencni zfetézeni plati také pro celé radky a celé sloupce. Napriklad SUM(A:B~D:D) je
soucCet vSech bunék ve sloupcich A a B a sloupci D.

Operator referenéniho prdniku

Operator priniku je psan jako vykfiénik. Vyraz pouzivajici operator priniku ma nasledujici
syntaxi:

reference vlevo ! reference vpravo

Pokud reference odkazuji na jednotlivé oblasti, vysledkem je odkaz na jedinou oblast obsahuijici
vSechny buriky, které jsou jak v levé referenci, tak v praveé referenci.

Pokud jsou referenci seznamy odkazU, je kazda polozka z levého seznamu protnuta s kazdou

z pravého seznamu (prinik) a tyto vysledky jsou spojeny do seznamu referenci. Poradi je prvni
prinik prvni polozky zleva se vSemi polozkami zprava, poté prlnik druhé polozky zleva se vsemi
polozkami zprava a tak dale.

Priklady
A2:B4 ! B3:D6

Vysledek je reference na oblast B3:B4, protoze tyto buriky jsou uvnitf A2:B4 a uvnitf B3:D6. To je
znazornéno na obrazku 221, na kterém maiji buriky v oblasti A2:B4 oranZové pozadi a burnky

v oblasti B3:D6 maji silné ¢erné okraje. Buriky, které maji oranZzové pozadi i tlusty Cerny okraj
(B3:B4), tvori prinik téchto dvou oblasti.

A | 8 | ¢ | b |

Obréazek 221: Jednoduchy pfiklad operatoru referenéniho
priniku
(A2:B4~B1:C2) ! (B2:C6~C1:D3)
Nejprve jsou pocitany priiniky A2:B4!B2:C6, A2:B4!C1:D3, B1:C2!B2:C6, a B1:C2!C1:D3.

Vysledkem je B2:B4, prazdny, B2:C2, a C1:C2. Poté jsou tyto vysledky zfetézeny, zahodi se
prazdné casti. Kone¢nym vysledkem je tedy referencni seznam B2:B4 ~ B2:C2 ~ C1:C2.

A:B ! 10:10
Vypodita prinik sloupcti A a B s fadkem 10, ¢imZ vybere A10 a B10.

Operator priniku mdzeme pouzit k tomu, abychom na buiiku v kfiZzové tabulce odkazovali
srozumitelnym zplsobem. Pokud mate sloupce oznacené 'Teplota' a 'Srazky' a fadky oznacené
'leden’, 'Gnor', 'bfezen' atd., poté nasledujici vyraz

"anor' ! 'Teplota'
bude odkazovat na buriku obsahujici teplotu v anoru.

Operétor priniku (') ma vyssi prioritu nez operator zfetézeni (~), ale nespoléhejme se na to.
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0 Tip

VZdy zadejme do zavorek Cast, kterd se ma vypocitat jako prvni.

Relativni a absolutni odkazy

Odkazy jsou zplsob, jakym odkazujeme na umisténi konkrétni buriky v Calc a mohou byt bud
relativni (k aktualni burice) nebo absolutni (pevna oblast).

Relativni odkazovani

Pfiklad relativni reference bude znazornovat rozdil mezi relativnim odkazem a absolutnim
odkazem pomoci tabulky z obrazku 222.

1) Zadame cCisla 4 a 11 do bunék C3 a C4 prislusného tabulkového procesoru.

2)  Zkopirujeme vzorec v burice B5 (=B3+B4) do buriky C5. To Ize provést pomoci
jednoduché kopie a vloZeni nebo klepnutim a pfetazenim B5 na C5, jak je ukédzano nize.
Vzorec v B5 vypocita sou€et hodnot ve dvou burnkach B3 a B4.

3) Klepneme do buiiky C5. Lista vzorc ukazuje =C3+C4 misto =B3+B4 a hodnota v C5 je
15, soucet 4 a 11, coz jsou hodnoty v C3 a C4.

V burice B5 jsou odkazy na buriky B3 a B4 relativni odkazy. To znamena, Ze program Calc
interpretuje vzorec v B5, aplikuje jej na buriky ve sloupci B a vysledek umisti do buriky, ve kterém
je vzorec. Kdyz jsme zkopirovali vzorec do jiné buriky, byl stejny postup pouZit pro vypocet
hodnoty, ktera se ma do dané buriky vloZzit. Tentokrat se vzorec v buiice C5 odkazoval na bunky
C3 a C4.

A B C | D |
1
2
3 15 4
4 46 11
5 | E1l |
| 6 |
A B C |
_1
_2
e | 15 4
4 46 11
5
6 |

Obréazek 222: Relativni odkazy

Relativni adresu miiZete povazovat za dvojici odchylek k aktualni burice. Burika B1 je 1 sloupec
nalevo od buriky C5 a 4 fadky vy3e. Adresa mliZe byt zapsana jako R[-4]C[-1]. Ve skute¢nosti
starSi tabulkové procesory umoziiovaly pouziti této metody zapisu ve vzorcich.

Kdykoli zkopirujeme tento vzorec z buriky B5 do jiné burky, vysledkem bude vzdy soucet dvou
Cisel ze dvou bunék, které jsou jeden a dva fadky nad burnikou obsahuijici vzorec.

Relativni adresovani je vychozi metoda odkazovani na adresy v programu Calc.
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Absolutni odkazovani

MozZna budete chtit znasobit sloupec &isel pevnou ¢astkou. Sloupec ¢isel mliiZze zobrazovat
¢astky v americkych dolarech. Pro pfevod téchto Castek na eura je nutné vynasobit kazdou
¢astku dolaru sménnym kurzem. 10,00 USD by bylo vynasobeno 0,75 pro pfevod na eura,

v tomto pfipadé 7,50 EUR. Nasledujici pfiklad ukazuje, jak zadat sménny kurz a pouZzit tento
kurz k pfevodu Castek ve sloupci z USD na eura.

1) Zadame sménny kurz EUR:USD (0,75) do bunky D1. Zadame €astky (v USD) do bunék
D2, D3 a D4, napfiklad 10, 20 a 30.

2) Do bunky E2 zadame vzorec =D2*D1. Vysledek je 7,5, zobrazen spravné.

3) Zkopirujeme vzorec v bufice E2 do buiky E3. Vysledek je 200, zcela Spatné! Program
Calc zkopiroval vzorec pomaoci relativniho adresovani: vzorec v E3 je =D3*D2 a ne to, co
chceme, coz je =D3*D1.

4) V buice E2 upravime vzorec na =D2*$D$1. Zkopirujeme jej do bunék E3 a E4. Vysledky
jsou nyni spravné 15 a 22,5.

Znaky $ pfed D a 1 prevadéji odkaz na bunku D1 z relativniho na absolutni nebo pevny. Pokud
je vzorec zkopirovan do jiné burky, druha ¢ast bude vZzdy zobrazovat $D$1. Interpretace tohoto
vzorce je ,vezméte hodnotu v burice jeden sloupec doleva ve stejném fadku a vynasobte ji
hodnotou v burice D1“.

E2 ~| x E = |[-0zD1 E2 > e B = |-D2D1
= = = D E F

1 €075 1 £0.75

2 s 7.50 2 st 7.50

3 520 3 g200

4 $30 4 $30

Zadame vzorec pro prevod do E2, kde se zobrazi spravny vysledek a poté jej zkopirujeme do
E3.

Vysledek E3 je zjevné Spatny; zménime vzorec v E2 na absolutni odkaz.

Zkopirujeme spravny vzorec z E2 do E3 a dostaneme spravny vysledek.
Obrazek 223: Absolutni odkazy

Odkazy na buriky Ize zobrazit Etyfmi zplsoby, které jsou zobrazeny v tabulce 9.

Tabulka 9: Typy odkazu na buriku
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Odkaz Vysvétleni

D1 Relativni, od buriky E3 je to burika o jeden sloupec vlevo a dva fadky nad ni
$D$1 Absolutni, je to burika D1

$D1 Castetné absolutni, z bufiky E3 je to bufika ve sloupci D a o dva fadky vyse
D$1 Castecné absolutni, z buriky E3 je to bufika o jeden sloupec vievo a v fadku 1

6 Tip

Chceme-li zménit odkazy ve vzorcich, zvyraznime bunku a stiskneme F4 pro zménu
mezi ¢tyfmi typy odkaz(l. Chceme-li ménit pouze ¢ast vzorce, vybereme buriky

a v pruhu vzorcl provadime zménu pomoci F4. Vybér moZnosti nabidky List > Ménit
typ odkazu na buriku je ekvivalentni stisknuti klavesy F4.

Znalost pouziti relativnich a absolutnich odkaz( je nezbytna, pokud chceme kopirovat a vkladat
vzorce a propojovat tabulky.

Pojmenované oblasti

Burikdm a oblastem bunék miZe byt pfifazen nazev. Pojmenovani bunék a rozsah( zlepsuje
Citelnost vzorcl a udrzbu dokumentt. Jednoduchym prikladem by bylo pojmenovani fady bunék
B1:B10 jako ,Hmotnost" a soucet vSech hmotnosti. Vzorec je =SUM(B1:B10). KdyzZ je oblast
B1:B10 pojmenovana jako Hmotnost, miZeme vzorec prevést na =SUM(Hmotnost). Vyhoda je
jasna z hlediska Gitelnosti vzorcd.

DalSi vyhodou je, Zze vSechny vzorce, které maji pojmenovanou oblast jako argument, se
aktualizuji, kdyZ pojmenovana oblast zméni umisténi nebo velikost. Pokud je napfiklad oblast
Hmotnost nyni v burikach P10:P30, nemusime kontrolovat vSechny vzorce, které maji jako
argument Hmotnost; staci aktualizovat pojmenovanou oblast Hmotnost s novou velikosti

a umisténim.

Chceme-li definovat pojmenovanou buriku nebo oblast, vybereme buriku nebo oblast
a pouZzijeme nabidku List > Pojmenované oblasti a vyrazy > Definovat. Zobrazi se dialog na
obrazku 224 s vybranym rozsahem a definujeme nazev a rozsah pojmenované oblasti.

Definovat nazev X

Definujte nazev a oblast nebo vzorec.
MNazev:

Hmotnost

Oblast nebo vzorec:
$List1.3B$1:5B8310

Rozsah platnosti:

= |

Dokument (globalni) ~

=l MoZnosti oblasti
] Oblast tisku [ Opakovat sloupec

CIFiltr [ Opakovat Fadek

MNapovéda Pridat Zrusit

Obrézek 224: Dialogové okno Definovat nazev
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Pojmenovanou oblast miizeme také definovat pfimo v listu vybérem oblasti a zadanim jejiho
ndzvu do Pole nazvu na levé strané listy vzorcl (obrazek 225).

Soubor Upravy Zobrazit Vlozit Forméat St
' 'E'a%@'\%%aﬁ

EW’chozf ~ | |Liberation Sans |~ | |10

Hmotnost vl fx ¥ -= 120

A B C
2
21
22
23
24
25
26
27
0 28
0 29
11

Obrazek 225: VloZeni nazvu do
pole nazvu pro definovani
pojmenované oblasti

Chceme-li rychle ziskat pfistup k pojmenované oblasti, vybereme pojmenovanou oblast
v rozeviracim seznamu Pole ndzvu. Pojmenovand oblast se zobrazi na obrazovce a je vybrana.

Spravovat nazvy

Mazev ‘Oblast nebo vzorec Rozsah

Hmotnost £List1.$B%$1:5B%10 Dokument (globalni)

Nazev:

Hmotnost

Oblast nebo vzorec:

SList1.5B$1:5BS10 =]

Rozsah platnosti:

|D0kument (globalni) w ‘

MozZnosti oblasti

Pridat Smazat

Napovéda 0K Zrusit

Obréazek 226: Dialogové okno Spravovat nazvy

Tvorba vzorcl | 269



Pro Upravu pojmenované oblasti pouzijeme dialogové okno Spravovat nazvy (obrazek 226).
K tomuto dialogu se dostanete vybérem List > Pojmenované oblasti a vyrazy > Spravovat
Z hlavni nabidky nebo stisknutim Ctrl + F3.

Pojmenované vyrazy

Dlouhy nebo slozity vzorec miizeme také pojmenovat. Chceme-li pojmenovat vzorec, otevieme
dialogové okno Definovat nazev (obrazek 224) a zadame vyraz vzorce do pole Oblast nebo
vzorec. Pojmenujeme vyraz a klepneme na Pridat.

Predpokladejme napriklad, Ze v buiikdch C1 aZz C10 musime spoditat obvod sady kruhd a jejich
polomér je uveden v B1 az B10. Definujeme pojmenovany vyraz OBVODKRUHU, s vyrazem
=2*PI()*B1 a klepneme na Pfidat, ¢imz zavieme dialog. Do buiky C1 zadame =OBVODKRUHU
a stiskneme Enter. Vzorec je aplikovan na buriku C1. Zkopirujeme buiiku C1 a vloZime ji do
zbyvajicich bunék od C2 do C10 a mame obvody vSech kruh(. VSechny buriky v rozsahu
C1:C10 maji vyraz =OBVODKRUHU.

VSimnéme si, Ze pojmenovany vyraz pouziva stejna pravidla pro adresovani bunék, tj. absolutni
a relativni odkazy.

Poradi vypocCtu

Poradi vypoctu se vztahuje k posloupnosti provadéni numerickych operaci a ¢lanek Wikipedie na
adrese https://en.wikipedia.org/wiki/Order_of operations poskytuje uzite¢né obecné informace.
Déleni a nadsobeni se provadi pred scitanim nebo odecitanim. Existuje obecna tendence
oCekavat, Ze vypocty budou provadény zleva doprava, protoze rovnice bude ¢tena v anglicting.
Program Calc vyhodnoti cely vzorec, poté na zakladé programovaci priority rozdéli vzorec

a provede operace nasobeni a déleni pfed jinymi operacemi. Proto bychom méli pfi vytvareni
vzorcl vyzkouset svij vzorec, abychom se ujistili, Ze je dosazeno o¢ekavaného a spravného
vysledku. Nasleduje pfiklad poradi vypoctu.

Tabulka 10: Poradi vypoctu

Vypocet zleva doprava Poradi vypoctu

1+3*2+3 =11 =1+3*2+3 vysledek 10

1+3 = 4, poté 4x2 = 8, poté 8+3 =11 3*2 = 6, poté 1+6+3 = 10

DalSim moznym zamérem by mohlo byt: Program feSi nasobeni 3 x 2 pfed zpracovanim
1+3*2+3 =20 dalSich Cisel.

1+3 = 4, poté 2+3 = 5, poté 4x5=20

Pokud chceme, aby vysledek byl jednim z dvou moznych feSeni vlevo, zadame vzorec takto:
(1+3) *2)+3 =11 (1+3) * (2+3) = 20

Poznamka

pro seskupeni operaci v pofadi, které zamyslime pouzijeme zavorky. Napfiklad
=B4+G12*C4/M12 se mlze stat =((B4+G12)*C4)/M12.

Vypocty spojujici listy

Dalsi silnou funkci programu Calc je schopnost propojit data pres nékolik listl. Pojmenovani list
mUlZe byt uzite¢né pfi urovani, kde Ize nalézt konkrétni data. Nazev jako VyplatniListina nebo
Prodeje je smysluplnéjSi nez Sheetl. Funkce s nazvem SHEET() vraci Cislo listu (pozici)

v seznamu list(. V kazdém dokumentu mliZe byt nékolik listd a mohou byt o&islovany zleva:
Listl, List2 atd. Pokud pfetdhneme listy na jiné umisténi mezi kartami funkce vraci Cislo
odkazujici na aktualni polohu tohoto listu. V nové instanci programu Calc je vychozi nastaveni
jeden list v sesité.
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Pokud je napfiklad vzorec =SHEET() vloZen do Al na List1, vrati hodnotu 1. Pokud pfetdhneme
Listl na umisténi mezi listy 2 a 3, hodnota se zméni na 2. Nyni je to druhy list v poradi.

Priklad vypoctl ziskavajicich data z jiné oblasti Ize vidét v podnikovém prostiedi, kde podnik
kombinuje vynosy a naklady kazdé ze svych pobocek do jediného kombinovaného listu. Viz Ctyfi
¢asti obrazku 227 pod.

List obsahuijici udaje

pro Pobocku 1.

List obsahuijici udaje
pro Pobocku 2.

List obsahuijici udaje
pro Pobocku 3.
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K7 ~| fx T - = [=sFilialka 1'K7+$Fililka 2 KT +$Filidlka 3'K7 List obsahuj ici
Y r—— e S . kombinovana data
, Hojné kvitnouci,
s.I.0. pro vdechny pobocky.
3 |Souhrny prodejd k dneSnimu dni
4
5 Rij Lis Pro K dne&nimu dni
6 |Vynos:
Prodej vegatace 140 340 126 030 233 102 3 809 089
8 Prodeje hnojiv 77775 23829 20 316 1705 215
9 Prode] zemin 61778 17 569 9 006 501 550
10 Mezisoucel 279 893 167 428 262 424 6015 854
11
12 |Naklady na prodej
13 Velkoobchodni nakupy 95 164 56 925 89224  2045390,74
14 Prodejni dait 30 788 18 417 28866 661 743,71
15 |Mezisoucet 125952,55 7534245 11809035 2707 134,45
16
17_Vynosy celkem: [ 153940 92086 144334 3308720
18
< > <L
+ Filialka 1 Filialka 2 Filidlka 3 Souhrn

Obrazek 227: Kombinace dat z nékolika listi do jednoho listu

Listy byly vytvoreny se stejnymi strukturami. Nejjednodussi zplsob, jak toho dosahnout, je otevrit
novou tabulku, nastavit prvni list pobocky, zadat data, naforméatovat burky a pfipravit vzorce pro
rlzné soucty fadkl a sloupctl. Poté vytvofime kopie prvniho listu nasledujicim zplsobem:

1) Na karté listu klepneme pravym tlaCitkem a vybereme Pfejmenovat list. Zadame Filialka
1. Klepneme pravym tlaCitkem mySi znovu na list a vybereme Pfesunout nebo kopirovat
list.

2) V dialogovém okné Pfesunout/kopirovat list (obrazek 228) vybereme volbu Kopirovat (je
automaticky vybrana, pokud je v tabulce pouze jeden list) a zvolime -pfesunout na konec-
v sekci Vlozit pfed. Zménime nazev v poli Novy nazev na Filidlka 2. Klepneme na OK.
stejnym zplsobem vytvorime listy Filidlka 3 a Souhrn.

Pfesunout/kopirovat list

Cinnost
Presunout Kopirovat
Umisténi

Do dokumentu

Bez nazvu 1 (aktualni dokument) ~

VloZit pfed

- pfesunout na konec -

Novy nazev

Filiglka 2

Napovéda QK Zrusit

Obrazek 228: Kopirovani listu
3) Do prislusnych listli zadame Gdaje pro filidlku 2 a filidlku 3. Kazdy samostatny list uvadi
vysledky pro jednotlivé pobocCky.

4) V listu Souhrn klepneme na bunku K7. Zadame =, klepneme na list Filialka 1, klepneme
na burnku K7, zmackneme +, opakujeme to pro listy Filialka 2 a Filidlka 3 a poté
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stiskneme Enter. Nyni mame vzorec v burice K7, ktery obsahuje pfijmy z prodeje zelené
pro tfi filialky.

K8

A

A

fx > -=

mﬂqmw&w

10
11

12
13
14
15
16
17
18
19
20

Hojné kvitnouci,
S.I.0.

\Vynos:
Prodej vegatace
Prodeje hnojiv
Prodej zemin
Mezisoucet

Naklady na prode;
Velkoobchodni nakupy
Prodejni dar

Mezisoucet

\ynosy celkem:

Naklady:

=$'Filidlka 1'.K8+%'Filidlka 2" K8+5Filialka 3".K8

e

]

140 340

77775
61 778
279 893

95 164
30 788
125 952,55

L | M | N
Lis Pro K dnesnimu dni
126 030 233102 3 809 089
23829 20 316 1705 215
17 569 9 006 501 550
167 428 262 424 6 015 854
56 925 89 224 2 045 390,74
18 417 28 866 661 743,71
7534245 118 090,35 2 707 134,45

Obrazek 229: List Souhrn zobrazujici odkazy mezi listy jednotlivych filidlek

5) Zkopirujeme vzorec, vybereme oblast K7:N17, v hlavni nabidce zvolime Upravy > VloZit
jinak > Vlozit jinak nebo klepneme pravym tlacitkem a z mistni nabidky vybereme Vlozit
jinak > Vlozit jinak nebo zmackneme Citrl + Shift + V. V dialogovém okné odskrtneme
volby Vlozit vSe a Formaty v oblasti Vybér. ZaSkrtneme vSechny ostatni volby v této
oblasti a klepneme na OK. Zobrazi se nasledujici zprava:

Napovéda

Upozomit i pfisté,

Chystate se vlozZit data do bunék, které nejsou prazdné.

Opravdu si pfejete prepsat jejich stavajici obsah?

Obrazek 230: Propojenti listt: vloZeni vzorce do

oblasti bunék

6) Klepneme na Ano. Nyni jsme zkopirovali vzorce do kazdé buriky pfi zachovani formatu
nastaveného v plvodnim listu. V tomto pfikladu bychom samoziejmé& méli upravit list

odstranénim nul v fadcich bez formatovani.
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N17 v| fx ¥ - = | =SFilislka 1"N17+$Filialka 2'N17+$Filidlka 3.N17
| A K | L | M

, Hojné kvitnouci,

S.r.o.
3 [Souhrny prodeji k dne$nimu dni
4
5 Rij Lis Pro K dnednimu dni
6 |Vynos:
7 Prodej vegatace 140 340 126 030 233 102 3 809 089
8 Prodeje hnojiv 17775 23 829 20 316 1705215
9 Prodej zemin 61 778 17 569 9 006 501 550
10 |Mezisoucet 279 893 167 428 262 424 6 015 854
11
12 |Naklady na prodej
13 Velkoobchodni nakupy 95 164 56 925 89 224 2045 390,74
14 Prodejni dar 30 788 18 417 28 866 661 743,71
15 |Mezisoucet 125 952,55 75342,45 118090,35 2707 134,45

16
Vynosy celkem: 153940 92086
18

Obrazek 231: Propojenti listi: Kopirovat/VIoZit jinak z K7:N17

K provedeni propojeni Ize také pouzit Prlivodce funkci. PouZiti tohoto priivodce je podrobné
popséano v ¢asti ,Pouzivani Privodce funkci“ na strance 315.

Rozumime funkcim

Program Calc obsahuje vice nez 500 funkci, které nam pomohou analyzovat a odkazovat na
data. Mnoho z téchto funkci se pouziva s Cisly, ale jiné se pouZzivaji s datumy a ¢asy nebo
dokonce s textem. Funkce mize byt stejné jednoducha jako s¢itani dvou ¢isel nebo nalezeni
prdméru seznamu ¢&isel, nebo mlZze byt stejné slozita jako vypocet standardni odchylky vzorku
nebo hyperbolického tangens Cisla.

Nazev funkce je obvykle zkraceny popis toho, co funkce déla. Napriklad funkce FV dava budouci
hodnotu investice (angl. future value), zatimco BIN2HEX pfevadi binarni ¢islo na hexadecimalni
¢islo. V programu Calc Ize nazvy funkci zadavat velkymi ¢i malymi pismeny nebo je kombinovat.

Neékolik zakladnich funkci je ponékud podobnych operatortim. Pfiklady:

+  Tento operator scita dvé Cisla dohromady. SUM() na druhé strané scita skupiny sousedicich
oblasti Cisel.

*  Tento operator vynasobi dvé Cisla dohromady. PRODUCT() déla totéZz pro nasobeni, jako
SUM() pro scitani.

Kazdéa funkce méa fadu argumentl pouzitych ve vypoctech. Tyto argumenty mohou nebo nemusi
mit svij vlastni nazev. Vasim Gkolem je zadat argumenty potfebné ke spusténi funkce.

V nékterych pfipadech maji argumenty preddefinované volby a mozna je budeme muset najit

v popiscich Prlvodce funkci, na karté funkci nebo v napovédé. Castéji je viak argumentem
hodnota, kterou zadavame ru¢né nebo je jiz zadana do bunky nebo oblasti bunék v tabulce.

V programu Calc miiZzeme zadat hodnoty z jinych buné&k zadanim jejich nazvu nebo oblasti, nebo
— na rozdil od nékterych tabulkovych procesorli — vybérem buné&k mysi. Pokud se hodnoty

v bunikach zméni, bude vysledek funkce automaticky aktualizovan.

Kompatibilita s jinymi tabulkovymi procesory

Pro mnoho funkci Calc nasleduje standard OpenFormula definovany v €asti 2 (Recalculated
Formula (OpenFormula) Format) formatu Open Document Format for Office Applications
(OpenDocument) verze 1.2. Tento standard je pfistupny na webu OASIS (https://www.oasis-
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open.org/) nebo webové strance ISO (https://www.iso.org/standard/66375.html). Obecna
podpora OpenFormula v programu Calc poskytuje kompatibilitu s funkéni sadou jakéhokoli jiného
tabulkového procesoru, ktery dodrzuje stejny standard. (V programu Calc jsou nékteré funkce,
které nejsou v souladu s OpenFormula, ale mnoho z nich je zahrnuto predevsim pro zlepseni
vymény souborli mezi Calc a Microsoft Excel.)

Pro zlepseni interoperability je Calc schopen otevirat sesity vytvofené mnoha rliznymi aplikacemi
a ukladat je v mnoha rliznych formatech. V pfipadé sady Microsoft Office je velmi snadné
vymeénovat seSity mezi témito dvéma aplikacemi. KdyZ aplikace Calc otevie tabulku aplikace
Microsoft Excel, automaticky podnikne kroky, aby se vyhnula nekompatibilitam, které by se jinak
mohly vyskytnout u ur€itych funkci. Napfiklad kdyz program Calc otevie soubor Excel, ktery
obsahuje volani funkce Excel CEILING, jsou tyto funkce automaticky pfevedeny na referencni
funkci programu Calc CEILING.XCL. Podobné, kdyz program Calc ulozi tabulku do formatu
Microsoft Excel, automaticky podnikne kroky, aby se pfedeslo potencialnim nekompatibilitam.
Prikladem toho je situace, kdy program Calc ulozi seSit obsahuijici volani funkce FLOOR, které
jsou automaticky pfevedeny na referencni funkci FLOOR.MATH aplikace Excel.

Wiki Document Foundation poskytuje srovnani funkci LibreOffice a Microsoft Office, viz
https://wiki.documentfoundation.org/Feature_Comparison:_LibreOffice_- Microsoft Office. Toto
srovnani ukazuje, Ze program Calc v souasné dobeé poskytuje 508 diskrétnich funkci, pricemz
pouze 30 z nich je jedinecnych pro Calc a zbytek ma protéjsky v aplikaci Microsoft Excel. Je
zfejmé, Ze mezi funkcemi sady Calc a Excel existuje vysoka uroven shodnosti a mnoho funkci
Ize pouzit v obou aplikacich beze zmén, ¢imz se zvySuje interoperabilita.

Existuji pfipady, kdy funkce programu Calc vytvafi vysledek v souladu s mezinarodnimi
standardy, ale vysledek se liSi od vysledku vytvoreného ekvivalentni funkci Excel. V takovych
pripadech m& program Calc ¢asto podobné pojmenovanou funkci, ale k jejimu ndzvu byl pfidan
vhodny modifikator (napfiklad ,,_ADD" nebo ,, EXCEL2003"), ktery poskytuje stejny vysledek jako
funkce Excel.

Pochopeni struktury funkci

VSechny funkce maji podobnou strukturu. Pokud pouZijeme spravny nastroj pro zadani funkce,
nemusime se ucit tyto struktury, ale stale je vhodné znat feSeni problémd.

Typickym pfikladem je struktura funkce k nalezeni bunék, které odpovidaji zadanym kritériim
vyhledavani:

= DCOUNT(Database; Database field; Search criteria)

Funkce nemiZe existovat sama o sobé&; musi byt vZdy soucasti vzorce. V disledku toho, i kdyZz
funkce predstavuje cely vzorec, musi byt na zacatku vzorce znaménko =. Bez ohledu na to, kde
ve vzorci je funkce, bude funkce zacinat svym nazvem, napfiklad DCOUNT ve vySe uvedeném
prikladu. Za nazvem funkce pfichazi jeji argumenty. VSechny argumenty jsou povinné, pokud
nejsou vyslovné uvedeny jako volitelné.

Argumenty jsou pfidany do zavorek a jsou oddéleny stfedniky. Funkce Calc mlze obsahovat az
255 argumentd. Argumentem miZe byt nejen Cislo nebo jedna burika, ale také pole nebo oblast
bunék, které obsahuji nékolik nebo dokonce stovky bunék.

V zavislosti na povaze funkce Ize argumenty zadavat jako v tabulce 11.

Tabulka 11: Zadavani argumentd funkce

Argument Popis

"textova Uvozovky oznacuji, Ze se zadava text nebo
data" fetézcova data.

9 Cislo devét zadano jako &islo.
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Argument Popis

"g" Cislo devét zadano jako text.
Al Adresa ¢ehokoliv, co je zadano v burice Al.
B2:D9 Zadana oblast bunék.

Vnorené funkce

Funkce Ize také pouzit jako argumenty v rdmci jinych funkci. Tyto funkce se nazyvaji vnofené
funkce.

=SUM(2; PRODUCT(5;7))

Chceme-li ziskat pfedstavu o tom, co mohou vnofené funkce délat, pfedstavme si, Zze
navrhujeme samofizeny vyukovy modul. BEhem modulu studenti délaji tfi kvizy a vysledky
zadavaji do bunék A1, A2 a A3. V A4 mlizeme vytvofit vnofeny vzorec, ktery zacina
primérovanim vysledk( kviz( s vzorcem =AVERAGE(A1:A3). Vzorec poté pomoci funkce IF
dava studentovi zpétnou vazbu, kterd zavisi na prdmérném ohodnoceni kvizi. Cely vzorec by
znél:

=IF(AVERAGE(A1:A3) >85; "Gratulujeme! Jste pripraveni postoupit
k dalSimu modulu ";" NeuspésSné. Zkontrolujte prosim material znovu.
V pripadé potreby kontaktujte svého instruktora.”)

V zavislosti na priméru obdrZi student zpravu s blahopfanim nebo vyjadienim netspéchu.

VSimnéme si, Ze vnofeny vzorec pro priimér nevyzaduje své vlastni znaménko rovnosti. Jeden
na zacatku rovnice je dostacujici pro oba vzorce.

Pokud jsme v tabulkovych procesorech novackem, nejlepsi zpUsob, jak premyslet o funkcich, je
skriptovaci jazyk. Pro snadné vysvétleni konceptu jsme pouzili jednoduché pfiklady, ale pomoci
vnoreni funkci se mliZe vzorec v Calcu rychle stat slozitym.

Poznamka

Calc zobrazuje syntaxi vzorce v bublinové napovédé vedle buriky jako uzite¢nou
pamétovou pomdcku pfi psani.

Pouziti postranni listy Funkce

s

Spolehlivéjsi metodou je pouZiti karty Funkce na postrannim panelu (obrazek 232), pfistupné
vybérem Zobrazit > Seznam funkci nebo, pokud je postranni liSta zobrazena, klepnutim na ikonu
Funkce v seznamu zéaloZek na pravé strané listy.

Karta Funkce obsahuje stru¢ny popis kazdé funkce a jejich argumentd. Pro zobrazeni popisu
vybereme funkci a podivame se do dolni ¢asti panelu. V pfipadé potfeby umistime kurzor nad
hranu mezi seznam a popis; Jakmile se kurzor stane dvojitou Sipkou, pfetahneme ji smérem
nahoru a zvétSime misto pro popis. Poklepanim na nazev funkce ji pfidame do aktualni bunky
spolu se zastupnymi symboly pro kazdy z argumentl funkce.

Pouziti karty Funkce je témér stejné rychlé jako rucni zadani a jeji vyhodou je, Ze si nemusime
pamatovat vzorec, ktery chcete pouzit. Teoreticky by to mélo byt také méné nachylné k chybam.
V praxi vSak mUze byt pro nékteré uZivatele obtiZzné nahrazovat zastupné symboly hodnotami.
DalSi funkci je schopnost zobrazit posledni pouzité vzorce.
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Obrazek 232: Karta Funkce v postranni listé
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Pouzivani Privodce funkci

NejbéZnéji pouzivanou metodou vstupu je Prlivodce funkcemi (obrazek 233). Chceme-li jej
otevrit, zvolime Vlozit > Funkce nebo klepneme na ikonu Prdvodce funkcemi na listé funkci,
nebo stiskneme Ctrl + F2. Prlivodce funkcemi poskytuje stejné funkce napoveédy jako karta
Funkce, ale pfidava pole, ve kterych mizeme vidét vysledek dokoncené funkce, jakoZ i vysledek
jakéhokoli vétSiho vzorce, jehoz je soucasti.

Pro zkraceni seznamu vybereme kategorii funkci, potom projdeme dold nazvy funkci a vybereme
pozadovanou funkci dvojitym klepnutim. Dostupné kategorie v Privodci funkci a pocet funkci
dostupnych v kazdé kategorii jsou uvedeny v tabulce 12. Kdyz vybereme funkci, jeji popis se
objevi na pravé strané dialogu. Pfipadné& mdizeme do vyhledavaciho pole zadat nazev funkce

a vyhledavani se zuzuje pfi kazdém vlozeném znaku (obrazek 233).

Tabulka 12: Kategorie funkci v Privodci funkci

Kategorie Pocet funkci podle kategorii
Dopliky 48
Matice 15
Databaze 12
Datum a Cas 36
Financni 63
Informace 21
Logické 11

Matematické 82

Sesit 22
Statistické 151
Text 47

Prdvodce nyni zobrazi oblast vpravo, kde midzeme ru¢né zadat data do textovych poli nebo
kliknout na tlacitko Zmensit, ¢imzZ se zmensi privodce a mizeme vybrat buriky z listu.
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Privodce funkei

Funkce Struktura SUM Vysledek funkce |0
Hledat Vrati soucet viech argumentd.
Kategorie B
Cislo 1 {vyZadovana)
Matematické e
Funkce Cislo 1, &islo 2,... jsou argumenty, jejichZ soucet se ma zjistit.
SECH ~
SERIESSUM ~
SIGN Cislo 1| fx =
SIN Cislo 2 | fx =
SINH
SQRT Cislo 3 | Jx =
SO Cislod | fi =] .
SUBTOTAL
SUMIF '
SUMIFS Vzoreg Vygledek 1]
SUMSQ =sump ~
TAN
TANH
TRUNC v v
[ Matice Napovéda < Zpét Dal3i >~ QK Zrudit

Obrézek 233: Karta Funkce Privodce funkci

| =sum(B)

Privodce funker - SUM( Cislo 1; ...)

D23

Obrazek 234: Privodce funkci po zmenseni

Chceme-li vybrat buriky, klepneme bud pfimo na buriku, nebo podrzime levé tlacitko mysSi
a tazenim vybereme poZadovanou oblast.

Po vybéru oblasti klepneme na ikonu Rozvinout a znovu se vratime do privodce.

Pokud potrebujeme vice argumentt, klepneme do dal$iho textového pole a zopakujeme proces
vybéru pro dal3i buriku nebo oblast buné&k. Tento postup opakujeme podle potfeby. Priivodce
umozni az 255 oblasti nebo argumentd ve funkci SUM.

Klepnutim na tlacitko OK potvrdime funkci, vioZzime ji do burniky a dostaneme vysledek.

@ Poznamka

Pokud vybereme funkci dvojitym klepnutim v seznamu a poté zménime nazor

a vybereme jinou dvojitym kliknutim znovu, pfida se vzorec druhé volby do vzorce
prvni volby v textovém poli Vzorec. Musite vymazat textové pole Vzorec a potom
poklepanim na funkci pfidat do pole.

Toto dopliiovani vzorcli umoziuje vytvaret sloZité vzorce jejich sestavovanim
v textovém poli Vzorec.

MlzZeme také vybrat kartu Struktura, kde uvidime stromové zobrazeni ¢asti vzorce. Hlavni
vyhoda oproti karté Funkce je, Ze kazdy argument se vklada do svého vlastniho pole, coz
usnadnuje spravu. Cena této spolehlivosti je pomalejSi zadavani, ale pfi vytvareni seSitu je
presnost obecné dllezitéjsi nez rychlost.

Zobrazeni struktury vzorce v privodeci je dllezité pro ladéni a opravu velmi dlouhych, vnofenych
a slozitych vzorcl. V tomto pohledu je vzorec analyzovan a kazda slozka vzorce je vypocitana
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N

jednodussim vyvolanim funkce nebo aritmetickou operaci a poté je zkombinovana podle pravidel
vypoctu. Je mozné vizualizovat kazdy analyzovany prvek vzorce a zkontrolovat, zda jsou
mezilehlé vysledky spravné, dokud neni nalezena chyba.

7~z

Funkce Ize zadat do vstupniho fadku. Po zadani funkce na vstupni fadce stiskneme klavesu
Enter nebo klepneme na tlacitko Pfijmout na listé vzorcl. Tim se funkce pfida do buriky
a ziskame jeji vysledek.

SUM “l fx X | =SUM{A1:A10)
1 2 3 4 5

1 Pole Nazev zobrazujici seznam béznych funkci

2  Pravodce funkci 4  Prijmout

3 Zrusit 5 Vstupni fadek

Obrézek 235: Lista vzorcli

Pokud vidime v bunce misto vysledku vzorec, pak je vybrana volba Vzorce v sekci Zobrazeni
dialogového okna Nastroje > MoZnosti > LibreOffice Calc > Zobrazit. Zru§ime vybér Vzorce
a zobrazi se vysledek. Stale vSdak mizeme vidét vzorec ve vstupnim radku.

6 Tip

Moznost nabidky Zobrazit > Zobrazit vzorec a klavesova zkratka v Linuxu/Windows
Ctrl + * (obracena Céarka) také zapina a vypina zobrazeni vzorce.

Maticové vzorce

Co je to maticovy vzorec?

Vzorec, ve kterém se vyhodnocuji jednotlivé hodnoty v oblasti bunék, se oznacuje jako maticovy
vzorec. Rozdil mezi maticovym vzorcem a jinymi vzorci je v tom, Ze maticovy vzorec pracuje
s nékolika hodnotami najednou namisto pouze jedné.

NejenZe maticovy vzorec zpracovava nékolik hodnot najednou, ale také miZe vicero hodnot
najednou vratit Vysledek maticového vzorce je také matice.

Kdyz program Calc aktualizuje vzorce, kazda ovlivnéna burka se nacte a jeji vzorec se
prepocita. Pokud mame ve sloupci se stejnym vzorcem tisic bunék (vyraz vzorce pouze zméni
data, ktera se maiji vypocitat), znamena to interpretaci a provedeni tisice stejnych vzorcu.

Maticové vzorce vyhodnoti vzorec jednou a provedou vypocty tolikrat, kolikrat je velikost pole,
¢imz se uSetfi Cas potfebny k interpretaci kazdého vzorce v bufice. A protoZe program Calc
uklada pouze jeden vzorec pro celé pole datovych bunék, Setfi také misto v souboru seSitu.

El [v] & & = |(=100ALC5)
A | B | C | D F | G |
1 2 3 20 30
_2 | 2 3 4 20 30 40
3| 3 4 5 30 40 50
4| 4 5 6 40 50 60
5 | 5 6 7 50 60 70

6

Obréazek 236: Zdrojové pole Zluté a vysledné pole zelené. Maticovy vzorec
je zobrazen na listé vzorcd.

Chceme-li vynasobit hodnoty v jednotlivych burikach deseti ve vySe uvedeném poli (obrazek
236), nemusime pouZzit vzorec pro kazdou jednotlivou buriku nebo hodnotu. Misto toho staci
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pouzit jeden maticovy vzorec. Vybereme oblast 3 x 5 bunék v jiné ¢asti tabulky, zadame vzorec =
10*A1:C5 a potvrdime jej kombinaci klaves Ctrl + Shift + Enter. Vysledkem je pole 3 x 5, ve
kterém jsou jednotlivé hodnoty v rozsahu bunék (A1:C5) vynasobeny Cislem 10.

Kromé nasobeni miZeme v referenéni oblasti (pole) pouzit také dal$i operatory. MiZeme scitat
(+), odecitat (-), nasobit (*), délit (/), pouZzit exponenty (%), zfetézeni (&) a porovnani (=, <>, <, >,
<=, >=). Pokud byl zadan maticovy vzorec Ize pouzit operatory pro kazdou jednotlivou hodnotu
v oblasti bunék a vratit vysledek jako pole.

Operatory porovnani v maticovém vzorci zpracovavaji prazdné buriky stejnym zplsobem jako

v normalnim vzorci, tj. bud jako nula, nebo jako prazdny fetézec. Pokud jsou napfiklad bunky Al
a A2 prazdné, maticoveé vzorce {=A1:A2=""} a {=A1:A2=0} vrati oba pole o velikosti 1 sloupec a 2
fadky s hodnotami PRAVDA.

Kdy pouzZivame maticové vzorce?

Pokud musime opakovat vypoc¢ty pomoci rliznych hodnot, pouZijeme maticové vzorce. Pokud se
rozhodneme pozdé&ji zmeénit metodu vypoctu, musime aktualizovat pouze maticovy vzorec.
Chceme-li pfidat maticovy vzorec, vybereme celou oblast pole a potom provedeme poZadovanou
zménu maticového vzorce.

Pole jsou nezbytnym nastrojem pro provadéni slozitych vypoctd, protoze do vypoétd miZzeme
zahrnout nékolik oblasti bunék. Program Calc ma rlizné matematické funkce pro pole, jako je
funkce MMULT pro vynasobeni dvou poli.

Vytvareni maticovych vzorci

Pokud vytvofime maticovy vzorec pomoci Priivodce funkci, musime pokazdé oznadit zaskrtavaci
policko Matice, aby vysledky byly vraceny v matici (obrazek 233). Jinak bude vracena pouze
hodnota v levé horni burice vypocitaného pole.

Pokud zadame maticovy vzorec pfimo do buriky, musime pouzit kombinaci klaves Shift + Ctrl +
Enter misto klavesy Enter. Teprve poté se vzorec stane maticovym vzorcem.
Poznamka

Maticoveé vzorce se v programu Calc zobrazuji v zavorkach (sloZenych zavorkéach).
Maticové vzorce nelze vytvofit ru¢né zadanim slozenych zavorek.

Poznamka

Buriky v poli vysledkd jsou automaticky chranény proti zménam. Maticovy vzorec
vSak mizeme upravit nebo zkopirovat vybérem celé oblasti maticového vzorce.

Strategie pro vytvareni vzorci a funkci

Vzorce, které provadeéji vice nez jednoduchy vypocet, soucet fadkd nebo sloupct hodnot,
obvykle obsahuji fadu argumentd. Zvazme napfiklad nasledujici rovnici:

Tato rovnice modeluje polohu objektu, ktery se pohybuje linearné s konstantnim zrychlenim.
Poloha (x) zavisi na €ase (t) a rovnice také obsahuje konstantni hodnoty pro pocatecni polohu
(xi), pocéatecni rychlost (vi) a zrychleni (a).

Pro snadnou prezentaci je vhodné sestavit tabulku podobnym zpUsobem, jaky je uveden na
obrazku 237. V tomto pfikladu jsou jednotlivé proménné vkladany do bunék na listu a neni nutna
zadna uprava vzorce.
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F6 v fx ¥ - = || =$C59+5C$8*E6+0,5*SCET*ERA2
A | B | C | b | E

1 Pozice jako funkce €asu (i) pro linearni, translaéni a neustale zrychleny pohyb
X=(L2)PaMA2+y_ Pt

2

3

4 |PRIKLAD: Zadejte hodnoty do zelenych poli t X

5 |t ¢as dana proménna (jednotky €asu) | (jednotky pozice)
nx pozice v Ease t vypoctena proménna 0 50

7 ja akcelerace 16 2 92

8 |v_i |pocatecni rychlost 5| 4 198

9 [x_i |pocateCni pozice 50| 6 368

10 8 602

11 10 900

Obrazek 237: Nastaveni vzorce s argumenty

Pfi vytvareni vzorce mizZete pouzit nékolik pfistupl. PFi rozhodovani, jaky pfistup zvolit,
vezmeme Vv Uvahu, kolik dal$ich lidi bude muset listy pouzivat, Zivotnost listdl a variace, s nimiz
by se mohli pfi pouZiti vzorce setkat.

Pokud budou seSit pouZivat jini lidé nez my, ujistime se, Ze je snadné zjistit, jaky vstup je
vyzadovan a kde. Na prvnim listu je ¢asto umisténo vysvétleni Gcelu sesitu, zakladu pro vypocet,
pozadovaného vstupu a generovaného vystupu.

U sesitu s mnoha komplikovanymi vzorci, ktery vytvofime dnes, nemusi byt zcela za 6 nebo 12
mésicl ziejmé, jak mél fungovat. Pro zdokumentovani je vhodné pouzivat komentare
a poznamky.

MozZna si uvédomujeme, Ze pro konkrétni argument nemliZeme pouzit zaporné nebo nulové
hodnoty, ale pokud nékdo jiny vlozi takovou hodnotu, bude né$ vzorec robustni nebo jednoduse
vrati standardni (a ¢asto ne pfilis uziteCnou) chybovou zpravu? Je vhodné zachytit chyby pomoci
néjaké formy logickych prikaz(i nebo podminénym formatovanim.

Do kazdé bunky viozime jedineény vzorec

Zakladni strategii je povazovat vSechny potfebné vzorce za jednoduché a s omezenou
Zivotnosti. Strategii je pak umistit jedinecny vzorec do kazdé vhodné buriky. To Ize doporugit
pouze pro velmi jednoduché nebo jednorazové sesity.

Rozdélime vzorce na ¢asti a spojime je

Druha strategie je podobna té prvni, ale misto toho rozdélujeme delSi vzorce na mensi ¢asti

a poté je zkombinujeme do celku. Mnoho priklad(l tohoto typu existuje ve slozitych védeckych

a technickych vypoctech, kde se prozatimni vysledky pouZzivaji na fadé mist v listu. Vysledek
vypoctu rychlosti proudéni vody v potrubi mdze byt pouzit pro odhad ztrat v disledku tfeni, kdy
potrubi protéka zcela nebo ¢astecné prazdné, a pfi optimalizaci priméru pro dany rezim pritoku.

Ve vSech pfipadech bychom méli pfijmout zakladni principy tvorby vzorcd popsané vyse.

Urychleni vypocti

Tabulky se Casto pouZivaji ke zpracovani surovych dat a k vytvareni smysluplnych shrnuti,
konsolidace a zobrazovani informaci pro osobu s rozhodovaci pravomoci nebo k pouziti jako
zdroj pro reporty. Surova data mohou byt ziskana fyzickymi méfenimi, obchodnimi transakcemi
nebo rdznymi jinymi zplsoby. Ve finan¢nich oddélenich nebo laboratofich se ¢asto nachazeji
listy s tisici nebo dokonce stovkami tisic fadk( a nékolika sloupci. Vypocty provadéné na téchto
zdrojovych souborech dat mohou byt Casové naro¢né a trvat minuty, hodiny a mozna i dny.

Castou chybou je vloZeni vzorctl do kazdé buriky a provedeni tisice interpretaci a vypoctl
vzorcl. Zde je nékolik doporucéeni pro urychleni vypoctd.
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PouZivani maticovych vzorcii pro mnoZstvi dat

Maticové vzorce maji jeden vzorec aplikovany na mnozstvi dat. Pro velké datové sady miZe byt
vyznamna Gspora vypodta.

Pouzivani konsolidac¢nich funkci

Konsolidacni funkce provadéji vypoclty na souborech dat. SUM, SUMIF, SUMIFS,
SUMPRODUCT jsou priklady konsolida€nich funkci. Napfiklad, pokud mame velmi dlouhy
seznam materialu, kde mnoZstvi musi byt vynasobeno jednotkovou cenou a pak secteno, aby se
vytvorila hodnota naklad(l, pak misto pouziti vzorce na kazdy zaznam kusovniku a pak seétent,
mUlzeme pouzit vzorec SUMPRODUCT(mnoZstvi; jednotkova cena), kde mnozstvi a jednotkova
cena jsou pojmenované oblasti prfedstavujici kusovnik. SUMPRODUCT néasobi kaZdou buriku
mnozstvi jeji odpovidajici buiikou jednotkové ceny a secte vSechny produkty.

Podobné situace nastavaji, kdyz musime séitat podmnozinu plvodni sady dat, kde musime
pouZzit test na kazdy zaznam, aby bylo mozné jej pouzit do souctu. Napfiklad kdyZ je hodnota
pouze kladn&. Pouzijeme SUMIF(data_pro_test;">0";data_pro_soucet), kde data_pro_test je
sada dat, ve které testujeme kladné hodnoty, data_pro_soucet je sloupec, kde maji byt hodnoty
souctu v zavislosti na testu, a ,>0" je samotny test.

Dal8imi konsolidacnimi funkcemi jsou AVERAGEIF, COUNTIF, MINIFS, MAXIFS a dalsi.

Pouziti maker pro vytvareni funkci

Dalsi strategii je vytvoreni vlastnich funkci a maker. Tento pfistup by se pouzil tam, kde by
vysledek vyrazné zjednodusil pouziti seSitu koncovym uzivatelem a udrzel vzorce jednoduché
s Vétsi Sanci vyhnout se chybam. Tento pfistup také mdze usnadnit Gdrzbu tim, Ze opravy

a aktualizace budou uloZeny na jednom centralnim misté. Pouziti maker je popsano v kapitole
12, Makra a je samo 0 sobé specializovanym tématem. Nebezpeci naduzivani maker

a uzivatelskych funkci spociva v tom, Ze principy, na nichz je seSit zaloZen, se stavaji mnohem

VA e

i autorem)!

Vice vlaken

Mnoho modernich pocitac¢li ma vicejadrové procesory a poskytuje vice viaken. Jadro je fyzicka
soucast hardwaru v CPU. VIakna jsou virtualni komponenty, které pomahaji efektivné fidit
pracovni vytizeni a Ukoly CPU. CPU miZe interagovat s vice nezZ jednim vlaknem najednou

a diky vice vlakntim jsou CPU efektivn&jsi a poskytuji lepsi celkovy vykon.

Program Calc podporuje vicevlaknové procesy, které pomahaji sesitlim vyuzivat veskerého
paralelniho zpracovani, které je v pocitaci k dispozici. Tato funkce je fizena volbou Povolit
vicevlaknové vypocty v sekci Nastaveni vidken CPU v dialogovém okné Nastroje > MoZnosti >
LibreOffice Calc > Vypocty. Vychozi nastaveni této moZnosti je povoleno a nedoporucuje se ji
deaktivovat. Toto je jediny ovladaci prvek v uzivatelském rozhrani programu Calc, ktery se tyka
vicevlaknového zpracovani; jakmile je zapnuto, zpracovani pracuje automaticky.

Pokud je povoleno vicevldknové zpracovani, program Calc automaticky identifikuje, kde by nas
seSit mohl tézit z vicevlaknového zpracovani a podle toho je zpracovava. Vldkna se obecné
pouzivaji pro skupiny vzorcl, kde dostatek sousednich bunék ve sloupci pouziva stejny vzorec,
ale z rdznymi vysledky kvdli relativnimu adresovani bunék. Jednim z ddsledk(l tohoto pfistupu je
to, Ze optimalizace je zaloZena na sloupcich, takze rozloZeni na fadcich mdze byt méné
efektivni.

Existuji i jiné zplsoby, jak Fidit vicevliaknovou funkci Calc, jako je Uprava proménné prostredi
LibreOffice MAX_CONCURRENCY. Tyto metody vSak pfesahuji ramec tohoto dokumentu.
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Hledani a oprava chyb

Je bézné narazit na situace, kdy se zobrazuji chyby. | se vSemi nastroiji, které jsou k dispozici
v programu Calc a poméhaji nam zadavat vzorce je snadné délat chyby. Mnoho lidi povaZuje
zadani Cisel za obtizné a mnoho z nich mdze udélat chybu, pokud jde o druh vstupu, ktery
potiebuje argument funkce. Kromé oprav chyb miiZzeme chtit najit buriky pouzité ve vzorci,
abychom zmenili jejich hodnoty nebo zkontrolovali odpovédi.

Program Calc poskytuje tfi nastroje pro zkoumani vzorcd a bunék, na které odkazuji: chybové
zpravy, barevné kédovani pro vstup a nastroj Detektiv.

Chybové zpravy

NejzakladnéjSim nastrojem jsou chybové zpravy. Chybové zpravy se zobrazuji v burice vzorce,
na stavovém fadku nebo v Privodci funkci misto vysledku.

Chybova zprava pro vzorec je obvykle trojciferné €islo od 501 do 540 nebo nékdy obecny kus
textu, jako je #NAME?, #REF! nebo #VALUE!. V burce se zobrazi chybové zprava a na pravé
strané stavového fadku se zobrazi kratké vysvétleni chyby.

VétSina chybovych zprav hlasi problém v zadani vzorce, nékolik pak oznamuje, Ze jsme narazili
na omezeni programu Calc nebo jeho aktualniho nastaveni.

Chybové zpravy nejsou uZzivatelsky privétivé a mohou nové uzivatele prekvapit. Jsou vSak
cennym voditkem k opravé chyb. Jejich podrobné vysvétleni najdeme v dodatku B - Kody chyb,
v napovédeé a hledanim ,chybovych kodd" v Calc. Nékteré z nej¢astéjSich jsou uvedeny v tabulce
13.

Tabulka 13: BéZné chybové zpravy

Kod Vyznam

#NAME?  Misto zobrazeni Err:525. Pro argument neexistuje platny odkaz.

#REF! Misto zobrazeni Err:524. Chybi sloupec, fadek nebo list pro odkazovanou buriku.

Misto zobrazeni Err:519. Hodnota jednoho z argumentd neni typu, ktery argument
vyzaduje. Hodnota mUzZe byt zadana nespravné; napriklad kolem hodnoty mohou
chybét uvozovky. Jindy mlze mit pouzita burika nebo oblast nespravny format,
napriklad text namisto Cisel.

#VALUE!

#DIV/0! Misto zobrazeni Err:532. Déleni nulou.

Misto zobrazeni Err:503. Vysledkem vypoctu je pfeteCeni definovaného rozsahu

|
ANUM hodnot.
509 Ve vzorci chybi operator, napriklad znaménko rovnosti.
510 Ve vzorci chybi proménna.

Priklady béZznych chyb

#DIV/0! déleni nulou

Tato chyba je vysledkem déleni €isla nulou (0) nebo prazdnou burkou. Existuje jednoduchy
zpUsob, jak se tomuto problému vyhnout. Pokud mame zobrazenu nulovou nebo prazdnou
bunku, pouzijeme podminénou funkci. Obrazek 238 znazortiuje déleni sloupce B sloupcem C,
coz vede k 2 chybam vyplyvajicim z nuly a prdzdné burnky znazornéné ve sloupci C.
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A B | C | D

]

2 Datum Pacienti Sestry FESIEIT 7=

sestru

3 |01.05.2020 24 5 4.8
4 |02.05.2020 16 5 3,2
5 |03.05.2020 21 3 7
6 |04.05.2020 17 0 #DIV/0!
7 |05.05.2020 18 4 4.5
8 |06.05.2020 17 #DIV/0!
9 |07.05.2020 19 5 3.8
10 | 08.05.2020 22 4 55
11 [09.05.2020 21 4 5,25
12 | 10.05.2020 18 3 6
13 | 11.05.2020 19 4 4,75

Obréazek 238: Priklady #DIV/0!, chyba déleni nulou

Je velmi Casté najit chybu, jako je ta, ktera vznikla v situaci, kdy data nebyla reportovana nebo
reportovana nespravné. Pokud je takovy vyskyt mozny, Ize pro spravné zobrazeni dat pouZzit
funkci IF. Lze zadat vzorec =IF(C3>0; B3/C3; "Zadny vykaz"). Vzorec je potom zkopirovan do
zbytku sloupce D. Vyznam tohoto vzorce by byl zhruba: “Pokud je C3 vétSi nez 0, pak vypocitej
B3 déleno C3, jinak vypi$ “Zadny vykaz.“ Piklad je znazorné&n na obrazku 239.

Je také mozné, aby posledni parametr pouzival dvoijité uvozovky pro prazdné (zadné hodnoty),

nebo aby se spodni Cislo nahradilo jinym vzorcem se standardizovanym cislem.

IF ~ | fx =IF(C3>0;B3/C3;"Zadny vykaz")
A [ s [ ¢ WM ¢ | ¢
1
2 Datum Pacienti Sestry PEETENM (=1
sestru

EN 01.05.2020 24 5/=IF(C3=0;B3/C3;"Zadny vykaz")
| 4 |02.05.2020 16 5 3,2
| 5 |03.05.2020 21 3 7
| 6 |04.05.2020 17 0Z&adny vykaz
| 7 |05.05.2020 18 4 4,5
| 8 |06.05.2020 17 Zadny vykaz
| 9 |07.05.2020 19 5 3,8
| 10 | 08.05.2020 22 4 5,5
| 11 |09.05.2020 21 4 5,25
| 12 |10.05.2020 18 3 6

13 | 11.05.2020 19 4 4,75

Obrazek 239: Reseni déleni nulou

#VALUE! Zadny vysledek a #REF! nespravné odkazy
Chyba #VALUE! je také velmi Casta.

Obvykly vyskyt této chyby nastane, kdyZ burika obsahuje nespravny typ hodnoty. V pfikladu na
obrazku 240 byl do C8 vlozen text ,None*, kde nas vzorec ve sloupci D oCekava Cislo.
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A

D

Datum

01.05.2020
02.05.2020
03.05.2020
04.05.2020
05.05.2020
06.05.2020
07.05.2020
08.05.2020
09.05.2020
12 | 10.05.2020
13 |11.05.2020

:%Emmuc\mnw‘m i

Pacienti

24
16
21
17
18
17
19
22
21
18
19

Sestry

Pacientd na
sestru

4.8

3,2

7

O W

45
#VALUE!
3.8

55

5.29

6

4,75

B oW

Zadny vykaz

Obrazek 240: Nespravna poloZka
zplsobujici #VALUE! chyba

Chyba #REF! je zplsobena chybé&jicim odkazem. V prikladu zobrazeném na obrazku 241

odkazuje vzorec na list, ktery byl odstranén.

SUM ~ || Fx
B | C

=SUMI(LIst5.ATAT) | | A2

=SUM(List5.A1:Al1)

=SUM(#REFLAT;AT)
c |

Obrazek 241: Smazany list, zplsobujici #REF! chyba

Barevné kédovani pro vstup

DalSim uziteCnym nastrojem pfi kontrole vzorce je barevné kdédovani vstupu. Kdyz vybereme
vzorec, ktery jiz byl zadén, jsou buriky nebo oblasti pouZité pro kazdy argument ve vzorci se

barevné zvyrazni.

IF ~ |l Fx =IF(C3>0;B3/C%;"Zadny vykaz")
A [ s [ ¢ NN -
1
2 Datum Pacienti Sestry FEELIL
sestru .
BEN 01.05.2020 | 24L al=IF(C3>0;B3/C3;"Zadny vykaz")

Obrazek 242: Barevné koédovani pro vstup

Program Calc pouziva osm barev pro zvyraznéni referen€nich bunék, poc€inaje modrou pro prvni
bunku, a pokraCujici Cervenou, purpurovou, zelenou, tmavé modrou, hnédou, fialovou a Zlutou,

coz se cyklicky opakuje v sekvenci.

Zvyraznovani hodnot

Existuji situace, kdy je zobrazeni obsahu bunék stejné, i kdyz je datovy typ odliSny. Napriklad
textovy obsah a ¢iselny obsah mohou vypadat stejné, ale mohou zpUsobit chybu, pokud jsou oba
pouzity v nékterych vypoctech. Pro ilustraci Ize fetézec ,10,35“ zarovnany doprava v burce
zameénit s hodnotou 10,35. KdyzZ je burika pouzita ve vzorci, fetézec mlze mit hodnotu nula

a mlze dojit k chybé.

Pokud povolime zvyraznéni hodnot (Zobrazit > Zvyraznovani hodnot nebo Ctrl + F8), program
Calc rozliSuje textove a Ciselné datové typy barvou. Ve vychozim nastaveni je textovy obsah
¢ernymi znaky a Ciselny obsah je modry. DalSi informace o zvyrazniovani hodnot nalezneme
v kapitole 2 - Zadavani, Upravy a formatovani dat.

Detektiv

V dlouhé nebo komplikované tabulce je barevné zvyraznéni méné uzite¢né. V téchto pfipadech
mlZeme pouzit podnabidky pod poloZkou Nastroje > Detektiv. Detektiv je nastroj pro kontrolu,
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které buriky jsou pouzity jako argumenty vzorce (predch(dci) a které dalsi vzorce jsou vnofeny
(naslednici), a chyb zavislosti. Lze jej také pouzit pro trasovani chyb, ozna€ovani neplatnych dat
(to je informace v bunkéach, ktera neni ve spravném formatu pro argument funkce), nebo dokonce
pro odstranéni predchlidcd a naslednikd.

Chceme-li pouzit nastroj Detektiv, vybereme buriku se vzorcem a poté vybereme poZadovanou
moZnost z nabidky Nastroje > Detektiv. V tabulce uvidime Cary koncici teCkami, které oznacuji
predchlidce, a ¢ary koncici Sipkami pro nasledniky. Radky ukazuji tok informaci.

Nastroj Detektiv pouzijeme pfi sledovani predchldcli uvedenych ve vzorci v burice. Sledovanim
téchto predchldct miZzeme Casto najit zdroj chyb. Umistime kurzor do pfislusné burky a poté
zvolime v hlavni nabidce Nastroje > Detektiv > Pfedchldci nebo stiskneme Shift + F9. Obrazek
243 ukazuje jednoduchy priklad trasovani predchddct pro buiiku B4.

A | B
1 |Kapital $200,000
2 |Roky 1
3 |Urokova sazba 7,50 %
4 |Roény vynos $15,000

Obréazek 243: Sledovani predchidct
pomoci nastroje Detektiv

To ndm umozZziiuje zkontrolovat, zda zdrojové buriky (coz mlze byt i oblast) nevykazuji chyby.
Pokud je zdrojem oblast, je tento rozsah zvyraznén modfre.

V jinych pfipadech bude moznéa nutné vyhledat zavislosti chyby. K tomu pouzivame funkci
Vyhledat zavislosti chyby v Nastroje > Detektiv > Vyhledat zavislosti chyby a vyhledame buriky,
které chybu zpUsobily.

DalSi informace vyhledame v rejstfiku systému napovédy pod heslem ,Detektiv*.

Priklady funkci

Pro novacky jsou funkce jednou z nejvice obtiznych oblasti v LibreOffice Calc. Novi uzivatelé
rychle zjisti, ze funkce jsou dilezitou vlastnosti tabulek, ale existuji jich stovky a mnoho z nich
vyzaduje vstup, ktery pfedpoklada specializované znalosti. Nastésti Calc obsahuje mnoho funkci,
které mize pouzit kdokoli.

Zakladni aritmetika a statistika

Nejzakladnéjsi funkce vytvareji vzorce pro zakladni aritmetiku nebo pro vyhodnoceni Cisel
v oblasti bunék.

Zakladni aritmetika
Mezi jednoduché aritmetické funkce patfi scitani, odCitani, ndsobeni a déleni. S vyjimkou
odcitani ma kazda z téchto operaci svou vlastni funkci:

*  SUM pro scitani

*  PRODUKT pro nasobeni

*  QUOTIENT pro déleni

SUM, PRODUCT a QUOTIENT jsou uZzite¢né pro zadavani oblasti bunék stejnym zplsobem
jako u jakékoli jiné funkce, s argumenty v zavorce za ndzvem funkce.

U z&kladnich rovnic vS§ak mnoho uZivateld dava prednost poc&itacovym symboldim pomoci
znaménka plus (+) pro scitani, pomlcky (-) pro odcitani, hvézdicky (*) pro nasobeni a lomitka (/)
pro déleni. Tyto symboly se rychle zadavaji a jsou jednoduse dostupné na klavesnici.
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Podobna volba je také k dispozici pro umocnéni Cisla jinym Cislem. Misto zadani =POWER(A1;2)
mlzeme zadat =A1"2.

Kromeé toho maji tu vyhodu, Ze s nimi zadavame vzorce v poradi, které se blizZi lidsky Citelnému
formatu vice nez formét Citelny tabulkovym procesorem pouzivany ekvivalentni funkci. Napfiklad
misto zadavani =SUM(A1:A2) nebo pfipadné =SUM(A1;A2) zadame =A1+A2. Tento témér lidsky
Citelny format je zvlasté uzitecny pro sloZzené operace, kde zapis =A1*(A2+A3) je kratSi a snaze
Citelny nez =PRODUCT(A1;SUM(A2:A3)).

Hlavni nevyhoda pouziti aritmetickych operator spoc¢iva v tom, Ze nem{zeme pfimo pouzit
oblast bunék. Jinymi slovy, pro zadani ekvivalentu =SUM(A1:A3) je tfeba zadat =A1+A2+A3.

Zda pouzivame funkci nebo operator, je z velké ¢asti na nds — samoziejmeé s vyjimkou odgitani.
Pokud vSak tabulky pouzivame pravidelné ve skupiné, napfiklad ve tfidé nebo kancelafi, mozna
budeme chtit standardizovat vstupni format, aby si kazdy, kdo tabulku zpracovava, zvykl na
standardni vstup.

Jednoduché statistiky

DalSim béznym vyuZitim funkci tabulkového procesoru je vytazeni uzite€nych informaci ze
seznamu, napfiklad série testll ve tfidé nebo souhrn vydélkd za Ctvrtleti pro spoleénost.

Samoziejmé mlzZeme prohledat seznam &isel, pokud chceme zakladni informace, jako je

x v s

v s

obvykle rychlejsi a efektivnéjsi zadat funkci. Takové dlvody vysvétluji existenci funkce, jako je
COUNT, ktera vraci pouze celkovy pocet zaznami v uréené oblasti bunék.

s

z téchto vzorcl jsou vdechny argumenty bud oblast bunék, nebo fada bunék zadanych
jednotlive.

Kazda ma také souvisejici funkci MINA nebo MAXA, ktera vykonava stejnou funkci, ale také
zachazi s bunku forméatovanou jako text jako s hodnotu 0. Stejné zachézeni s textem se
vyskytuje v jakékoli varianté jiné funkce, ktera na konec prida ,A". Kazda funkce poskytuje stejny
vysledek a mdze byt uzite¢na, pokud jsme napfiklad pomoci textového zapisu uvedli, Ze v dobé,
kdy byl psan test, byli studenti nepfitomni a chtéli jsme zkontrolovat, zda naplanovat nahradni
zkouSku.

Pro vétsi flexibilitu pfi podobnych operacich bychom mohli pouzit LARGE nebo SMALL, které
pridavaji specializovany argument poradi. Pokud je s LARGE pouzito pofadi 1, dostaneme stejny
vysledek jako s MAX. Pokud je vSak pofadi 2, je vysledkem druhy nejvétSi vysledek. Podobné,
poradi 2 pouzité se SMALL ndm dava druhé nejmensi €islo. LARGE i SMALL jsou vhodné jako
trvala kontrola, protoZze zménou argumentu poradi mizeme rychle prohledat vice vysledk.

Museli bychom byt odbornikem, abychom nasli Poissonovu distribuci vzorku, nebo nasli
zkosenou nebo negativni binomii distribuce (a pokud jsme, v programu Calc pro takoveé véci
najdeme funkce). Pro nas ostatni vSak existuji jednodussi statistické funkce, které se mlizeme
rychle naucit pouzivat.

Zejména pokud potfebujeme prdmér, musime si vybrat z nékolika funkci. MlZeme naijit
aritmeticky primér — vysledkem funkce AVERAGE je, Ze zadanim oblasti ¢isel pfidame vSechny
polozky do seznamu a je pak vydélime poétem zaznamd. Chceme-li zahrnout textové zaznamy
a dat jim hodnotu nula, pouzijeme funkci AVERAGEA.

Kromé toho mUZete ziskat dal3i informace o sadé dat:

* MEDIAN: Logicky fadi Cisla (od nejnizsi k nejvyssi) pro vyhodnoceni stfedni hodnoty.
V sadé, kter4 obsahuje nerovnomeérny pocet hodnot, bude medidnem ¢islo uprostied
seznamu. V sadé, kterd obsahuje sudy pocet hodnot, bude stfedni hodnota primérem ze
dvou hodnot uprostfed sefazeného seznamu.

288 | Prirucka Calc 7.0



Vv wrw

* MODE: Nejbéznéjsi polozka v seznamu Cisel.
*  QUARTILE: Zaznam na nastavené pozici v poli ¢isel. Kromé rozsahu bunék zadate typ

pro nejvyssi polozku. Vysledek u typl 1 az 3 nemusi predstavovat skutecné zadanou
polozku.

« RANK: Pozice dané polozky v celém seznamu, méfena shora dolli nebo zdola nahoru.
Musite zadat adresu buriky pro zaznam, rozsah zaznamdi a typ hodnoceni (0 pro
hodnoceni od nejvyssiho, nebo jakakoliv jina hodnota pro hodnoceni odspodu).

Neékteré z téchto funkci se prekryvaji; napriklad MIN a MAX jsou obé pokryty QUARTILE.

V jinych pfipadech mize vlastni fazeni nebo filtr poskytnout témér stejny vysledek. To, co
pouzivame, zavisi na nasich zvyklostech a potfebach. Néktefi mozné davaji pfednost pouZziti
MIN a MAX, protoZe jsou shadno zapamatovatelné, zatimco jini davaji pfednost QUARTILE,
protoZe je univerzalngjsi.

Pouzivani téchto funkci

V nékterych pfipadech je u nékterych z téchto funkci mozné ziskat podobné vysledky
nastavenim filtru nebo vlastniho tfidéni. Obecné jsou vSak funkce snadnéji nastavitelné nez filtry
nebo tfidéni a poskytuji Sirokou Skalu moznosti.

Nékdy mizeme chtit jen zadat do¢asné jeden nebo vice vzorcl do vhodné prazdné buiiky a po
dokonceni je odstranit. Pokud vSak narazime na to, Ze neustale pouzivame stejné funkce, méli
bychom zvazit vytvofeni Sablony a vyhradit misto pro vSechny funkce, které pouzivame, pfiCemz
burika vlevo slouzi jako popisek. Po vytvoreni Sablony miizeme snadno aktualizovat kazdy
vzorec podle zmén polozek, a to bud automaticky a za béhu, nebo stisknutim klavesy F9 pro

k aktualizaci vdech vybranych bunék.

Bez ohledu na to, jak tyto funkce pouzivame, pravdépodobné zjistime, Ze jsou snadno pouzitelné
a prizpUsobitelné mnoha Gcéellim. Poté co zvladneme tyto jednodussi funkce budeme pripraveni

Mrlw N s

Zaokrouhlovani cisel

Pro statistické a matematické Gi¢ely obsahuje program Calc réizné zplsoby zaokrouhleni &isel.
Né&které z t&chto metod jsou znamé programatorlm. Nemusime vSak byt specialistou, abychom
pouzivali nékteré z téchto uzite€nych metod. MoZzna budeme chtit zaokrouhlovat za G€elem
fakturace, nebo proto, Ze desetinna mista se do fyzického svéta dobfe neprevadéji — napriklad
pokud soucastky, které potfebujeme jsou v baleni po 100, pak skutec¢nost, Ze potfebujeme pouze
66, je pro nas irelevantni; pro objednani je tfeba zaokrouhlit nahoru. Naucime-li se moznosti

v s

Pfi pouziti funkce zaokrouhlovani mame dvé moznosti, jak nastavit vzorce. Pokud se
rozhodneme, miiZzeme vnorit vypocet do jedné z funkci zaokrouhlovani. Napfiklad vzorec
=ROUND((SUM(A1;A2)) pfida Cisla do bunék Al a A2 a zaokrouhli je na nejblizsi celé Cislo.
| kdyZ nemusime pracovat s presnymi Udaji kazdy den, mizeme se na né obc¢as odkazovat.
Pokud je tomu tak, pak je pravdépodobné lepsSi oddélit obé funkce, umistit =SUM(A1;A2) do
buiiky A3 a =ROUND(A3) do A4 a jasné oznacit kazdou funkci.

Podrobnosti o metodach zaokrouhlovani nalezneme v ndpoveéde.

Volatilni/nevolatilni funkce

Open Document Format for Office Applications (OpenDocument) Verze 1.2 obsahuje nasledujici
definici: “Funkce, které jsou vzdy pfepocitany, kdykoli dojde k pfepoctu, se nazyvaji volatilni
funkce.
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Abychom pochopili néktera chovani volatilni funkce v programu Calc, zvazme jednoduchy
pfiklad, ve kterém jsme vytvorili prazdnou tabulku a zadali vzorec =RAND() do buriky A1 (RAND
je jedna z volatilnich funkci programu Calc). Program Calc zobrazi v bufice A1 ndhodné Cislo
mezi 0 a 1. Pokud poté zadame libovolnou hodnotu do jiné burky (pro Gcely této diskuse
fekneme burnku B2) a stiskneme Enter, vSimneme si, Ze hodnota zobrazena v Al je
aktualizovana, aby zobrazovala jiné nahodné €islo. Calc prepocita nahodné ¢&islo v Al, navzdory
tomu, Ze uzivatel nezménil vzorec v A1 a navzdory tomu, Ze aktualizované B2 nema zadny
odkaz na Al. Stru¢né fe€eno, funkce RAND vygeneruje novou hodnotu, kdyZ je néktera burika
aktualizovana vybérem Data > Spocitat > Pfepocitat nebo zmacknutim klavesy F9 nebo
jakoukoliv jinou vstupni udalosti. Pochopeni volatilnich funkci je dilezité, zejména pokud
vytvafime velkou tabulku, kde Casté pfepocty mohou nepfiznivé ovlivnit vykon. Ujistime se, Ze
jsme seSit navrhli tak, aby spravné pouzival volatilni funkce.

Nasleduijici funkce programu Calc jsou volatilni:
* FORMULA
* INDIRECT
* INFO
* NOW
* OFFSET
* RAND
* RANDBETWEEN
« TODAY

Pro funkce RAND a RANDBETWEEN nabizi program Calc nevolatilni nahrady — RAND.NV

a RANDBETWEEN.NV. Mohou byt uzite¢né, kdyz nepotfebujeme tak ¢asto aktualizovat hodnoty
funkci. Nevolatilni funkce se pfi novych vstupnich udalostech nepfepocita a znovu se nepocita
pfi vybéru Data > Spocitat > pfepocitat nebo zméacknuti F9, s vyjimkou pokud neni burika
obsahujici funkci vybrana. P¥i otevieni souboru jsou nevolatilni funkce prepocitany.

Pouziti zastupnych znakl a regularnich vyrazi ve funkcich

Calc podporuje pouZiti zastupnych znakl nebo reguléarnich vyraz(i v argumentech mnoha svych
funkci.

Regularni vyrazy nabizeji vykonné metody hledani textovych fetézcl. Dalsi informace
o regularnich vyrazech v&etné priklad(i nalezneme v ¢asti ,Regularni vyrazy“ v kapitole 1, Uvod.

Pokud je pro nasi tabulku dilezita interoperabilita s Microsoft Excel, moZna nebudeme moci piné
vyuZzivat moznosti regularnich vyrazl programu Calc, protoZze Excel neposkytuje ekvivalentni
funkce. KdyZ tedy exportujeme tabulku Calc do formatu Excel, informace tykajici se regularnich
vyrazl nebudou v aplikaci Excel pouZitelné. V tomto pfipadé mdzeme pouzit méné vykonnou
funkci zastupnych znak( poskytovanou programem Calc, protozZe tabulky, které pouZzivaji
zastupné znaky, Ize exportovat do forméatu Excel bez ztraty dat. Zastupny znak je specialni znak,
ktery zastupuje jeden nebo vice blize neuréenych znakd. Vyhledavani s vyuzitim zastupnych
znakdl je vykonné, Casto je vSak méné konkrétni. dostupné zastupné znaky jsou ? (otaznik), *
(hvézdicka) a ~ (vinovka). PouZiti téchto zastupnych znaki je stejné jako u dialogového okna
Najit a nahradit, popsaného v Casti 2, Zadavani, Upravy a formatovani dat.

Nasledujici funkce programu Calc povoluji pouzivani zastupnych znak{ nebo regularni vyrazti ve
vyhledavacich kritériich.

+ Databazové funkce (DAVERAGE, DCOUNT, DCOUNTA, DGET, DMAX, DMIN,
DPRODUCT, DSTDEV, DSTDEVP, DSUM, DVAR, DVARP)
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* AVERAGEIF, AVERAGEIFS, COUNTIF, COUNTIFS, MAXIFS, MINIFS, SUMIF, SUMIFS
*+  HLOOKUP, LOOKUP, VLOOKUP

« MATCH
* REGEX (neplati pro zastupné znaky)
*+ SEARCH

Moznosti konfigurace jsou dostupné v sekci Zastupné zn